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About This Guide

This guide describes how to use VXT software on a VXT 2000 windowing
terminal. The terminal makes use of the open windowing environment. The
guide describes how to create X window or terminal window sessions on a wide
variety of operating systems.

Who Should Use This Guide

This guide is for the general user of the VXT 2000 windowing terminal.

• If you are new to windows or the Motif windows environment, the guide
provides basic information on how to use windows and the mouse pointing
device.

• If you are familiar with windows, you can use the guide to learn about VXT
software features and customize your terminal’s operating features.

Organization

This guide contains the following chapters and appendices:

• Chapter 1, ‘‘A Look at the Terminal,’’ provides an overview of the terminal
and its features.

Terminal Manager Window

• Chapter 2, ‘‘Using the Terminal,’’ describes the basic features of the
Terminal Manager window. The chapter describes how to create sessions,
print the screen, and view online VXT 2000 documentation.

• Chapter 3, ‘‘Customizing the Terminal,’’ describes how to customize basic
terminal settings for your language, personal preference, and system
security.

• Chapter 4, ‘‘Customizing Communications,’’ describes how to customize
terminal settings that affect communications with host computer systems.
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• Chapter 5, ‘‘Customizing Fonts and Startup Settings,’’ describes how to
customize more advanced settings. Topics include autostarting sessions
and applications, changing font paths, booting VXT software, and loading
or unloading VXT software features.

• Chapter 6, ‘‘Checking the Terminal’s Status,’’ describes how to use the
Terminal Manager window’s Status menu to monitor memory use, network
use, network counters, and the terminal’s system configuration. You can
also view TCP/IP routes and use ping to determine the availability of hosts.

VXT DECterm Windows

• Chapter 7, ‘‘Using VXT DECterm Windows,’’ describes how to use DECterm
windows, which emulate a VT300 series terminal.

• Chapter 8, ‘‘Customizing VXT DECterm Windows,’’ describes how to
customize your DECterm windows for your computing environment and
personal preference.

VXT 3270 Windows

• Chapter 9, ‘‘Using VXT 3270 Windows,’’ describes how to use the VXT 3270
terminal emulator to run applications on an IBM SNA host system through
a DECnet/SNA gateway.

• Chapter 10, ‘‘Customizing VXT 3270 Windows,’’ describes how to customize
the VXT 3270 terminal emulator window.

Window Manager

• Chapter 11, ‘‘Using Windows,’’ describes how to manage windows and use
menus, dialog boxes, and scroll boxes. The chapter also shows how to use
the mouse.

• Chapter 12, ‘‘Customizing Windows,’’ describes how to check and control
the settings for many of the window manager’s features. You can make
changes to the settings and save them for all future sessions.

• Chapter 13, ‘‘Launching Applications,’’ describes how to launch sessions,
local VXT applications or remote host applications from your terminal.

VXT EX Software

• Chapter 14, ‘‘Using VXT EX Software,’’ describes how to use VXT EX
software. VXT EX software is a minimal version of VXT software without
a terminal manager and other local clients.
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Keyboards

• Chapter 15, ‘‘Using Your Keyboard,’’ describes the keys and indicator lights
on the terminal’s ANSI, short ANSI (UNIX), PC, and Sun style keyboards.
It also describes how to type additional characters not listed on your
keyboard keys and how to use the keyboard in place of the mouse.

Appendixes

• Appendix A, ‘‘Solving Problems and Getting Service,’’ describes how to solve
typical operating problems and how to get service.

• Appendix B, ‘‘Mixing Colors,’’ describes how to use the Color Mixing dialog
box that lets you change the color of windows and the screen.

• Appendix C, ‘‘Programming with the X Windows Image Extension,’’
provides guidelines for programming with XIE protocol functions.

• Appendix D, ‘‘Related Documentation,’’ lists related documentation.

• Appendix E, ‘‘Options,’’ lists available hardware options.

• Appendix F, ‘‘Specifications,’’ lists the general, environmental, and electrical
specifications for the terminal.

• Appendix G, ‘‘Setting Up the Work Environment,’’ lists recommendations
for your health and safety while using the terminal.

• The glossary defines new terms introduced in the text and other relevant
terms.

Comments?

Please send us your comments and suggestions about this guide or other VXT
manuals. You can use the Reader’s Comments form at the end of this guide, or
you can send electronic mail to the following Internet address:

docteam@gwen.enet.dec.com

When making comments, please include the manual title and part number
listed on the front cover. For specific comments, please include a page number,
section number, or section title for reference.
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Conventions

This guide uses the following conventions:

Convention Meaning

VXT 2000 windowing
terminal

Refers to all models of the VXT 2000 windowing terminal.

InfoServer system Refers to a disk server that downloads a VXT system image to
the terminal.

Mouse Refers to any pointing device, such as a mouse, a puck, or a
stylus.

MB1, MB2, and MB3 Represent the three mouse buttons: left (MB1), middle (MB2),
and right (MB3). Lefthanded users can exchange the MB1 and
MB3 button assignments if desired.

key Keys or switches that are labeled appear in a box .

Example: Press the Return key.

Alt Represents the Alt or Alt Function key on your keyboard.

Ctrl key key For Ctrl key sequences, press and hold each key in order until
you complete the sequence.

Ctrl+left Alt If a key sequence includes descriptive words, the keys are
joined by a plus (+) symbol for clarity.

Caution Provides information to prevent damage to equipment or
software.

Note Provides general information about the current topic.

Menu item . . . Menu items followed by . . . display a dialog box when chosen.

Menu item . Menu items followed by . display a submenu when chosen.

Glossary entries Appear in bold when first used in text.

Index entries The following abbreviations are used in the index:

(TM)
(WM)

for Terminal Manager
for Window Manager

Notes to the Reader

The screens and windows shown in this guide represent the latest information
available at the time of publication. Some screens and windows may not
exactly match those that appear on your terminal or reflect the system-default
settings.
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1
A Look at the Terminal

1

This chapter provides an overview of the VXT 2000 windowing terminal and
its basic operating features. The chapter tells you where to look in this guide
for more information about each feature.

1.1 Terminal Highlights

The VXT 2000 windowing terminal lets you access X window applications and
traditional terminal applications on computer systems in your network. You
can open several windows on the terminal, to display multiple applications
from different systems at the same time.

The VXT 2000 terminal provides many features of a workstation without the
need for workstation management. Here are some of the terminal’s main
features:

Hardware

• A workstation-style display, a keyboard, and a mouse.

• A monochrome, gray scale, or color monitor.

• A choice of Ethernet network connectors: ThinWire, thickwire, or twisted
pair.

• A 25-pin RS-232 serial printer/communications port with full modem
control.

• A 25-pin parallel printer port.

• Serial interfaces for a keyboard and a mouse or tablet.

• Expandable memory (user installable).

VXT 2000+/VXT 2000 Windowing Terminal User Information 1
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1.1 Terminal Highlights

Software

• The ability to access several computer systems at the same time, using the
TCP/IP, LAT, or DECnet transports.

• A choice of VXT software or VXT EX software, downloaded from a host
computer system or an InfoServer system.

• VXT software provides local applications and features such as

A local Terminal Manager window that lets you create and manage
connections to computer systems. You can connect to systems using the
TCP/IP, LAT, or DECnet transport. See Chapter 2.

VXT DECterm windows that let you access VT video terminal
applications on computer systems. VXT DECterm windows emulate
VT300 series video terminals. See Chapter 7.

VXT 3270 windows that let you access applications on an IBM SNA
system. See Chapter 9.

A local Motif window manager that lets you easily move and resize
windows, using a mouse or keyboard for navigation. See Chapter 11.

An AutoStart feature to automatically start your selected computer
sessions and local terminal applications when you start work, or at any
other time. See Section 5.6.

A Customize Boot dialog box for choosing the VXT software version you
want your terminal to load. See Section 5.7.

A Customize Font Path dialog box that lets you access fonts from host
systems and font servers on your network. See Section 5.3.

Configuration Manager windows that let a system manager configure
individual terminals or groups of terminals to share customized
settings and fonts. See VXT Software Version 2.1 Installation and

System Management.

• VXT EX (essential X server) software is a clientless version of VXT
software, without local applications. You can use VXT EX software to
access X applications on computer systems with minimal memory installed
in the terminal. When you use VXT EX software, the system you connect
to must provide all window and session management features.

2 Chapter 1
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1.2 How the Terminal Works

1.2 How the Terminal Works

The VXT software and fonts for your terminal are installed on a host computer
system or an InfoServer system. An InfoServer system is a high-performance
virtual disk server that can efficiently download software to many terminals.

You can use the terminal with one or more computer systems. You can connect
the terminal to

• An Ethernet network, using the ThinWire, thickwire, or twisted-pair port

• A computer, using the serial port

The computer system you connect to is called the host. You can connect your
terminal to several hosts.

You use the keyboard, mouse and monitor to interact with applications on your
host. You send data to the application by typing on the keyboard or selecting
window options with the mouse. Data sent by the application appears as
text or graphics on the terminal’s screen. You can print text or graphics on a
printer connected to the terminal’s printer port or on any networked printer.

You can use a variety of host software applications on the terminal. For
example, your host may have applications for word processing, data entry,
programming, or business graphics. Most applications involve interactive
processing. This means the terminal immediately sends the information you
enter from the keyboard or mouse to the host.

1.3 VXT Software

Each time you start up the terminal, it sends out a network request for a host
or InfoServer system to download VXT software and fonts to the terminal.
This process of starting up the software and bringing it to an operable state is
also known as booting.

Knowledgeable users can customize the terminal’s boot settings to load a
particular VXT software version. See Section 5.7 for details.

There are some differences between host-based and server-based operation.

VXT Host-Based Software

If your terminal downloads VXT software from a host system, the terminal
always uses its own physical memory to display applications and store your
customized terminal settings. Host-based operation provides

• A Terminal Manager window

• VXT DECterm and VXT 3270 windows
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1.3 VXT Software

• A local Motif window manager

• A configuration manager—Your system manager can use the Configuration
Manager dialog boxes to customize and manage individual terminals from
a central terminal.

VXT Server-Based Software

If your terminal downloads VXT software from an InfoServer system, the
terminal typically operates in server-based mode. In server-based mode, the
terminal saves your customized terminal settings on an InfoServer system.
Server-based mode provides all the features of the host-based operation, plus

• Virtual memory capability—The InfoServer system provides the terminal
with additional memory as needed to display more applications. As a
result, the terminal needs less installed memory than when you use
host-based operation.

• More configuration manager features—Your system manager can use the
Configuration Manager dialog boxes to customize and manage groups of
terminals, as well as the fonts they use.

• InfoReader library—You can access this library of online VXT documenta-
tion from the Getting Started menu in the Terminal Manager window. The
library includes this user guide.

You can also choose the host-based mode of operation when downloading from
an InfoServer system. In this case, your customized settings are stored in the
terminal’s memory, and the terminal cannot use the InfoServer system for
memory services. You still have access to the InfoReader library. Your boot
settings determine the mode of operation. See Section 5.7.

1.4 VXT EX Software

VXT EX (essential X server) software is a clientless version of VXT software,
which means it does not include any local applications such as the Terminal
Manager window, VXT DECterm and VXT 3270 windows, or the Motif window
manager.

VXT EX software lets you use a VXT 2000 windowing terminal as a
workstation companion, relying on the host system to provide a session
manager, window manager, and other applications. You can use VXT EX
software with minimal memory installed in the terminal.

VXT EX software provides a single dialog box for starting an X session on
a host system. You can start a session on a system that supports the LAT
or TCP/IP transports and access that system’s X window applications. See
Chapter 14.
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1.5 Memory Requirements

1.5 Memory Requirements

When you turn on the terminal, the VXT software is loaded into the terminal
from an InfoServer system or from a host computer system. There are
different memory requirements for using server-based or host-based software.
The optional image accelerator board for some VXT 2000 models also requires
extra memory.

If You Use VXT Software... And...
Your Terminal Needs At
Least...

Server-based – 4 megabytes of memory

Server-based Image accelerator board 6 megabytes

Host-based – 10 megabytes

Host-based Image accelerator board 12 megabytes

If You Use VXT EX
Software... And...

Your Terminal Needs At
Least...

Host- or server-based – 4 megabytes of memory

Host- or server-based Image accelerator board 6 megabytes

Standard Terminal (4 MB)

The standard terminal comes with 4 megabytes of memory. You can expand
memory up to 18 megabytes by installing memory modules in the terminal. To
expand memory on system box models, you must install a memory controller
board.

Optional Memory (To 18 MB)

• 2-megabyte memory controller board (for system box models)

• One to three 2-megabyte or 4-megabyte memory modules

To install memory, see VXT 2000+/VXT 2000 Windowing Terminal Installing

and Getting Started. To order memory, see Appendix E.
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1.5.1 Monitoring Memory Use (Host-Based Terminals)

If your terminal uses host-based VXT software, the number of applications
and windows you can display is limited by the amount of physical memory in
the terminal. The amount of memory in use changes as you open and close
windows and applications. If you run out of memory, the terminal may quit all
current X sessions and terminal window sessions and reboot itself.

When the amount of available memory is low, the Terminal Manager window
displays a warning message. You can also monitor memory use by checking the
System Monitor dialog box (Section 6.5).

To regain memory, you can

• Close or quit from any unused applications, windows, or sessions.

• Decrease the number of lines the terminal saves when you scroll them off
the top of a VXT DECterm window. See Section 8.4.

• Limit the software options you load to only those you need. See Section 5.8.

• End all current sessions by rebooting the terminal’s software. To reboot the
terminal’s software:

– Choose Reset, Reboot, or Shutdown from the Terminal Manager
window’s Session menu.

– Press the reboot key sequence for your keyboard:

ANSI (LK401) keyboard Press Ctrl Alt . , using the left Alt key and the
period key on the numeric keypad.

PC (LK443/LK444)
keyboard

Press Ctrl Alt . , using the period key on the
numeric keypad.

Short ANSI (LK421)
keyboard

Press Ctrl Alt Extend . .

Sun style (LK460)
keyboard

Press Ctrl } Del .

To install more memory in the terminal, see Appendix E.

1.6 X Window Sessions and Terminal Window Sessions

You can use two types of sessions on your host computers: an X window

session or a VXT terminal window session. You can open X window
sessions and VXT terminal window sessions at the same time.
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1.6 X Window Sessions and Terminal Window Sessions

X Window and DECwindows Sessions

The X Window System is a graphically oriented user interface that lets you
display one or more windows on the screen. Each window can represent a
different software application running on its own host system. For example,
you could run a word processing application in one window and a spreadsheet
application in another window. With multiple windows, you can perform many
tasks in an easy and efficient manner.

The X Window System was designed at the Massachusetts Institute of
Technology. Digital’s DECwindows Motif software is based on the X Window
System and the Open Software Foundation’s Motif standard.

To use an X window session, you log in to a host that has X window
applications. In an X window session, you can use all the applications and
utilities provided in the X Window System. For more information about
Digital’s X applications, see the DECwindows Motif User’s Guide for your
operating system.

Terminal Window Sessions

You can create terminal windows to access video text terminal applications on
host systems. The terminal lets you create multiple VXT DECterm or VXT
3270 terminal windows. When you open a terminal window, you log in to a
host as you would on a conventional video terminal.

1.7 Customizing Your Terminal

VXT software provides menus and dialog boxes that let you customize the
operating settings for your terminal’s window manager, terminal manager,
VXT DECterm windows, and VXT 3270 windows. You can save your own
settings or use factory-default settings from memory.

When you save customized settings in dialog boxes, the terminal stores
your settings in a native resource file. Whenever you turn on or reset the
terminal, it reads the settings in the native resource file.

If you use host-based operation, the terminal stores the native resource file
in the terminal’s nonvolatile memory. If you use server-based operation, the
terminal stores the native resource file on an InfoServer system.

If you want central management, you or your system manager can use the
configuration manager on any VXT 2000 windowing terminal in your network.
The configuration manager lets you customize settings for individual terminals
or groups of terminals. Configuration manager settings are stored in the native
resource files. Alternatively, you can create your own host-based resource

files and store them on a host system.
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Using Menus

You can use the following menus to customize settings:

• Terminal Manager—Customize menu

You use the Customize menu in the Terminal Manager window to view and
change the settings for most of the terminal’s operating features.

– For user-preference features, see Chapter 3.

– For communication settings, see Chapter 4.

– For startup settings and fonts, see Chapter 5.

• Window manager—Options submenu

The window manager provides an Options submenu that lets you customize
window features such as border colors. You can access the Options
submenu from the window menu button (Section 11.3) or from the
Workspace pop-up menu (Chapter 12).

Advanced users can customize window manager menus, mouse buttons,
or keyboard keys (Section 12.9). For example, you can define menu
items, buttons, or keys to launch local VXT applications or remote host
applications (Chapter 13).

• VXT DECterm Options menu

Each VXT DECterm terminal window you create includes an Options
menu. This menu lets you change many DECterm operating features for
that window while an application is running in the window. However,
many applications handle the customization of the VXT DECterm window
on their own. Chapter 8 describes how to use the VXT DECterm Options
menu.

• VXT 3270 Options menu

Each VXT 3270 terminal window you create includes an Options menu.
This menu lets you change certain VXT 3270 operating features while an
application is running. However, many applications handle customization
of the VXT 3270 window on their own. Chapters 9 and 10 describe how to
use the VXT 3270 Options menu.

Central Management

VXT Software Version 2.1 Installation and System Management describes how
to centrally manage terminals, using the configuration manager or your own
host-based resource files.

• Configuration Manager

When you click on Configuration . . . in the Terminal Manager window’s
Customize menu, the terminal displays the Configuration submenu. From
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the Configuration submenu you can display a Resource Management or
Font Management dialog box.

The Resource Management dialog box lets a system manager centrally
manage VXT 2000 windowing terminals from one terminal. The system
manager can control the customizable features of these menus:

• Terminal Manager window’s Customize menu

• Terminal Manager window’s Create menu

• Window manager’s Options menu

• VXT DECterm window’s Options menu

The Font Management dialog box lets a system manager customize and
configure font support for terminals on multiple InfoServer systems.

• Host-based resource files

You can create your own host-based resource files to store the customized
settings for terminals. You edit these files directly. Host-based resource
files provide a way for host-based terminals to share the same settings.

Other Features on Host Systems

Host systems can also customize certain features of your terminal:

• Host-based control functions

Applications can control many terminal features from the host system by
using control functions.

• Client Customize

The X window or DECwindows software package includes its own
Customize utility, not described here. For more information, see the
DECwindows Motif User’s Guide for your operating system.

1.8 Compatibility with VT Series and 3270 Terminals

The terminal can operate as a video text terminal when you want to log in to a
host system and use applications designed for conventional video terminals.

You can use VXT DECterm windows to emulate VT300 series video terminals.
See Chapters 7 and 8.

You can use VXT 3270 windows to access applications on an IBM SNA system.
See Chapters 9 and 10.
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1.8.1 Character Sets

VXT DECterm Windows

When you use VXT DECterm terminal windows, you can choose different
character sets to match your computer system or software application
requirements. You can choose from

• Two 8-bit multinational character sets—DEC Multinational or the ISO
Latin Alphabet No. 1 set of the International Standards Organization

• Several 7-bit national replacement character sets (NRCs) for Western
European languages

Chapter 3 describes how to choose characters sets.

VXT 3270 Windows

VXT 3270 windows use a translation table to translate the characters
generated by the terminal into EBCDIC characters that your IBM application
uses. See Section 10.3.
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2
Using the Terminal

2

This chapter describes how to start using the terminal with VXT software.

When you turn on the terminal, it normally displays the Terminal Manager
window after loading VXT software. This window acts as a control panel for
creating sessions and customizing terminal settings.

VXT 2000+/VXT 2000 Windowing Terminal Installing and Getting Started

provides step-by-step instructions to start creating sessions with the Terminal
Manager window. This chapter provides more details and describes other basic
functions you can perform from the Terminal Manager window. The chapter
covers the following major topics:

• Terminal Manager Window

• VXT Message Box

• Creating Sessions and VXT Applications

• Autostarting, Pausing, or Ending Sessions

• Checking Network and Terminal Status

• Working with Multiple Remote X Session Managers

• Using the Open Look Window Manager from Sun Systems

• Printing

• Getting Started Menu

If you want to use VXT EX software, see Chapter 14. When you use VXT EX
software, the terminal displays a VXT EX connection window instead of the
Terminal Manager window.
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2.1 Terminal Manager Window

When you turn on the terminal, it normally displays the Terminal Manager
window and VXT Message Box. Here is the Terminal Manager window:

08−00−2B−11−CD−46

Ethernet Active Address

LAT_08002B11CD46

LAT Host Name

12.122.123.123

IP Address

12.123

DECnet Address

VXT V2.1 Terminal Manager

LJ−01140C−RAGS

• The title bar displays the window title and VXT software version.

• The menu bar provides access to the following menus:

Session To end, pause, or autostart a session, or to display network and
terminal status information (Chapter 6)

Create To start X sessions, terminal windows, and local terminal
applications

Customize To customize terminal manager features and access the
Configuration Manager dialog boxes

Print Screen To print all or part of the screen on a local printer, or to cancel a
LAT print job

Getting Started To get help on creating sessions and entering your terminal’s IP
or DECnet address

To access the InfoReader library of online VXT documentation
(server-based terminals)

• The address region shows the terminal’s Ethernet, LAT, IP, and DECnet
addresses. These addresses define the terminal’s location on a network for
LAT, TCP/IP, and DECnet communications.

Initially, the IP and DECnet addresses are blank. To use TCP/IP or
DECnet communications, you must enter and save the terminal’s IP or
DECnet address in the appropriate Customize Communications dialog box.

Initially, the Ethernet Active Address field displays the terminal’s Ethernet
hardware address. If you enable DECnet communications, the displayed
Ethernet address is converted to a global network address in the network
service access point (NSAP) format. In this case, you can still view the
Ethernet hardware address in the System Configuration dialog box.
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2.1.1 VXT Message Box

The VXT Message Box lets you monitor system messages that affect the
terminal’s operating status.

The VXT Message Box provides a Customize menu that lets you choose
the category of messages displayed and change the box’s position and size
(Section 3.13).

Normally, the terminal starts the Terminal Manager window and the VXT
Message Box as a single application. You can start them as separate
applications if you want to control them separately (Section 5.6). In this
case, the VXT Message Box also includes a File menu with an Exit item that
lets you close the box.

TI−03010−RAGS

2.1.2 Closing the Terminal Manager Window and VXT Message Box

The Terminal Manager window and Message box are local VXT applications.
You can close these applications without closing your other open sessions.
Closing the Terminal Manager window can free the terminal’s memory to
perform other tasks. You can restart the Terminal Manager window and VXT
Message Box if needed.

To close the Terminal Manager window and VXT Message Box:

• Click on the Session menu in the Terminal Manager window.

• Click on the Close menu item.

If you have customized settings in the Customize AutoStart dialog box to run
the Terminal Manager window and VXT Message Box as separate applications,
the VXT Message Box remains open.
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To restart the Terminal Manager window and VXT Message Box:

1. Click and hold MB2 anywhere on the screen background, outside your
windows. The terminal displays the pop-up VXT Create menu.

2. Click on the Term Mgr + Msg Box menu item.

Hiding the Terminal Manager Window

You can also hide the Terminal Manager window and Message Box applications
without stopping them. You can choose to hide these applications each time
you start the terminal or hide them during operation. You can enable the F3

key to act as a toggle switch for hiding or displaying these applications. See
Section 3.10.

2.2 Creating Sessions and VXT Applications

You can open two types of sessions on host systems—an X session or a terminal
window session. X sessions let you access X window applications on your host.
Terminal window sessions provide a VXT DECterm or VXT 3270 terminal
emulator for accessing traditional video terminal applications on your host.
You can open multiple sessions.

You can also start or stop three VXT applications:

Terminal Manager window
VXT Message Box
Motif window manager

By default, the terminal starts all three applications when you turn on or reset
the terminal.

Initially, you use a Create dialog box to start sessions or change VXT
applications. After you save a list of preferred services in the dialog box, you
can quickly start sessions and VXT applications from the Create pull-down
menu or VXT Create pop-up menu (Section 2.2.8).

2.2.1 Displaying the Create Dialog Box

To display the Create dialog box:

1. Click on the Create menu in the Terminal Manager window.

2. Click on Other... menu item to display the Create dialog box.

Note

Your system manager can use the terminal’s configuration manager to
prevent users from accessing the Create dialog box. In this case, the
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Other... menu item is dimmed.

TI−3009A−RAGS

You can connect to hosts or services on a network supporting the TCP/IP, LAT,
or DECnet protocol.

2.2.2 Starting LAT or Serial Sessions

To start a LAT or serial session from the Create dialog box:

1. In the Application box, click on the type of session you want to start:
X Session, DECterm, or 3270.

2. In the Transport box, click on the communication method to use for the
session: LAT or Serial.

If you choose the Serial transport, skip the next step.
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3. Click on the Host Name or Address box and enter the name or address of
the host you want to connect to.

4. Click on the " button to add your session settings to the Preferred
Services scroll box.

5. Click on the Save button to save your Preferred Services list for future
use. The terminal adds your services to the Create menu and VXT Create
pop-up menu for quick access.

6. Click on the Start button to connect to the host. The terminal displays a
login window.

7. Log in to the session.

If the Start button is dimmed:

If you are trying to start a serial DECterm window, see Section 4.2 to change
the Port Usage feature to set the serial port to work as a host port.

2.2.3 Starting a DECnet Session

Before you create your initial DECnet session, you must enter and save your
terminal’s DECnet address (Section 4.9).

Your host system must have the VXT$SERVER DECnet object installed.
For more information, see the section on the OpenVMS operating system in
VXT Software Version 2.1 Installation and System Management.

To start a DECnet session from the Create dialog box:

1. In the Application box, click on the type of session you want to start:
X Session, DECterm, or 3270.

2. In the Transport box, click on the DECnet button.

3. Click on the Host Name or Address box and enter the DECnet host address
or name (up to 6 characters). Host names require at least one alphabetic
character.

You can specify DECnet addresses in two forms:

• The long form uses a period to separate the area number and node
number. For example: 61.513.

• The short form collapses the area and node numbers into a single deci-
mal value, using the formula (area_number � 1024) + node_number.
For example: 62977 = (61 � 1024) + 513.

If you want to use host names instead of addresses, you first must
enter and save the address of your network’s DECnet name translator
(Section 4.10).
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4. Click on the " button to add your session settings to the Preferred
Services scroll box.

5. Click on the Save button to save your Preferred Services list for future use.
The terminal adds your list to the Create menu and VXT Create pop-up
menu for quick access.

6. Click on the Start button to connect to the host. The terminal displays a
login window.

7. Log in to the session.

2.2.4 Starting an IP Session

Before you create your initial session, you must enter and save your terminal’s
TCP/IP address (Section 4.5).

Note

You can create only one IP X session to a given host. If you try to
create a second IP X session to the same host, the X display manager
(XDM) closes the first IP X session while creating the second IP X
session.

To start an IP session from the Create dialog box:

1. In the Application box, click on the type of session you want to start:
X Session, DECterm, or 3270.

2. In the Transport box, click on the TCP/IP button.

3. Click on the Host Name or Address box and enter the IP host address or
name (up to 30 characters).

If you want to use host names instead of addresses, you first must enter
and save the address of your network’s TCP/IP name server (Section 4.6).

Options:

• Use the Any Host button if you want to use the first available IP host.

• Use the Any Host Indirect button to specify a host that will act as a
pathway to find the first available IP host. Specify the host in the Host
Name or Address box.

• Use the Comment box to enter optional text comments. For example,
if you entered a host name, you may want to enter the IP address as a
comment.
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• Use the List Known Hosts... button to display a dialog box that lets
you list available IP hosts.

See Section 2.2.4.1 for button descriptions.

You can enter a host IP address in one of the following formats:

Format Example

Decimal whole number 215279382

Decimal dot notation 12.212.231.22

Hexadecimal 0xcd4e716

Hexadecimal dot notation 0xc.d4.e7.16

Octal dot notation 01465163426

Octal whole number 014.324.347.26

For DECterm windows, you can specify the port for Telnet to connect on.
Simply append a comma to the host name or IP address followed by the
port number.

Format Example

Host_Name,Port market,24

IP_Address,Port 12.212.231.22,24

4. Click on the " button to add your session settings to the Preferred
Services scroll box.

5. Click on the Save button to save your Preferred Services list for future use.
The terminal adds your list to the Create menu and VXT Create pop-up
menu for quick access.

6. Click on the Start button to connect to the host. The terminal displays a
login window.

7. Log in to the session.

HP–UX Systems: Reset Required if You Cannot Log In

When creating X IP sessions to the HP–UX system, you may have to reset the
terminal if you are unable to log in. This is because the HP–UX system does
not issue a server reset after closing the login box.

2.2.4.1 Optional Buttons for Specifying IP Hosts

Any Host

Use the Any Host button if you want to connect to first available IP host on the
network. When you click on the Any Host button, an asterisk appears in the
Host Name or IP Address box.
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Any Host Indirect

Use the Any Host Indirect button if you want to enter a host to use as a path
to your destination host. When you click on the Any Host Indirect button, the
title of the Host Name or IP Address box changes to Through Host Name or IP
Address. You can then enter the host name or IP address of the host to use as
a pathway.

Optional Comment for Host

You can store optional text comments with your host name or IP address. For
example, if you entered a host name in the Host Name or IP Address box, you
may want to store the IP address as a comment.

List Known Hosts...

You can choose from a list of hosts on your local subnet or on other subnets,
by using on the List Known Hosts... button. Click on the button to display the
Known Hosts dialog box:

LJ−1147A−RAGS
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The Known Hosts dialog box lists the available TCP/IP hosts and services on
the network. If the host you want is not listed, it may be currently unavailable.
Click on the List button to update the list. You may have to click on this
button several times before the host you want is listed. Sometimes it takes
a few minutes for the terminal to establish communication with hosts on the
network.

If the Known Hosts box displays IP addresses with question marks (?) where
host names should appear, you need to enter your TCP/IP Name Server address
in the TCP/IP Name Server dialog box (Section 4.6).

To view hosts on the local subnet:

Click on the Local button. The dialog box lists known hosts in the terminal’s
local subnet. In the following example, 135 represents the local subnet of the
terminal.

Subnet example:

16.122.135.222

To view hosts on other subnets:

Click on the Indirect button. Then click on the Indirect Host Name box and
enter the name of a host to use as a source for subnet information.

To connect to a Host in the Known Hosts scroll box:

There are two ways to connect to a host from the Known Hosts scroll box.

• Double click on the host in the Known Hosts scroll box.

• Click on the host name or address in the Known Hosts scroll box. The
name or address appears in the Host Name or IP Address box of the Create
Session dialog box.

Click on the Connect button in the Create dialog box.

To add a host from the Known Hosts scroll box to the Preferred

Services scroll box:

1. Click on the host name in the Known Hosts scroll box. The host name
appears in the Host Name or IP Address box of the Create dialog box.

2. Click on the " button in the Create dialog box. The host appears in the
Preferred Services scroll box.

3. Click on the Save button in the Create dialog box.

To update the Known Hosts scroll box list:

Click on the List button. The terminal updates the list of available hosts.
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To close the Known Hosts dialog box:

Click on the Close button.

2.2.5 Starting VXT Applications

To start a VXT application from the Create dialog box:

1. In the Application box, click on the type of local application you want
to start: Motif Window Manager, Terminal Manager, Message Box, or
Terminal Manager + Message Box.

By default, the terminal runs the Terminal Manager window and VXT
Message Box as a single application.

2. Click on the " button to add the application to the Preferred Services
scroll box.

3. Click on the Save button to save your Preferred Services list for future use.
The terminal adds your list to the Create menu and VXT Create pop-up
menu for quick access.

4. Click on the Start button if you wish to start the application.

If the application is already running, it will not start again. Only one copy
of an application can run at a time.

2.2.6 Starting Remote Applications

You can start a remote application on a host system that you are currently
connected to. Before you start a remote application, you must run the VXT
application launcher on the host system. For instructions, see Section 13.3.

To start a remote application from the Create dialog box:

1. In the Application box, click on the Remote Application button.

2. In the Name box, enter the name of the VXT launcher. The default name
is VXT.

If you plan to launch applications from several host systems, you must
specify a unique name for the VXT launcher on each system. You can
specify a name when you run the VXT launcher. See Chapter 13.

3. In the Command box, enter the host system command to start the
application.

For example, the following command starts a clock:

OpenVMS system MCR DECW$CLOCK
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ULTRIX, DEC OSF/1
AXP, or UNIX system

/usr/bin/dxclock

4. Click on the " button to add your remote application settings to the
Preferred Services scroll box.

5. Click on the Save button to save your Preferred Services list for future use.
The terminal adds your list to the Create menu and VXT Create pop-up
menu for quick access.

6. Click on the Start button to start the remote application. The terminal
displays the application.

2.2.7 Preferred Services

You can add, move, and delete services from your Preferred Services list in the
Create dialog box.

To add a service to the Preferred Services scroll box:

1. Use the Application, Transport, and Host Name or Address boxes to specify
the service you want to add.

2. Click on the " button to add the service to the Preferred Services scroll
box.

3. Click on the Save button to save your service’s name so you do not have to
enter it each time you turn on the terminal.

To start a session or application from the Preferred Services scroll

box:

• Double click on a service in the Preferred Services scroll box.

• Click on a service in the Preferred Services scroll box. The service name
appears in the Service or Host Name box. Click on the Connect button.

To move a service in the Preferred Services scroll box:

You can move a service up or down in the list. The terminal will display the
services in the same order on the Create pull-down submenus and the VXT
Create pop-up menu.

1. Click on the service name you want to move.

2. Click on the 4 or 5 button to move the service one place up or down in
the list.

To remove a service from the Preferred Services scroll box:

1. Click on the service name you want to remove.
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2. Click on the trash can button.

2.2.8 Creating Sessions from a Menu: Preferred Services

After you save preferred services in the Create dialog box, the terminal adds
them to

• The Create menu, as submenus

• The VXT Create pop-up menu (after you restart the window manager)

You can quickly start a preferred service (a session or VXT application) by
choosing the service name from these menus.

Create Menu

The Create menu adds a menu item for each type of session you have saved –
DECterm, X Session, and so on. When you choose one of these menu items, the
terminal displays a submenu that lists all of your preferred services for that
type of session.

VXT V2.1 Terminal Manager

LJ−01145C−RAGS

VXT Create Pop-Up Menu

After you restart the window manager, the VXT Create pop-up menu also lists
all preferred services.

To restart the window manager and view the VXT Create pop-up menu:

1. Click and hold mouse button 1 (MB1) anywhere on the screen background,
outside the Terminal Manager window and other windows.

The terminal displays a Workspace pop-up menu.

2. Drag the pointer to the Restart... menu item, then release MB1.

The terminal displays a confirmation box asking if you really want to
restart the window manager.

3. Click on the OK button to restart the window manager.

The borders around the windows on the screen disappear while the window
manager is being restarted.
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4. After the window borders reappear, click and hold MB2 anywhere on the
screen background.

The terminal displays the VXT Create pop-up menu, listing your preferred
services. The default VXT Create pop-up menu lists the combined Terminal
Manager and VXT Message Box applications:

VXT Create

Term Mgr + Msg Box

LJ−03026−RAGS

2.3 Autostarting, Pausing, or Ending Sessions

The Terminal Manager window’s Session menu lets you automatically start or
pause a session. You can also end all sessions by using the Reset, Reboot, or
Shutdown items to reset the terminal’s VXT software.

LJ−01141C−RAGS

VXT V2.1 Terminal Manager

2.3.1 Autostarting a Session

The AutoStart menu item lets you quickly start the list of sessions and VXT
applications that you saved in the Customize AutoStart dialog box. The
terminal also autostarts this list when you perform any action that restarts the
terminal, such as

• Turning the terminal on

• Choosing the Reset, Reboot or Shutdown menu items from the Session
menu

To enter your AutoStart settings, see Section 5.6.

To autostart your applications:

1. Click on the Session menu in the Terminal Manager window.
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2. Click on AutoStart. The terminal starts up the sessions and applications in
the order you listed them in the Customize AutoStart dialog box.

2.3.2 Pausing a Session

If you want to interrupt your work without ending your session, you can
pause a session. When you pause a session, the terminal displays the Pause
Password dialog box. After you enter and verify a pause password, the
terminal clears the screen and displays the Enter Password to Resume prompt.
Any applications you started continue to run. When you resume your session,
you can continue work where you left off.

The pause password is valid for the current terminal session only. The
password is not saved when you reboot or reset the terminal.

To pause your session:

1. Click on the Session menu in the Terminal Manager window.

2. Click on Pause to display the Pause Password dialog box.
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3. You can enter a new pause password or use a previous pause password
that you saved during the current terminal session.

To enter a new pause password:

a. Enter the password in the Enter Pause Password box. The password
may be from 1 to 127 characters. Blank spaces are not allowed.

b. Click on the Verify Password box and enter the same password. If you
make a mistake, click on the Clear button to start over.

c. Click on the OK button to save the password and exit the dialog box.

To use your previous pause password:

Click on the Use Previous Password button.
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When you click on the OK or Use Previous Password button, the terminal
clears the screen and displays the Enter Password to Resume prompt.
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To resume your session :

Enter your password into the Password box and click on the OK button.

If you forget the password, you can click on the Reset button to end all sessions
and restart the terminal.

If you choose... The terminal...

OK Verifies that your password is correct.

Clear Clears the password box.

Reset Ends all sessions on the terminal. Resets the X server and restarts
applications listed in the Customize AutoStart dialog box.

Note: Serial Window Not Closed

The Reset button does not end a terminal window created on the serial
port. To close a session on the serial port, choose the Exit menu item
from the terminal window’s File menu.
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2.3.3 Ending All Sessions and Restarting VXT Software

You can use the Reset, Reboot, or Shutdown menu items on the Session menu
to end all active sessions on the terminal. If you choose Reboot or Shutdown,
the terminal also reloads the VXT software from a host system or InfoServer
system. You must reload VXT software to activate changes you make in some
Customize dialog boxes (Language, Boot, Communications, Software Options,
Resource Files).

If you choose... The terminal...

Reset Ends all sessions on the terminal.

Resolicits the network for the terminal’s resource file.

Restarts your AutoStart sessions and clients.

Resets the X server.

Reboot Ends all sessions on the terminal.

Resolicits the network for the terminal’s resource file.

Reloads VXT software.

Restarts your AutoStart sessions and clients.

Resets the X server.

Shutdown Ends all sessions on the terminal and displays the message

Press RETURN to restart VXT

After you press Return , the terminal

Resolicits the network for the terminal’s resource file.

Reloads VXT software.

Restarts your AutoStart sessions and clients.

Resets the X server.

When you choose the Reset, Reboot, or Shutdown menu item, the terminal
displays a confirmation box. To confirm your choice, click on Yes. To remain in
the session, click on No. To bypass this confirmation box, see Confirm Reset
Session in Section 3.10.

You can also reboot the terminal by pressing Ctrl+left Alt+keypad . .

2.3.4 Ending Individual Sessions

If you have multiple sessions open, you can end individual sessions. The effect
of ending a session depends on the type of session.
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Ending an IP X Session

You can end an IP X session by using the quit function in the remote session
manager for that session. Quitting from the remote session manager (xsession)
on a UNIX, ULTRIX, or DEC OSF/1 AXP system ends the xsession and the
window manager (xwm).

Ending a LAT X or DECnet X Session

You can end a LAT X or DECnet X session by using the End Session function
in the remote session manager for that session.

By default, using the End Session function from an OpenVMS remote session
manager restarts the terminal, ending all sessions on the terminal. If your
terminal is using VXT server-based software, you can customize the terminal
so it only ends the LAT X window session without restarting the terminal. See
Section 5.4.

Ending Terminal Window Sessions

You can end a Telnet, LAT, DECnet, or Serial terminal window session by using
the Exit menu item in the window’s File menu.

2.4 Checking Network and Terminal Status

You can use the Status menu item on the Session menu to access screens that
help you identify network problems. You can

• View the terminal’s configuration—software version, font path, network
addresses, memory, installed options, and work group

• View TCP/IP routes and ping hosts to determine their availability

• Monitor and reset LAT and Ethernet counters

• Monitor memory and network utilization

Chapter 6 describes the Status submenu.

2.5 Working with Multiple Remote X Session Managers

Each X session you create has its own session manager on the host system.
Each session manager expects to have complete control of your terminal.
To maintain a consistent user interface when using multiple remote session
managers, you should consider the effects on the terminal’s feature settings
and the Motif window manager.

28 Chapter 2



Using the Terminal
2.5 Working with Multiple Remote X Session Managers

Feature Settings

The host session manager changes any settable features of your terminal, such
as screen background, security, and keyboard selection.

If you run multiple session managers, each one sets up the terminal according
to the terminal’s saved settings at the time the session manager starts up. To
keep the settings from changing unexpectedly, be sure to change and save all
your preferences in all of your session managers.

When you quit from a remote session manager, the system may ask you if you
want to save customized settings before quitting. This question refers only to
the remote session manager’s settings.

Security Settings with OpenVMS DECwindows Session Manager The
DECwindows session manager overrides the terminal manager’s Customize
Security settings. Every time you log into a new OpenVMS host and run its
DECwindows session manager, the security settings on the new node override
the current settings. To maintain security, enter your settings on each host.

Remote Window Managers

You can choose whether or not a host-based window manager can take over
windowing operations on the screen. The terminal’s local window manager
provides you with quicker response time and overall higher performance.
However, a host-based window manager may offer more features. To let the
host control windowing operations, click on the Allow Remote Window Manager
button in the Customize Terminal Manager dialog box (Section 3.10).

2.6 Using the Open Look Window Manager from Sun
Systems

If your host system has the Open Look window manager, you can perform the
following steps to use this window manager on the terminal:

1. Load the fonts for the Sun Open Look cursor in the /vxt/fonts/misc
directory on the host system.

2. In the Customize Terminal Manager dialog box, click on the Allow Remote
Window Manager button (Section 3.10).

3. In the Customize Security dialog box, click on the All button to allow all
connections for TCP/IP (Section 3.7).

4. In the Customize X Server dialog box, set the X Session Reset Server
Action to Ignore Reset Server.
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5. In the Create dialog box, create a session on your Sun system. The Sun
system must have the X display manager (XDM) installed to be able to
display the username and password banner on the terminal.

6. Use the env command to verify the following symbol definitions on the Sun
system:

OPENWINHOME=/usr/openwin
DISPLAY=vxt-ip:0
LD_LIBRARY_PATH=/usr/openwin/lib

If the symbols are not defined, apply them manually. For example:

# setenv OPENWINHOME /usr/openwin
# setenv DISPLAY vxt_ip_address:0.0
# setenv LD_LIBRARY_PATH /usr/openwin/lib

7. To complete the initialization of the window manager, enter the following
commands:

# xrdb .Xdefaults (or .OWdefaults for Solaris 2.n systems)
# /usr/openwin/lib/openwin-sys
This is the OpenWindows X11/NeWS Server system
initialization file)
# olwm &

After you complete these steps, the Open Look window manager
environment should appear after a short time.

If the system displays errors about elements not found, you may need to modify
your path in .cshrc to access those elements.

1. Use the find command to find the elements’ location.

2. Modify the .cshrc file to include the correct path to the elements.

3. Enter the following command to have the system read the updated .cshrc
file.

# source .cshrc

The following example uses the find command to locate the executable
code named xrdb:

# find / -name xrdb -print
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Using Sun Open Look Fonts from the Host System

You use the Customize Font Path dialog box (Section 5.3) to enter the path to
the Sun Open Look fonts on your host system. By default, the VXT software
installation places font directories in the following path:

/tftpboot/vxt/fonts or /usr/tftpboot/vxt/fonts

The fonts you need are in the 100dpi and misc directories.

Specify the following two font paths in the Customize Font Path dialog box.
You need both font paths to access the fonts for various Sun applications. The
font paths you specify depend on whether your host system uses restricted or
unrestricted TFTP access. Digital recommends using restricted TFTP access,
for security reasons.

Restricted TFTP Systems

/vxt/fonts/misc/fonts.dir

/vxt/fonts/100dpi/fonts.dir

Unrestricted TFTP Systems

/tftpboot/vxt/fonts/misc/fonts.dir
(or /usr/tftpboot/vxt/fonts/misc/fonts.dir)

/tftpboot/vxt/fonts/100dpi/fonts.dir
(or /usr/tftpboot/vxt/fonts/100dpi/fonts.dir)

Using Sun Open Look Fonts from an InfoServer

Server-based terminals can use an InfoServer system to provide the Sun Open
Look fonts. VXT Software Version 2.1 Installation and System Management

describes how to use the terminal’s font manager to copy host fonts to
InfoServer font sets.

Converting Sun Fonts

The VXT 2000 windowing terminal uses fonts in the portable compiled font
(PCF) format. You can convert Sun fonts into PCF format, using conversion
utilities provided with the VXT software installation kit. See VXT Software

Version 2.1 Installation and System Management.
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2.7 Customizing Your Terminal’s Environment

The Customize menu in the Terminal Manager window lets you check
and control the settings for many features—from the keyboard to host
communications. See the following chapters for details on the Customize
menu:

Chapter 3 Describes user-preference and security settings (top half of the
Customize menu).

Chapter 4 Describes settings that affect communication with host systems
(Communications submenu).

Chapter 5 Describes advanced settings for autostarting sessions, entering font
paths, booting VXT software, and turning VXT software options on or
off (bottom half of Customize menu).

2.8 Printing

This section describes how to

• Print the screen from the Print Screen menu

• Send printing jobs from a host system to the terminal’s printer

You can also perform printing operations from the Print menu in VXT
DECterm windows (Section 7.5).

Supported Printers

The terminal supports level 1 and level 2 Digital printers.

• Level 1 printers include the LA50 and LA70 dot matrix printers.

• Level 2 printers include the LA75 and LA324 dot-matrix printers; LJ250
(serial) and LJ252 (parallel) color ink-jet printers; and LN03, LN05, and
LN06 laser printers.

The terminal also supports PostScript printers, including Digital’s and
ScriptPrinter and DEClaser family, the HP LaserJet II and HP LaserJet III
printers, and the IBM 4019 laser printer.

2.8.1 Printing the Screen

The Print Screen menu in the Terminal Manager window lets you print all or
part of the screen display, using a serial or parallel printer connected to the
rear of the terminal. Depending on your printer, you can print monochrome,
gray scale, or color displays in sixel or PostScript format.

You can also cancel a current printing job sent from a remote host system to
the terminal’s printer.
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Before printing, you should customize the print screen settings and select the
port you are using (serial or parallel). Normally, the print screen function
is set to print a monochrome image in sixel format on the parallel port. To
customize the print screen settings, see Section 3.6. To choose the printer port,
see Section 4.2.

The Print Screen menu looks like this:

LJ−01153C−RAGS

VXT V2.1 Terminal Manager

To print the complete screen image:

Choose the Local Print Entire Screen menu item.

If you are printing from a VR319 monitor to an LA50 printer, the image may
be too large for the page. Click on the Rotate/Scale Picture button in the
Terminal Manager window’s Customize Print Screen dialog box to print the
image on the page.

To print a portion of the screen image:

1. Choose the Local Print Portion of Screen menu item. The pointer turns
into a cross.

2. Wait for terminal to redisplay the Print Screen menu.

3. Move the pointer to one corner of the area you want to print. Hold down
MB1 and drag the pointer to the opposite corner of the desired area. As
you drag the pointer, a rectangular outline is displayed.

4. Release MB1 to send the selected image to the printer.

To cancel a remote printing job that is currently printing:

Choose the Cancel Current Remote Print Job menu item. The remote print job
currently printing stops.

Normally, the terminal can accept printing jobs from systems using the TCP/IP
or LAT transport. To change this setting, see Section 4.2.
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Printer Status

When you send a job to the printer, the terminal displays printer status
messages in the VXT Message Box.

Printer Offline Indicates that the printer is turned off or not
connected. The printer did not assert its DTR signal
within 2 seconds after the print request.

Printer Busy Indicates the printer is printing another job.

In both cases, your print request is canceled.

Canceling a Print Screen Operation

During large printing jobs, the terminal displays a Print Cancel dialog box to
let you cancel the print operation. To cancel the print operation, click on the
Click Here to Cancel Print button. Printing stops when the printer empties its
input buffer. The Print Cancel dialog box is not printed.

2.8.2 Printing from a Host System

VXT Software Version 2.1 Installation and System Management describes how
to set up the terminal’s printer port for printing from a host system. After
the host is set up, you can send printing jobs from the host to the terminal’s
printer.

You can print from hosts that use the TCP/IP or LAT transport.

Printing from Hosts that Use TCP/IP

To use TCP/IP for printing:

• The terminal’s TCP/IP or Ethernet address must be displayed in the
Terminal Manager window

• The Host Accessible Printer Port button must be enabled in the Customize
Serial and Parallel Ports dialog box (Section 4.2). This is the default
setting.

• The VXT printer support utilities provided with the VXT software
installation kit must be installed on your host system.

The terminal accepts only one TCP/IP printing job at a time. If a second job is
sent while the first job is printing, the second job is ignored and no notification
is sent to the requester. The requester must wait until the first job completes,
then submit the second job again.
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Printing from ULTRIX, DEC OSF/1 AXP, SunOS, or IBM AIX Hosts Use the
lpr command to submit printing jobs to the terminal’s printer. Ask your
system manager for the printer name to specify.

lpr -Pvxt_printer [-Dpostscript] printfile

• vxt_printer is the name of the printer connected to the terminal.

• printfile is the file to print.

• The -Dpostscript option is for printing PostScript files from ULTRIX
systems. You can use this option if your printer supports PostScript
printing.

For more information, see the lpr man page.

Printing from an HP–UX or SCO ODT Host Use the lp command to submit
printing jobs to the terminal’s printer. Ask your system manager for the
printer name to specify.

lp -dvxt_printer printfile

• vxt_printer is the name of the printer connected to the terminal.

• printfile is the file to print.

Printing from an OpenVMS Host

To print from an OpenVMS system to a VXT 2000 windowing terminal’s
printer, use the DCL PRINT command. Ask your system manager for the
printer’s queue.

$ PRINT/QUEUE=vxt_printer myfile.EXT

• vxt_printer is the name of the terminal’s printer queue. Use the queue
name that was created when initializing the printer port.

• myfile.ext is the file you wish to print.

Canceling a Remote Printing Job

To cancel a printing job from a host that is currently printing, choose the
Cancel Current Remote Print Job menu item from the Print Screen menu in
the Terminal Manager window. The terminal stops printing the current job.
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2.9 Getting Started Menu

The Getting Started menu in the Terminal Manager window provides help
on choosing your keyboard type, entering an IP or DECnet address, and
creating sessions. If you have a server-based terminal, you can also acess
the InfoReader library of online VXT documentation. To display the Getting
Started menu, click on the Getting Started menu in the menu bar. The Getting
Started menu looks like this:

VXT V2.1 Terminal Manager

LJ−01144D−RAGS

InfoReader—Viewing Online VXT Documentation

To view online VXT documentation, choose the InfoReader... menu item.
The documentation is an optional part of the VXT software installation. The
InfoReader utility is similar to the Bookreader utility on DECwindows systems.
When you choose the InfoReader... menu item, the terminal displays a new
window that lists the available VXT document titles. If you are unfamiliar
with Bookreader or InfoReader, double click on the Using InfoReader selection.

For VXT Version 2.1 software, the following titles are available:

• VXT 2000+/VXT 2000 Windowing Terminal Installing and Getting Started

(in six languages)

• VXT 2000+/VXT 2000 Windowing Terminal User Information

• VXT Software Version 2.1 Release Notes

• VXT Software Version 2.1 Installation and System Management

Each section of this document is a separate online book that covers the use
of VXT software on different operating systems.
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• InfoServer System Operations Guide

LJ−03013A−RAGS
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3

This chapter describes how you can customize basic terminal feature settings,
using the top half of the Customize menu in the Terminal Manager window.
The chapter also describes how to customize the VXT Message Box.

Initially, the terminal uses factory-default settings that work with many
host systems. You can make changes to suit your personal preference and
computing environment. After you make changes, you can save your settings
for all future sessions.

The chapter covers the following major topics:

• Displaying the Customize Menu

• Saving and Restoring Terminal Manager Settings

• Changing Your Keyboard Settings

• Choosing the Display Language

• Changing Your Pointer and Mouse Settings

• Changing Your Print Screen Settings

• Changing Your Security Settings

• Changing Your Screen Background

• Changing Your Window Colors

• Changing Your Terminal Manager Settings

• Changing Your Video Alignment Settings (VX227 Models)

• Saving the Terminal Manager Window’s Position and Size

• Customizing the VXT Message Box
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3.1 Displaying the Customize Menu

To display the Customize menu, click on Customize in the Terminal Manager
window’s menu bar. This chapter describes the menu items highlighted in
gray:

VXT V2.1 Terminal Manager
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When you choose one of the highlighted menu items from the Customize menu,
the terminal displays a dialog box with the feature settings for that topic. In
dialog boxes, shaded buttons indicate the current settings. You can examine
the settings and change them if desired. You can use the last three menu items
to save and restore the Terminal Manager window’s position and size.

Note

A system manager can customize settings for terminals and work
groups. The system manager can also lock or unlock access to one or
more of the Customize menu items. Locked menu items are dimmed.
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3.2 Saving and Restoring Terminal Manager Settings

Each dialog box has a set of push buttons for saving and restoring settings.
After you make changes in a dialog box, you can save your settings for future
sessions by clicking on the OK button or Apply button. If you do not want to
save your changes, click on the Cancel button. Some new settings do not take
effect until you end your current session and begin another one.

Click on ... To ...

OK Apply and save new settings and dismiss the dialog box.

Apply Apply and save new settings without dismissing the dialog box.

System Defaults Apply and save the factory-default settings, clearing all text and
scroll boxes.

If your terminal is in a work group: Clicking on the System
Defaults button applies and saves the work group’s customized
settings.

Cancel Dismiss the dialog box without changing any settings. If you made
any changes without applying them, clicking on the Cancel push
button cancels those changes.
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3.3 Changing Your Keyboard Settings

You can control general keyboard settings from the Terminal Manager window,
such as your keyboard type and keyclick volume. The keyboard type setting
should match the keyboard you are using. To view or change your keyboard
settings, choose Keyboard... from the Terminal Manager window’s Customize
menu. The Customize Keyboard dialog box looks like this:

Note

You can also customize some keyboard settings for individual VXT
DECterm windows. See Chapter 7.

 LJ−01158−RAGS

From the Customize Keyboard dialog box, you can change any of the following
settings:

Keyboard Type

The keyboard comes in various models for different languages and dialects.
The location of some keyboard characters varies, depending on the keyboard
model. Make sure the Keyboard Type setting in the dialog box matches your
keyboard model number, so the system will send the correct characters when
you use the keyboard.
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The System Default setting is the North American model of your standard
(LK401), short UNIX style (LK421), PC style (LK443 or LK444), or Sun style
(LK460) keyboard. If you are using a keyboard for another language or dialect,
you must choose the matching keyboard type.

To find your keyboard model number: Look on the bottom of the keyboard
for the label that specifies the model number. The model number should be in
a format similar to LK4nn-xx or nn-nnnnn-xx. Use the xx value to choose your
keyboard type from the Keyboard Type scroll box.

For example, if you have a British keyboard and the model number is LK401-
AA, you choose British_LK401AA_TW or British_LK401AA_DP.

Typewriter (TW) or data processing (DP) keys

You also use the keyboard type setting to specify whether you want your
keyboard to act as a typewriter (TW) or data processing (DP) keyboard.
This setting affects keys with three or more characters. If you choose data
processing, these keys send the characters on the right half of their keycaps.
If you choose the typewriter setting, these keys send the characters on the left
half of their keycaps.

Typewriter and data processing settings are identical for these keyboard types:

• North American and Dutch

• When using 8-bit multinational characters: British, German, and
Portuguese

When using DECwindows: The DECwindows host session manager has a
similar Keyboard Type option. Digital recommends that you leave the host
setting at System Default to avoid having the host session manager and local
terminal manager compete to set the keyboard.

Bell Volume

The keyboard’s warning bell alerts you to system messages. To adjust the bell
volume, either drag the Percent Volume slider to the right or left, or point to
a new location on the scale and click MB1. To disable the bell, click on the
Disable button.

Keyclick Volume

When you press a keyboard key, the keyboard makes a clicking sound. To
adjust the keyclick volume, either drag the Percent Volume slider to the right
or left, or point to a new location on the scale and click MB1. To disable
keyclicks, click on the Disable button.
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Cursor Blink

Normally, the text input cursor blinks. To adjust the rate of blinking, either
drag the Milliseconds slider to the right or left, or point to a new location on
the scale and click MB1. To disable blinking, click on the Disable button. Your
new setting takes effect when you restart the terminal.

VXT DECterm windows also have a Cursor Blink feature, controlling the text
cursor in the VXT DECterm terminal window. The Cursor Blink setting in
the Customize Keyboard dialog box has no effect on the VXT DECterm Cursor
Blink setting.

Auto Repeat

When you press a key longer than normal, it repeats until you release it. To
disable this feature, click on the Disable button. The Help and Return keys
never autorepeat.

VXT DECterm windows also have an Auto Repeat feature. When you create
a VXT DECterm window, its Auto Repeat setting works independently of the
Terminal Manager window’s setting. To disable Auto Repeat for the Terminal
Manager and VXT DECterm windows, disable both settings.

Lock Key State

Normally when you press the lock key, the alphabetic keys send uppercase
letters; the number keys and nonalphabetic character keys do not send their
shifted character.

When you click on the Shift Lock button, all keys send their shifted character.
The new setting takes effect when you restart the terminal.
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3.4 Choosing the Display Language

The terminal supports different display languages for VXT screens. To change
your display language setting, choose Language... from the Terminal Manager
window’s Customize menu. The Customize Language dialog box looks like this:

LJ−01159A−RAGS

To choose a new language:

1. Click on the language in the Session Language scroll box.

2. Click on OK to save the setting and dismiss the Customize Language dialog
box.

3. Display the Session menu from the Terminal Manager window’s menu bar.

4. Click on Reboot to restart the terminal and display the new language.

Hebrew Language for VXT DECterm Windows Only

The Hebrew language setting only affects VXT DECterm windows. All other
VXT windows are displayed in English. You may also wish to select the
Hebrew keyboard type.

Reenter Your AutoStart Settings

If you have customized AutoStart settings, you must reenter the settings after
you change your display language (Section 5.6).
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3.5 Changing Your Pointer and Mouse Settings

You can change the shape, color, and speed of the screen pointer for the mouse
or other input device. You can set the mouse buttons for a left-handed or
right-handed user. You can also set the time limit for performing the second
click in a double-click sequence. To change your mouse and pointer settings,
choose Pointer... from the Terminal Manager window’s Customize menu. The
Customize Pointer dialog box looks like this:

Customize Pointer Dialog Box (Monochrome)

 LJ−01160−RAGS
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Customize Pointer Dialog Box (Gray Scale or Color)

LJ−01150−RAGS

From the Customize Pointer dialog box, you can change any of the following
settings:

Pointer Acceleration

Click on one of the four options to vary the rate at which the pointer moves in
relation to the mouse. The None setting keeps the pointer speed constant. The
Fast setting makes the pointer move farther as you move the mouse faster.
The default setting is Medium.

Button Arrangement

The default mouse button arrangement is for a right-handed user—MB1 on the
left of the mouse and MB3 on the right. If you are left-handed, you can click
on the Left Handed button. This makes MB1 the right mouse button and MB3
the left mouse button. MB2 is always the middle button.
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Pointer Foreground Color

The pointer consists of an outline and filled center.

On a monochrome terminal: Normally, the pointer’s filled area is black with
a white outline. To reverse the fill and outline colors, click on the White On
Black button.

On gray scale and color terminals: Normally, the pointer’s filled area
(foreground) is black. To change this setting, click on the Pointer Foreground
Color button. The terminal displays a Color Mixing dialog box (Appendix B).

To see your changes, click on Apply or OK in the dialog box.

Pointer Background Color

This button is only on gray scale and color terminals. To change the default
color, click on the Pointer Background Color button. The terminal displays a
Color Mixing dialog box (Appendix B).

To see your changes, click on Apply or OK in the dialog box.

Pointer Shape

To change the pointer shape, scroll through the list of shapes and choose the
one you want.

Mouse Double Click Timeout

Some applications can tell two single clicks from a double click, based on the
speed at which buttons are clicked. To change the time allowed for making the
second click in a double-click sequence, drag the slider to the right or left, or
move the pointer to a location on the scale and click MB1.
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3.6 Changing Your Print Screen Settings

Print screen settings affect a printer connected locally to the serial or parallel
port on the rear of the terminal. You can control certain printing features for
print screen operations, such as the output format and the ability to center or
rotate the image. To view the print screen settings, choose Print Screen... from
the Terminal Manager window’s Customize menu. The Customize Print Screen
dialog box looks like this:
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From the Customize Print Screen dialog box, you can change the following
settings:

Output Format

You can choose the output format to match your printer’s data format, sixel or
POSTSCRIPT.
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Pixel Aspect Ratio

You can choose the pixel aspect ratio to match the dot density of the printer
you are using. A pixel aspect ratio of 1 to 1 is appropriate for most printers.

• For level 2 printers such as the LA75 or LN03, use a pixel aspect ratio of
1 to 1.

• For level 1 printers such as the LA50, use a pixel aspect ratio of 2 to 1.

Print FF Mode

The terminal can send a form feed (FF) character to the printer port at the end
of a print screen operation. If you want to send a form feed, click on the Form
Feed button.

Ribbon or Toner Saver

Normally, you print dark images on a light background. However, a large
image may consume a great deal of printer ribbon or toner. To save ribbon or
toner, you can click on the Negative Image button; this reverses the dark and
light portions of the printed output.

Output Color Mode

Window snapshots are usually printed or captured in black and white.

Click on the Color option if you want to print color pictures. Click on the
Grayscale option to print black and white images in various gray tones. The
Grayscale setting also makes screen colors easier to distinguish in black and
white print.

You may want to use the Dithered Color or Dithered Grayscale buttons when
you are printing continuous tone images, such as photographic images.

Center Image

Use the Center Image button to automatically center the screen image on the
printed page.

Rotate/Scale Picture

For wide images, you can use the Rotate/Scale button to automatically rotate
and scale images so they fit on the printed page.
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3.7 Changing Your Security Settings

Initially, you cannot connect to your terminal from another system (unless
your system manager has customized your security settings). This means you
cannot log in from another system and use your terminal until you authorize
yourself to do so.

You can choose which hosts and users can connect to your terminal. Only
authorized hosts and users can make connections to the terminal to display
applications on your screen or request data from your screen. To change your
security settings, choose Security... from the Terminal Manager window’s
Customize menu. The Customize Security dialog box looks like this:

LJ−01162B−RAGS

Connections Allowed

Normally, only those users listed in the Authorized Users scroll box can connect
to the terminal. To allow any user on the network to connect to the terminal,
click on the All button.

To prevent any X connection to your terminals, click on the Listed Users Only
button and leave the Authorized Users scroll box empty.

50 Chapter 3



Customizing the Terminal
3.7 Changing Your Security Settings

Listed Users Only When you choose this setting, only the systems and users
entered in the Authorized Users scroll box can establish X connections to
your terminal. This setting requires that you authorize your own account in
addition to any others that need access to your display.

All When you choose this setting, any system on the Ethernet can establish
an X connection to your terminal. Use this setting if you are part of a small
group running interactive applications that require sharing of information in
real time.

Authorized Users

The Authorized Users scroll box contains the names of those users you allow
to have access to your terminal. When you add a user, you associate the user
with their communication transport, address, node name, and username, if
applicable.

To add users to the Authorized Users List:

1. In the Transport box, click on the type of transport of the user (TCP/IP,
LAT, or DECnet).

2. Enter an address or node name in the Node box, then press the Return

key.

• TCP/IP example: market or 12.345.123.45

• LAT example: MARKET

• DECnet example: MARKET or 61.513

3. For LAT and DECnet, enter a username in the Username box, then press
the Return key. You can use the asterisk (*) wildcard character to specify
all users.

• Example: CAROLYN or *

4. Click on the ! button to enter the user in the Authorized Users scroll
box.

5. Repeat the previous steps for each user you want to add to the Authorized
Users scroll box.

6. Click on Apply or OK to save your security settings.

To remove an authorized user:

1. In the Authorized Users scroll box, click on the username you want to
remove.
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2. Click on the trash can button.

Caution

If you click on System Defaults, you clear the Authorized Users scroll
box. If you belong to a work group, System Defaults recalls your work
group settings.

3.8 Changing Your Screen Background

You can change the look of your terminal’s screen display. For example, you
can change the screen’s background color or select the default screen pattern.
To change your screen settings, choose Screen Background... from the Terminal
Manager window’s Customize menu. The Customize Screen Background dialog
box is displayed:

Customize Screen Background Dialog Box (Monochrome)
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Customize Screen Background Dialog Box (Gray Scale or Color)
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From the Customize Screen Background dialog box, you can change the
following settings:

Screen Saver

The Screen Saver extends the life of your monitor by shutting off the display if
the terminal is inactive for a specified time. Normally, the terminal shuts off
its display after 10 minutes of keyboard or mouse inactivity. You can use the
sliding scale to vary the time, from 1 to 60 minutes.

Screen Background

The default screen background pattern is a tight, gray crossweave. To change
the screen background to a solid color:

On a monochrome terminal: Click on the Black or White radio button.

On gray scale and color terminals: Click on the Solid Color button. Then
click on the Screen Color button. The terminal displays a Color Mixing dialog
box (Appendix B).

To see your new setting in effect, click on Apply or OK.

To display the default pattern, click on the Default Pattern button.
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DECwindows Session Manager Sets the Screen Background

On host systems that use DECwindows software, the session manager has a
similar Screen Background option. If you create an X session to the system,
the screen background setting on the host system takes effect. For a consistent
screen background, use the same setting on the terminal and the host.

3.9 Changing Your Window Colors

You can change the window colors of your local VXT windows. On monochrome
terminals, you can use the default black text on a white background or change
to white text on a black background. On gray scale and color terminals, you
can change foreground, background, and highlight colors. You can also change
the shadow colors that produce the three-dimensional look.

If you have VXT Version 2.1 software, your color settings also affect local VXT
DECterm windows.

Your window color settings do not affect windows that you open through a
remote session manager. For example, if you open DECterm windows through
a remote session manager on a host system, you can set the colors for those
windows in the remote session manager.

To change your window color settings, choose Window Color... from the
Terminal Manager window’s Customize menu. The terminal displays the
Customize Window Color dialog box for a monochrome or color terminal.

Customize Window Color Dialog Box (Monochrome)
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From the Customize Window Color dialog box, you can change the following
settings on monochrome terminals:

54 Chapter 3



Customizing the Terminal
3.9 Changing Your Window Colors

On Monochrome Terminals

Window Color

The window color is normally black on white. Click on the White On Black
radio button to reverse the colors.

To see your new setting in effect, click on Apply or OK.

Customize Window Color Dialog Box (Color)
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From the Customize Window Color dialog box, you can change the following
settings on gray scale or color terminals:

On Gray Scale or Color Terminals

Top Shadow Color

Top and bottom shadow colors must be well matched to present a three-
dimensional look. Normally, the terminal automatically determines top and
bottom shadow colors when you change the window color. When you use
automatic shadowing, the Top Shadow Color and Bottom Shadow Color labels
are dimmed.

To choose your own top shadow color:

1. Click on the Manual Shadowing button to disable automatic shadowing.

2. Click on the Top Shadow Color button to display the Color Mixing dialog
box (Appendix B).
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Window Background Color

The window background color is normally white. To change this setting, click
on the Window Background Color button to display the Color Mixing dialog box
(Appendix B).

If you save your changes by clicking on Apply or OK in the Color Mixing dialog
box, your new settings take effect when you start your next session.

Bottom Shadow Color

The Bottom Shadow button works like the Top Shadow button.

Window Foreground Color

The Window Foreground Color setting changes the color of text and graphics in
the window.

To change the window foreground color, click on the Window Foreground Color
button to display the Color Mixing dialog box (Appendix B).

If you save your changes by clicking on Apply or OK in the Color Mixing dialog
box, your new settings take effect when you start your next session.

Highlight Color

The Highlight Color setting controls the color of screen objects with input focus
such as text-entry boxes and check and radio buttons. The highlight color is
normally black. To change the highlight color, click on the Highlight Color
button to display the Color Mixing dialog box (Appendix B).

If you save your changes by clicking on Apply or OK in the color mixer, your
new settings take effect when you start your next session.

3.10 Changing Your Terminal Manager Settings

The Customize Terminal Manager dialog box lets you choose various settings
that affect the terminal manager and window management. You can

• Choose to use the terminal’s window manager or a window manager on a
host system

• Choose the Terminal Manager window’s startup state (normal, icon, or
hidden)

• Use the F3 toggle key to hide or display the Terminal Manager window

• Disable the confirmation box displayed when resetting the terminal

• Enter a tag to identify your terminal in the configuration manager

• Enter the text to display when you pause a session
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• Specify how frequently to update the status boxes in the Session menu

To change your Terminal Manager window settings, choose Terminal Manager...
from the Terminal Manager window’s Customize menu. The Customize
Terminal Manager dialog box looks like this:
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From the Customize Terminal Manager dialog box, you can change the
following settings:

Allow Remote Window Manager

You can choose whether or not a host-based window manager can take over
windowing operations on the screen. The terminal’s local window manager
provides you with quicker response time and overall higher performance.
However, a host-based window manager may offer more features. To let the
host control windowing operations, click on the Allow Remote Window Manager
button.
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Confirm Reset Session

When you choose Reset, Reboot, or Shutdown from the Session menu, the
terminal normally asks for confirmation. You can turn this feature on or
off by clicking on the Confirm Reset Session button. When this feature
is off, choosing Reset, Reboot, or Shutdown from the Session menu will
immediately end the current session, without displaying the confirmation
box. See Section 2.3.3 for details on the Session menu.

Confirm Close Terminal Manager

When you choose Close from the Session menu, the terminal normally asks you
to confirm that you want to close the Terminal Manager window. You can turn
this confirmation feature on or off by clicking on the Confirm Close Terminal
Manager button. When this feature is off, choosing Close from the Session
menu immediately closes the Terminal Manager window, without displaying
the confirmation box. Closing the Terminal Manager window also closes the
VXT Message Box, unless you have customized the terminal to start the VXT
Message Box as a separate application.

Disable F3 Key (For Hiding the Terminal Manager Window)

You can choose to use the F3 key as a toggle key for hiding and displaying the
Terminal Manager window, VXT Message Box, and their icons. This feature
allows you to hide these applications while you are working in other windows,
then redisplay them when needed. Normally, the F3 key function is disabled.

When you redisplay the Terminal Manager window and VXT Message Box, the
message box receives input focus.

If you have customized the AutoStart dialog box to start the Terminal Manager
window and VXT Message Box as separate applications, then the F3 key
cannot hide the message box. In this case, the Terminal Manager window
receives input focus when you redisplay it.

When you use the F3 key to hide and redisplay the Terminal Manager and
VXT Message Box, you lose any customized window size settings for those
applications. If you maximize the windows before hiding them, you cannot use
the maximize button to return them to their normal size.

Startup State

Normally when you restart the terminal, it displays the Terminal Manager
window and VXT Message Box. You can choose to hide the Terminal Manager
window and VXT Message Box at startup, or to display them as icons. To
change the current setting, click on the appropriate button.
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If you have changed the Customize AutoStart dialog box settings to start the
Terminal Manager window and VXT Message Box as separate applications, the
Startup State only affects the Terminal Manager window.

Caution

Before you change the Startup State to Hidden, decide whether or
not you need to make the Terminal Manager window viewable after
startup. If you want the window to be viewable, make sure the F3 key
is enabled to display the Terminal Manager window. See the Disable
F3 Key button in this dialog box. If you forget to enable the F3 key,
see your system manager to change the setting from the Configuration
Manager: Resource Management dialog box.

Terminal Tag

You can specify a name to identify your terminal in the configuration manager
(server-based systems only). To enter a name, click on the Terminal Tag box.
Your name can have up to 31 characters. After you click on Apply or OK in the
Customize Terminal Manager dialog box, your system manager can display the
new terminal tag in the Configuration Manager: Resource Management dialog
box.

Your system manager can also create a name for your terminal by using the
Optional Name field in the configuration manager’s Create Terminal dialog box.
The terminal uses the most recently entered name (Terminal Tag or Optional
Name).

Pause Prompt

You can specify the text displayed in the pause prompt box when you pause
your terminal session. Click on the Pause Prompt box and enter a prompt of
up to 80 characters.

Status Update Frequency (seconds)

You can specify how frequently the terminal updates the information in the
status dialog boxes displayed from the Session menu. The normal setting is 5
seconds. Click on the Status Update Frequency (seconds) slider to specify an
interval from 0 to 60 seconds.
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3.11 Changing Your Video Alignment Settings (VX227
Models)

If you have a VXT 2000 model VX227 windowing terminal, you adjust your
video alignment from a Customize dialog box rather than using physical
controls on the terminal. The video alignment dialog box is only for VX227
terminals.

To adjust your video alignment settings, choose Video Alignment... from the
Terminal Manager window’s Customize menu. The Customize Video Alignment
dialog box looks like this:

 8

 9 7
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From the video alignment dialog box, you can change the following settings.
Your new settings take effect when you click on OK.

Adjust Video Centering

You use the four Adjust Video Centering buttons to center the display on the
screen. Each time you click on an " button, the display shifts in the arrow’s
direction.

Adjust Video Rotation

You use the two Adjust Video Rotation buttons to rotate the display on the
screen. Each time you click on one of the buttons, the display rotates in the
arrow’s direction.
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3.12 Saving the Terminal Manager Window’s Position and
Size

You can make changes to the Terminal Manager window’s position and size on
the screen, then save the changes for use in all future sessions. You can also
recall the factory-default position and size for the Terminal Manager window,
or recall the last position and size you saved.

To save or restore the Terminal Manager window’s position and size on the
screen, use the following menu items from the Customize menu:

Choose... To...

Save Terminal Manager Window Save the Terminal Manager window’s
current position and size for use in all
future sessions.

Restore Terminal Manager Window Restore the last position and size you
saved. Choose this menu item if you want
to reset features you changed temporarily,
but did not save.

Default Terminal Manager Window Recall the factory-default position and size
for the Terminal Manager window.

3.13 Customizing the VXT Message Box

The VXT Message Box displays system status and error messages. You can
choose the categories of messages displayed. You can also set the number
of message lines saved in the scroll box. To change your VXT Message Box
settings:

1. Click on the Customize menu in the VXT Message Box.
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2. Choose Message Box... to display the Customize Message dialog box.
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From the Customize Message dialog box, you can change the following settings:

Message Region

You can scroll through text in the VXT Message Box. The Scroll Lines Saved
slider lets you specify how many message lines to save when they are scrolled
out of the region. Any extra lines are discarded.

This feature does not affect the size of the Messages region. You can change
the size of the scroll box by changing the size of the VXT Message Box window.

Messages Displayed

Normally, the terminal displays all informational, warning, and error messages
in the Messages scroll box. You can choose to display warning and error
messages only, or error messages only.

Header Text

Normally, the title of the Messages scroll box in the VXT Message Box is
Messages. To change the title, click on the Header Text box and enter a new
title.
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3.13.1 Saving the VXT Message Box’s Position and Size

You can make changes to the VXT Message Box’s position and size on the
screen, then save the changes for use in all future sessions. You can also recall
the factory-default position and size, or recall the last position and size you
saved.

To save or restore the VXT Message Box’s position and size on the screen, use
the following menu items from the Customize menu:

Choose... To...

Message Box... Display the Customize Message Box.

Save Message Box Window Save the VXT Message Box’s current position and
size for use in all future sessions.

Restore Message Box Window Restore the last position and size you saved. Choose
this menu item if you want to reset features you
changed temporarily, but did not save.

Default Message Box Window Recall the factory-default position and size for the
VXT Message Box.

Closing the VXT Message Box:

Normally, the VXT Message Box runs together with the Terminal Manager
window. To close the Terminal Manager window and VXT Message Box, click
on the Session menu in the Terminal Manager window and choose Close.

If you customize your AutoStart settings to run the VXT Message Box as a
separate application, the VXT Message Box has a separate File menu. In this
case, you can close the VXT Message Box alone by clicking on the File menu
and choosing Exit. See Section 5.6.
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This chapter describes how to customize communication between the terminal
and host systems. Your terminal can use several communication protocols to
communicate with host systems: TCP/IP, NFS, LAT, LASTport, and DECnet.
You can also choose to use a serial or parallel port for a local printer or host
system. After you make changes, you can save your settings for all future
sessions.

The chapter covers the following major topics:

• Changing Your Serial and Parallel Port Settings

These settings affect your local printer or serial host.

• Changing Your LAT Settings

These settings let a system manager fine-tune communication in a LAT
network.

• Changing Your LASTport Group Code Settings (InfoServer Systems)

The group code determines which InfoServer systems your terminal can
communicate with.

• Changing Your TCP/IP IP Address Settings

You must enter an IP address to communicate with systems that use the
TCP/IP transport.

• Changing Your TCP/IP Name Server Settings

You must specify a name server if you want to identify TCP/IP systems by
name in other dialog boxes.

• Changing Your TCP/IP Routing Table Settings

You can specify routing information for communicating with TCP/IP
systems.
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• Changing Your NFS Settings

You must enter NFS Mount Points to communicate with systems that use
the NFS transport.

• Changing Your DECnet Name Translator Settings

You must specify a name translator if you want to identify DECnet systems
by name in other dialog boxes.

To customize communications, you use the Communications submenu on the
Terminal Manager window’s Customize menu.

4.1 Displaying the Communications Submenu

To display the Communications submenu, first click on the Customize
menu in the Terminal Manager window and choose Communications. The
Communications submenu looks like this:

.12.123.123             12.123

VXT V2.1 Terminal Manager
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When you choose a menu item from the Commmunications submenu, the
terminal displays a dialog box with the feature settings for that topic. In
dialog boxes, shaded buttons indicate the current settings. You can examine
the settings and change them if desired.
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Note

A system manager can customize settings for terminals and work
groups. The VXT manager can also lock or unlock access to one or
more of the Customize menu items. Locked menu items are dimmed.

4.2 Changing Your Serial and Parallel Port Settings

You can specify the communication settings of the terminal’s serial and parallel
ports to make them compatible with a serial host system or a local printer.
The default settings work with most Digital systems. Make sure the settings
you use match your host system.

The serial port is for connecting a host system or a local serial printer. The
parallel port is for connecting a local parallel printer. Each port has one 25-pin
connector on the rear of the system box.

When you connect to a host system through the serial port, you use the 25-pin,
RS–232 serial port connector on the rear of the terminal. The serial port
connector is above the parallel port connector.

To change the port settings, choose the Communications submenu from the
Terminal Manager window’s Customize menu. Then choose Serial and Parallel
Ports... to display the Customize Serial and Parallel Ports dialog box:

66 Chapter 4



Customizing Communications
4.2 Changing Your Serial and Parallel Port Settings

LJ−01168B−RAGS

From the Customize Serial and Parallel Ports dialog box, you can change the
following settings:

Port Usage

By default, the parallel port acts as a printer port and the serial port acts as a
host port. You can set the serial port to act as the printer port. You can choose
one of two functions for the serial port:
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Choose... To...

Parallel Port: Printer,
Serial Port: Host

Use the parallel port for a parallel printer, and the serial
port for a host system.

Serial Port: Printer Use the serial port for a serial printer.

Transmit

You can change the speed the terminal uses to send data, to match your host
system or printer. Normally, the serial port uses a speed of 9600 baud, which
works with most Digital systems. To choose another speed, click on the button
in the Transmit box and make a choice from the pop-up menu. Your new speed
appears in the Transmit box.

The terminal does not support speeds lower than 300 baud.

Receive

You can change the speed the terminal uses to receive data from the host
system or printer. Make sure you choose a receive speed that matches your
host’s or printer’s transmit speed. Normally, the terminal’s receive speed
matches its transmit speed (rx = tx setting). However, the terminal can
transmit at one speed and receive at another.

To choose another speed, click on the button in the Receive box and make a
choice from the pop-up menu. Your new speed appears in the Receive box.

Character Format

You can choose the word size and number of parity bits used to communicate
with the host system or printer. The terminal uses a default word size of 8 bits
and no parity. This setting works with most of today’s computer systems.

To choose another setting, click on the button in the Character Format box
and make a choice from the pop-up menu. Your new setting appears in the
Character Format box.

Parity Check

Normally, the terminal performs a parity check on bytes of data. To turn this
feature on or off, click on the Parity Check button.

Host Accessible Printer Port

Normally, the terminal can accept remote printing jobs sent from host systems
that use the TCP/IP or LAT transport. To turn this feature on or off, click on
the Host Accessible Printer Port button. To send printing jobs from a host, see
Section 2.8.2.
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Stop Bits

You can choose the number of stop bits used in the character format. Digital
recommends using one stop bit for most applications. To select two stop bits,
click on the Two button.

XOFF At

You can choose how many characters the terminal stores in its receive buffer
before sending the host or printer an XOFF signal to stop sending data.
Normally, the terminal sends XOFF to the host when the input buffer contains
64 characters. To choose 128 characters or no XOFF, click on the appropriate
button.

Modem Control

You can choose Modem Control if you are communicating with a host system
and need to use extended modem features. Otherwise, use Data Leads Only.

Data Leads Only Choose Data Leads only if you do not plan to use modem
control features or your modem (or modem cable) is not configured for modem
control. The terminal uses pin 2 to transmit data and pin 3 to receive data.

The terminal asserts the data terminal ready (DTR) signal on pin 20 whenever
the terminal is on.

The terminal receives the data set ready (DSR) signal on pin 6. The terminal
uses DSR to detect the status of the connected printer or host system modem
and display status messages about the device. Note that in Data Leads Only
mode data is always transmitted, regardless of the state of the DSR signal.

Modem Control Choose Modem Control if you plan to use modem features
that require additional signals beyond data leads only, such as call origination
and dialing from the keyboard. The control lines follow the CCITT V.24 and
V.28 and EIA RS–232–C designations and control the flow of data based on the
state of various signals.

4.3 Changing Your LAT Settings

OpenVMS systems typically use the local area transport (LAT) to connect to
the terminal. The terminal connects to all LAT group codes (0 to 255); you
cannot select group codes.

Your system manager can fine-tune the characteristics of your LAT
environment by adjusting the three slide bars in the Customize LAT dialog
box.
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Note

These settings directly affect the performance of your local area
network. Do not try to adjust these settings yourself; they should be
adjusted only by system managers. Incorrect adjustments can produce
poor network and terminal performance.

To change LAT settings and adjust performance, choose the Communications
submenu from the Terminal Manager window’s Customize menu. Then choose
LAT... to display the Customize LAT dialog box:
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From the Customize LAT dialog box, you can change the following settings:

LAT Circuit Timer

You set the LAT Circuit Timer to tune the network for the best response time
and network performance when running an X window or DECterm terminal
window session. The optimum setting depends on the number of users on
the local area network and the typical network traffic conditions. The normal
setting of 30 milliseconds produces the best performance for most systems.
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LAT circuit timer settings takes effect when the first LAT circuit is created. If
you change the setting while LAT circuits are running, it does not take effect
until you exit all existing LAT circuits.

Retransmit Limit

To make a LAT connection to a host system, the terminal sends out a request-
to-connect message, then waits for an acknowledgement. If the host does not
acknowledge the request, the terminal resends the message a specified number
of times.

The Retransmit Limit setting tells the terminal how many times to resend the
message. If the terminal does not receive an acknowledgement after sending
the message the specified number of times, the terminal stops requesting a
connection and indicates it could not connect to that host.

Normally, the terminal resends the message 40 times before it stops trying to
connect to the host. This setting works well with most Digital systems.

Keep Alive Timer

When the terminal is inactive, it sends certain LAT messages out on the
network every few seconds to keep the LAT connection alive. Normally, the
terminal sends messages out every 40 seconds. This setting works well with
most Digital systems.

4.4 Changing Your LASTport Group Code Settings
(InfoServer Systems)

Server-based terminals use an InfoServer system for downloading and booting
VXT software, configuration management, access to the InfoReader library,
virtual memory, and other services. To communicate with a particular
InfoServer system, your terminal must have the same group code as the
InfoServer. On large local area networks, group codes can help reduce
the number of InfoServer systems that your terminal must identify and
communicate with.

By default, the LASTport group code on InfoServer systems and VXT 2000
windowing terminals is set to 0. If the InfoServer system’s group code is not 0,
you or your system manager must change the terminal’s default group code to
match the InfoServer’s group code.

The LASTport Group Code dialog box lets you change the terminal’s group
code setting to match the servers that you want to access. Ask your system
manager for your server’s group code. New group code settings take effect
when you restart the terminal.
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If you cannot boot your terminal from an InfoServer system because your
terminal has a different group code:

1. Quickly press and release the halt button on the rear of the terminal.

• If your terminal has a system box, the halt button is next to the
indicator lights on the rear of the system box.

• If your terminal does not have a system box, the halt button is below
the keyboard connector on the rear of the monitor.

2. At the >>> prompt, enter the command b/100000.

3. At the LASTport group code (0-1023)> prompt, enter the group code of the
server you want to connect to. See your system manager for the correct
group code.

4. After the Terminal Manager window appears, enter the group code in the
Customize LASTport dialog box.

To enter or change LASTport group code address settings, choose the
Communications submenu from the Terminal Manager window’s Customize
menu. Then choose LASTport... to display the Customize LASTport dialog box:
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To enter a LASTport group code:

1. Enter the LASTport group code (from 0 to 1023) in the text-entry box.

Examples: 34 or 567.

2. Press Return or click on OK or Apply.

3. Restart the terminal.
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4.5 Changing Your TCP/IP IP Address Settings

UNIX, ULTRIX, and DEC OSF/1 AXP systems typically use the TCP/IP
transport to connect to the terminal. To communicate with systems using
TCP/IP, you must enter an IP address and subnet mask for the terminal. You
use the Customize TCP/IP dialog box to enable or disable TCP/IP and enter
the terminal’s IP address and subnet mask. After you enter and save the IP
address, it appears at the bottom of the Terminal Manager window.

To enter or change TCP/IP address settings, choose the Communications
submenu from the Terminal Manager window’s Customize menu. Then choose
TCP/IP... to display the Customize TCP/IP dialog box:
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From the Customize TCP/IP dialog box, you can change the following settings:

TCPIP

You can choose to enter an IP address yourself or to have the terminal
automatically determine its address from a file set up by your system manager.
Normally, the User Specified IP Address button is on. You can disable the use
of TCP/IP by clicking on the Disable button.
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Determine IP Address Use this setting if you want the terminal to
automatically determine its IP address, subnet mask, and the IP address
of an optional name server by reading a host system file created by your
system manager.

After you reboot the terminal, the terminal’s IP address appears in the
Terminal Manager window.

Note

Your system manager must enter your terminal’s information in the
BOOTP daemon’s configuration file.

User Specified IP Address Use this setting if you want to enter your
terminal’s IP address in this dialog box. After you enter the address and reboot
the terminal, the terminal’s IP address appears in the Terminal Manager
window.

Disable Use this setting to disable TCP/IP.

Terminal’s IP Address

After you click on the User Specified Address button, you can enter an IP
address for your terminal. See your system manager for an address to use.
After you enter the IP address and subnet mask, click on OK to save the
address and dismiss the dialog box. Then reboot the terminal.

IP Subnet Mask

After you click on the User Specified Address button, you can enter the IP
subnet mask for your terminal. An IP subnet mask acts as a filter for your
TCP/IP network. Using the subnet mask makes the terminal ignore certain
traffic on the network.

See your system manager for a subnet mask to use. After you enter the IP
subnet mask, click on the OK button to save the setting and dismiss the dialog
box. Then reboot the terminal.

4.6 Changing Your TCP/IP Name Server Settings

If your network has a name server, you can specify host systems by their
names instead of addresses when making entries in the Create and Customize
AutoStart dialog boxes. A name server stores host names and addresses, so it
can determine a host’s address from the name you enter.

You can specify a primary and secondary name server. See your system
manager for your name server’s IP address.
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To enter your name server, choose the Communications submenu from the
Terminal Manager window’s Customize menu. Then choose TCP/IP Name
Server... to display the Customize TCP/IP Name Server dialog box:
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From the Customize TCP/IP Name Server dialog box, you can change the
following settings:

Primary Name Server IP Address

The terminal first attempts to use the primary name server to resolve names
entered into fields requiring a host name or IP address. If the terminal cannot
find the primary name server specified, you need to enter your terminal’s
domain name.

To enter or change the primary name server, click on the Primary Name Server
IP Address box and enter the primary name server’s IP address.
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Secondary Name Server IP Address

If the terminal cannot resolve a host name or IP address with the primary
name server, the terminal queries the secondary name server.

If the Automatic button for Determine Domain Name is selected and the
primary name server is unavailable, the terminal uses the secondary name
server to provide translations from names to IP addresses for connections.
However, the secondary name server does not return the terminal’s domain
name, because it customarily resides within a second domain.

To enter or change the secondary name server, click on the Secondary Name
Server IP Address box and enter the secondary name server’s IP address.

Determine Domain Name

The terminal displays its domain name in the Domain Name box if the primary
name server finds it available on the network. The terminal attempts to
resolve a domain name only if a primary name server is specified.

To enter a domain name:

1. Click on the User Specified button in the Determine Domain Name box.

2. Enter a domain name in the Domain Name box.

3. Click on Apply or OK.

If you choose the System Defaults button or clear the name server fields and
choose OK or Apply, the terminal’s Name Server capability is turned off and
the terminal no longer has a domain name. The Domain Name field is not
cleared, even though there is no domain name.

When you reboot the terminal, the domain name is determined and maintained
in the name server. If you change your primary name server, the domain of the
terminal does not change unless you change the domain name for the subnet
and reboot the terminal.

If the primary name server is on a different subnet than the terminal, the
domain name may not be available when you reboot the terminal. In this case,
the domain name is resolved the next time it is needed.

4.7 Changing Your TCP/IP Routing Table Settings

You can enter TCP/IP routes from your network to hosts on other networks.
You can also enable or disable dynamic routing to automatically update the
network routing table. After you save your settings, you can view these and
other TCP/IP routes in the TCP/IP Routes dialog box (Section 6.3).
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To enter your routes, choose the Communications submenu from the Terminal
Manager window’s Customize menu. Then choose TCP/IP Routing Tables... to
display the TCP/IP Routing Tables dialog box:
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From the Customize TCP/IP Routing Tables dialog box, you can change the
following settings:

Dynamic Routing button

The Dynamic Routing button lets you enable or disable the VXT software’s
routing daemon. This daemon listens for routing information protocol (RIP)
packets and uses the packets to automatically enter, update, or delete TCP/IP
routes in the TCP/IP Routes dialog box (Section 6.3).
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User Defined Routes scroll box

The User Defined Routes scroll box lists the route destination for each entry.
The gateway for each entry is stored, but not displayed.

To add a route to the User Defined Routes scroll box:

1. Specify whether the route applies to either a host or a network, by clicking
on the Host, Network, or Default button. If you click on the Default button,
the terminal tries to determine if the route is for a host or a network.

2. Click on the Destination box and enter the route’s destination.

3. Click on the Gateway box and enter the route’s gateway.

4. Click on the " button to add your route to the Routes scroll box.

To remove a route:

1. In the Routes scroll box, click on the route you want to remove.

2. Click on the trash can button.

Metric button

RIP packets contain a metric that helps to determine which gateway to use.
Metric values range from 1 to 15, with smaller metrics indicating preferred
paths. A 0 metric affects only the system routing table and tells the system the
route is locally reachable.

4.8 Changing Your NFS Settings

You can use the NFS transport to load fonts or read your customized terminal
resource files from host systems that use an NFS server.

The NFS transport uses mount points to identify locations where files can
be accessed. You can define up to 10 mount points in the Customize NFS
dialog box. You use these mount points when making entries in the Customize
Font Path dialog box (Section 5.3) or Customize Resource Files dialog box
(Section 5.9).

To enter your mount points, choose the Communications submenu from the
Terminal Manager window’s Customize menu. Then choose NFS... to display
the Customize NFS dialog box:
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From the Customize NFS dialog box, you can change the following settings:

NFS Mount Points

The NFS Mount Points scroll box lists the currently entered mount points.
Each entry lists the full mount point name on the host and an equivalent name
that you define for local use on the terminal.

Host:RemoteName LocalName

You use the Host:RemoteName LocalName box to add a new mount point in
the scroll box.

To add a mount point to the NFS Mount Points scroll box:

1. Click on the Host:RemoteName LocalName box. Enter the mount point in
the following format:

Host:RemoteName LocalName

• Host is the name or IP address of the host with the NFS server.

• RemoteName is the directory path for the NFS server to export.

VXT 2000+/VXT 2000 Windowing Terminal User Information 79



Customizing Communications
4.8 Changing Your NFS Settings

• LocalName is a local name you want to use for this mount point. You
use the local name when making entries in the Customize Font Path or
Customize Resource Files dialog box.

Examples

Host:RemoteName LocalName

16.122.128.224:/usr/lib/X11/fonts/decwin/75dpi nfs_fonts

mynode:/usr/users/resource resource

To load fonts from the first sample mount point, you would use the local
name nfs_fonts when entering the font path in the Customize Font Paths
dialog box.

To load a terminal resource file from the second sample mount point, you
would use the local name resource when entering the path to the file in
the Customize Resource Files dialog box.

2. Click on the " button to add your mount point to the NFS Mount Points
scroll box.

To apply your mount points:

Click on OK or Apply. The terminal saves the listed mount points and tries to
mount any remote file systems you added.

To remove a mount point:

1. In the NFS Mount Points scroll box, click on the mount point you want to
remove.

2. Click on the trash can button.

Notes on Using NFS

For more information about using NFS, refer to your host system’s NFS
documentation.

• If an error occurs when mounting or accessing file systems, the VXT
Message Box displays an NFS error code. See Section A.1.1 for a list of
error codes.

• Some NFS mount daemons require name service to honor mount requests
that use an address instead of a name.

• Files on the NFS server must be world-readable. The terminal implements
NFS for clients only, so the NFS server must provide open file access.
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• The NFS server must export remote file systems before the terminal can
mount them. The exported file system should include the areas holding the
desired fonts or terminal resource files.

4.9 Changing Your DECnet Address Settings

To communicate with other DECnet nodes, your terminal must have a unique
DECnet address. From the Customize DECnet dialog box, you can enable
or disable the use of the DECnet transport and enter the terminal’s DECnet
address.

See your system manager for your terminal’s DECnet address. The new setting
takes effect when you reboot the terminal.

To enter or change your terminal’s DECnet address settings, choose the
Communications submenu from the Terminal Manager window’s Customize
menu. Then choose DECnet... to display the Customize DECnet dialog box:
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From the Customize DECnet dialog box, you can change the following settings:

DECnet

Before you can enter an address, you must click on the User Specified DECnet
Address button. You can disable the use of the DECnet transport by clicking
on the Disable button.
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Terminal’s DECnet Address

After you click on the User Specified DECnet address button, you can enter
your terminal’s DECnet address in the Terminal’s DECnet Address box. Click
on OK to save the address and dismiss the dialog box.

You can enter your DECnet address in the long or short form:

• The long form uses a period to separate the area number and node number.

Example: 61.513.

• The short form collapses the area number and node number into a single
decimal value, using the formula (area_number � 1024) + node_number.

Example: (61 � 1024) + 513) = 62977.

Network Buffer Size

The system manager chooses a DECnet network buffer size to optimize the
traffic flow on a wide area network, minimizing retransmission costs while
maximizing throughput. The default network buffer size 576 bytes.

You enter your network buffer size in the Network Buffer Size box. See your
VXT manager for the correct size. The buffer size value must be consistent
throughout your network. Click on OK to save the size and dismiss the dialog
box.

4.10 Changing Your DECnet Name Translator Settings

You can use DECnet node names instead of DECnet addresses to specify host
systems in the Create and Customize AutoStart dialog boxes.

The terminal can check the DECnet node names you use without maintaining
a local node name database. To do this, the terminal uses the DECnet Network
Management Listener (NML) object (object 19) on a host system as its name
translator. You specify the host system in the Customize DECnet Name
Translator dialog box.

When resolving a DECnet address, the terminal connects to the NML object
and issues a Network Information and Control Exchange (NICE) protocol
message. This message conveys the NCP command SHOW NODE nodename

to the host. The host responds with the DECnet address associated with the
supplied node name.

Your terminal first attempts to connect to the primary name translator. If
the primary name translator is unavailable, the terminal attempts to use the
secondary name translator.

See your system manager for the addresses of primary and secondary DECnet
name translator nodes. Settings take effect immediately.
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To enter or change DECnet name translator addresses, choose the
Communications submenu from the Terminal Manager window’s Customize
menu. Then choose DECnet Name Translator... to display the Customize
DECnet Name Translator dialog box:
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From the Customize DECnet Name Translator dialog box, you can change the
following settings:

Primary Name Translator’s DECnet Address

Use this box to enter the address of the host that serves as the primary name
translator for DECnet addresses. Click on OK to save the address and dismiss
the dialog box. You can enter your DECnet address in the long or short form
(Section 4.9).

Secondary Name Translator’s DECnet Address

Use this box to enter the address of a secondary host for DECnet name
translation, if you have one. Click on OK to save the address and dismiss
the dialog box.
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Customizing Fonts and Startup Settings

5

This chapter describes how you can customize more advanced system settings
to autostart sessions and applications, change font paths, boot VXT software,
and load or unload VXT software features. To customize these settings, you
use the bottom half of the Customize menu in the Terminal Manager window.

Initially, the terminal uses factory-default settings that work with many
host systems. You can make changes to suit your personal preference and
computing environment. After you make changes, you can save your settings
for all future sessions.

The chapter covers the following major topics:

• Changing Your Font Path Settings

• Changing Your X Server Settings

• Specifying Your AutoStart Settings

• Changing Your Boot Settings for VXT Software

• Changing Your Software Options Settings
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5.1 Displaying the Customize Menu

To display the Customize menu, click on Customize in the Terminal Manager
window’s menu bar. This chapter describes the menu items highlighted in
gray:
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VXT V2.1 Terminal Manager

Note

A VXT manager can customize settings for terminals and work groups.
The VXT manager can also lock or unlock access to one or more of the
Customize menu items. Locked menu items are dimmed.

5.2 Changing Your Configuration Manager Settings

The configuration manager lets you centrally manage and customize the
VXT 2000 windowing terminals on your local network from a single terminal.
You also have the alternative of creating your own terminal resource files
and storing them on a host system. Typically, these are system management
functions. The VXT Software Version 2.1 Installation and System Management

guide describes the configuration manager, host-based resource files, and how
to use them.
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From the configuration manager, a system manager can access the Customize
dialog boxes for each terminal and lock or unlock customized settings. If you
customize settings at your terminal, they override terminal or work group
settings entered in the configuration manager.

For host-based terminals, the system manager can customize individual
terminals in the configuration manager. The customized settings are written
directly to your terminal. The settings take effect the next time you reboot
your terminal.

For server-based terminals, the system manager can customize individual
terminals or set up terminal work groups to share the same settings. Your
terminal stores its customized settings on an InfoServer system rather than in
the terminal. The system manager can also set up font sets on an InfoServer
system for work groups to share.

To display the Configuration submenu, choose Configuration... from the
Terminal Manager window’s Customize menu.

5.3 Changing Your Font Path Settings

VXT software provides 23 local fonts for use with the terminal. If you have
a server-based terminal, the VXT software on an InfoServer system provides
1166 fonts. You can also access fonts on host systems or font servers in your
network. To access fonts from network devices, you enter a font path in the
Customize Font Path dialog box.

A font is a set of character images in a particular typeface and style. The
font defines how characters look. The terminal displays characters as they are
defined in the selected font. A font path points to the network location of a
set of fonts residing on a host or server.

Font Formats and Communication Protocols

The terminal supports the industry-standard X11R5 server for accessing fonts.
You can access fonts from multiple sources, in any supported format, using
different communication methods. For each font source you want to use, you
enter a font path element in the Customize Font Path dialog box. The terminal
can use any fonts in the active font path, plus the 23 local fonts.
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The terminal can access fonts from the following systems:

System Communication Method

X11R5 font server TCP/IP

InfoServer system LASTport

UNIX host NFS or TFTP

OpenVMS host LAT

Fonts can be in any of the following formats:

• Portable compiled format (PCF) (compressed and uncompressed)

• Server natural format (SNF) (Version 1 and Version 4)

• Bitmap distribution format (BDF)

• Speedo outline format

• PostScript Type 1 format (ASCII or binary form)

VXT Software Version 2.1 Installation and System Management also provides
information on converting fonts for use on your terminal.

Activating the Font Path

The terminal tries to set a font path when you

• Turn on the terminal

• Reset or Reboot the terminal from the Session menu

• Click on OK, Apply, or System Defaults in the Customize Font Path dialog
box

You can make changes to the font path while you are using the terminal.
After you apply your changes in the Customize Font Path dialog box, any
applications you start use the fonts from the new font path. Applications that
were already running continue to use the same fonts; one exception is VXT
DECterm windows, which use the new fonts. See Section 8.3.1 for information
on using fonts in VXT DECterm windows.
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Customize Font Path Dialog Box

To customize the font path, choose Font Path... from the Terminal Manager
window’s Customize menu. The Customize Font Path dialog box looks like this:
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5.3.1 Entering a Font Path

The Active Font Path Elements scroll box lists the font paths the terminal uses
to find fonts. The font server searches for font paths in the order listed in the
scroll box.

To enter a font path into the Active Font Path Elements scroll box:

1. In the Font Source box, choose the type of device supplying your fonts:
InfoServer, host, or font server.
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2. In the Transport box, choose the protocol used to communicate with the
font source. The choices available depend on the font source you chose.
The titles of the two text-entry boxes also depend on the type of font source
you chose.

Font Source Transport Server/Host/Mountpoint Font Sets/Path/Catalogs

InfoServer LASTport Server Font Sets

Host NFS Mount Point Path

Host TFTP Host Path

Host LAT Host Path

Font Server TCP/IP Host Catalogs

3. In the Server/Mount Point/Host box, enter the host name or address of
the font source (font server, InfoServer system, host, or NFS mount point)
where the fonts reside.

4. In the Font Sets/Path/Catalogs box, enter the path to the directory where
the fonts reside.

5. Click on the " button to add the font path to the Active Font Path
Elements scroll box.

6. Click on Apply or OK. The terminal tries to set a new font path to each
element listed in the scroll box.

To remove a font path:

1. In the Font Paths scroll box, click on the font path element you want to
remove.

2. Click on the trash can button.

The following sections provide more detailed examples for each type of font
source and transport.

InfoServer Font Path

To enter a font path to fonts on an InfoServer system:

1. Click on the InfoServer button in the Font Source box. The LASTport
transport is automatically selected.

2. In the Server box, click on Any if you want to use any InfoServer on your
network.

Click on Other if you want to specify a particular InfoServer. Enter the
name of the InfoServer in the Server box.

VXT 2000+/VXT 2000 Windowing Terminal User Information 89



Customizing Fonts and Startup Settings
5.3 Changing Your Font Path Settings

3. In the Font Sets box, click on Default if you want to use the default font
set on the InfoServer.

Click on Other if you want to specify a particular font set. Enter the font
set name in the Font Sets box.

4. Click on the " button to add your font path to the scroll box.

Examples

//lastport Solicits any InfoServer and its default font set.

//lastport/InfoServer_1 Solicits for InfoServer_1 and its default font set.

//lastport//v2_1 Solicits for any InfoServer with font set V2_1.

//lastport/InfoServer_1/V2_1 Solicits for InfoServer_1 and font set V2_1.

Host System Font Path (NFS)

To set an NFS font path, you must first enter the NFS mount point in the
Customize NFS dialog box (Section 4.8).

To enter a font path to a host system using NFS:

1. In the Font Source box, click on the Host button. The NFS transport is
automatically selected.

2. In the Host box, enter the local name of the NFS mount point. You define
the local name in the Customize NFS dialog box.

Example: fonts

3. In the Path box, click on Default if you want to use the default path.

Click on Other if you want to specify a particular font path. Enter the path
in the Path box.

Example: /vxt/fonts/vxt-decwin/100dpi

4. Click on the " button to add your path to the scroll box.

Example: //nfs/fonts/vxt/fonts/vxt-decwin/100dpi

Host System Font Path (TFTP)

To enter a font path to a host system using TFTP:

1. In the Font Source box, click on the Host button.

2. In the Transport box, click on the TFTP button.

3. In the Host box, enter the name or IP address of the host where the fonts
reside.

Example: market or 12.345.678.901

4. In the Path Box, enter the path to the fonts.

90 Chapter 5



Customizing Fonts and Startup Settings
5.3 Changing Your Font Path Settings

Example: /usr/lib/fonts/100dpi

5. Click on the " button to add your font path to the scroll box.

Example

//tftp/12.123.123.122/usr/lib/fonts/100dpi

Host System Font Path (LAT)

To enter a font path to a host system using the LAT transport:

1. In the Font Source box, click on the Host button.

2. In the Transport box, click on the LAT button.

3. In the Host box, enter the name of the host where the fonts reside.

Example: MARKET

4. In the Path Box, click on Default if you want to use the default font
directory search list on the host.

Click on Other if you want to specify a particular font path. Enter the path
into the Path text entry box.

Example: fonts$disk:[user_fonts.100dpi]

5. Click on the " button to add your font path to the scroll box.

Examples

lat/market Specifies the default font directory search list
on host MARKET.

lat/market/fonts$disk:[user_fonts.100dpi] Specifies a particular font path on host
MARKET.

Font Server Font Path (TCP/IP)

To enter a font path to a font server using TCP/IP:

1. In the Font Source box, click on the Font Server button. The TCP/IP
transport is automatically selected.

2. In the Host box, enter the name or IP address of the host where the fonts
reside.

Example: expo

3. If you want to specify a particular port, click on the Port box and enter a
port address. The default port address is 7000.

4. In the Catalogs box, click on Default if you want to use the default font
catalog on the font server.
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Click on Other if you want to specify a catalog. Enter the catalog name in
the Catalogs box.

Example: available

5. Click on the " button to add your font path to the scroll box.

Examples

tcp/expo:7000/available
tcp/18.30.0.212:7890

Font Path Errors

If a font source is unavailable: The VXT Message Box displays a message
indicating the terminal could not set a font path to that source.

Backup font services: If a font source fails while in use, the terminal can
automatically access the same font from a second source if available. The
second source must be listed somewhere after the first source in the Active
Font Path Elements scroll box. If the terminal does not find the font on
another font source, the terminal sends an error to the client that was using
the font.

If no fonts are found in a valid LAT font path: The VXT Message box
displays a message indicating that the set font path action succeeded and the
number of fonts which are available.

Tips on Setting Font Paths

• If host applications need fonts, use the fonts from the host supplying the
application.

• Include backup font sources in your font path. If the primary font source is
unavailable, the terminal can find the same fonts on the backup source.

• Use an InfoServer system to supply fonts, if available. If your network has
multiple InfoServers, the terminal provides automiatic font failover service
to backup InfoServers. You can also use the Font Management dialog
box to create and manage font sets on an InfoServer; you can copy fonts
from host systems. VXT Software Version 2.1 Installation and System
Management describes how to use the Font Management dialog box.

• To reduce the time for setting the font path, make sure your font path
includes only fonts required for your applications.
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5.4 Changing Your X Server Settings

The Customize X Server dialog box lets you

• Choose whether or not to reset the X server or reboot the terminal’s
software when you end an X session.

• Scale display fonts to emulate a 75/dots inch display on a 100 dots/inch
monitor, or a 100 dots/inch display on a 75 dots/inch monitor

• Set an 8-plane terminal to use color or gray scale settings.

When you end an X session on an OpenVMS system, resetting the server will
end all open sessions on the terminal. If you do not reset the server, you can
end an X session without affecting other open sessions.

To change your X server settings, choose X Server... from the Terminal
Manager window’s Customize menu. The Customize X Server dialog box looks
like this:
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Backing Store

The backing store function improves the time needed to restore a window from
an icon, by having the terminal perform the restore instead of the remote
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application. The Graphics Option dialog box in VXT DECterm windows also
has a Backing Store button (Section 8.8).

The Disabled setting causes the terminal to ignore application requests for
backing store, and not to save the contents of an obscured window. The
terminal informs the client when its window is uncovered, and should be
redrawn. Use this setting to conserve the terminal’s memory.

The When Requested setting causes the terminal to save the contents of an
obscured window, or a portion of that window, when requested by the client.
If you select When Requested, the terminal can display an iconified or covered
window without waiting for the client to redraw it.

Display Scaling

The display scaling option lets you adjust the font size displayed on your
terminal to resemble a 75 dots/inch or 100 dots/inch display. Use the 75%
button if you have a 100 dots/inch monitor and want your display to look like
a 75 dots/inch monitor. Use the 133% button to make a 75 dots/inch monitor
display look like a 100 dots/inch monitor display. Your new setting takes effect
when you restart the terminal.

X Session Reset Server Action

Normally, the terminal restarts the X server when you quit from an X session.
If you end an X session on an OpenVMS system, restarting the X server causes
the terminal to end all open sessions.

If you click on the Ignore Reset Server button, you can end an OpenVMS X
session without ending other open sessions.

If you click on the Reboot Terminal button, the terminal reloads the VXT
software when you end an X session.

Your new setting takes effect when you click on Apply or OK.

Monitor

You can choose a gray scale or color setting for an 8-plane terminal. These
buttons are dimmed on monochrome terminals. Your new setting takes effect
when you restart the terminal.

5.5 Changing Your Startup Settings

You can customize the terminal to automatically start up the applications you
frequently use. You can also customize the terminal to load a particular VXT
system image or turn off individual VXT software options.
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To customize startup settings, you use the Startup submenu on the Terminal
Manager window’s Customize menu. The following sections describe the
functions you can perform from the Startup submenu:

• Specifying Your AutoStart Settings

The AutoStart dialog box lets you enter a list of host sessions and VXT
applications to automatically start each time you turn on, autostart, or
reboot the terminal.

• Changing Your Boot Settings for VXT Software

The Customize Boot dialog box lets you customize the VXT software
loading process to match your system environment.

• Changing Your Software Options Settings

The Customize Software Options dialog box lets you turn VXT software
options options on or off. Host-based terminals can use this feature to
improve memory use.

5.6 Specifying Your AutoStart Settings

The AutoStart dialog box lets you enter a list of host sessions and VXT
applications to automatically start each time you

• Turn on the terminal

• Choose the AutoStart menu item from the Session menu

• Choose the Reset, Reboot, or Shutdown menu item from the Session menu

By default, the terminal autostarts the Terminal Manager window, VXT
Message Box, and local Motif window manager.

The format of the AutoStart dialog box is the same as the Create dialog box.
To display the AutoStart dialog box, choose AutoStart... from the Terminal
Manager window’s Customize menu. The Customize AutoStart dialog box looks
like this:
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AutoStart List

The terminal starts applications in the order you list them in the AutoStart
List. The default entries in the Customize AutoStart dialog box are

• Terminal Manager window and VXT Message Box

• Motif Window Manager

By default, the terminal starts the Terminal Manager window and VXT
Message Box as a single application. You can choose to start them as separate
applications.

To add a session or application to the AutoStart list:
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Use the following steps. The AutoStart dialog box controls operate the same as
the Create dialog box controls. See Section 2.2 for syntax rules and details on
buttons.

1. In the Application box, click on the type of session (X Session, DECterm,
3270) or VXT application you want to autostart. For VXT applications, skip
steps 2 and 3.

2. In the Transport box, click on the communication method to use for the
session. If you choose Serial, skip step 3.

3. In the Host Name or Address box, enter the name or address of the host
system. If you make a typing mistake, you can use the Clear button to
clear the box.

For IP sessions:

• Use the Any Host button if you want to use the first available IP host.

• Use the Any Host Indirect button to specify a host that will act as a
pathway to find the first available IP host.

• Use the Comment box to enter optional text comments. For example,
if you entered a host name, you may want to enter the IP address as a
comment.

• Use the List Known Hosts... button to display a dialog box that lets
you list available IP hosts.

4. Click on " to add your entry to the AutoStart List.

To delete entries, select the entry in the list and click on the trash can
button.

To move entries, select the entry in the list and click on the 4 or 5 button.

5. Click on the OK button to save your settings.

The AutoStart dialog box saves your settings when you click on the OK button.
The Create dialog box contains a Save button for saving settings.

Reenter AutoStart Settings After Changing the Display Language

If you change your display language, you must reenter your AutoStart settings.

User Tip: Remove Unused Applications to Start the Terminal Faster

Normally, the terminal autostarts the local Motif window manager and the
combined Terminal Manager window + VXT Message Box applications. If you
no longer need to use an application, you should remove it from your AutoStart
list. The fewer applications listed in the AutoStart List, the faster the terminal
can start up and connect to your host sessions.
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If you use the remote window manager on a host system, you may want to
remove the local Motif window manager application from the AutoStart list.
You can enable the use of remote window managers in the Customize Terminal
manager dialog box (Section 3.10).

If you remove the combined Terminal Manager window + VXT Message Box
applications, you can restart them from the VXT Create pop-up menu. To
display the pop-up menu, click MB2 anywhere on the screen workspace.

Caution

If you remove the combined Terminal Manager window + VXT Message
Box applications from the Preferred Services list in the Create dialog
box, they will not appear on the VXT Create pop-up menu the next
time you reset the terminal.

5.7 Changing Your Boot Settings for VXT Software

The Customize Boot dialog box lets you specify a VXT software image and how
to load it. You can specify

• VXT software or VXT EX software

• Host-based or server-based mode of operation

You can also turn the following options on or off:

• X image extension, for working with XIE software to display graphics

• MOP trigger feature, for booting the terminal from a remote system

Your new Customize Boot settings take effect when you reboot the terminal.
When a loading process succeeds, the terminal saves the successful method in
local memory. The next time you reboot the terminal, it attempts to use the
same method. When you save your settings in the Customize Boot dialog box,
they override any previously saved settings.

Your booting options depend on what type of systems in your network have
VXT software and how your system manager has configured them to work with
VXT 2000 windowing terminals. For example, your system manager can enter
boot settings for your terminal in a file stored on a host system.
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You can also enter boot commands at the terminal’s >>> prompt. See
Section 5.7.5.

Caution

Before you change settings in the Customize Boot box, you should
understand how and when the terminal loads its software.

5.7.1 Overview

How Does the Terminal Load VXT Software?

Your terminal operates in a computer network. The terminal loads its VXT
software from a host computer system or InfoServer system in the network.
To begin the loading process, the terminal sends out a sequence of requests on
the network for the first available host system or InfoServer system that has
VXT software or the VXT loader file. The VXT loader file is for server-based
operation only.

The terminal sends each request by using a communication transport. The
terminal can communicate with systems that use the maintenance operations
protocol (MOP) or the Internet protocol (IP) transport.

By default, the terminal loads its software from one of these systems:

• A host system that your system manager has preconfigured

VXT Software Version 2.1 Installation and System Management provides
instructions to configure systems.

• An InfoServer system

If your network has an InfoServer system with VXT software, you can use
your terminal without a system manager having to configure a host system.

When Does the Terminal Load VXT Software?

Booting is the process of loading a system’s software and bringing it to an
operable state. The terminal tries to boot after you

• Turn on the terminal and the terminal’s self-test succeeds

• Restart the terminal by choosing the Reboot or Shutdown menu item from
the Session menu

• Press one of these key sequences to reboot the terminal:

ANSI (LK401) keyboard Ctrl +left Alt+keypad .
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PC (LK443/LK444) keyboard Ctrl+Alt+keypad .

Short ANSI (LK421) keyboard Ctrl Alt Function Extend .

5.7.2 Using Host-Based Operation

The terminal can load a VXT or VXT EX software image directly from a host
system, using the MOP or IP protocol. You can also load a VXT or VXT EX
software image in host-based mode from an InfoServer system; however, the
terminal does not make use of the InfoServer’s memory services in host-based
mode.

When you load a VXT or VXT EX software image in host-based mode, the
terminal stores all of your customizations in its nonvolatile memory. For
host-based operation, the terminal needs at least 10 megabytes of memory
installed.

Host System

VXT or VXT EX

 Software Image

VXT

Customizations

10 MB

VXT

Customizations

10 MB

VXT

Customizations

10 MB

VXT

Customizations

10 MB
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VXT or VXT EX

 Software Image

InfoServer

Setting Up a Host System

Your system manager can preconfigure a host system that uses MOP or IP
to load a host-based VXT software image into your terminal. VXT Software

Version 2.1 Installation and System Management describes how to preconfigure
systems.

If you use IP The system manager must preconfigure the host system.
VXT Software Version 2.1 Installation and System Management describes how
to add a line item to the /etc/bootptab file listing each terminal’s Ethernet
address, IP address, and the VXT software image file or VXT loader file (for
server-based operation).

If you use MOP The system manager can preconfigure the host system or
InfoServer system, or you can enter the name of a VXT software image file in
the Customize Boot dialog box.
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Specifying a Host-Based Image in the Customize Boot Dialog Box

If your system manager has not preconfigured a host system or InfoServer
system to load your terminal, you can specify a host-based VXT or VXT EX
software image in the Customize Boot dialog box. Your system must support
the MOP transport. To specify a host-based image:

1. Display the Customize Boot dialog box (Section 5.7.4).

2. In the Primary Boot box, click on the MOP button.

3. In the MOP Boot File box, click on the Other button. Enter the name of
the VXT or VXT EX software image file.

Enter... To load this image...

VXT Version 2.1 software provides two VXT software image files:

VXT VXT software image

VXTEX VXT EX software image

VXT Version 2.0 software included version numbers in the software image files:

VXT020 VXT software image

VXTEX020 VXT EX software image

Earlier versions of VXT software used separate software images to support
monochrome and color/gray scale terminals:

VXTMP00nn0 VXT host-based, monochrome image

VXTSP00nn0 VXT host-based, color or gray scale image

VXTMPI0nn0 VXT host-based, monochrome image with XIE support

VXTSPI0nn0 VXT host-based, color or gray scale image with XIE support

nn is the version number. For example, 12 is Version 1.2.

4. Click on the OK button to save your setting and dismiss the dialog box.

5. In the Terminal Manager window, click on the Session menu.

6. In the Session menu, click on the Reboot menu item to reboot the terminal.

The terminal loads the specified VXT or VXT EX software image from the
first available host system or InfoServer system that has the software.
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5.7.3 Using Server-Based Operation

When you load a VXT software image file from an InfoServer system, you can
choose to operate in server-based mode or host-based mode (Section 5.7.2).

In server-based mode, the terminal stores its customizations on an InfoServer
system. The InfoServer system also performs certain memory functions for the
terminal, so the terminal needs only 4 megabytes of installed memory.

In server-based mode, the terminal takes two steps to load a VXT or VXT EX
software image:

1. The terminal loads a VXT loader file from an InfoServer system or host
system, using the MOP or IP protocol.

2. The VXT loader file loads the VXT software image file from an InfoServer
system, using the LASTport Version 3.1 protocol.

VXT VXT VXT VXT

4 MB 4 MB 4 MB 4 MB
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VXT or VXT EX
 Software Image

Customizations

InfoServer

VXT Loader

VXT or VXT EX
 Software Image

Customizations

InfoServer

VXT Loader

Plug and Play Operation

If you have an InfoServer with VXT software, the terminal can normally load
the software without any need to configure a host system or use the Customize
Boot dialog box. By default, the terminal looks for a VXT loader file named
VXTLDR, which is supplied with VXT software kits for InfoServer systems.
By default, the VXT loader first solicits the network for the full-function VXT
software image; if the VXT software image is not available, the VXT loader
solicits for the VXT EX image.

Network Bridges May Affect the VXT Loader

If your InfoServer system is on the other side of a network bridge that
filters MOP messages, your system manager must install the VXT
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loader file on a host system. Your system manager can preconfigure the
host to load the file into the terminal. After the terminal loads the VXT
loader file, the VXT loader file loads the VXT software image from the
InfoServer system.

Specifying a Server-Based Image in the Customize Boot Dialog Box

If you want to load a particular VXT or VXT EX software version in server-
based mode, you can use the Customize Boot dialog box.

1. Display the Customize Boot dialog box (Section 5.7.4).

2. In the Primary Boot box, click on the MOP button.

3. In the MOP Boot File box, click on the Other button.

Enter the name of the VXT loader file. The default name is VXTLDR.

If needed, you can specify the loader supplied with a particular VXT
software version. Normally you do not need to specify a version, unless
you are loading a new version of VXT software that has not been made the
default on your network yet. For example, if VXT Version 1.3 is the default
version and you want to load VXT Version 2.1, you would specify the loader
for VXT Version 2.1.

Enter... To use this loader...

VXTLDR Default version on your network

VXTLDR_NODENAME Default version on nodename

VXTLDR021 VXT Version 2.1 loader

VXTLDR020 VXT Version 2.0 loader

VXTLDR0130 VXT Version 1.3 loader

VXTLDR1 VXT Version 1.3 loader (for VXT 2000+ terminals)

VXTLDR0120 VXT Version 1.2 loader

VXT Loader Requirements

To load the VXT Version 2.1 software image, you must use the VXT
Version 2.1 loader file.

To load the VXT EX software image, you must use the VXT Version 2.0
or 2.1 loader file.
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4. In the Secondary Boot box, choose the type of VXT software you want to
use. Click on the VXT Software button or the VXT EX button.

5. In the Version box, click on the Default button if you want to load the
default version of VXT or VXT EX software on your network.

Click on the Other button if you want to specify a VXT or VXT EX version
other than the default. The terminal displays the letters VXT or VXT EX
in front of the box. Enter the value for the version number (three digits for
Version 2.0 and Version 2.1, four digits for earlier versions).

Enter... To load this version...

VXT VXT EX

021 2.1 2.0

020 2.0 2.0

0130 1.3 –

0120 1.2 –

0110 1.1 –

0100 1.0 –

6. Click on the OK button to save your setting and dismiss the dialog box.

7. In the Terminal Manager window, click on the Session menu.

8. In the Session menu, click on the Reboot menu item to reboot the terminal.

The terminal loads the VXT loader file from the first available system.

Server-Based Customizations and Loading

If you have several InfoServer systems with VXT software, your
terminal always loads the VXT software from the first available
InfoServer system that has the same LASTport group code. However,
your terminal’s customized settings are always stored on a specific
InfoServer system; therefore, your terminal does not necessarily use
the same system to load software and store customizations.
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5.7.4 Customize Boot Dialog Box Description

To view or change your boot settings, choose Boot... from the Terminal
Manager window’s Customize menu. The Customize Boot dialog box looks like
this:

LJ−00176D−RAGS

From the Customize Boot dialog box, you can change the following settings:
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Primary Boot

Normally, the terminal alternates between using MOP and IP on attempts to
boot the VXT software image file (host-based mode) or VXT loader file (server-
based mode). To use IP only, click on the IP button. To use MOP only, click on
the MOP button.

MOP Boot File

If you use MOP, the MOP Boot File box lets you specify a host-based VXT
software image file (from a host or InfoServer system) or a VXT loader file.
The VXT loader file is for loading a server-based VXT software image.

Default By default, the terminal looks for the VXT loader file on an InfoServer
system or host. The terminal repeats this sequence using different versions of
the MOP protocol.

Host Preconfigured The terminal first looks for any host system using MOP
that has been preconfigured to load the terminal with VXT software. If it does
not find a host, the terminal looks for the VXT loader file on an InfoServer
system or host. The terminal repeats this sequence using different versions of
the MOP protocol.

VXT Software Version 2.1 Installation and System Management describes how
your system manager can add your terminal’s Ethernet address and the desired
host-based VXT software image file or VXT loader file to a system database.

If you use MOP: OpenVMS system managers use the Network Control Program
(NCP), and ULTRIX system managers use the addnode utility.

Other This setting lets you specify a host-based VXT software image file or
VXT loader file. The image or loader file can be on a host or InfoServer system.
Omit the .SYS file extension.

The file should be in a default MOP directory. For example:

• OpenVMS systems—Use VXT$LIBRARY or MOM$SYSTEM. To use
VXT$LIBRARY, the system manager must add it to the MOM$LOAD
search list. See the OpenVMS section in VXT Software Version 2.1

Installation and System Management.

• ULTRIX systems—Use /usr/lib/mop on the local subnet.

VXTLDR is the default name of the VXT loader file. If you enter the file name
VXTLDR, any MOP service with the load file can respond and supply the file to
the terminal. The VXT loader uses the LASTport Version 3.1 protocol to load
the system image specified in the Secondary Boot and Version fields.
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Typically, the terminal uses the VXT loader file from the InfoServer system
that supplies the VXT software image. However, if there is a bridge that
filters MOP requests between the terminal and InfoServer system, the system
manager should make sure the VXT loader file is available on a host system in
the same network segment as the terminal.

Secondary Boot

When you load a server-based VXT software image from an InfoServer system,
you use the Secondary Boot box to choose VXT software or VXT EX software.

Version You can use the default version of your Secondary Boot choice (VXT
Software or VXT EX) or specify a version in the Other box. If you specify a
version, make sure a VXT software image file with that name is available on
an InfoServer system.

Options: X Image Extension

VXT software images include an X image extension (XIE) capability that allows
server-based and host-based terminals to work with XIE software. The VXT
EX software image does not include XIE capability.

Normally, the terminal’s XIE capability is turned on. If you turn this feature
off and on, you must reboot the terminal before your new setting takes effect.
Appendix C describes how to use the terminal with XIE.

VXT 2000 terminals with a system box and 17-inch VX227 models without a
system box can use an optional image accelerator board to increase the speed
at which the terminal displays XIE bitonal images. However, you do not need
the image accelerator board to use the terminal’s XIE capability.

Reboot Options

The MOP protocol provides a trigger mechanism for rebooting a remote node.
If you enable the MOP trigger feature, your terminal can be rebooted from a
remote node.

Allow MOP Trigger Normally, the terminal ignores MOP trigger messages. To
enable MOP triggering, click on the Allow MOP Trigger button.

Trigger Password You can also supply a password to restrict rebooting from
a remote node. The MOP trigger password can be from 1 to 16 hexadecimal
characters (0–9 and A–F characters). If you do not supply a password, a
default value of 0 is used (equivalent to no password).

See your host system’s network control program (NCP) manual or online help
for more information on the syntax for triggering remote nodes.
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5.7.5 Entering Boot Commands to Load VXT Software

In addition to the Customize Boot dialog box, you can load VXT software from
the terminal’s >>> prompt.

Displaying the >>> Prompt

To display the >>> prompt, you must halt your terminal. There are two ways
to halt the terminal; you can use the keyboard, or you can use the halt button.

Caution

Halting the terminal closes any currently open sessions.

To display the >>> prompt from the keyboard:

Press Ctrl+left Alt+keypad . . The terminal ends all sessions and begins to
boot VXT software. Immediately press Ctrl C to halt the booting sequence and
display the >>> prompt.

To display the >>> prompt using the halt button:

Quickly press and release the halt button on the rear of the terminal. The
terminal halts all activity and displays a >>> prompt.

• For terminals with a system box: The halt button is next to the indicator
lights on the rear of the system box.

• For terminals without a system box: The halt button is below the keyboard
connector on the rear of the monitor.

Loading VXT Version 2.0 or 2.1 Software

To load VXT Version 2.0 or 2.1 software, enter the command sequence for
host-based or server-based operation.

To load... In this mode... Enter...

VXT Version
2.1

Host

>>> B/100 Return

Bootfile: VXT Return

Server

>>> B/101 Return

Bootfile: VXTLDR Return

VXTLDR> VXT.SYS or VXT021.SYS Return
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To load... In this mode... Enter...

VXT EX� Host

>>> B/100 Return

Bootfile: VXTEX or VXTEX020 Return

Server

>>> B/101 Return

Bootfile: VXTLDR Return

VXTLDR> VXTEX020.SYS Return

VXT Version
2.0

Host

>>> B/100 Return

Bootfile: VXT020 Return

Server

>>> B/101 Return

Bootfile: VXTLDR Return

VXTLDR> VXT020.SYS Return

�If you have VXT Version 2.1 software, you can omit the version number when specifying VXT EX
software.

Loading Earlier VXT Software Versions

Earlier versions of VXT software used separate software images to support
monochrome and color/gray scale terminals. Enter the command sequence for
host-based or server-based operation.

Host-Based Mode

>>> B/100 Return

Bootfile: host_image Return

Enter host_image... To load this image...

VXTMP00nn0 VXT host-based, monochrome image

VXTSP00nn0 VXT host-based, color or gray scale image

VXTMPI0nn0 VXT host-based, monochrome image with XIE support

VXTSPI0nn0 VXT host-based, color or gray scale image with XIE support

nn is the version number. For example, 12 is Version 1.2.
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Server-Based Mode

>>> B/101 Return

Bootfile: VXTLDR Return

VXTLDR> server_image Return

Enter server_image... To load this image...

VXTMV00nn0.SYS VXT server-based, monochrome image

VXTSV00nn0.SYS VXT server-based, color or gray scale image

nn is the version number. For example, 12 is Version 1.2.

5.8 Changing Your Software Options Settings

The Customize Software Options dialog box lets you turn certain VXT software
features on or off at startup. By default all options are turned on.

If you have a host-based terminal, you can conserve memory by selecting only
those options you need to use. You can monitor your terminal’s memory use
by checking the Memory Remaining scale in the System Monitor dialog box
(Section 6.5).

The following table lists the approximate memory saved for each option
unloaded.

If You Unload This Option... You Save This Much Memory (Kilobytes)...

DECterm 235 KB

Motif WM 617 KB

Terminal Manager 1422 KB

Print Screen 19 KB

Message Box 116 KB

Net Print 8 KB

3270 233 KB

X Image Extension 194 KB

Font Manager 37 KB

InfoReader 33 KB

Total 2914 KB
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If you try to use a disabled option, the VXT Message Box displays the following
message:

Software option is disabled.

To view or change your software option settings, choose the Startup submenu
from the Terminal Manager window’s Customize menu. Then choose Software
Options... to display the Customize Software Options dialog box:
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From the Customize Software Options dialog box, you can turn the following
options on or off as startup:

DECterm Terminal Windows

This setting affects your ability to create VXT DECterm windows.

Motif Window Manager

This setting affects your ability to use the terminal’s Motif window manager.
If you disable this option, you cannot restart the window manager using the
Create dialog box or any other method.
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Terminal Manager

This setting affects your ability to use the Terminal Manager window. This
setting also affects the VXT Message Box, unless you autostart the message
box as a separate application from the the Terminal Manager window.

Caution

The Software Options dialog box is part of the Terminal Manager
window. If you turn off the Terminal Manager window and reboot the
terminal, you cannot access the Software Option dialog box to enable
the Terminal Manager window again. See your system manager to
reenable the Terminal Manager window.

Print Screen

This setting affects your ability to use the Print Screen menu item in the VXT’s
Terminal Manager window.

Message Box

This setting affects your ability to use the VXT Message Box.

Network Printing

This setting affects your ability to print from a host system to a local printer
attached to the terminal. If this setting is disabled, you cannot use the Host
Accessible Printer Port setting in the Customize Serial and Parallel Ports
dialog box.

VXT 3270 Terminal Windows

This setting affects your ability to create VXT 3270 terminal windows. VXT
3270 terminal windows also require a separate software license and access to a
DECnet/SNA gateway.

X Image Extension

This setting affects the terminal’s ability to work with X image extension (XIE)
software (Appendix C). VXT EX software does not include XIE capability.

Font Manager

This setting affects your ability to use the Font Management dialog box for
server-based terminals, described in VXT Software Version 2.1 Installation and
System Management.

InfoReader

This setting affects your ability to display the InfoReader library of VXT
documentation from the Getting Started menu.
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5.9 Using Customized Resource Files

VXT software provides two methods for remotely managing terminal settings—
the configuration manager or your own host-based resource files. If you use
your own host-based resource files, you can create individual terminal resource
files and group resource files. You enter the network location of a terminal’s
individual and group resource file in the Customize Resource Files dialog box.

To display the Customize Resource Files dialog box, choose Resource Files...
from the Terminal Manager window’s Customize menu. VXT Software

Version 2.1 Installation and System Management describes the configuration
manager, resource files, and how to use the Customize Resource Files dialog
box.

You can use the TFTP or NFS transport to access your resource files on
the host. If you use NFS, you must first enter the NFS mount point in the
Customize NFS dialog box.
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6

This chapter describes how to monitor the operating status of your terminal
and of network communication. To monitor the terminal’s status, you use the
Status submenu accessed from the Session menu in the Terminal Manager
window. This chapter covers the following topics:

• Displaying the Status Submenu

• Checking a TCP/IP Host System

• TCP/IP Routes Dialog Box

• Displaying LAT and Ethernet Counters

• Monitoring the Terminal’s Memory and Network Use

• Checking the Terminal’s System Configuration
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6.1 Displaying the Status Submenu

To display the Status submenu, choose the Status menu item from the Session
menu in the Terminal Manager window.

VXT V2.1 Terminal Manager
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When you choose a menu item from the Status submenu, the terminal displays
a dialog box for that topic.

6.2 Checking a TCP/IP Host System

You can check if a TCP/IP host is available by using the TCP/IP Network Test
(ping) dialog box. You specify a host name or IP address and a timeout period
for the test. The terminal sends a ping (Packet InterNet Groper) packet once
every second for the time you enter in the Timeout box. If you are testing the
availability of a remote host on another network, you may want to increase the
timeout value.

To display the TCP/IP Network Test (ping) dialog box, choose TCP/IP Network
Test (ping)... from the Status submenu.
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To run the test:

1. Click on the Host Name or IP Address box and enter a host name or
address. Use the <x key if you make a mistake.

Examples

market
12.212.231.22

2. Click on the Test button. The terminal displays the status of the host on
the Status line:

• Host name or IP Address is alive

• No answer from Host name or IP Address

• Trying...

To change the timeout period for performing the test:

Click on the Timeout (seconds) box and enter a new timeout value from 1 to 99
seconds. Use the <x key if you make a mistake.

To dismiss the dialog box:

Click on the Close button.
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6.3 TCP/IP Routes Dialog Box

You can display a list of TCP/IP routes from your network to hosts on other
networks. To display the TCP/IP Routes dialog box, choose TCP/IP Routes...
from the Status menu.
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The dialog box lists routes from four sources:

• Static routes you enter in the Customize TCP/IP Routing Tables dialog box

• Interface routes added by interface initialization (NID startup)

• Internet control message protocol (ICMP) redirects

• Dynamic routes added by RIP packets (Normally dynamic routing is
enabled. See Section 4.7 to enable or disable.)

To enter your own routes into the TCP/IP Routes dialog box:

See Section 4.7.

To update the list:

Click on the Update Routes button. The terminal displays the current list of
static and dynamic routes.

To dismiss the dialog box:

Click on the Close button.
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6.4 Displaying LAT and Ethernet Counters

You can check the status of the terminal’s LAT and Ethernet counters.
Normally, the terminal updates the information in these dialog boxes every 5
seconds. You can set the update frequency time from 1 to 60 seconds, using the
Customize Terminal Manager dialog box (Section 3.10).

LAT Counters Dialog Box

To display the LAT Counters dialog box, choose LAT Counters... from the
Status submenu. Table 6–1 describes each counter.
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To set all counters to 0:

Click on the Zero Counters button. All counters in the list are set to 0.

To dismiss the dialog box:

Click on the Close button.

Table 6–1 LAT Counters Display Fields

Field Description

Seconds Since Zeroed The number of seconds since these counters were set to 0.

(continued on next page)
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Table 6–1 (Cont.) LAT Counters Display Fields

Field Description

Messages Received The number of LAT protocol messages successfully received
by the terminal.

Messages Transmitted The number of LAT protocol messages successfully
transmitted by the terminal.

Slots Received The number of LAT slots received by the terminal. A slot
represents a message segment for a particular LAT session.

Slots Transmitted The number of LAT slots transmitted by the terminal. A
slot represents a message segment for a particular LAT
session.

Bytes Received The number of data bytes received by the terminal over the
LAT protocol.

Bytes Transmitted The number of data bytes sent by the terminal over the LAT
protocol.

Duplicates Received The number of virtual circuit messages the terminal
received that were not in the correct sequence.

Messages Retransmitted The number of virtual circuit messages that the terminal
resent to remote nodes.

Illegal Messages The number of incorrectly formatted LAT messages the
terminal has received.

Illegal Slots The number of incorrectly formatted slots of data in a LAT
message that the terminal has received.

Virtual Circuit Timeouts The number of times that the terminal terminated a LAT
connection because the remote node did not respond within
the time allowed by the LAT protocol.

Protocol Errors The number of times that the terminal determined that the
LAT protocol has been violated by a remote node. See the
Protocol Error Mask field for more information.

Protocol Error Mask A bit mask providing information about the LAT protocol
errors detected by the terminal. The bits in the mask are
numbered from right to left, starting with bit 0 on the right.
The following bits are defined in the mask:

0 An unknown LAT message type was received.

1 An invalid LAT START message was received.

2 A zero-valued virtual circuit reference was
received.

(continued on next page)
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Table 6–1 (Cont.) LAT Counters Display Fields

Field Description

3 An out-of-range virtual circuit reference was
received.

4 A reference to a nonexistent virtual circuit was
received.

5 A reference to a virtual circuit no longer in use
was received.

6 An invalid LAT STOP message was received.

7 An invalid reference to a remote slot was received.

8 A reference to a nonexistent slot was received.

9 A credit violation was detected.

10 A repeated creation of a slot was detected.

11 An invalid sequence number was received.

12 A repeated disconnect of a slot was detected.

Ethernet Counters Dialog Box

To display the Ethernet Counters dialog box, choose Ethernet Counters... from
the Status submenu. Table 6–2 describes each counter.
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To set all counters to 0:

Click on the Zero Counters button. All counters in the list are set to 0.

To dismiss the dialog box:

Click on the Close button.

Table 6–2 Ethernet Counters Display Fields

Field Description

Seconds Since Zeroed The number of seconds since these counters were set to
0.

Bytes Received The number of bytes contained in datagrams successfully
received by the terminal, excluding Ethernet header and
CRC data.

Bytes Sent The number of bytes contained in datagrams successfully
sent by the terminal, excluding Ethernet header and
CRC data.

Frames Received The number of datagrams successfully received by the
terminal, including multicast frames.

Frames Sent The number of datagrams successfully sent by the
terminal, including multicast frames.

Multicast Bytes Received The number of bytes received by the terminal in
multicast frames, excluding Ethernet header and CRC
data.

Multicast Bytes Sent The number of bytes sent by the terminal in multicast
frames, excluding Ethernet header and CRC data.

Multicast Frames Received The number of multicast frames received by the
terminal.

Multicast Frames Sent The number of multicast frames sent by the terminal.

Frames Sent, Deferred The number of times that the terminal deferred a frame
transmission because the datalink was in use.

Frames Sent, 1 Collision The number of times the terminal sent a frame on the
second attempt after a collision occurred on the first
attempt.

Frames Sent, 2+ Collisions The number of times the terminal successfully sent
a frame after collisions during the first two or more
attempts.

(continued on next page)
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Table 6–2 (Cont.) Ethernet Counters Display Fields

Field Description

Send Failures The number of times the Ethernet interface aborted a
transmission request. If this count is not 0, see the Send
Failure Reasons field for more information.

Send Failure Reasons A bit mask providing information about the reason for
a send failure if the Send Failures counter is not 0.
The bits in the mask are numbered from right to left,
starting with bit 0 on the right. The following bits are
defined in the mask:

0 A transmission failed to complete after 16 retries,
usually due to excessive collisions.

1 A loss of carrier occurred on the Ethernet during a
transmission.

2 A short circuit occurred on the Ethernet during a
transmission.

3 An open circuit occurred on the Ethernet during a
transmission.

4 Heartbeat error.

5 Data underflow.

Receive Failures The number of frames received with an error condition.
For more information, see the Receive Failure Reasons
field.

Receive Failure Reasons A bit mask providing information about the type of
receive failures encountered if the Receive Failures
counter is not 0. The bits in the mask are numbered
from right to left, starting with bit 0 on the right. The
following bits are defined in the mask:

0 A block check error. The received frame did not
pass the cyclical redundancy check (CRC).

1 A framing error. The received packet did not
contain an integral number of 8-bit bytes.

Unrecognized Destination The number of frames received by the terminal that
did not contain a multicast address or protocol type
recognized by the terminal. These frames are discarded.

Data Overrun The number of times that the terminal’s hardware lost
an incoming frame because it was unable to keep up
with the data rate.

(continued on next page)
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Table 6–2 (Cont.) Ethernet Counters Display Fields

Field Description

User Buffer Unavailable Currently unused. Should always be 0.

System Buffer Unavailable The number of times that the terminal’s software did
not have a buffer available to receive an incoming frame
(MISS error).

6.5 Monitoring the Terminal’s Memory and Network Use

You can use the System Monitor dialog box to monitor the amount of local
memory available for use by the terminal. You can also monitor the percent of
the terminal’s network capacity currently being used. Normally, the terminal
updates this information every 5 seconds. You can set the update frequency
time from 1 to 60 seconds, using the Customize Terminal Manager dialog
box (Section 3.10). To display the System Monitor dialog box, choose System
Monitor from the Status submenu.
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Memory Remaining: Indicates how much of the local memory installed in
the terminal is currently available for use.

Network Utilization: Indicates what percent of the network capacity of the
terminal is currently being used.

Uptime: Indicates how long the terminal has been running since being booted.
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Pagefile Reads: Indicates the number of blocks of memory read by the
terminal since being booted.

Pagefile Writes: Indicates the number of blocks of memory written by the
terminal since being booted.

To dismiss the dialog box:

Click on the Close button.

6.6 Checking the Terminal’s System Configuration

You can use the System Configuration dialog box to check the terminal’s
software version, network addresses, work group, active font path, installed
options, and amount of installed memory.

To display the System Configuration dialog box, choose System Configuration...
from the Status submenu.

Monochrome Host Based VXT V2.1

System Configuration

VXT.SYS on server ROM

VXT Software:

System Image:

Pagefile:                                  N/A

Active Font Path: Local Fonts

Software Options: Terminal Manager, Message Box, Motif WM, DECterm, Print Screen,

X Image Extension, Net Print

Ethernet Hardware Address: 08−00−2B−25−3C−36

Ethernet Active Address: 08−00−2B−25−3C−36

IP Address: 16.122.123.122

DECnet Address: 55.123

Total Memory: 10 Megabytes

Hardware Options: None

Diagnostic Revision: V1.4

Terminal 08002B253C36 on server Local Terminals

Work Group Local on server Local Terminals

Resource files currently in use

Update Close
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Table 6–3 describes the System Configuration fields:
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Table 6–3 System Configuration Display Fields

Field Description

VXT Software: Lists the VXT software version and type:

{Monochrome, Color} {Host-Based, Server-Based} VXT Vn.n

A plus symbol (+) after the word Monochrome or Color indicates
the terminal has a VXT 2000+ video board installed.

System Image: Lists the system image name of the VXT software in use and
the name of the server supplying the software. The default
system image name for VXT Version 2.0 software is VXT or
VXT021.

For host-based software: the displayed server name is
always ROM, because VXT host-based software is loaded into
the terminal’s ROM memory and does not use an InfoServer for
memory services.

For server-based software: the server name is the name of
the InfoServer system from where the software was loaded.

If you have several InfoServer systems with VXT software on
your network, the terminal may use different servers to load
software, provide fonts, and store terminal and work group
customizations.

Pagefile: For server-based software: this field lists the name of the
InfoServer pagefile the terminal is using for memory paging
services. The pagefile resides on the InfoServer that loaded the
terminal’s VXT software.

If a pagefile has not been opened yet, this field displays No
Pagefile.

For host-based software: this field lists N/A for not
applicable.

(continued on next page)
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Table 6–3 (Cont.) System Configuration Display Fields

Field Description

Active Font Path: Lists the location of the fonts currently in use. Font path
elements are separated by commas. To change the font path,
use the Customize Font Path dialog box (Section 5.3). Font
path elements are listed in the order entered in the Customize
Font Path dialog box.

For host-based software: by default, the terminal uses the
Local Fonts set loaded with VXT software into the terminal’s
local memory.

Local Fonts

For server-based software: by default, the terminal uses the
Local Fonts set and the VXT fonts on an InfoServer. The font
path indicates the name of the InfoServer system supplying
fonts:

//lastport/server_name/VXT, Local Fonts

Software Options: Lists the VXT software options available for use. By default,
all options are available. You can turn options on and off in
the Customize Software Options dialog box (Section 5.8). Host-
based terminals can conserve memory by turning off unused
options.

Terminal Manager, Message Box, Motif WM, DECterm, Print Screen,
X Image Extension, Net Print, 3270, Font manager, InfoReader

Ethernet Hardware
Address:

Lists the terminal’s Ethernet physical address, set at the
factory.

Ethernet Active
Address:

If you use DECnet: this field lists the terminal’s global
network address, in the network service access point (NSAP)
format. DECnet derives this address from the Ethernet
hardware address.

If you use TCP/IP or LAT: this field lists the same address as
the Ethernet Address field.

IP Address Lists the terminal’s Internet protocol address, for communicat-
ing with systems that use the TCP/IP protocol. If you have not
entered an IP address in the Customize TCP/IP dialog box, this
field is empty.

(continued on next page)
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Table 6–3 (Cont.) System Configuration Display Fields

Field Description

DECnet Address Lists the terminal’s DECnet address, for communicating with
systems on a wide area network that use the DECnet protocol.
If you have not enabled the DECnet protocol and entered an
DECnet address in Customize DECnet dialog box, this field is
empty.

Total Memory: Lists the amount of memory installed in the terminal, from 4
megabytes to 18 megabytes.

Hardware Options: Lists any option boards installed in the terminal:

Image VXT image accelerator board

Diagnostic Revision: Lists the terminal’s ROM revision level.

Resource files
currently in use:

Lists the name and location of the terminal and work group
resource files that store the terminal’s customizations.

For host-based software: the terminal and work group
resource files are always listed on the Local Terminals server.

For server-based software: the terminal and work group
resource files reside on the same InfoServer system. This
system may be a different InfoServer system than the one that
loads the terminal’s VXT software.

The system manager may have new terminals join the
Unregistered Terminals work group.

To display updated information:

Click on the Update button. The terminal displays updates any information
that has changed since you opened the dialog box.

To dismiss the dialog box:

Click on the Close button.
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This chapter describes how to use VXT DECterm windows, also known as
terminal windows. The chapter covers the following major topics:

• The VXT DECterm Window

• Copying and Pasting Text

• Clearing or Resetting the Window

• Printing the DECterm Window

• Exiting from a VXT DECterm Window

7.1 The VXT DECterm Window

The VXT DECterm window is a VT300 series terminal emulator. You can open
several VXT DECterm windows on the screen and run different applications in
each window. You can use your mouse to move between windows.

Chapter 2 describes how to create a terminal window session on your host,
using the Create menu and dialog box. When you create the session, the
terminal displays a VXT DECterm window.

2

3

LJ−0163C−RAGS

Host Telnet VXT DECterm 1

 1

File     Edit     Commands      Options      Print
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Chapter 11 describes the basic features of windows. For VXT DECterm
windows:

! The window title uses the following format:

Transport VXT DECterm on Host n

Transport is the method used to connect to the host system —Telnet, LAT,
DECnet, or Serial. The Host system is identified by a host name, service
name, or IP address. VXT DECterm windows are numbered sequentially
(n) in the order you open them during a session. The name VXT DECterm
lets you distinguish the terminal’s DECterm windows from any remote
DECterm windows you create using a host system’s session manager. You
can change the title by choosing the Window... menu item from the Options
menu.

" The menu bar displays the names of the five pull-down menus available
from the window:

File Edit Commands Options Print

You can use your mouse or keyboard to display menus and choose menu
items. To display a menu from the keyboard, press the Alt key and the key
for the underlined letter in the menu name at the same time. After that,
you can use the arrow keys to navigate to different menu items and menus.
You choose a menu item the same way you choose a menu: Alt + underlined
letter.

# The work area is where you enter text and commands and interact with
host applications, similar to a video terminal screen. By default, the size of
this area is 24 lines by 80 columns. You can change the terminal size by
selecting the Window... menu item from the Options menu.

The Terminal Size setting in the Window Options dialog box should match
the host system’s row and page settings, to ensure the proper display of
applications such as editors and mail.

Window Colors

VXT DECterm windows use the same color scheme as other VXT windows. You
choose the colors in the Terminal Manager’s Customize Window Color dialog
box (Section 3.9). You can also use the Display Options dialog box in the VXT
DECterm window to choose dark text on a light background or light text on a
dark background (Section 8.4).
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7.2 Copying and Pasting Text

You can copy and paste text in a DECterm window. You can also copy text from
one window and paste the text into another window. To copy and paste text,
you use the DECterm window’s Edit menu. The Edit menu looks like this:
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From the Edit menu, you can perform the following functions:

Copy

Choosing this item places the currently selected text into the terminal’s copy
buffer. You can also use the Select All menu item to select the complete
window.

Paste

Choosing this item sends the contents of the terminal’s copy buffer to the
cursor location in the window as if it were typed on the keyboard.

Select All

Choosing this item places all of the window’s text into the terminal’s copy
buffer. You can also use the Copy menu item to place selected text from the
window into the copy buffer.

7.2.1 Host Synchronization Required

To prevent loss of data when the contents of the paste buffer is sent to the host,
set the host to send XON and XOFF synchronization characters as follows:

On a UNIX or ULTRIX system

% stty ixoff ixon

On an OpenVMS system

$ SET TERMINAL/HOSTSYNC
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7.2.2 Selecting Text to Copy

You can select a word, a line, or a block of text at a time. A block can be a
single character or any number of contiguous characters, up to the complete
window. You can also use the Select All menu item in the Edit menu to select
the complete window.

To select a block of text:

1. Point to the start of the block.

2. Press and hold MB1, then drag the pointer to the end of the block.

3. Release MB1 to indicate the end of the block. The selected text is
highlighted.

4. In the Edit menu, click on the Copy menu item.

To select a single word:

1. Point to the word.

2. Double click MB1 to select the word. The selected word is highlighted.

3. In the Edit menu, click on the Copy menu item.

To select a line of text:

1. Point to the line.

2. Triple click MB1 to select the line. The selected line is highlighted.

3. In the Edit menu, click on the Copy menu item.

7.2.3 Pasting Text

After you select text and store it in the copy buffer, you can paste the text to
the text cursor location in the same window or in a different window.

To paste text:

1. Place the text cursor where you want to copy the text.

2. Choose the Paste menu item from the Edit menu of the window that will
receive the copied text. The terminal copies the text to the cursor position.
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7.2.4 Using Quick Copy

The quick copy feature lets you paste text without storing it in the copy buffer
or using the Edit menu. There are two ways to perform a quick copy:

Method 1

1. Select the text as described in Section 7.2.2.

2. Place the text cursor where you want to paste the text.

3. Press and release MB2. If you accidentally move the mouse before
releasing MB2, method 2 is activated.

You can use this method to copy text from one window to another. Move the
input focus to the other window before clicking MB2. To paste into remote
DECterm windows, use MB3.

Method 2

1. Place the text cursor where you want to paste the text.

2. Point to the start of the text you want to copy.

3. Press and hold MB2. Drag the pointer to the end of the text to be copied.
Release MB2 to copy the selected text to the cursor position.

Copy and Paste Functions Disabled by Some Applications

If you are running an application that provides support for positioning its
pointer or cursor from the mouse, the copy and paste functions may not work.
See your application’s documentation.

7.2.5 Extending Your Selected Text

After you select an area of text to copy, you may decide that you wanted to
copy a larger area. Before you paste text, you can use the mouse or the arrow
keys to extend the area you have selected.

To extend your selection with the mouse:

1. After selecting text with MB1, move the mouse cursor to the position that
marks the boundary of the area you would like to have selected.

2. Press the Shift key and click MB1. This extends the initially selected area
up to the present position of your mouse cursor.

To extend your selection with the arrow keys:

After selecting text with MB1, press the Shift key and any arrow key to extend
your selected text in the direction of the arrow.
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7.3 Clearing or Resetting the Window

The Commands menu in a VXT DECterm window lets you clear, reset, or
resize the window. To display the Commands menu, click on Commands in the
VXT DECterm window’s menu bar. The Commands menu looks like this:

Host Telnet VXT DECterm 1

LJ−01182B−RAGS

From the Commands menu, you can perform the following functions:

Clear Lines Off Top

Choosing this item clears the information stored in the transcript. The
transcript is an area of memory that contains the last saved lines of your
screen display. You can read the transcript by using the scroll bars. The
transcript exists as long as the Record Lines Off Top option in the Display
dialog box is enabled. To change the size of the transcript, use the Display
Options dialog box from the Options menu.

Clear Display

Choosing this item clears the contents of the current window.

Resize Window

Choosing this item resizes the window to match the size (number of rows and
columns) of your DECterm terminal.

Clear Communications

Choosing this item performs the following actions:

• Cancels any print operation in progress.

• Cancels any escape sequence, control sequence, control string, or character
string processing in progress.

• Clears the keyboard buffer.

• Clears the receive buffer.
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Reset Terminal

Choosing this item sets several terminal operating features to their default
settings.

Resets... To...

Color map Default.

Cursor mode Visible.

Insert/replace mode Replace.

Origin mode Upper left of window, independent of margins.

Autowrap mode Off.

Keyboard action mode Unlocked.

Keypad mode Numeric.

Cursor key mode Normal.

Top margin Line 1.

Bottom margin The bottom line in the window.
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7.4 Using Options

The Options menu in a VXT DECterm window lets you customize the settings
for many VXT DECterm features–from window settings to printing. Chapter 8
describes the Options menu and how to use it.
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Host Telnet VXT DECterm 1

Note

Your VXT manager may choose to restrict your access to the Options
menu or certain menu items. In this case, the items are dimmed.

7.5 Printing the DECterm Window

You can print the contents of the DECterm window on a serial or parallel
printer connected to the rear of the terminal. See Section 4.2 to activate the
serial or parallel printer port. You can print all or part of the window. You can
print the window as text, sixel graphics, or PostScript if your printer supports
the format. To display the Print menu, click on Print in the DECterm window’s
menu bar. The Print menu looks like this:
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Host Telnet VXT DECterm 1

From the Print menu, you can perform the following functions:

Print Text Page

This option sends the contents of the page to the printer as text. The page
size is set by the Terminal Size option in the Window Options dialog box. You
can choose the Window Options dialog box from the Options menu in the VXT
DECterm window. The default size is 24 lines.

Print Selected Text

This option sends text you select on the screen to the printer.

Print All Text

This option sends the contents of the page and the transcript to the printer as
text. The transcript contains the lines that were saved after they were scrolled
off the top of the screen. You can control the number of lines saved.

Print Graphics

This option sends the contents of the page to the printer in text, PostScript, or
sixel format.

Finish Printing

This option stops the printing after the current contents of the buffer are
printed.

Cancel Printing

This option stops the printing immediately.
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7.6 Exiting from a VXT DECterm Window

There are two ways to exit from a VXT DECterm window:

• Log out from the window as you normally log out from your host system.

This action closes the window and stops all applications in the window.

• Click on the File menu in the Terminal Manager’s menu bar and choose
Exit.

This action closes the window, but may leave applications running.
Depending on your operating system, you may be able to create another
DECterm window and reconnect to the application.

Host Telnet VXT DECterm 1
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This chapter describes how to set many VXT DECterm window features to
suit your personal preference, by using the Options menu in a VXT DECterm
window. Initially, the features use factory-default settings that work with
many host systems. You can make changes to the settings and save them for
all future sessions.

The chapter covers the following major topics:

• Displaying the Options Menu

• Saving and Restoring VXT DECterm Option Settings

• Changing Your Window Settings

• Changing Your Display Settings

• Changing Your General Operating Features

• Changing Your Keyboard Features

• Choosing National Replacement Character Sets

• Changing Your Graphics Display Settings

• Changing Your Printer Settings
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8.1 Displaying the Options Menu

To display the Options menu, click on Options in the VXT DECterm window’s
menu bar. The Options menu looks like this:
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Host Telnet VXT DECterm 1

When you choose a menu item from the Options menu, the terminal displays
a dialog box with the feature settings for that topic. In dialog boxes, shaded
buttons indicate the current settings. You can examine the settings and change
them if desired. You can use the last three menu items to save your settings,
restore your last saved settings, or restore the system-default settings.

Note

A system manager can customize settings for terminals and work
groups. The system manager can also lock or unlock access to menu
items on the Options menu.
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8.2 Saving and Restoring VXT DECterm Option Settings

Initially, the terminal uses the system-default settings for each VXT DECterm
window you create. If you make changes to option settings and save them, the
terminal applies your saved settings to each new VXT DECterm window you
create. To make changes to VXT DECterm settings and save them:

1. Make your changes in a VXT DECterm Options dialog box, then click
on the OK or Apply button. The changes are applied to the current VXT
DECterm window.

2. Click on Save Options in the Options menu. The settings are saved for
future VXT DECterm windows.

Applying Changes in a Dialog Box

Each VXT DECterm Options dialog box has three push buttons for applying or
dismissing new settings in that box:

Click
on . . . To . . .

OK Apply new settings for the current session and dismiss the dialog box.

Apply Apply new settings for the current session without dismissing the dialog
box.

Cancel Dismiss the dialog box without changing any settings. If you made any
changes without applying them, clicking on the Cancel button cancels
those changes.

Some option settings do not take effect until you open a new VXT DECterm
window.

OK and Apply Do Not Save VXT DECterm Options

Note that the OK and Apply buttons work differently in VXT DECterm Options
dialog boxes than in the Terminal Manager window’s Customize dialog boxes.
In the Customize dialog boxes, the OK and Apply buttons save the feature
settings for future use.
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Saving or Restoring Option Settings

To save or restore settings for future sessions, choose from the following menu
items on the Options menu:

Choose . . . To . . .

Save Options Save your current option settings for use in all future
sessions.

Restore Options Recall the last option settings you saved with the Save
Options menu item. Choose the Restore Options menu item
if you want to reset any option settings that you changed
temporarily, but did not save. To see changes to specific
settings, display the dialog box for those settings.

Restore System Options Restore the terminal’s default option settings. To see
changes to specific settings, display the dialog box for
those settings.

If you have changed some settings and want to use or view the factory-default
settings for your VXT DECterm Option dialog boxes, click on Restore System
Options in the Options menu. If you saved some customized settings but decide
you want to return to the factory-default settings for future sessions, click on
Restore System Options and Save Options; remember that this clears the
customized settings you saved.

Applications May Customize Some Settings

Some application software that you use may also set certain window features.
Programmers can use control sequences in their applications to customize
most DECwindows features from the host system. This provides the individual
application with more control.

ReGIS and Sixel Graphics

VXT DECterm windows emulate the VT300 series terminal, so you can display
ReGIS and sixel graphics on the terminal. You can also use the remote
DECterm application available under a host session manager to display ReGIS
and sixel graphics.
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8.3 Changing Your Window Settings

You can use the Window Options dialog box to control the size of the VXT
DECterm window, by choosing the number of rows and columns displayed.
You can also control such features as the window title and the font size (big or
small) used to display characters. You can use an alternative font on your host
system or InfoServer system, if the font meets certain requirements.

Before your resize a VXT DECterm window in the Window Options dialog box,
you should understand how host system and window manager settings also
affect the window’s operation.

Factors Affecting the VXT DECterm Window Size

Three factors affect the display of a VXT DECterm window:

• The Terminal Size setting in the Window Options dialog box

• The host’s settings for the DECterm terminal size

• Any adjustments you make to the window size, using a local or remote
window manager (such as maximizing the window or using the window
border to stretch the window)

The normal Terminal Size in the Window Options dialog box is 24 rows by
80 columns. Keeping the Terminal Size matched with the host’s setting
ensures the proper display of applications such as editors and mail. If you
use unmatched settings, be aware that some application displays may be
affected.

If you change the Terminal Size, you can make the same adjustments on the
host. The commands for setting the DECterm window size on the host depend
on the operating system.

For example, on OpenVMS hosts you can enter the SHOW TERMINAL
command to check the Page and Width settings. These settings should match
the Terminal Size row and column settings. You can adjust the host settings
with the SET TERM/PAGE=n and SET TERM/WIDTH=n commands.

The Auto Resize Terminal feature in the Window Options dialog box
determines whether or not the Terminal Size automatically changes when
you adjust the window with a window manager. Normally this feature is off,
so the Terminal Size remains matched with the host’s settings. For example,
when you click on the window border and stretch the window, the number of
rows and columns within the window does not change.
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Using the Window Options Dialog Box

To view or change your VXT DECterm window settings, choose Window... from
the Options menu. The terminal displays the Window Options dialog box:
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From the Window Options dialog box, you can change the following features:
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Auto Resize Terminal

Normally, changing the window size does not change the number of rows
and columns displayed. If you click on Auto Resize Terminal, the terminal
automatically adjusts the number of display rows and columns when you or
your application software changes the window size.

Auto Resize Window

Normally, the terminal automatically resizes the window when the number of
rows and columns changes. You can turn this feature on or off by clicking on
Auto Resize Window. If you display a large number of rows and columns when
this feature is off, some information may be outside the window boundary.

Terminal Size

The default size of the VXT DECterm window is 24 rows and 80 columns. You
can choose from standard values or enter your own value:

• Standard values: Choose 24, 48, or 72 rows and 80 or 132 columns.

• Your own value: Click on the Rows box and enter a number from 1 to 99.
Click on the Columns box and enter a number from 9 to 254.

Normal Font, Condensed Font

Normally, the terminal displays characters in a font suitable for the display
width—a normal font for 80 columns, a condensed font for 132 columns. You
can also choose to use the normal font or condensed font at all times, by
clicking on the Normal Font (80 Columns) button or Condensed Font (132
Columns) button. The condensed font lets you display more characters in a
small window.

Window Title

You can choose a window title of up to 30 characters for each window you open.
The default title is

Host Transport VXT DECterm n

• Host is the host name, service name, or IP address of the host system.

• Transport is the method used to connect to the host system —Telnet, LAT,
DECnet, or Serial.

• n is the number of the window. VXT DECterm windows are numbered
sequentially in the order you open them during a session.

Programmers can change the title by using the following command:

<OSC>21;title_string<ST>
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If you change the title, the terminal stops numbering windows in the session.
The only way to restart numbering is to choose Restore Systems Options from
the Options menu. In doing so, all VXT DECterm settings are restored to their
system-default settings.

Icon Name

You can choose an icon name to identify each window you reduce to an icon.
This option works the same as the Window Title option.

Programmers can change the icon name with the following command:

<OSC>2L;icon_string<ST>

Big Font, Little Font, German Standard Font

You can display characters in a little font, big font, or German standard font.
Normally, the terminal displays characters in its little font, which is a 14-point
font (10-point font on 100 dots/inch monitors). The big font is an 18-point font.

As an alternative, you can specify a suitable font on your host system or
InfoServer system. In any case, you can display only one font in a window at a
time. You may use a different font in each VXT DECterm window.

To choose one of the terminal’s default fonts:

1. Click on the Big Font, Little Font, or German Standard Font button.

2. Click on the Default button next to the font you chose.

3. Click on OK or Apply to see the new font in the VXT DECterm window.

To save a font selection for future use:

Click on Save Options in the Options menu.

VXT 2000+/VXT 2000 Windowing Terminal User Information 145



Customizing VXT DECterm Windows
8.3 Changing Your Window Settings

8.3.1 Using Fonts on Your Host System or InfoServer

If you have suitable fonts on your host or InfoServer system, you can use those
fonts instead of the terminal’s fonts in your VXT DECterm windows. In each
VXT DECterm window, you can specify an alternative big font, little font, and
German standard font. You can specify fonts from different hosts or InfoServer
systems.

To use alternative fonts on a host or InfoServer system, you must specify a font
path and font name.

Note

VXT DECterm windows require specific fonts and sizes to run and
display properly. Most fonts do not meet these requirements. Problems
and error messages will occur if VXT DECterm cannot find the proper
fonts.

Step 1: Specify a Font Path

Use the Customize Font Path dialog box in the Terminal Manager window
(Section 5.3).

You can set only one font path at a time. You can change font paths while a
VXT DECterm window is running. Applications currently running continue to
use the old font path.

Step 2: Enter the Font Name in the Window Options Dialog Box

You can specify an alternative font for each of the standard font choices: big
font, little font, and German standard font. You can specify different fonts in
each VXT DECterm window you create. You can also change fonts while a VXT
DECterm window is displayed.

To save your font settings, click on Save Options in the Options menu. New
applications will use the new font. Applications currently running will continue
to use the same font.

1. Click on the Big Font, Little Font, or German Standard Font button.

2. Click on the Other button next to font you chose in step 1.

3. Clear the text in the box next to the Other button. Double-click on the box.
All text in the box is highlighted. Press the Remove key to erase all the
text.

4. Enter the name of your font in the box. See your system manager if you
need help.
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Use the following steps if your font is on an InfoServer system.

To use a font on an InfoServer system:

After you set the font path, you can use the terminal’s Configuration Manager:
Font Management dialog box to list the available fonts on your InfoServer
system. You can cut and paste the font name into the DECterm Window
Options dialog box.

1. In the Terminal Manager window, click on Customize in the menu bar to
display the Customize menu.

2. In the Customize menu, click on Configuration... to display the
Configuration submenu.

3. Click on the Font Management... menu item to display the Configuration
Manger: Font Management dialog box.

4. Click on the name of the font set you want. The font set name appears
highlighted in the scroll box.

5. Click on the List Contents... button to display the List Font Set Contents
box.

6. In the List Font Set Contents scroll box, find the font you want. Triple
click on the font.

7. Click on the DECterm Window Options dialog box. The input cursor should
be blinking in the Other box that you cleared. If not, click on the Other
box.

8. Click on MB2. The font name is copied to the Other box.

9. Click on Apply or OK. The terminal applies the new font to the VXT
DECterm window.
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8.4 Changing Your Display Settings

You can control display features such as the type of cursor, use of scroll bars,
and appearance of text (light or dark). You can also specify how many lines to
save when text is scrolled off the top of the window. To view or change your
display settings, choose Display... in the Options menu. The terminal displays
the Display Options dialog box:
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From the Display Options dialog box, you can change the following settings:

Record Lines Off Top

Normally, the terminal saves lines that are scrolled off the top of the VXT
DECterm window. To view these lines, use the vertical scroll bar. If you do not
want to save lines that are scrolled from the display, click on the Record Lines
Off Top button to turn it off. To specify the number of lines to save, use the
Record 100 Lines Off Top box in this display box.

Vertical Scroll Bar

Normally, the VXT DECterm window has a vertical scroll bar. To remove the
scroll bar, click on the Vertical Scroll Bar button to turn it off.
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Horizontal Scroll Bar

Normally, the VXT DECterm window does not have a horizontal scroll bar. To
add a horizontal scroll bar to the bottom of the window, click on the Horizontal
Scroll Bar button.

Vertical Cursor Coupling

Normally, the cursor automatically returns to the cursor position in the
DECterm window to display text when it comes from your host system. For
example, if you scroll back into transcript and output from the host occurs, the
cursor returns to display the output text. Click on the Vertical Cursor Coupling
button if you wish to turn vertical cursor coupling off.

Horizontal Cursor Coupling

Normally, the cursor does not return to display text from a host system if you
are scrolling horizontally. For example, if you scroll horizontally into transcript
and output from the host occurs, the cursor will not return to display the
output text. Click on the Horizontal Cursor Coupling button if you wish to
turn horizontal cursor coupling on.

Auto Wrap

Normally, text does not automatically wrap to the next line when the cursor
reaches the right margin in the window. To have text automatically wrap to
the next line, click on the Auto Wrap button.

Display Cursor

Normally, the terminal displays the text cursor, which is a block or underline
character. To turn the text cursor off, click on the Display Cursor button.

Cursor Blink

Normally, the text cursor blinks. To have the cursor appear steady, click on the
Cursor Blink button. The terminal manager also has a Cursor Blink feature,
in the Customize Keyboard dialog box. The two settings have no effect upon
each other.

Text and Window Background

VXT DECterm windows use the same color scheme as other VXT windows. You
choose the colors in the Terminal Manager’s Customize Window Color dialog
box (Section 3.9). To swap the text and background colors, you can use the
Dark Text, Light Background or Light Text, Dark Background buttons.

Status Display

If you want to display a host status line, click on the Host Status Display
button. The host status line is a line at the bottom of the window where your
host application software can display messages.
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Cursor Style

Normally, the terminal uses a solid block cursor to indicate the active position.
To use an underline character for the cursor, click on the Underline Cursor
button.

Batch Scroll 0 Lines

You can specify the speed at which the terminal displays text from your
host during scrolling. The slowest settings of 0 or 1 line display every line
during scrolling. Faster settings greater than 1 line cause multiple lines to be
displayed quickly from the host.

Record 100 Lines Off Top

Normally, the terminal saves up to 100 lines that are scrolled off the top of the
display. You can specify the number of lines to save (0 to 999) by using the
Record 500 Lines Off Top box. Increasing the number of lines saved increases
the terminal’s memory usage.

8.5 Changing Your General Operating Features

You can set general operating features to match your computing environment
and application software. For example, you choose which of the terminal’s
character sets to use. To view or change general operating settings, click on
General... in the Options menu. The terminal displays the General Options
dialog box:
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From the General Options dialog box, you can change the following settings:

Newline

Normally when you press the Return key, the cursor moves to a new line
because the terminal sends a carriage return (CR) character and a line feed
(LF) character. Similarly, when the terminal receives a line feed, form feed
(FF), or vertical tab (VT) character, the cursor moves to the first column of the
next line.
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If you click on the Newline button, pressing Return sends only a carriage
return, so the cursor does not move to a new line. When the terminal receives
a LF, FF, or VT character, the cursor moves to the current column of the next
line.

Lock UDKs

Your keyboard contains keys you can define for your own use (Chapter 15).
Normally, the host system can change the function of these user-defined keys
(UDKs). If you click on the Lock UDKs button, the host system cannot change
your definitions.

Lock User Features

There is a set of VXT DECterm option features that users often set to their
own preference, including the terminal size (in Window Options), text and
background color (in Display Options), and auto repeat feature for keys (in
Keyboard Options). Your host applications can override these option settings
unless you click on the Lock User Features button.

Local Echo

Normally, the terminal sends data entered at the keyboard to your host system,
which may send it back to the terminal for display after processing. This is
called a remote echo.

If you want to send keyboard data to both the host system and the terminal
(local echo), click on the Local Echo button.

Cursor Keys

Normally, the arrow keys move the cursor by sending standard ANSI cursor
control sequences. Clicking on the Application Cursor Keys button lets the
arrow keys send application-specific control sequences.

Keypad

Normally, numeric keypad keys send the character shown on the key (using
ASCII codes). If you click on the Application Keypad button, the numeric
keypad keys send control sequences used with some applications.

User-Preferred Supplemental Set (UPSS)

If you click on the 8-Bit Multinational Characters button in this dialog box, you
can choose one of two supplemental character sets to use—DEC Supplemental
or ISO Latin 1 Supplemental. Both character sets feature special characters
used in the major Western European languages. The ISO Latin-1 set includes
a few more characters that are not included in the DEC Supplemental set.

Normally, the terminal uses the UPSS DEC Supplemental set. Click on the
UPSS ISO Latin 1 button to use the UPSS ISO Latin 1 Supplemental set.
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8-Bit Multinational or 7-Bit NRCS Characters

You can select the type of characters the terminal uses, 8-bit multinational or
7-bit national replacement characters.

Normally, the terminal uses 8-bit multinational characters. This setting
supports most of today’s computing environments. There are two multinational
character sets available—the DEC Multinational character set and the ISO
Latin Alphabet No. 1 character set. Both sets consist of the ASCII character
set and their own supplemental set. To choose one of the multinational
character sets, you choose their supplemental set by using the UPSS buttons
in this dialog box.

Clicking on the 7-Bit NRCS Characters button lets the terminal use one
of several national replacement character sets. This setting is useful in
computing environments that are restricted to 7 bits. The 7-bit NRC character
sets are for the major Western European languages. When you choose this
setting, the terminal uses the NRC set that matches the current Keyboard
Type chosen in the Terminal Manager’s Customize Keyboard dialog box
(Section 3.3). You can also choose the individual NRC set by using the 7-Bit
NRCS Selection menu item from the Options menu.

VT Emulation Mode

The terminal can emulate the responses of VT300 series, VT200 series, VT100
series, or VT52 text terminals to text and control functions sent from the host
system. If you have application software developed for one of these terminals,
you can choose the appropriate operating mode to run that software.

Normally, the terminal uses VT300 7-bit controls. In 7-bit controls mode, the
terminal sends 7-bit controls and 8-bit character codes to the host. Use this
mode with VT300 and VT200 applications that use 7-bit control characters.

In 8-bit controls mode, the terminal can send 8-bit controls and 8-bit character
codes to the host. This mode supports VT300 and VT200 8-bit text applications.

In either VT300 mode, the terminal accepts both 7-bit and 8-bit controls from
the host.

VT100 mode lets the terminal run applications that require VT100
compatibility.

VT52 mode lets the terminal run VT52 applications.

Terminal ID

The terminal sends the host system a terminal identification (ID) message to
let the system know the terminal’s specific operating characteristics. You can
choose another terminal ID if needed. The terminal ID is also called the device
attributes response.
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Answerback Message

The terminal sends an answerback message to the host system when (1)
you press Ctrl F5 , or (2) the host requests the message by sending an ENQ
character. Host requests do not affect screen data or require a user response.
To enter an answerback message, click on the Answerback Message box. Your
message can have up to 30 characters.

Conceal Answerback Message

You can conceal your answerback message by clicking on the Conceal
Answerback Message button. Your answerback message is replaced with
the text <concealed> in the Answerback Message box.

If you conceal the message, you can never redisplay it. If you click on the
Answerback Message box, your concealed message is erased; you can enter a
new message and conceal it by clicking on the Conceal button.

8.6 Changing Your Keyboard Features

You can turn the keyboard’s warning bell and margin bell on and off. You can
also control the function of the <x , tilde, angle bracket, and comma keys to
suit your working environment. To view or change these and other keyboard
settings, choose the Keyboard... menu item from the Options menu. The
terminal displays the Keyboard Options dialog box:
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From the Keyboard Options dialog box, you can change any of the following
settings:

Warning Bell

Normally, a warning bell sounds whenever the terminal receives a bell (BEL)
character from the host system. To turn this feature off, click on the Warning
Bell button.

Margin Bell

The terminal can sound a bell when the cursor approaches the right margin.
Normally, the margin bell feature is turned off. To turn this feature on, click
on the Margin Bell button.

Tilde Key Sends

North American, British, and Dutch keyboards only: You can use the
tilde key ~ ` to send the escape (ESC) character for control sequences.
Normally, the tilde key sends an accent mark ( ` ) when unshifted and a
tilde ( ~ ) when shifted. To use the tilde key as an ESC key, choose the Tilde
Key Sends ESC button. To type an ESC character, press the tilde key twice.

Angle Brackets Key

North American, British, and Dutch keyboards only: If you use the tilde
key as an ESC key, you may want to use the < > key to send the accent mark
( ` ) and tilde ( ~ ) characters. If you click on the Angle Brackets Key Sends `~
button, the < > key sends the accent mark ( ` ) when unshifted and the tilde (
~ ) when shifted.

Auto Repeat

Most keys on the keyboard automatically repeat when you hold them down.
You can turn this feature off or on by clicking on the Auto Repeat button. The
Return and Help keys never autorepeat.

The Terminal Manager window’s Customize Keyboard dialog box also has an
Auto Repeat feature. The two settings do not affect each other. To disable
autorepeating in both the Terminal Manager and VXT DECterm windows,
disable both settings.

Ctrl-Q, Ctrl-S = Hold

Normally, pressing Ctrl S prevents data from the host appearing on the
screen. Pressing Ctrl Q allows data to display.

You can turn this feature off or on by clicking on the Ctrl-Q, Ctrl-S = Hold
button. If you turn the feature off, pressing Ctrl S or Ctrl Q have no effect on
the display of text.
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<x Delete / Backspace Key

Normally, pressing the <x key sends a delete (DEL) character to the host
application.

When you click on the <x Backspace button, the <x key sends a backspace
(BS) character.

Comma Key

North American, British, and Dutch keyboards only: Normally, the , <

key sends a comma whether shifted or unshifted, and the . > key sends a
period. If you want to use these keys to send angle brackets in the shifted
position, click on the Comma Key Sends ,< button.

8.7 Choosing National Replacement Character Sets

You can use 8-bit multinational character sets or 7-bit national replacement
character (NRC) sets with VXT DECterm windows. You should use the type of
character set that matches your computing environment. To choose the type of
character set, select the General... menu item from the Options menu.

When you choose to use 7-bit character sets, the terminal automatically uses
the NRC set that matches the current Keyboard Type chosen in the Terminal
Manager’s Customize Keyboard dialog box (Section 3.3). You can also choose
an NRC set by using the Options menu. Choose 7-Bit NRCS Selection... to
display the 7-Bit NRCS Selection Options dialog box:
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The scroll box lists the available NRC sets. To choose an NRC set for the
current window, click on a set in the scroll box. Then click on the OK button.

8.8 Changing Your Graphics Display Settings

You can control some features that affect the display of graphics, such as color
map entries. To view or change the graphic settings used with VXT DECterm
windows, choose Graphics... from the Options menu. The terminal displays the
Graphics Options dialog box:
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From the Graphics Options dialog box, you can change the following settings:

Share Color Map Entries

Normally, color map entries are shared. This prevents the VXT DECterm
window from allocating color map entries for its exclusive use. Instead,
DECterm allocates shared, read-only colors out of a default color map. This
means that DECterm does not need to create a private color map, which would
prevent the windows from displaying in their true colors. However, it also
means that DECterm colors may not match the colors used on a VT terminal.

Enable Backing Store

The backing store feature enables the terminal to redisplay DECterm graphics
after they are covered by another window or iconified. The Customize X Server
dialog box in the Terminal Manager window also has a Backing Store button
(Section 5.4).

Report Macrograph Contents

The VXT DECterm window does not respond to a request by an application to
report macrograph contents. Clicking on this option enables ReGIS commands
to report macrograph contents. When reporting is complete, disable this
feature to reduce any security risks.
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Number of Bit Planes

The number of bit planes supported by your system determines the number of
colors available for ReGIS and sixel graphics. With 2-bit planes, the DECterm
emulator can display four different colors at the same time. With 4-bit planes,
the DECterm emulator can display 16 colors.

The DECterm emulator uses 2-bit planes on 4-plane systems; it uses 4-bit
planes on all other systems. This reduces the probability that the DECterm
emulator must create a private color map. You can choose the number of
colors available in ReGIS and sixel graphics by entering the number of planes
supported by your system.

8.9 Changing Your Printer Settings

You can control print settings used with VXT DECterm windows, such as
what area of the window to print. To view or change printer settings, choose
Printer... from the Options menu. The terminal displays the Printer Options
dialog box:
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From the Printer Options dialog box, you can change the following settings:

Form Feed Terminator

Normally, the terminal sends a form feed (FF) character to the printer port
at the end of any printing operation started from the VXT DECterm window’s
Print menu.
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Printer to Host

If you use a serial input device connected to the terminal’s serial port, the
terminal can accept input data from the device and send the data to the host
application. By default, the serial port does not work as a printer port, so the
Printer to Host button is dimmed. To use the serial port to receive data, change
the Port Usage setting to Serial Port: Printer (Section 4.2). Then choose the
Printer to Host button.

Graphics Printing

Normally the terminal supports graphics printing operations in addition to text
printing.

Printing Modes

You can choose from three printing modes:

• Normal Print Mode

• Auto Print Mode

• Printer Controller Mode

Normal Print Mode

Normally, you can send all or part of the text displayed in a window to a local
printer. To print the window’s text, press the F2 (Print) key.

Auto Print Mode

Auto print mode immediately sends each line of text received from the host
system to your local printer. The terminal sends the current display line to
the printer when the cursor moves to the next line after a line feed, form feed,
vertical tab, or autowrap.

To turn auto print mode on or off, press Alt A . You return to normal print
mode when you leave auto print mode.

You can perform normal printing functions in auto print mode.

Print Controller Mode

Printer controller mode lets a host system send text directly to the local printer,
without displaying the text in the VXT DECterm window. You cannot select
this mode from the keyboard. Applications select this mode by using VT320
programming functions.

The F2 (Print) key does not work in printer controller mode.
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Printing All or Part of the Window

You can print all or part of the VXT DECterm window. You can also choose to
print selected characters. To print the window’s text, press the F2 (Print) key.
You can choose from the following options.

Print Full Page

Normally when you print a VXT DECterm window, the terminal sends the text
in the main display to the printer.

Print Full Page + Transcript

This option prints the text in the transcript (the lines saved off the top of the
scrolling region), followed by the text in the main display. You can specify the
number of lines saved by using the Display Options dialog box.

Print Scroll Region Only

This option prints the text in the scrolling region of the main display.

Print Selection Only

This option prints text that you have selected in the main display.

Matching Your Printer’s Capabilities

You can print from character sets that match the capability of your printer.

Print National Characters Only

This option prints national replacement characters (NRC) only. Other
characters are converted to the corresponding national characters, if any;
otherwise they are not sent.

Print National + Line Drawing

This option prints national replacement characters and line-drawing
characters.

Print All Characters

This option prints all characters, including multinational and technical
characters.
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This chapter describes how to create and use VXT 3270 windows. The chapter
covers the following major topics:

• VXT 3270 Windows

• Before You Start

• Creating a VXT 3270 Session

• Entering 3270 TE Connection Parameters

• Using the VXT 3270 Window

9.1 VXT 3270 Windows

VXT 3270 windows emulate IBM graphic display terminals. The windows let
you access application programs on an IBM Systems Network Architecture
(SNA) host system through a DECnet/SNA gateway. You can have several VXT
3270 windows displayed at the same time, running different applications. You
can use your mouse to move between windows.

All VXT 3270 terminal emulation tasks are performed by the VXT 2000
windowing terminal, significantly decreasing the load on the host system and
on the network.

VXT 3270 windows provide functions similar to the following IBM terminal
models:

IBM 3178
IBM 3179–G and 3192–G
IBM 3180 models 1–5
IBM 3270
IBM 3270–S3G
IBM 3278 models 1–5
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IBM 3279–S3G

Common features supported by the VXT 3270 include

• Active and passive connects

• Protected and unprotected fields

• Alphanumeric and numeric data

• Audible alarm

• Intensified display, normal display, and nondisplay characters

• Alphanumeric cursor (block cursor)

9.2 Before You Start

Before you create a VXT 3270 window, you need the following:

A VXT 3270 software license

A DECnet address for your terminal, displayed in the Terminal Manager
window (Section 4.9)

A DECnet name server address entered in the DECnet Name Translator
dialog box (Section 4.10)

A gateway name to enter in the Connection Parameters dialog box

An access name to enter in the Connection Parameters dialog box

9.3 Creating a VXT 3270 Session

To create a VXT 3270 session:

1. Display the Create dialog box (Section 2.2.1).

a. In the Application box, click on the 3270 button.

b. In the Transport box, click on the DECnet button.

c. In the Host Name or Address box, enter the name or address of the
DECnet host to use for the connection.

d. Click on the " button to save your settings in the Preferred Services
list.

e. Click on Start to start the session.

2. Enter connection information in the 3270 TE Enter Connection Parameters
dialog box (Section 9.4).
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9.4 Entering 3270 TE Connection Parameters

When you create a VXT 3270 session from the Create dialog box, the terminal
displays a Connection Parameters dialog box for establishing a connection with
an IBM host:
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To connect to an IBM host, you need to specify a gateway name and one of the
following:

• An access name

• A PU name and the Wait button

• A PU name and an application name

For example:

1. Click on the Gateway box and enter your gateway name.

2. Click on the Access Name box and enter your access name.
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3. Click on the Save button to save your connection parameters for future
sessions.

4. Click on the OK button to establish connection with your host.

5. A login box appears. Log in to your host system.

From the Connection Parameters dialog box, you can enter the following
settings:

Gateway
Identifies the name of the DECnet node that is defined as the host node for the
gateway.

Example: MARKET

Access Name
Identifies the name of the entry in the gateway access name table to use when
connecting to the SNA network. Access names are set up on the host DECnet
node for the gateway. The name can be 1 to 16 characters from the set of A to
Z, 0 to 9, period (.), dollar sign ($), at sign (@), and pound sign (#).

Example: PAYROLL

An access name can provide values for the following parameters:

Application name
Data
Logon mode
PU
Session address

If you specify these parameters with the Access Name parameter, they override
any existing values in the access name table you specified.

PU Name
Identifies the name of a particular physical link from the gateway to the IBM
host. Ask the gateway manager for the appropriate PU value.

Example: SNA-1

Session Address
Identifies the IBM session address used to communicate with the IBM host.
The gateway manager receives this value from the IBM systems programmer.
The value is defined by the LOCADDR operand on the ACF/NCP LU macro or
the VTAM LU macro.

The address is a decimal number from 0 to 255. You can specify 0 to let the
gateway select the next available session address.
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Example: 42

Application Name
Identifies the IBM application that will be the primary logical unit (PLU). The
gateway manager receives this value from the IBM VTAM programmer. The
value is defined in the VTAM APPL statement. The application name can be 1
to 8 characters from the set of A to Z, 0 to 9, period (.), dollar sign ($), at sign
(@), and pound sign (#).

Example: CICS

Logon Mode
Identifies the name of an entry in the logon mode table defined by the host
IBM system. This entry specifies a selected set of SNA protocol parameters.
The gateway manager receives this value from the IBM VTAM programmer.
The value is defined in the VTAM MODEENT macro. The Logon Mode entry
can be 1 to 8 characters from the set of A to Z, 0 to 9, period (.), dollar sign ($),
at sign (@), and pound sign (#).

Example: T3279M3

Data
Identifies user data to send to the IBM system as part of the logon request.
The data can be a string of up to 110 ASCII characters.

Some IBM subsystems use values for the Data parameter at VXT 3270 window
startup time to speed the logon process.

Example: JOE

Authorization Password
Allows access to secured logical units (LUs). Ask your gateway manager for
the value of an authorization password if you need to specify this parameter.
It is relevant only if your version of the DECnet/SNA gateway or VMS/SNA
Gateway supports LU security. The value can be 1 to 32 characters from the
set of A to Z, 0 to 9, period (.), dollar sign ($), at sign (@), and pound sign (#).

Example: 645312

Terminal Type
Identifies the IBM display station to emulate. The value can be 3192G
(default), 3279S3G, or 3270.

If you specify 3270, the VXT 3270 window emulates a generic 3270 display
station. Graphics will not be displayed, and a smaller font and window size
may be used. Use 3270 to emulate an IBM Model 4 (43�80 window) terminal
or an IBM Model 5 (27�132 window) terminal.
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Example: 3192G

[No]Wait
Causes the VXT 3270 window to wait for an IBM application (PLU) to initiate
a session. Nowait is the default. The Unformatted Systems Services (USS)
window may appear when the session is established, depending on the version
of the gateway or VMS/SNA gateway you are using.

Wait does not have a value as the other parameters do. If you use the Wait
parameter, you cannot specify values for the following parameters:

Application Name
Data
Logon Mode

9.5 Using the VXT 3270 Window

After you establish a session establish a session with the IBM host, the
terminal displays a VXT 3270 TE dialog box. The dialog box provides the
work area for your session. This section describes how to use the work area to
perform different tasks. The section covers the following major topics:

• Using the VXT 3270 Window Work Area

• Entering Data

• Editing Data

• Printing Text

• Copying and Pasting Text

• Recording and Playing Back Key Sequences

• Using the Numeric Keypad to Enter Numbers

• Saving Current Settings

• Viewing Your Connection Parameters

• Using the MB3 Pop-Up Menu

Chapter 11 describes the basic features of windows and how to use menus.
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9.5.1 Using the VXT 3270 Window Work Area

The VXT 3270 work area has two sections — the display area and the operator
information area.
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9.5.2 Working in the Display Area

The display area is where you perform most application-related duties, such as
entering data and receiving output. The following sections explain some of the
characteristics of the display area.

The window

The VXT 3270 window lets you display different window sizes, which are
controlled by the IBM host.

The VXT 3270 window can be unformatted or formatted. An unformatted
window has no fields. How you enter data in an unformatted window depends
on the application program you are using. Your IBM application program
user’s guide gives you instructions for using an unformatted window.

A formatted window contains two types of fields:

• Protected fields prompt you for required data. You cannot alter or add
to the text in a protected field. If you try to enter data in a protected field,
the keyboard locks, the terminal bell rings, and the word Inhib appears on
the status line. To free the keyboard, press Reset.

• Unprotected fields are the spaces where you can enter data. When
displaying a formatted window, the program normally places the cursor
under the first empty position in an unprotected field. You can enter data
until the field is full or use the Tab function to move to the start of the next
unprotected field.

The Cursor

The cursor in the display area can take three forms:

• The default text cursor is a blinking block. You can use the CrBlnk
(Cursor Blinking) parameter to select a nonblinking cursor. See
Section 10.2 to use VXT 3270 parameters.

• The selector mouse cursor is a small hand with a pointing finger that
appears when you use the Selector Mouse function (Section 10.1.4).

• A small cross cursor appears for certain graphics applications.
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9.5.3 Understanding Operator Information

The operator information area displays status indicators that let you monitor
the current status of your session. Table 9–1 lists possible status indicators.

Table 9–1 Status Indicators

Status
Indicator Meaning

Appl You are in a session with an application program (an LU–LU session).

Ext You are using the Ext function.

Insert You are in insert mode.

Inhib The software suspended input from your keyboard. This occurs when

You try to enter data in a protected field

You enter the wrong type of data in a field

The VXT 3270 window is communicating with the IBM software after
you press a key such as Enter

O You are using the numeric lock override function. This indicator is turned
off when you press the NumOvr function again.

P You are in play mode. A key sequence is being recalled by the Play
function.

Print The contents of your window are being copied to the printer you specified
at startup. The indicator remains displayed until the process is complete.
The window is refreshed when the process is complete.

R You are in record mode. A key sequence is being recorded.

SSCP You are in a session with the IBM control program (an SSCP–LU session).

SysAvl You are successfully communicating with the IBM system and can initiate
transmission. SysAvl turns off while the VXT 3270 window transmits data
to the IBM host.

Wait The IBM system is not available for input.

9.5.4 Entering Data

Unformatted windows

If your IBM application displays an unformatted window, use the FM key to
separate entries. Your application guide explains how and when to use this
key.
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Improper use of some keys causes the keyboard to lock in order to prevent
input to protected fields. If the keyboard locks, the Inhib status indicator
appears and you cannot use any keys to enter data. Use the Reset function to
unlock the keyboard and continue entering data.

Formatted windows

When the IBM application displays a formatted window, enter and edit data
in the unprotected fields only. After you fill an unprotected field with data,
the application may move the cursor to the start of the next protected or
unprotected field. You can also move the cursor by using the arrow keys or the
Tab, BckTab, Home, and Newlin functions (Section 10.2).

9.5.5 Editing Data

You can edit data in unprotected fields by typing new data over the old data
(normal mode) or inserting new data into partially filled fields (insert mode).
You can also use the Delete, ErEof, ErInp, and RubOut functions to change the
contents of unprotected fields (Section 10.2).

Using Normal Mode

Normal mode lets you enter new data or edit existing data. When you enter
data, the character you type either fills in an empty position or replaces a
character previously displayed in that position. The cursor then moves to the
next position. Remember that a space or a blank is a character.

Using Insert Mode

Insert mode lets you enter new characters between existing characters in an
unprotected field.

Use the Insert function to activate insert mode. Place the cursor under the
character where you want to insert text. When you insert text, characters
starting from the cursor position move right.

You can insert characters in an unprotected field until it is full. If you try to
insert text after the field is full, the keyboard locks, and Inhib is displayed
on the Status line. Use the Reset function to exit insert mode and return
to normal mode. Insert mode is also ended by any Enter, Clear, PA, or PF
function.

Note

Some fields that appear to have room for more data may contain one or
more trailing blank characters that cause the field to fill.
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9.5.6 Printing Text

The VXT 3270 Print... function lets you print text from the VXT 3270 window
to a printer connected to the terminal’s printer port.

To Print from the File Menu

To print the contents of an application window, pull down the File Menu and
choose Print. The VXT 3270 window send the text from the active window to
the terminal’s printer.

9.5.7 Copying and Pasting Text

You can copy and paste text in a VXT 3270 window. You can also copy text
from one window and paste the text into another window. To copy and paste
text, you use the VXT 3270 window’s Edit menu.

From the Edit menu, you can perform the following functions:

Copy

Choosing this item places the currently selected text into the terminal’s copy
buffer. You can also use the Select All menu item to select the complete
window.

Paste

Choosing this item sends the contents of the terminal’s copy buffer to the
cursor location in the window as if it were typed on the keyboard.

Select All

Choosing this item places all of the window’s text into the terminal’s copy
buffer. You can also use the Copy menu item to place selected text from the
window into the copy buffer.

9.5.8 Selecting Text to Copy

You can select text a word, a line, or a block at a time. A block can be a single
character or any number of contiguous characters, up to the complete window.
You can also use the Select All menu item in the Edit menu to select the
complete window.

To select a block of text:

1. Point to the start of the block.

2. Press and hold MB1, then drag the pointer to the end of the block.

3. Release MB1 to indicate the end of the block. The selected text is
highlighted.

4. In the Edit menu, click on the Copy menu item.

VXT 2000+/VXT 2000 Windowing Terminal User Information 171



Using VXT 3270 Windows
9.5 Using the VXT 3270 Window

To select a single word:

1. Point to the word.

2. Double click MB1 to select the word. The selected word is highlighted.

3. In the Edit menu, click on the Copy menu item.

To select a line of text:

1. Point to the line.

2. Triple click MB1 to select the line. The selected line is highlighted.

3. In the Edit menu, click on the Copy menu item.

9.5.9 Pasting Text

After you select text and store it in the copy buffer, you can paste the text to
the text cursor location in the same window or in a different window.

To paste text:

1. Place the text cursor where you want to copy the text.

2. Choose the Paste menu item from the Edit menu of the window that will
receive the copied text. The terminal copies the text to the cursor position.

9.5.10 Using Quick Copy

The quick copy feature lets you paste text without storing it in the copy buffer
or using the Edit menu. There are two ways to perform a quick copy:

Method 1

1. Select the text as described in Section 9.5.8.

2. Place the text cursor where you want to paste the text.

3. Press and release MB2. If you accidentally move the mouse before
releasing MB2, method 2 is activated.

You can use this method to copy text from one window to another. Move the
input focus to the other window before clicking MB2. To paste into remote
DECterm windows, use MB3.

Method 2

1. Place the text cursor where you want to paste the text.

2. Point to the start of the text you want to copy.

3. Press and hold MB2. Drag the pointer to the end of the text to be copied.
Release MB2 to copy the selected text to the cursor position.
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9.5.11 Extending Your Selected Text

After you select an area of text to copy, you may decide that you wanted to
copy a larger area. Before you paste text, you can use the mouse or the arrow
keys to extend the area you have selected.

To extend your selection with the mouse:

1. After selecting text with MB1, move the mouse cursor to the position that
marks the boundary of the area you would like to have selected.

2. Press the Shift key and click MB1. This extends the initially selected area
up to the present position of your mouse cursor.

To extend your selection with the arrow keys:

After selecting text with MB1, press the Shift key and any arrow key to extend
your selected text in the direction of the arrow.

9.5.12 Copying and Pasting With the Keyboard Only

If your mouse is not operating, you can use the keyboard to copy and paste
text. Table 9–2 lists the keys to use.

Table 9–2 Keyboard Copy and Paste Keys

Press... To...

Select Define the starting point for selected text.

Shift Select Select the range between the starting point and the current
cursor position. This sequence also deselects any previous
selection.

Shift F8 Toggle between add mode and normal mode. The default
mode is normal.

Shift ", #, ! ,  Extend the current selection.

Ctrl / Select all.

Ctrl \ Deselect all.

F14 Paste.

Ctrl Insert Here Do a clipboard copy.

Shift Insert Here Do a clipboard paste.
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9.5.13 Recording and Playing Back Key Sequences

You can save frequently used text and commands, then recall them when
needed. The VXT 3270 lets you record up to 127 keystrokes on a PF key, then
play them back using the Playback... function.

Recording Key Sequences

To record a key sequence:

1. Pull down the Commands menu and choose Record... to display the Record
dialog box.
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2. Click on the PF key that you want to store your key sequence.

3. Click on OK. The window displays an R in the operator information area,
and a message box pops up requesting the key sequence.

4. Click on OK to dismiss the message box.

5. Enter the key sequence you want to save.

6. To record your keystrokes, pull down the Commands menu and choose
Record... again. Click on OK.
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Canceling a Key Sequence While Recording

You can cancel a key recording in progress at any time up until you choose
Record Key a second time. To cancel a recording in progress:

1. Pull down the Commands menu and choose Cancel Recording. The Cancel
Recording dialog box appears.

2. Click on Yes to cancel the Record function.

Viewing Recorded Key Sequences

To view currently recorded keystrokes:

1. Pull down the View menu and choose Recorded Key Sequences. The
Recorded Key Sequences dialog box appears.

2. Click on the PF key that contains the keystrokes you want to see. The key
sequence appears. Items enclosed in angle brackets are function keys.

3. Click on the Dismiss button to close the dialog box.

Playing Back Recorded Key Sequences

Before playing back a recorded key sequence, be sure your cursor is at the
right place on the application window. If your cursor was in a specific field
when you recorded a sequence of text and commands, you must be in the same
field for the playback sequence to work properly. To play back a recorded key
sequence:

1. Pull down the Commands menu and choose Playback... to see which PF
keys have key sequences. The VXT 3270 displays the Playback dialog box.

2. Click on the PF key that stores the keystrokes you want to play back.
Then click on OK. The letter P appears in the operator information area
while the VXT 3270 plays back the key sequence you have chosen.

9.5.14 Using the Numeric Keypad to Enter Numbers

When you use a VXT 3270 window, the numeric keypad keys have default
functions assigned. If you want to use the keypad to enter numbers, pull down
the Options menu and select Numeric Keypad. This menu selection is a toggle
that lets you switch back and forth between entering numbers and functions.

The toggle indicator next to the Numeric Keypad selection is darkened when
the keypad’s numeric values are in effect.
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9.5.15 Saving Current Settings

To save your current settings, choose Save Current Settings from the Options
pull-down menu.

When you save the current settings, the terminal saves the settings in your
terminal’s resource file for future sessions.

9.5.16 Viewing Settings

The following sections describe how to view

• Keyboard layout maps

• Function list

• Connection parameters

• Field attributes

9.5.17 Viewing Keyboard Layout Maps

Supported Keyboards

The VXT 3270 supports key function definitions and keyboard layout maps for
the LK401 keyboard. By default, the VXT 3270 functions map to the LK401-
style keyboard, and the LK401 layout is the default keyboard map. This
section explains how to enable key function definitions and access keyboard
layout maps.

Interpreting Keyboard Layout Maps

The left half of the layout map lists function keys and their functions.

• A shaded key means you press the Ext key then the character key. The Ext
key is the period key on the numeric keypad.

• The caret (^) symbol in front of a key means you must press the Ctrl key
along with that key to access the associated function.

The top and right area of the layout map shows the functions assigned to
keypad keys. For shaded functions, press the Ext key first.

Viewing Your Keyboard Layout Map

To view the keyboard layout map for your LK401 keyboard, pull down the View
menu and choose Key Definitions.
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9.5.18 Viewing the Function List

Many of the VXT 3270’s keys have default function definitions. Section 10.2
provides detailed explanations of VXT 3270 functions and their default
mappings. You can redefine these functions so that they more closely match
your particular needs. To see how VXT 3270 functions are mapped, you can
check the VXT 3270 Function List.

To view the Function List, pull down the View menu and choose the Function
List menu item. The 3270 TE Function List dialog box appears. The Function
List dialog box displays how functions map to the keys on your keyboard.

If you change any key definitions during a session, those changes are
automatically reflected in the function list when you click on the Update
button.

The Dismiss button closes the dialog box.

9.5.19 Viewing Your Connection Parameters

You can check current connection parameters at any time by pulling down the
View menu and choosing Connection Parameters. The Connection Parameters
dialog box appears, showing the parameters as they are currently set. Click on
Dismiss when you finish viewing the parameters.

9.5.20 Viewing Field Attributes

Field attributes are characters that appear at the start of a field to indicate
how the field displays on the window: at normal intensity, at high intensity, or
invisibly. You can display field attributes three ways:

• Choose the Field Attributes menu item from the View menu.

• Choose the View Attributes menu item from the MB3 pop-up menu.

• Define a key to enable or disable the DspAtt function.

Table 9–3 describes the attribute characters.
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Table 9–3 Field Attributes

Field Attribute Meaning

n Unprotected field with normal intensity

N Protected field with normal intensity

d Unprotected field, detectable with a light pen

D Protected field, detectable with a light pen

h Unprotected field with high intensity

H Protected field with high intensity

i Unprotected nondisplay field

I Protected nondisplay field

To remove the field attributes from your window, display the MB3 pop-up menu
again. The View Attributes selection has a toggle indicator next to it, showing
that field attributes are turned on. Choose View Attributes again to turn them
off.

9.5.21 Using the MB3 Pop-Up Menu

The MB3 pop-up menu provides you with quick access to certain functions also
found on pull-down menus. Table 9–4 lists the MB3 pop-up menu items and
their corresponding location on the main menus:

Table 9–4 Quick Access to Functions: MB3 Pop-Up Menu

MB3 Pop-Up Menu Main Menu

Key Definitions View menu

View Attributes View menu

Numeric Keypad Options menu

Print File menu

Record... Commands menu

Playback... Commands menu

Cancel Recording Commands menu
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9.5.22 Exiting from a VXT 3270 Window

To exit the VXT 3270 window, pull down the File menu and choose Exit. You
can also press Ctrl Z to exit your session.
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This chapter describes how to customize VXT 3270 windows and use keyboard
functions. The chapter covers the following major topics:

• Customizing the VXT 3270 Window

• Using VXT 3270 Keyboard Functions

• Translation Table

10.1 Customizing the VXT 3270 Window

The VXT 3270 window lets you define keys and customize certain display
features such as the font size and window title. You can also set the mouse to
perform certain light pen functions. This section describes the following topics:

• Customizing Key Definitions

• Saving and Loading Custom Key Definitions

• Modifying VXT 3270 Window Options

• Using the Selector Mouse Function

10.1.1 Customizing Key Definitions

When you use a VXT 3270 window, certain keys perform specific IBM 3270
functions. You can customize key definitions to suit your needs. This section
describes how to assign and delete custom key definitions.
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Assigning Custom Key Definitions

To assign your own key definitions, pull down the Options menu and choose
the Define Key... menu item. The Define Key dialog box looks like this:
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This figure shows an example of the Dup function being assigned to the Ctrl Y

key sequence.

To Assign a Key Definitions

1. In the Key Name list box, click on the key you want to define. To define Ctrl

key or extend+key sequences, click on the Extend or Control option button
first.
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2. The Function or Character box contains a list of functions (left) and
characters (right). Click on the name of the function or character that
you want to assign to the key you just selected. Click on Apply to assign
the function or character to the key.

3. Repeat this procedure to create as many custom key definitions as you
want.

4. Click on OK to dismiss the dialog box.

Your new key definitions remain in effect for the current session. to create a
permanent file of your key definitions, choose the Save Key Definitions... menu
item from the File menu.

Deleting Custom Key Definitions

To delete custom key definitions:

1. Pull down the Options menu and choose Delete Key... to display the Delete
Key dialog box.

2. Click on the key whose function you want to delete. Click on the Extend or
Control button if you are deleting a Ctrl key or extend+key function.

3. Click on Apply to delete the key definition.

4. Repeat this procedure for each key function you want to delete.

5. Click on OK to dismiss the dialog box.

10.1.2 Saving and Loading Custom Key Definitions

You can save your customized key definitions for future sessions. The terminal
loads your saved key definitions when you start a new VXT 3270 window or
choose the Last Saved Key Definitions menu item from the File menu. You can
also return to the default key definitions at any time.

Saving Key Definitions

To save your customized key definitions:

From the VXT 3270 window, pull down the File menu and choose the Save
Key Definitions menu item. Your customized key definitions are saved in the
terminal’s resource file.

Loading Customized or Default Key Definitions

You can recall the last set of key definitions you saved whenever you need
them. You can also recall the system-default key definitions when needed. For
example, you may want to use the default key definitions for some tasks, then
switch to your customized definitions for other tasks.
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To load customized or default key definitions:

1. In the VXT 3270 dialog box, pull down the File menu and choose Load Key
Definitions.

2. To use customized keys, choose Last Saved Key Definitions.

To use system-default keys, choose Default Key Definitions.

If the definitions cannot be loaded, the session continues with the previous
definitions still in use.

10.1.3 Modifying VXT 3270 Window Options

The Window Options dialog box lets you change the font size used in
application windows. You can also change the window title and icon name
of the VXT 3270 dialog box.

To view the Window Options dialog box, pull down the Options menu and
choose the Window... menu item. The Window Options dialog box looks like
this:
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If you are running in 3270 emulation mode, you can change any of the settings
listed in the dialog box. You cannot change the font height in 3279S3G or
3192G emulation mode.

To change the font height or width:

Click on the button in the Font Height or Font Width box to display a pop-up
menu of choices.

To change the Window Title or Icon Name:

Click on the Window Title or Icon Name box and enter your text.

To apply your changes, click on Apply.

VXT 2000+/VXT 2000 Windowing Terminal User Information 183



Customizing VXT 3270 Windows
10.1 Customizing the VXT 3270 Window

To apply your choices and dismiss the dialog box, click on OK.

10.1.4 Using the Selector Mouse Function

The Selector Mouse function lets you use your mouse to perform selection and
attention operations provided by a selector light pen. When you use Selector
Mouse, the mouse pointer appears as a small hand with a pointing finger.

To use the Selector Mouse function, pull down the Options menu and choose
Selector Mouse. This menu selection is a toggle switch that lets you go back
and forth between Selector Mouse and normal mouse operation. A toggle
indicator appears next to the Selector Mouse selection when it is in use.

Note

You cannot access the MB3 pop-up menu within the display area while
you are using the Selector Mouse function. To access the MB3 pop-up
menu, move the mouse pointer to the operator information area.

10.2 Using VXT 3270 Keyboard Functions

This section describes available VXT 3270 keyboard functions and the
default keys that perform these functions. To customize key functions, see
Section 10.1.

The VXT Terminal Manager’s Customize Keyboard dialog box contains a
Keyboard Type scroll box. The Keyboard Type setting has no effect on the key
definitions used in the VXT 3270 window.

Table 10–1 lists default key functions on the standard LK401 ANSI keyboard.

Table 10–1 VXT 3270 Window — Default Key Functions

Function Default Key or Key Combination

Attn F19 or Ext+ A

BckTab F12 or Ctrl H

Clear Ext+ F20 or Ext+ Enter

CrBlnk F17

Ext = the period key on the numeric keypad.
KP = keypad.

(continued on next page)
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Table 10–1 (Cont.) VXT 3270 Window — Default Key Functions

Function Default Key or Key Combination

Defkey Ctrl K

Delete Next Screen

DspAtt Ext+ F17 or Ctrl V

DUP Ext+ F12 or Ext+ *

DvCncl Ext+ Remove

Enter Do or Enter

ErEof F18

ErInp Ext+ F18 or Ext+KP -

Exit F10 or Ctrl Z

Ext KP .

FM Ext+ F13 or Ext+ ;

Help Help or Ext+ H

Home F13 or Ext+ B

Horizontal Control  and !
Insert Ext+ PF4

Logical NOT Ext+ N

Logical OR Ext+ O

Newlin Return or Ctrl M

NumOvr Remove or Ext+ J

PA1 PF4

PA2 KP -

PA3 KP ,

PF1 PF1

PF2 PF2

PF3 PF3

PF4 KP 7

PF5 KP 8

PF6 KP 9

Ext = the period key on the numeric keypad.
KP = keypad.

(continued on next page)
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Table 10–1 (Cont.) VXT 3270 Window — Default Key Functions

Function Default Key or Key Combination

PF7 KP 4

PF8 KP 5

PF9 KP 6

PF10 KP 1

PF11 KP 2

PF12 KP 3

PF13 Ext+ PF1

PF14 Ext+ PF2

PF15 Ext+ PF3

PF16 Ext+KP 7

PF17 Ext+KP 8

PF18 Ext+KP 9

PF19 Ext+KP 4

PF20 Ext+KP 5

PF21 Ext+KP 6

PF22 Ext+KP 1

PF23 Ext+KP 2

PF24 Ext+KP 3

Play Insert Here

Print F11 or Ext+ P

Record Ext+ Insert Here

Reset KP 0

RubOut <x

Save Ext+ V

Select Ext+ Select

SelTab Prev Screen

SysReq Ext+ F19

Tab Tab

Ext = the period key on the numeric keypad.
KP = keypad.

(continued on next page)
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Table 10–1 (Cont.) VXT 3270 Window — Default Key Functions

Function Default Key or Key Combination

Vertical Control # and "
Warp Ext+ w

Ext = the period key on the numeric keypad.
KP = keypad.

If the Keyboard Is Locked

Improper use of some keys causes the keyboard to lock. For example, if you try
to enter data in a protected field, the keyboard may lock. If the keyboard locks,
the status indicator Inhib appears, and you cannot use any keys to enter data.
Use the Reset function to unlock the keyboard and resume using it.

If you need additional information about the VXT 3270 window key functions,
refer to these IBM documents:

• IBM 3270 Information Display System

• IBM 3270 Information Display System: Operator’s Guide

• IBM 3270 Information Display System: 3278 Display Station Operator’s

Guide

• IBM 3179-G/3192-G Color Graphics Display Station Description

10.2.1 Key Functions Defined

Attn

The Attn function requests the attention of the IBM application program
that you are running. Attn sends an SNA SIGNAL command to the IBM
application. See your application’s user guide to determine the program’s
response.

BckTab

The BckTab function moves the cursor backward.

In a formatted window, the cursor moves to the beginning of the unprotected
field it is in or to the beginning of the preceding unprotected field. If the cursor
is in the first position of the first unprotected field, the cursor moves to the first
position of the last unprotected field in the window.

In an unformatted window, the cursor returns to the first position on the
window.
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Clear

The Clear function clears the window contents and moves the cursor to the
first position in the window. When you use Clear, the software notifies the
application that this function is being used.

Crblnk

The CrBlnk function lets you turn cursor blinking on and off. By default, the
cursor blinks.

Defkey

The Defkey function lets you define keys during an active session. When you
use Defkey, the terminal displays the Define Key dialog box.

Delete

The Delete function deletes the character at the cursor position. The cursor
remains where it is, and characters to the right of the cursor in the same field
move one position to the left. The end of the field fills with null characters.

DspAtt

The DspAtt (display attributes) function turns visible attribute mode on and
off. You use this mode of operation to display the field attribute characters at
the beginning of fields (Table 9–3).

DUP

The DUP (duplicate) function lets you enter the same value in the same field
on different forms without having to repeat the entry for each form. After
entering the value in the first form, use DUP when you come to the same field
on other forms. The application fills these fields with the same value. See your
application’s user guide for details on using the DUP function.

When you use the DUP function, the window displays an asterisk (�).
DvCncl

The DvCncl (device cancel) function lets you cancel a Record function at any
point.

Enter

The Enter function sends the data you type to the application running on
the IBM host. While data is being sent, the keyboard locks and the window
displays the Inhib status indicator Inhib. Usually, the application releases the
keyboard after it finishes processing your data.

ErEof

The ErEof (erase to end of field) function erases the contents of the current
field, from the cursor to the end of the field. The cursor remains in the same
location.
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ErInp

In formatted windows, the ErInp (erase input) function clears all data in
unprotected fields and moves the cursor to the first position in the first
unprotected field.

In unformatted windows, ErInp clear all data and moves the cursor to the first
position in the window.

You can use Record + ErInp to remove all recorded key sequences.

Exit

The Exit function exits the VXT 3270 window. Communications with the IBM
host ends, including any data exchange in progress.

Ext

The Ext (extended function) key lets you access the second function of another
key. You press Ext, then press the other key. The Ext key is the period key on
the numeric keypad.

When you press Ext, the window displays the Ext status indicator.

Note

If you press Ext accidentally, you can press Reset to cancel its effect.

FM

The FM (field mark) function marks the end of a field on an unformatted
window or the end of part of an unprotected field on a formatted window. See
your application’s user guide for specific uses.

When you use FM, your window displays a semicolon (;).

Help

The Help function displays your current keyboard layout. This function is
identical to the Keyboard Layout selection on the View menu.

Home

The Home function repositions the cursor to the first position in the first
unprotected field on the window.
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Left and Right Arrow Keys

The  and ! keys let you move the cursor to the left or right without
changing data you have already entered.

If you use the ! key when the cursor is at the end of a line, the cursor
automatically moves down to the start of the next line.

If you use the  key when the cursor is at the beginning of a line, the cursor
automatically moves up to the end of the previous line.

Insert

The Insert function enables Insert mode, which lets you edit data by
entering new characters between existing characters in an unprotected field
(Section 9.5.4). When you use Insert, the window displays the Insert status
indicator.

Use Reset to return your window to Normal mode. Using any Clear, Enter, PA,
or PF function also returns your window to Normal mode.

If the keyboard locks when you try to insert characters into a field that looks
empty, there may be trailing spaces in that field. Use the ErEof function to
erase these spaces.

Logical NOT

The use of the Logical NOT function is controlled by the IBM application.

Logical OR

The vertical bar (j) represents the IBM symbol for a Logical OR. The use of the
Logical OR is controlled by the IBM application.

Newlin

The Newlin (new line) function moves the cursor to the first unprotected
position on the next line of your window. If there are no unprotected fields on
the window, the cursor moves to the first location in the window. If the window
has no fields, the cursor moves to the beginning of the next line.

NumOvr

The NumOvr (numeric lock override) function is a toggle switch that lets you
enter nonnumeric characters into numeric fields. When you use NumOvr, the
window displays the O status indicator.

PA1 to PA3

The program access keys PA1 to PA3 are defined by the application you are
using. These keys request attention from the IBM application without sending
any data. See your application’s user guide for the function of these keys.
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PF1 to PF24

The program function keys PF1 to PF24 are defined by the application you
are using. They request attention from the application and send the data
entered to the host. The PF keys are coded by the application to perform
related application functions. See your application’s user guide for PF key
assignments.

Play

The Play function lets you recall text and commands that you stored in a PF
key by using the Record function. To recall a sequence, press the Play key
followed by the PF key that stores the sequence. The Play function executes
any commands included in the sequence.

When you use the Play function, the window displays the P status indicator.

Print

Use Print to send the contents of your window to the terminal’s printer. For
more information, see Section 9.5.6. When you use Print, the window displays
the Print status indicator.

Record

Use Record to store a keystroke sequence in a specific PF key. Press Record,
choose a PF key, enter the keystroke sequence, then press Record again.
You can save a up to 127 keystrokes on a PF key. When you use the Record
function, the window displays the R status indicator R.

You cannot record the following functions as a part of your keystroke sequence:

• Defkey

• DvCncl

• Play

• Record

• Save

• SysReq

To recall the keystroke sequence, use the Play function.

To cancel a Record function in progress, use the DvCncl function.

To erase all previously recorded sequences, use Record + ErInp.

You can also record keystrokes by using the Record Keys selection from the
MB3 pop-up menu (Section 9.5.13).
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Reset

Use Reset to return your keyboard to Normal mode after using Insert mode.
Also,

You can also use Reset to unlock the keyboard if you tried to enter data into a
protected or a full field, or you tried to enter the wrong type of data into a field.

Reset removes the Inhib status indicator. The cursor remains where it is and
the window remains unchanged.

RubOut

The RubOut function erases the character to the left of the cursor and moves
the cursor to that position.

Save

The Save function lets you save any key definitions you have redefined during
a session.

Select

The Select function lets you choose items from a menu, table, or list, then
notify the application of your selection. Use the vertical and horizontal control
keys to place the cursor on the field designator character, then use Select. See
the appropriate IBM manual for more information.

SelTab

The SelTab function repositions the cursor to the first character position of the
next select-key detectable field (protected or unprotected) with a designator
character. SelTab works the same as the IBM Selectable Field Tab key. See
the appropriate IBM manual for more information.

SysReq

The SysReq (System Request) function lets you shift between the application
program (LU-LU session) and the control program (SSCP-LU session). When
you are in an LU–LU session, the window displays the Appl indicator. When
you are in the SSCP–LU session, the window displays an SSCP indicator. The
window in your LU-LU session is refreshed when you return to it by using
SysReq.

Tab

The Tab function moves the cursor to the first character location of the next
unprotected field on your window. If the window has no fields, Tab moves the
cursor to the first location on the window.

If you press Tab when the cursor is within the last unprotected field in the
window, the cursor moves to the first position of the first unprotected field on
the window.
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Up and Down Arrow Keys

The " and # keys let you move the cursor up or down on your window
without altering data already entered.

If you use the " key when the cursor is at the top of the window, the cursor
moves to the same column at the bottom of the window.

If you use the # key when the cursor is at the bottom of the window, the
cursor moves to the same column at the top of the window.

Warp

By default, the VXT 3270 supports warping. When using certain applications,
the mouse pointer shifts (or warps) to a new position on the window. You can
use the Warp function to turn warping on or off.

10.3 Translation Table

The VXT 3270’s built-in translation table contains a modified version of
the ISO-Latin character set, meant mainly for use in North America. The
ISO-Latin to Extended Binary Coded Decimal Interchange Code (EBCDIC)
table translates the ISO-Latin characters you generate to the EBCDIC
characters that your IBM application uses. The EBCDIC to ISO-Latin table
then translates the EBCDIC characters generated by the IBM application back
into the appropriate ISO-Latin characters.

The following figure shows the left and right halves of the 8-bit code table for
the modified ISO-Latin character set. To determine the hexadecimal code for
the character you want, locate the character and then combine the number
or letter in its row with the number or letter in its column. For example, the
letter A is represented by the hexadecimal code 41.
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11

This chapter describes how to use windows, menus, dialog boxes, and window
icons on your terminal.

The chapter covers the following major topics:

• Using the Mouse

• Working with Windows

• The Window Menu

• Choosing Items from Pull-Down Menus

• Supplying Information in Dialog Boxes

• Using Scroll Bars

11.1 Using the Mouse

When you work with windowing applications, you use your mouse to perform
many operations—from making menu selections to manipulating windows on
the screen. Your mouse lets you move quickly through windowing applications.
When you roll the mouse across your mouse pad, you move the pointer on
the screen. If you run out of space on the pad, you can pick up and move the
mouse without moving the pointer.

The mouse has three buttons:

MB1 (mouse button 1) on the left
MB2 in the middle
MB3 on the right
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This button arrangement normally suits right-handed users. If you are left-
handed, you can reverse the position of MB1 and MB3 by changing the Button

Arrangement setting in the Customize Pointer dialog box (Chapter 3).

MB3

MB2

MB1

LJ-01641-TI0

You can perform six basic actions with the mouse.

Point Move the mouse across the mouse pad until the pointer is where you
want the next action to occur.

Click Quickly press and release MB1. You should hear and feel a faint
click.

Press Point to a menu name, scroll bar, or other action item that you want
to perform. Without moving the mouse, press and hold MB1.

Drag Point to an object, such as a window outline. Press and hold MB1
(or MB2), move the pointer to drag the object, then release MB1.

Double click Point to an object and click MB1 twice in quick succession.

Shift click Point to an object. Press and hold the Shift key and click MB1. Then
release the Shift key.

You will get a chance to practice these movements when you open your first
session.

Using the Keyboard Instead of the Mouse

If you prefer, you can use your keyboard to navigate through windows, display
menus, and make selections from menus and dialog boxes. See Section 15.5 for
a list of keyboard commands.
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11.1.1 Pointer Shapes

Usually the pointer is an arrow, but you can choose a different shape. (See
Section 3.5.) The pointer also changes shape when you perform certain actions,
to reflect the type of action or state of the action. For example, the pointer
may become an hourglass or a wristwatch to indicate a working action is in
progress.

Pointing

Working

Moving

ZK−3573A−GE

11.2 Working with Windows

This section describes the basic techniques for manipulating windows:

• What Are Windows?

• Selecting the Active Window

• Moving Windows

• Changing the Size of Windows

• Reducing Windows to Icons

• Raising and Lowering Stacked Windows

You can also perform many of these functions from the window menu. See
Section 11.3.

11.2.1 What Are Windows?

A window is an area on your screen that represents all or part of an
application. You can use windows to view several applications at once. You can
move windows on the screen, organizing information for easier use. The VXT
DECterm window is one of several windows available on your terminal.
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! The window menu button displays a window menu that lets you perform
common window management functions.

" The window title identifies the function of a window. For a main window,
it usually contains the name of the application. For a dialog box, it may
also contain specific information about the use of the window.

# The title bar includes the window title and is used for moving the window
on the screen.

$ The minimize button lets you shrink a window to an icon. An icon is a
small graphic representation of the window.

% The maximize button is a toggle button that lets you enlarge a window to
its maximum size or return it to its normal size.

& The menu bar contains pull-down menus for the application’s commands.
You can display the menus and choose menu items.

' The scroll bar at the right allows you to view text or graphics that do not
fit in the window.

( The resize border surrounds an application window and lets you resize
the application’s window.

) The window frame includes the resize border and title bar.

+> The work area displays the application’s text and graphics.

+? The matte is an optional decorative border between the window frame and
the work area.
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11.2.2 Selecting the Active Window

The terminal lets you open several windows on the screen. When you have
several windows open at one time, you give input focus to a window by
selecting it. Only one window can have input focus at a time. Input focus
activates the window, allowing you to enter information in the window from
your keyboard or mouse.

To select a window:

1. Point to any location in the window or its title bar.

2. Click MB1.

The window’s title bar and frame is highlighted to indicate it has input focus.
Any text you type appears in this window, if your application allows text entry.
When you select another window, the first window’s title bar and frame is no
longer highlighted.

Host Telnet VXT DECterm 1Host Telnet VXT DECterm 1

Host Telnet VXT DECterm 1

Window With Input Focus

Window Without Input Focus

Options PrintFile Edit Commands

Options PrintFile Edit Commands

LJ−01221C−RAGS

Optional Method: You can also set the terminal to make a window active
simply by moving the pointer into the window. See Section 12.3.

11.2.3 Moving Windows

When you display several windows, they may overlap one another on the
screen. You can rearrange the windows to make them visible.
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Host Telnet VXT DECterm 1

Options PrintFile Edit Commands
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Title Bar

To move a window by the title bar:

1. Point to the window’s title bar.

2. Press and hold MB1. The pointer changes to a cross, and an outline of the
window is displayed.

3. While holding MB1, drag the outline to the new location.

4. Release MB1. The window moves to the new location.

11.2.4 Changing the Size of Windows

You can make windows larger, to display more information. You can also make
windows smaller, so you can view more applications.

There are three ways to change the size of your windows.

• Window frame

• Maximize button

• Window menu

To use the window menu, see Section 11.3.

Host Telnet VXT DECterm 1

Options PrintFile Edit Commands

Window Frame Maximize Button
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To make a window larger or smaller:

1. Point to a location on the window’s frame. Depending on the location
chosen, the pointer changes to a resize cursor.
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ZK−3572A−GE

2. Press and hold MB1. An outline of the window is displayed.

3. While holding MB1, drag the window outline to make the window the size
you want. You can move vertically, horizontally, or diagonally to change
one or both dimensions of the window in any direction. The window outline
changes size as you move.

4. Release MB1. The size of the window changes to the outline size.

To maximize the size of a window:

You can enlarge a window to cover the entire screen by using the maximize
button.

1. Point to the window’s maximize button.

2. Click MB1. The window expands to fill the entire screen.

Pressing the maximize button again returns the window to its normal size.

11.2.5 Reducing Windows to Icons

You can reduce a window to an icon by using the minimize button. Minimizing
a window frees up space on your screen to run other applications. The
application represented by the icon continues to run in memory and remains
easily accessible.

Host Telnet VXT DECterm 1

Options PrintFile Edit Commands

Minimize Button
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To reduce a window to an icon:

1. Point to the window’s minimize button.

2. Click MB1. The window closes, and its icon is displayed at the lower right
of the screen.
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To restore a window from an icon:

1. Point to the icon on the screen.

2. Double click MB1. The window is restored at the position where it was
minimized.

To rearrange icons in the lower-right portion of the screen:

1. Point to the icon.

2. Press and hold MB1. A moving pointer and outline is displayed.

3. While holding MB1, drag the icon to the new location. The outline follows
the moving pointer, showing where the icon will be repositioned.

4. Release MB1. The icon moves to the new location.

11.2.6 Raising and Lowering Stacked Windows

When windows overlap, you can view partially concealed windows by changing
their stacking order rather than moving windows around on the screen.

You can raise a window to the top of the stack by clicking on any visible portion
of the lower window. Clicking on the window also gives it input focus.

You can also lower the top window to the bottom of the stack by using the
window menu.

11.3 The Window Menu

The window menu provides another method for performing window
management commands, such as sizing, moving, and stacking windows.
To display the window menu, click on the window menu button at the left
corner of the title bar.

You can also display the window menu by clicking on MB3 in the window
border.
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Window Menu Button

Host Telnet VXT DECterm 1

Options Print

Move

Size

Minimize

Maximize

Lower

Workspace

Close

Alt+F8

Alt+F7

Alt+F9

Alt+F10

Alt+F3

Alt+F4
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From the window menu, you can choose the following menu items. Some items
may not apply to a particular window.

Restore

To restore a window from an icon:

1. Point to the window’s icon at the lower right of the screen.

2. Click MB1. The window menu is displayed.

3. Choose the Restore menu item. The window is restored at the position
where it was minimized.

Move

When you choose the Move menu item, a moving pointer and outline of the
window is displayed. To move the window:

1. Move the window outline to the new location.

2. Click MB1. The window moves to the new location.

Size

When you choose the Size menu item, a moving pointer and window outline
are displayed. To resize the window:

1. Move the pointer vertically, horizontally, or diagonally until the window
outline is the desired size.

2. Click MB1. The window size changes to the new size.

Minimize

When you choose the Minimize menu item, the window closes and its icon
appears at the lower right of the screen.
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Maximize

When you choose the Maximize menu item, the window expands to fill the
entire screen.

Lower

When you choose the Lower menu item, you lower the top window to the
bottom of the stack.

Workspace

The Workspace menu item provides access to a submenu with more choices for
stacking windows and icons. See Section 11.3.1.

Close

When you choose the Close menu item, the window closes.

11.3.1 Using the Workspace Submenu

The workspace submenu lets you control the stacking order of your windows
and icons. You can also access the Options submenu to customize window
features. After you customize features, you can save your settings by restarting
the window manager from the workspace submenu.

To view the workspace submenu:

1. Click on the window menu button to display the window menu.

2. Click on the Workspace menu item to display the workspace submenu.

Host Telnet VXT DECterm 1

LJ−01125B−RAGS

204 Chapter 11



Using Windows
11.3 The Window Menu

You can also display this menu as a pop-up menu, by clicking on MB1 (for left-
handed buttons) or MB3 (for right-handed buttons) in the screen background.

From the workspace submenu you can choose any of the following menu items:

Shuffle Up

The Shuffle Up menu item lets you move the bottom window to the top of the
stack, giving that window input focus.

Shuffle Down

The Shuffle Down menu item lets you move the top window to the bottom of
the stack.

Shuffle Up and Shuffle Down are useful for uncovering small windows that are
completely concealed by larger windows.

Next Window

The Next Window menu item gives input focus to the next window in the stack.

Previous Window

The Previous Window menu item gives input focus to the previous window in
the stack.

Pack Icons

The Pack Icons menu item lets you stack the icons in order at the lower right
of the screen.

Options

The Options menu item lets you display a submenu with items for checking
and controlling the settings for many of the window manager’s features.
Chapter 12 describes the options submenu.

Restart...

The Restart... menu item lets you save your window manager settings and
restart the window manager. When you choose the Restart... menu item, the
terminal displays a confirmation box. Chapter 12 further describes the Restart
menu item.
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11.4 Working With Menus

Menus display a list of related items that you can choose from. Some menu
items perform actions, while others display screens with more information to
choose from, such as dialog boxes. The terminal’s windows use three types of
menus:

• Pull-down menus

• Pop-up menus

• Options menus

Using the Keyboard to Choose Menus and Menu Items

If you prefer, you can perform menu actions from the keyboard, without using
a mouse. There are three methods:

• Each menu name and menu item has an underlined letter, called a
mnemonic. To display a menu or activate a menu item, you can press
the Alt key and the underlined letter on the keyboard at the same time. A
menu remains displayed after you release the keys. You can then use the
arrow keys to move to different menu items and menus.

• Some menu items in the Window Manager window menu list an
accelerator key sequence on the right. You can use the accelerator key
sequence to perform that menu function. You do not have to display the
menu to perform the function.

• You can use the arrow keys to move the pointer around the screen. Press
Shift Ctrl F3 to turn this feature on or off. You can use the following keys to
perform mouse functions:

Select

Prev

Next

MB1
MB2
MB3

For more key sequences, see Section 15.5.

11.4.1 Choosing Items from Pull-Down Menus

The menu bar of a window lists the names of menus for that application.

To display a pull-down menu:

Point to the menu name, then click on MB1. The menu remains displayed
until you choose a menu item or click MB1 outside the menu.
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Here is an example of a pull-down menu:

LJ−01141C−RAGS

VXT V2.1 Terminal Manager

Some pull-down menus list commands. Others list the names of items you can
work with.

If a menu item is followed by three periods (...), choosing that item displays a
dialog box. If a menu item is followed by an arrowhead (.) , choosing that item
displays a submenu.

To choose an item from a pull-down menu:

1. On the menu bar, point to the name of the menu you want to display.

2. Click MB1 to pull down the menu.

3. Move the pointer to the menu item you want.

4. Click MB1 to choose the menu item.

If you change your mind while looking at a pull-down menu, drag the pointer
outside the menu and release MB1. The menu disappears, and no action is
taken.

11.4.2 Choosing Items from Pop-Up Menus

Pop-up menus provide quick access to functions that are also available on
pull-down menus.

The terminal provides a pop-up Workspace menu (Chapter 12) for managing
windows and a pop-up VXT Create menu (Section 2.2.8) for quickly starting
sessions. To display the Workspace menu, click and hold MB1 anywhere on the
screen background outside windows. To display the VXT Create menu, click
and hold MB2 anywhere on the screen background. Here is a sample VXT
Create pop-up menu:
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VXT Create

DECnet 3270

Message Box

Terminal Manager

LAT X Session mynode
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Some host applications you use may also provide pop-up menus within their
window. In most cases, you click and hold MB1 within the window area to
display the pop-up menu.

To choose items from pop-up menus:

1. While holding the designated mouse button down, drag the pointer to the
menu item you want.

2. Release the mouse button.

If you decide not to choose an item, drag the pointer outside the menu
before releasing the mouse button.

11.4.3 Choosing Items from Options Menus in Dialog Boxes

An options menu is a type of pop-up menu used in dialog boxes. The dialog box
displays the current selection from the menu.

To display an options menu and choose a new setting:

1. Press and hold MB1 on the current option, to display the menu.

2. Drag the pointer to the setting you want.

3. Release MB1. The dialog box now displays your new setting.

If you decide not to make a change, drag the pointer outside the menu and
release MB1.

11.5 Supplying Information in Dialog Boxes

Windowing applications display a dialog box when they need more information
from you to carry out a task. Dialog boxes are like forms, offering various ways
to supply information. In some dialog boxes, you need to enter text. In others,
you click MB1 on a button to change a setting. Some dialog boxes display
settings you chose earlier.
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! Text-entry
box

Clicking on a text-entry box allows you to enter text from the
keyboard into the box. When you click on the box, it receives input
focus and displays a blinking text input cursor (I).

What you type appears to the left of the cursor. When editing
text entries, if you use an arrow key or other key to move the
cursor back and forth in the text, a caret symbol (^) appears as a
placemarker at the point where you started moving the cursor.

Use the <x key to delete typing mistakes. Use the  and !
keys to move within the text. Password text-entry boxes do not
display a text cursor.

If a dialog box has more than one text-entry box, you can move
between boxes by

• Clicking MB1 on the box you want

• Pressing Tab to advance to the next box in the window

" Check
buttons

Clicking on a square check button turns a setting on or off.
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# Scales You use scales to select a numeric value from a range of settings.
You drag a slider in the scale. The arrow in the slider points to the
current value.

$ Radio
buttons

Clicking on a diamond-shaped radio button selects that option from
a group of options.

% Push buttons Clicking on a rectangular push button (such as OK, Apply, Cancel,
or System Defaults) tells an application what to do with the
information you supplied in the dialog box.

& Default push
buttons

A button with a second border is the default action for a dialog
box. On a color terminal, the border area looks recessed. Default
actions are those that you choose most frequently. Usually, the OK
button is the default action for a dialog box. You can also choose
the default action by pressing the Return key.

' Push buttons
with input
focus

A default button with a third border has input focus. Input focus
means that keyboard input is connected to the push button. You
can change the input focus by clicking on another element in the
dialog box. When you open a dialog box, the OK button usually has
input focus.

When you enter a dialog box that has a text field, the OK button
is the default option but does not have input focus. In some dialog
boxes, the default action may change from the OK button to
another button after you start using the dialog box.

11.5.1 Dimmed Items in Menus and Dialog Boxes

If a menu item, button, or text-entry box is dimmed, you cannot currently use
that item. There are several reasons why an item may be dimmed:

• You must perform some other action before you can choose the item.

• Your VXT manager has configured your terminal so that item is not
selectable.

11.5.2 Moving and Changing Settings in a Dialog Box

Here are the methods for moving among text-entry boxes and for changing text
entries, button settings, and scales in a dialog box.

Moving

To move . . . Do this . . .

Forward among text-entry boxes. Press Tab or click MB1 on the box.

Backward among text-entry boxes. Press Shift Tab , or click MB1 on the box.
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To move . . . Do this . . .

The cursor in a text-entry box Point to where you want to insert text and
press MB1, or use the  or ! keys.

Changing

To . . . Do this . . .

Change a radio or check button setting. Point to the button and click MB1.

Change the numeric value on a scale. Drag the slider left or right on the scale,
or point to a location on the scale and click
MB1.

11.6 Using Scroll Bars

Some windows have scroll bars that let you view text or graphics that do
not fit in the window. A scroll bar has stepping arrows at either end of the
scroll region. The slider represents your relative position in the list or file.
If the slider is at the top of the scroll region, the beginning of the list is visible.
If the slider is at the bottom of the scroll region, the end of the list is visible.

 Slider

Stepping
Arrow

Scroll
Region
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The size of the slider tells you how much of the list the window is displaying.
If the slider is as large as the scroll region, the complete list is displayed. If
the slider is small, only part of the list is displayed. The smaller the slider, the
larger the list.
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Using scroll bars: You can scroll a line at a time, a window at a time, or to a
selected point.

To scroll this way . . . Do this . . .

One line at a time. Click MB1 on the stepping arrow at either
end of the scroll bar.

Forward one window of text at a time. Point to the scroll region below the slider
and click MB1.

Backward one window of text at a time. Point to the scroll region above the slider
and click MB1.

Continuously, one line at a time. Press and hold MB1 on the stepping arrow
at either end of the scroll bar.

Continuously, one window of text at a
time.

Press and hold MB1 in the scroll region.

To another location in the list or file. Drag the slider to a point in the scroll
region that you think corresponds to the
location you want to see. For example, if
the slider is at the top of the scroll region,
you are viewing the beginning of the list or
file.

To cancel the drag, click another mouse
button before releasing MB1.
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This chapter describes how to customize many of the window manager’s
features, using an Options submenu in the workspace area. The Options
submenu lets you check and control the settings for many window features—
from window borders and icons to the way windows become active on the
screen. Initially, the features use factory-default settings that work with many
host systems. You can make changes to suit your personal preference and
computing environment. After you make changes, you can save your settings
for all future sessions.

This chapter describes the tasks you can perform from the Options submenu:

• Displaying the Options Submenu

• Saving and Restoring Window Option Settings

• Changing Your Workspace Settings

• Changing Your Border Settings

• Changing Your Border Color Settings

• Changing Your Icon Settings

• Changing Your Icon Color Settings

• Changing Your Matte Settings

• Changing Menu, Button, and Key Bindings

The chapter describes how to use the Options submenu from the workspace
area. You can also display the Options submenu from the window menu
button. Display the window menu and choose the Workspace menu item. Then
choose the Options menu item from the Workspace submenu.
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12.1 Displaying the Options Submenu

To display the Options submenu:

1. Click and hold MB1 anywhere on the screen’s workspace. The workspace
submenu is displayed.

2. Drag the pointer down to the Options menu item. The Options submenu is
displayed.

3. Release MB1.
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Note

A system manager can lock or unlock settings in the Options submenu
by using the terminal’s configuration manager. If the settings are
locked, the Options menu item is dimmed and you cannot view the
Options submenu. See your system manager.

When you choose a menu item from the Options submenu, the dialog box
for that item is displayed. Shaded buttons in the dialog box indicate current
settings. You can examine the settings and change them if desired.
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12.2 Saving and Restoring Window Option Settings

To make changes to window settings and save them:

1. Make your changes in a dialog box, then click on the OK button.

2. Click on the Restart... menu item in the Workspace submenu.

or

Click on the Apply current settings menu item in the Options submenu.

3. The terminal displays a box to confirm that you want to apply the current
settings and restart the window manager.

For example, if you modify your window settings, and click on the Restart...
menu item, the terminal displays the following box:
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Click on the OK button to close the confirmation box, save changes, and
restart the window manager.

To cancel the restart operation, click on the Cancel button. The Cancel
button closes the restart confirmation box without restarting the window
manager.
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Making Changes in a Dialog Box

Each dialog box displayed from the Options submenu has a set of control push
buttons:

Click on... To...

OK Record new settings temporarily and dismiss the dialog box.

Reset Display the currently saved settings.

Default Restore the factory-default settings.

Cancel Dismiss the dialog box without changing any settings.

If you make changes, you must use the Apply current settings or Restart...
menu item to save your settings for future sessions.

Saving or Restoring Option Settings

To save or restore settings, use the following menu items on the Options
submenu of the window menu:

Choose... To...

Apply current settings Apply new settings and save them. You can also use
the Reset... menu item on the Workspace submenu.

Reset to last saved settings Restores the last settings you saved. Choose this
menu item if you want to reset any features that
you changed temporarily, but do not want to save.

Reset to default Restore the factory-default settings.

12.3 Changing Your Workspace Settings

You can change how and when windows become active in your workspace. You
can also show an entire window while it is moving instead of just the window
outline. To change these and other workspace settings, click anywhere on the
screen’s workspace to display the Workspace submenu. Choose the Options
submenu, then choose Workspace... to display the Workspace: Options dialog
box.
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From the Workspace: Options dialog box, you can change any of the following
settings:

To make a window active,

Normally, a window becomes active when you select it with your mouse or
keyboard. If desired, you can have windows become active as soon as you move
the pointer into them. To do this, click on the select the window button and
choose move the pointer into the window from the pop-up menu.

If you use the pointer to make windows active, you cannot use the Alt Tab and
Alt F11 keyboard navigation sequences to move the input focus among windows.

When a window becomes active,

Normally, a window is raised to the top of the stack on the screen when
activated. Click on the button if you want to turn this feature off.
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Make a window active when it is created or restored from an icon

Normally, a window becomes active when it is created or restored from an icon.
Click on the appropriate button if you want to change the current settings.

When a window is removed from the screen,

Normally when you remove a window from the screen, another window
becomes active. Click on the button if you do not want another window to
become active.

When moving a window, show the outline or entire window.

Normally when you move windows, only the window outline appears. If you
want to display the entire window while it is moving, click on the outline

button and choose entire window from the pop-up menu.

Show feedback when moving or sizing windows

Normally when you move or size a window, a box appears in the center of
the screen. For moving, the box provides a horizontal and vertical screen
coordinate position. For sizing, the box provides a horizontal and vertical size.
Click on the button if you do not want the box to appear. Turning off the box
can improve performance.

Set Alt+Space to display the window menu

If you choose this feature, you can press the Alt key and space bar to display
the window menu. This is an alternative to the window menu button.

For international keyboards, ignore the Mod keys

If you choose this feature, the terminal ignores modifier keys such as the Ctrl

key.

Freeze on interactive placement and resize of window

Normally when you move a window, its frame appears solid on the background.
To change to a flickering frame, click on the button.

12.4 Changing Your Border Settings

You can change the features of your window border to include or exclude
minimize and maximize buttons, borders, a title, or menus. You can also
change the size of borders. To change your border settings, click anywhere on
the screen’s workspace to display the Workspace submenu. Choose the Options
submenu, then choose Border... to display the Workspace: Border Options
dialog box.
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From the Workspace: Border Options dialog box, you can change any of the
following settings:

Border Decorations

You can add or remove border decorations and buttons from all of your window
frames. To change the current setting for a border decoration, click on its
button.

Resize Border Size

The resize border is the part of the window frame that you drag to resize
a window. To change the thickness of the border, click on the button in the
Resize Border Size box and make a choice from the pop-up menu. If you choose
Other, you can enter a specific size in the Other Resize Border Size box.

Other Resize Border Size

If you choose Other from the pop-up menu in the Resize Border Size box, you
can enter a border width from 0 to 999 in the Other Resize Border Size box.

Double Click on Window Menu to Close Window

When this setting is enabled, a window will close when you double click on the
window menu button.
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12.5 Changing Your Border Color Settings

You can choose distinct colors for active and inactive windows, to make it
easy to see which window is active. To change your border color settings,
click anywhere on the screen’s workspace to display the Workspace submenu.
Choose the Options submenu, then choose Border Colors... to display the
Workspace: Border Color Options dialog box.
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From the Workspace: Border Color Options dialog box, you can change any of
the following settings for active or inactive windows:
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On Gray Scale and Color Systems

Foreground

The Foreground button lets you change the foreground color of the window’s
title. When you click on the button, the window manager displays a Color
Mixing dialog box (Appendix B).

Background

The Background button lets you change the color behind the title. When you
click on the button, the window manager displays a Color Mixing dialog box.

Top Shadow

The Top Shadow button lets you change the color on the top and left sides of
the border. The top and bottom shadow colors create the three-dimensional
effect of the window display, so it is important to use well-matched colors.
If the Automatically Set the Shadow Colors button is on, the terminal
automatically chooses the top and bottom shadow colors when you change
the background color.

To choose your own top shadow color, first turn off the automatic button. Then
click on the Top Shadow button to display the Color Mixing dialog box. You
should use the HLS model in the dialog box to choose a color that is lighter
and less saturated than the bottom shadow color.

Bottom Shadow

The Bottom Shadow button works like the Top Shadow button, but changes the
color on the bottom and right sides of the border.

Customize the window manager menu colors

This button lets you change the colors of the window manager menu. Click on
the button to display a pop-up menu of choices.

On Monochrome Systems

The Color Mixing dialog box is not displayed on monochrome systems. To
change the foreground, background, or shadow colors, click on the appropriate
button.

12.6 Changing Your Icon Settings

You can customize the size, placement, and use of labels and images for your
window icons. To change your icon settings, click anywhere on the screen’s
workspace to display the Workspace submenu. Choose the Options submenu,
then choose Icons... to display the Workspace: Icon Options dialog box.
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From the Workspace: Icon Options dialog box, you can change any of the
following settings:

Display the Icon Box

Click on the Display the Icon Box button to turn the display of an icon box on
or off. The icon box contains the window icons of each session and application
running on the terminal.

You can save changes to the size or location of the icon box for future sessions.
You cannot save changes to the location of icons within the icon box. To save
the icon box, click on the Apply current settings menu item in the Options
submenu, then click on the Restart... menu item to restart the window
manager (Section 12.1).

Place Icons on

This button lets you choose the location and direction for placing icons on the
screen. Click on the button to display a pop-up menu of choices.

Icon Size

The Icon Size button lets you choose the size of the icons. Click on the button
to display a pop-up menu of choices. If you choose Other, you can enter a
specific size in the Other Icon Height and Width boxes.
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Other Icon Height and Width

If you choose Other from the Icon Size pop-up menu, you can enter a value
from 0 to 999 in the Other Icon Height and Width boxes.

Icon Decorations

To turn the use of icon labels and images on or off, click on the appropriate
button.

12.7 Changing Your Icon Color Settings

You can customize the colors for icon images and boxes. To change your
icon color settings, click anywhere on the screen’s workspace to display the
Workspace submenu. Choose the Options submenu, then choose Icon Colors...
to display Workspace: Icon Color Options dialog box.
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From the Workspace: Icon Color Options dialog box, you can change any of the
following settings:
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On Gray Scale and Color Terminals

– Customize the icon image colors –

Foreground

The Foreground button lets you change the color of the icon’s title. To change
the color, click on the Foreground button to display the Color Mixing dialog box
(Appendix B).

Background

The Background button lets you change the color behind the icon’s title. To
change the color, click on the Background button to display the Color Mixing
dialog box.

Top Shadow

The Top Shadow button lets you change the color on the top and left of the
icon border. The top and bottom shadow colors create the three-dimensional
effect of the icon display, so it is important to use well-matched colors. If the
Automatically Set the Shadow Colors button is on, the terminal automatically
chooses the top and bottom shadow colors when you change the background
color.

To choose your own top shadow color, first turn off the automatic button. Then
click on the Top Shadow button to display the Color Mixing dialog box. You
should use the HLS model in the dialog box to choose a color that is lighter
and less saturated than the bottom shadow color.

Bottom Shadow

The Bottom Shadow button works like the Top Shadow button, but changes the
color on the bottom and right of the icon border.

– Customize the icon box color –

Background

Normally, the background color of the icon box is set automatically. To change
the color, turn off the Automatically Set the Color button and click on the
Background button to display the Color Mixing dialog box.

On Monochrome Terminals

The Color Mixing dialog box is not displayed on monochrome terminals. To
change the foreground, background, or shadow colors, click on the appropriate
button.
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12.8 Changing Your Matte Settings

You can add an optional matte frame between the window border and the work
area. You can control the matte’s size and colors. To create a matte or change
your matte settings, click anywhere on the screen’s workspace to display the
Workspace submenu. Choose the Options submenu, then choose Matte... to
display the Workspace: Matte Options dialog box.
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From the Workspace: Matte Options dialog box, you can change any of the
following settings:

On Gray Scale and Color Terminals

– Customize the matte –

Matte Size, Other Matte Size

The Matte Size button lets you change the size of the matte. To change the
size, click on the button and make a choice from the pop-up menu. To turn off
the matte, choose None. To enter your own size, choose Other, then click on the
Other Matte Size box and enter a size.
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– Customize the matte colors –

Foreground

To change the matte’s foreground color, click on the Foreground button to
display the Color Mixing dialog box (Appendix B).

Background

To change the color behind the matte’s title, click on the Background button to
display the Color Mixing dialog box.

Top Shadow

The Top Shadow button lets you change the color on the top and left of the
matte. The top and bottom shadow colors create the three-dimensional effect,
so it is important to use well-matched colors. If the Automatically Set the
Shadow Colors button is on, the terminal automatically chooses the top and
bottom shadow colors when you change the background color.

To choose your own top shadow color, first turn off the automatic button. Then
click on the Top Shadow button to display the Color Mixing dialog box. You
should use the HLS model in the dialog box to choose a color that is lighter
and less saturated than the bottom shadow color.

Bottom Shadow

The Bottom Shadow button works like the Top Shadow button, but selects the
color on the bottom and right of the matte.

On Monochrome Terminals

The Color Mixing dialog box is not displayed on monochrome terminals. To
change the foreground, background, or shadow colors, click on the appropriate
button.

12.9 Changing Menu, Button, and Key Bindings

Caution

This topic is for advanced users who have a thorough understanding
of the information discussed in the OSF/Motif Programmers Guide.
Changing menu, button, or key bindings could remove needed functions
from menus and may disable your ability to use the window manager.

For example, if you edit a menu or binding and leave a blank line when
you remove a function, the items below the blank line will not work or
may not appear on the menu following a restart.
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You can modify six of the window manager’s menus and the functional bindings
for certain buttons and keys.

To change your bindings, click anywhere on the screen’s workspace to display
the Workspace submenu. Choose the Options submenu, then choose Resource
configuration... to display the Workspace: Customize Resource Configuration
dialog box.
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Binding Set

The Workspace: Customize Resource Configuration dialog box contains a list
of six menu binding sets, one keyboard key binding set, and one mouse button
binding set. When you click on a binding set in the list, the bindings for that
set are displayed in the scroll box to the right of the list. The name of the set
is displayed in the Currently editing: field.

Here is what each binding sets does:
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Click on... To modify...

Menu RootMenu The Workspace menu accessed by clicking MB1 in
an open space.

Menu WorkspaceMenu The Workspace submenu accessed from the window
menu.

Menu MwmCustomizeRootMenu The Options submenu accessed from the Workspace
submenu.

Menu MwmCustomizeMenu The Options submenu accessed from the window
menu.

Menu DefaultWindowMenu The window menu accessed from the window menu
button.

Menu IconBoxMenu The Icon Box menu.

Keys DefaultKeyBindings Keyboard keys associated with window manage-
ment functions.

Buttons DefaultButtonBindings Mouse button actions associated with window
management functions.

Push Button Controls

Below the scroll box are push buttons to control the editing process:

Choose... To...

Apply Record the setting of the currently edited binding set.

Reset Redisplay the current settings for the currently edited binding set, if
you changed the setting without applying them.

Default Restore the factory-default settings for the currently edited binding
set.

List Window
Manager
Functions...

Display a list of supported window manager functions.

To display window manager functions:

To display the List of Window Manager Functions dialog box, click on the List
Window Manager Functions... button in the Customize Resource Configuration
dialog box. From this list, you can select and copy functions into the binding
set you are editing in the scroll box. For descriptions of the window manager
functions, see the OSF/Motif Programmers Guide.
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To change or add to a menu binding:

1. Click on a menu binding set in the Workspace: Customize Resource
Configuration dialog box. The functions for the menu appear in the scroll
box.

2. To make changes: Enter changes from your keyboard or use your mouse
to copy a new binding from the List of Window Manager Functions.

To add functions to the binding: Click to the right of the last function
listed in the scroll box, then press Return .

Each menu item entry has the following syntax:

item [mnemonic] [accelerator] function [argument]

The mnemonic and accelerator are optional. The function is the action
the window manager takes when a user chooses the menu item. Some
functions may require arguments.

The window manager treats blank lines as the end of the menu binding
set. To remove blank lines, use the <x key or  Backspace key.

3. Click on Apply.

4. Click on OK.
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To change or add to a key binding:

1. Click on the Keys DefaultKeyBindings binding set. The functions for
certain keyboard keys are displayed in the scroll box.

2. To make changes: Enter changes from your keyboard or use your mouse
to copy a new binding from the List of Window Manager Functions.

To add functions to the binding: Click to the right of the last function
listed in the scroll box, then press Return .

Each key binding has the following syntax:

key context[|context] function [argument]

Each line identifies a unique key sequence, one or more contexts in which
the sequence is valid, and the function of the sequence. The context
indicates where the keyboard input focus must be when keys are pressed,
in order for the sequence to work: window, icon, or root. The function is
the action the window manager takes when a user chooses the menu item.
Some functions may require arguments.

The window manager treats blank lines as the end of the key binding set.
To remove blank lines, use the <x key or  Backspace key.

3. Click on Apply.

4. Click on OK.

To change or add to a button binding:

1. Click on the Buttons DefaultButtonBindings binding set. The functions for
the buttons are displayed in the scroll box.

2. To make changes: Enter changes from your keyboard or use your mouse
to copy a new binding from the List of Window Manager Functions.

To add functions to the binding: Click to the right of the last function
listed in the scroll box, then press Return .

Each button binding has the following syntax:

button context[|context] function [argument]

Each line identifies a certain button action, one or more contexts in which
the button action is valid, and the function to perform. The context
indicates where the pointer must be for the button action to work: window,
root, frame, icon, title, or border. The function is the action the window
manager takes when a user chooses the menu item. Some functions may
require arguments.
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The window manager treats blank lines as the end of the button binding
set. To remove blank lines, use the <x key or  Backspace key.

3. Click on Apply.

4. Click on OK.

To save settings:

To save the settings in the Workspace: Customize Resource Configuration
dialog box, use the push buttons at the bottom of the dialog box.

Choose... To...

OK Record new settings and dismiss the dialog box.

Reset All Redisplay the current settings for the entire dialog box if you
changed settings without applying them.

System Defaults Restore the factory-default settings for the entire dialog box.

Cancel Dismiss the dialog box without changing any settings. If you made
changes without applying them, clicking on Cancel button cancels
those changes.
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This chapter describes how to launch local VXT applications and remote host
applications on your terminal. The chapter covers the following major topics:

• Launching Sessions and Applications

• Launching Sessions and VXT Applications with the Window Manager

• Launching Remote Applications

• Launching Sessions and VXT Applications Using rsh

13.1 Launching Sessions and Applications

Application launching refers to starting sessions, local VXT applications,
or remote host applications on the terminal. Normally, you start sessions and
applications from the Terminal Manager window by using

• The Create dialog box, Create menu, or VXT Create pop-up menu
(Section 2.2)

• The Customize AutoStart dialog box or AutoStart menu item (Section 5.6)

You can also launch sessions and applications from the terminal’s local window
manager. This feature is provided for users who may want to run sessions
or applications without running the Terminal Manager window or a remote
session manager.

To launch applications or sessions from the window manager, you define menu
items, keys, or mouse buttons. Section 12.9 describes the general steps to
define menu items, mouse buttons, or keys. This chapter lists the specific
functions and arguments you can use to launch sessions and applications from
the window manager.
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Launching Remote Applications

To launch host applications from the Terminal Manager window or window
manager, you first must run the VXT application launcher on the host system.
See Section 13.3.

13.2 Launching Sessions and VXT Applications with the
Window Manager

There are two methods to launch sessions and local VXT applications with the
window manager:

• Use the VXT Create pop-up menu (Section 2.2.8).

• Define menu items or keys.

13.2.1 Defining Menu Items to Launch Sessions and Local VXT
Applications

You can add menu items to the window manager’s Workspace submenu to start
local VXT applications or sessions.

1. Click and hold MB1 anywhere on the screen’s workspace to display
the Workspace submenu. Choose the Options submenu, then choose
Resource configuration... to display the Workspace: Customize Resource
Configuration dialog box.

2. In the Binding Set box, click on the Menu RootMenu binding set.

3. Enter new menu items at the bottom of the scroll box list.

• Use the following syntax to add a menu item for a session:

"Menu item" f.exec "session transport host"

Examples

"Market DECterm" f.exec "decterm -ip market"
"Market X Session" f.exec "x -ip market"
"Serial DECterm" f.exec "decterm -serial"

• Use the following syntax to start a local VXT application:

"Menu item" f.exec "application"

Examples

"Terminal Manager" f.exec "term_mgr"
"Message Box" f.exec "msgbox"

Table 13–1 lists all possible session and application functions.
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4. Click on Apply.

5. Click on OK.

6. Restart the window manager.

a. Click and hold MB1 anywhere on the screen’s workspace to display the
Workspace submenu.

b. Click on Restart... to restart the window manager.

The window manager adds your new menu items to the Workspace
submenu.

After you restart the window manager, you can use your new menu items to
launch the sessions or local VXT applications you added.

1. Click and hold MB1 anywhere on the screen’s workspace to display the
Workspace submenu.

2. Choose the desired menu item to launch a particular session or local VXT
application.

Table 13–1 Application Names and Arguments

Application
Name Arguments

x [-ip],[-lat],[-dnet] <host>

decterm [-ip],[-lat],[-dnet] <host>

decterm [-serial]

mwm none

term_mgr [-msgbox]

msgbox none

font_mgr none

3270 [-dnet]

<> indicates a required argument.
[ ] indicates an optional argument. Commas separate choices.
IP is the default transport for DECterm and X sessions.
DECnet is the default transport for the VXT 3270 application.
You cannot launch the configuration manager as a separate application.
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13.2.2 Defining Keys to Launch Sessions and Local VXT Applications

You can define keys to start local VXT applications or sessions.

1. Click and hold MB1 anywhere on the screen’s workspace to display
the Workspace submenu. Choose the Options submenu, then choose
Resource configuration... to display the Workspace: Customize Resource
Configuration dialog box.

2. In the Binding Sets box, click on the Keys DefaultKeyBindings binding set.

3. Enter your new key definitions at the bottom of the list.

• Use the following syntax to define a key to launch a session:

<Key>key root | window f.exec "session transport host"

Examples

<Key>F18 root|window f.exec "decterm -lat market"
<Key>F19 root|window f.exec "x -ip market"
<Key>F20 root|window f.exec "decterm -serial"

• Use the following syntax to define a key to launch a local VXT
application:

<Key>key root | window f.exec "application"

Example

<Key>F17 root | window f.exec "term_mgr -msgbox"

Table 13–1 lists all possible session and application functions.

4. Click on Apply.

5. Click on OK.

6. Restart the window manager.

a. Click and hold MB1 anywhere on the screen’s workspace to display the
Workspace submenu.

b. Click on Restart... in the Workspace menu.

The window manager updates your key definitions.

After you restart the window manager, you can use your new key definitions to
launch the sessions or local VXT applications you defined.

1. Click and hold MB1 anywhere on the screen’s workspace to display the
Workspace submenu.

2. Press the key you defined to launch your session or local VXT application.
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13.3 Launching Remote Applications

You can launch applications on your host system from the terminal. For
example, you may want to run your host’s clock or calendar program on your
terminal.

There are two basic steps in launching a remote application:

1. Before you launch remote applications, you must run the VXT launcher in
a host session on the terminal (Section 13.3.1).

2. Launch the remote application from the Terminal Manager window or the
window manager. This step is similar to launching sessions or local VXT
applications.

• If you use the Terminal Manager window, you can enter and launch
applications in the Create dialog box (Section 2.2.6). After you save
your settings and restart the window manager, your applications are
also listed on the Create menu and VXT Create pop-up menu.

• You can also use the terminal’s local window manager to define keys
or menu items on the Workspace submenu for launching remote
applications (Section 13.3.3). This feature is provided for users who
may want to run sessions or applications without running the Terminal
Manager window or a remote session manager.

Launching Remote Applications from Several Systems

You can launch remote applications from several systems and display those
applications concurrently on your terminal. However, you must define a unique
name for the launcher on each system.

One VXT Application Launcher Connection

1.  Connect to the host and start the application launcher.

2.  Launch the host application.

3. The host displays the application on the terminal.
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TCP/IP, DECnet, or LAT Session
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Two VXT Application Launcher Connections

Connect to host 1 and start  launcher 1.

Launch application 1.

The host displays application 1.

Launcher 2

Application 2

Connect to host 2 and start launcher 2.

Launch application 2.

The host displays application 2.

Launcher 1

Application 1
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13.3.1 Running the Application Launcher

VXT Version 2.1 and later software provides the application launcher. Check
with your system manager for the name and location of the application
launcher file on your host system. VXT Software Version 2.1 Installation and

System Management describes the installation and setup of the launcher.

The launcher establishes a display connection with the terminal. This allows
you to send launch commands from the terminal to the launcher, which relays
the commands to the host system.

The following sections describe methods to run the application launcher on
UNIX or OpenVMS systems. Section 13.3.2 describes the command syntax in
detail.

UNIX, ULTRIX, and DEC OSF/1 Systems

The default name of the application launcher file is vxtlaunch. The default file
location is in the /usr/local/bin path.

You can use the following commands to run the launcher. Make sure the
launcher is in your current path.

% setenv DISPLAY terminal’s_IP_address:0
% vxtlaunch arguments &

Section 13.3.2 describes possible command arguments.
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Example

The following commands starts the launcher with a process name of launch1,
to connect to a terminal with a TCP/IP address of 16.122.144.56:

% setenv DISPLAY 16.122.144.56:0
% vxtlaunch -name launch1 &

If you do not specify a process name, the default is vxt.

OpenVMS Systems

The default name of the application launcher file is VXT$LAUNCH.EXE. The
default file location is VXT$LIBRARY. The following commands shows one
possible method for invoking the launcher:

$ SET DISPLAY/CREATE/NODE=terminal’s_DECnet_address
$ MCR VXT$LIBRARY:VXT$LAUNCH arguments

Section 13.3.2 describes possible command arguments.

Example

The following command starts the launcher with the name LAUNCH1 to connect
to a terminal with a DECnet address of 3456:

$ SET DISPLAY/CREATE/NODE=3456
$ MCR VXT$LIBRARY:VXT$LAUNCH -NAME LAUNCH1

If you do not specify a process name, the default is VXT.

13.3.2 Launch Command Arguments

This section lists the arguments you can use with the command that runs
the application launcher. On UNIX systems, the command is vxtlaunch. On
OpenVMS systems, the system manager must define a foreign command name.
This section assumes the command is vxtlaunch.

vxtlaunch arguments

Standard vxtlaunch Arguments

The application launcher supports the following arguments:

Argument Description

-help Provides help information on arguments.
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Argument Description

-display name Enter the name of the display to connect to.

IP Enter terminal’s_IP_address:0.

DECnet Enter terminal’s_DECnet_address::0

-name name Specifies a name to use for the launcher on this host system.
If you launch applications from multiple systems for display
on the same terminal, you must specify a unique name for the
launcher on each system. You use this name when entering
launch commands for applications. The default name is VXT.

-kill Stops a VXT launcher process on the host system. You must
specify the -name argument if the launcher has a name other
than the default (VXT).

Examples

Here are some vxtlaunch command examples using the supported arguments:

Argument Example Description

vxtlaunch Starts a launch process with the default name VXT.

vxtlaunch -name LCH1 Starts a launch process with the name LCH1.

vxtlaunch -kill Stops a launch process with the default name VXT.

vxtlaunch -kill -name LCH1 Stops a launch process with the name LCH1.

Other vxtlaunch Arguments

The following vxtlaunch arguments may present security implications on your
system:

Argument Description

-retry interval:number If the launcher fails to make an X connection with the
terminal, this argument specifies how often (interval)
and how many times (number) the launcher should
retry to make a connection. The default interval is 1
second. The default duration is forever.

-reconnect If the launcher receives a fatal error after a
successful X connection, this argument tells the
launcher to try to reestablish the connection.
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Examples

Here are some vxtlaunch command examples using the -retry and
-reconnect arguments:

Argument Example Description

vxtlaunch -retry -reconnect Retry to make a connection every 1 second, forever.
If an existing connection fails, try to reconnect.

vxtlaunch -retry 3 Retry to make a connection every 3 seconds, forever.

vxtlaunch -retry :3 Retry to make a connection every 1 second, for 3
times.

vxtlaunch -retry 3:3 Retry to make a connection every 3 seconds, for 3
times.

13.3.3 Defining Menu Items or Keys to Launch Remote Applications

You can define keys or menu items on the Workspace submenu to launch
remote applications.

To define a menu item to launch a remote application:

Follow the same steps used to define menu items for local applications or
sessions (Section 13.2.1), but use the following command syntax:

"menu item" root | window f.exec "rexec launcher command"

The launcher is the name of the application launcher. Default name: VXT.

The command is the host system command to launch the desired application.

Examples

The following examples show typical commands to start a clock on a UNIX
system or OpenVMS system.

UNIX system:

"xclock" root|window f.exec "rexec launch1 /usr/bin/X11/xclock"

OpenVMS system:

"Clock" root|window f.exec "rexec vxt run @sys$system:decw$clock"

To define a key to launch a remote application:

Follow the same steps used to define keys for local applications or sessions
(Section 13.2.2), but use the following command syntax:

"<Key>key" f.exec "rexec launcher command"
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The key is the key you want to define.

The launcher is the name of the application launcher. Default name: VXT.

The command is the host system command to launch the desired application.

Examples

The following examples show typical commands to start a clock on a UNIX
system or OpenVMS system.

UNIX system:

"<Key>F17" f.exec "rexec launch1 /usr/bin/X11/xclock"

OpenVMS system:

"<Key>F17" f.exec "rexec vxt run @sys$system:decw$clock"

13.4 Launching Sessions and VXT Applications Using rsh

On UNIX systems, you can use the rsh (r shell) application to launch sessions
and local VXT applications over the IP transport. The rsh commands contain
the host name, user name, and the command to launch the application.
The terminal checks the host name and user name for authorization in the
terminal’s Customize Security list.

rsh vxt_name application -ip node

vxt_name is the terminal’s IP host name, as listed in the host system’s
/etc/hosts file. You cannot use IP addresses with rsh.

application is the session or local VXT application to start.

node is the host system you are connected to.

Example

The following example starts a VXT DECterm window on the terminal myvxt
from the host system market.

csh>rsh myvxt decterm -ip market

1. Connect to the host.

2. Use an r shell command to start a VXT application.

3. The host passes the command to the terminal’s
    window manager, which displays the application.

TCP/IP Session
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This chapter describes how to load and use VXT EX software with the
terminal. The chapter covers the following major topics:

• VXT EX Software

• Loading VXT EX Software

• Creating a Session

• VXT EX Options Dialog Box

14.1 VXT EX Software

VXT EX (essential X server) software is a minimal version of VXT software,
without any local applications such as the Terminal Manager window, VXT
DECterm and VXT 3270 windows, and the Motif window manager. VXT EX
software lets you create X sessions with minimal memory installed in the
terminal. The system you connect to must provide all window management
and terminal emulation features.

VXT EX software provides a single dialog box for creating an X session. You
can create an X session to systems that support the TCP/IP or LAT transports.

VXT EX software

• Requires only the minimum 4 megabytes of installed memory

• Requires host-based clients for window management and terminal
emulation

• Does not support printing to locally attached printers

• Requires a mouse or pointing device
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14.2 Loading VXT EX Software

When you turn or reboot the terminal, it normally loads full-function VXT
software. There are two ways to load VXT EX software instead of VXT
software:

• Specify VXT EX software in the Customize Boot dialog box and reboot the
terminal. To specify host-based operation, see Section 5.7.2. To specify
server-based operation, see Section 5.7.3.

• Enter a BOOT command that specifies VXT EX software (Section 5.7.5).

14.3 Creating a Session

When you reboot the terminal with VXT EX software, the terminal displays
the VXT EX connection dialog box. You use the dialog box to create an X
session to a host system. You can create multiple X sessions.

VXT EX V2.0
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The Video Alignment button is for VXT 2000 model VX227 windowing
terminals only. This button provides centering and rotation controls to align
the screen display if necessary. See Section 3.11.

To connect to a host system:

1. Choose your display language. The default is English.

2. Choose the communication transport to use for the X session—LAT or IP.

3. For LAT: Enter your LAT Service Name. By default, the host system you
connect to supplies your fonts.

For IP: Enter your Host IP Address, TFTP Font Path, and IP Name
Server.

Your terminal’s IP address and name server must be defined on a host
system by your system manager. See Section 4.5.

4. Click on the Save button if you want to save your host settings.

If you save your host settings, the terminal automatically tries to establish
a connection to that host whenever you turn on or reboot the terminal. The
terminal does not display the VXT EX dialog box.

If you do not save your settings, the terminal uses these settings for the
current session only. The next time you turn on or reboot the terminal, it
will display the VXT EX dialog box again.

5. Click on the Connect button. If a connection is made, the terminal displays
your host system’s login prompt.

If a connection is not made, the terminal redisplays the VXT EX dialog box.

6. Log in to your host system.

To redisplay the VXT EX dialog box:

Press the F3 key.

You can change your settings or create a second X session.

To switch from VXT EX to VXT software:

If you are using host-based operation, you must halt the terminal and enter a
BOOT command that specifies VXT software. See Section 5.7.5.

If you are using server-based operation, you can choose VXT software from the
VXT EX options box (Section 14.4).
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14.4 VXT EX Options Dialog Box

You can specify VXT EX option settings by choosing the Options... button in
the VXT EX dialog box. When you click on Options, the terminal displays the
VXT EX options dialog box:

VXT EX V2.0

LJ−03025−RAGS

From the VXT EX options dialog box, you can change the following settings:

Setup Key

Normally, you use the F3 key to display the VXT EX dialog box. You can choose
to use the Ctrl Alt F3 key sequence instead.

Allow All Connections

Normally, other systems and users cannot connect to your terminal when you
are using VXT EX software. If you click on the Allow All Connections button,
any system on the Ethernet can establish an X connection to your terminal.

VXT 2000+/VXT 2000 Windowing Terminal User Information 245



Using VXT EX Software
14.4 VXT EX Options Dialog Box

Secondary Boot VXT Software

If your terminal operates in server-based mode, you can use this button to
switch from VXT EX software to full-function VXT software. The VXT software
image must be available on an InfoServer system in your network. Your new
setting takes effect the next time you turn on or reboot the terminal. You can
reboot the terminal by pressing the Ctrl+left Alt+keypad . sequence.

Host-based terminals and server-based terminals operating in host-based mode
cannot use this option. However, you can switch to VXT software by entering a
boot command (Section 5.7.5).

To close the Options dialog box:

Click on the Cancel button.
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You can use one of the following keyboards with your terminal:

• ANSI Keyboard

• Short ANSI Keyboard

• The PC Keyboard

• The Sun Style Keyboard

This chapter describes the basic functions of the keys and indicators on each
keyboard. The chapter also describes how to use the keyboard instead of the
mouse to navigate through windows and to choose items from menus and
dialog boxes. Finally, the chapter describes how to type additional characters
not shown on the keyboard keys.

VXT 3270 Keyboard Functions

For keyboard functions in VXT 3270 windows, see Chapter 9.

15.1 ANSI Keyboard

The ANSI keyboard comes in many versions for use with different languages
and dialects. The only physical difference between these keyboards are the
legends on the keys.

15.1.1 Keyboard Dialect

The terminal is initially set to work with the North American/United Kingdom
keyboard. If you have a keyboard for a different language or you want to
use the British dialect, you must change the Keyboard Type setting in the
Customize Keyboard dialog box (Section 3.3).
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15.1.2 Layout

The keyboard has four groups of keys and two visual indicators. The keys are
grouped by function.

Main keypad
Editing keypad
Numeric keypad
Top-row function keys

The keyboard also has two audible indicators, a keyclick and bell.

The following figure shows the North American/United Kingdom keyboard:
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15.1.3 Main Keypad

The main keypad is similar to a typewriter keyboard with alphanumeric
characters, punctuation marks, and Shift keys. The main keypad also has a
number of keys not found on a standard typewriter, such as the Ctrl modifier
key and the Compose Character and Alt prefix keys. The German keyboard has
a Group Shift key and Alternate Shift key instead of Compose Character keys.

Modifier keys are pressed in combination with another key, to modify the
code sent by that key. Prefix keys are pressed and released before pressing
another key, to change the function of one or more keystrokes.
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Special-Function Keys

The main keypad has the following special-function keys:

Tab In VXT DECterm windows, pressing Tab sends a horizontal tab,
which normally moves the cursor to the next tab stop. Applications
can change tab stops. In the Terminal Manager window screens
and in some DECwindows menus, Tab moves the cursor to the next
text-entry box.

Ctrl Holding down Ctrl and pressing another key sends a control code to
the host.

For example, Ctrl Z means to hold down Ctrl and press the Z key.

Shift There are left and right Shift keys. Holding down Shift and pressing
a standard key sends the shifted (top) character on the key.

Holding down Shift and pressing a special-function key starts a
predefined control function. For example, Shift F2 (Print) means to
hold down Shift while pressing the F2 (Print) key.

Pressing the lock key down puts the keyboard in caps lock mode or
shift lock mode. You can set the mode from the Customize Keyboard
dialog box (Section 3.3). The default setting is Caps Lock.

• In caps lock mode, the alphabetic keys send their uppercase or
shifted character when pressed alone. You can use a Shift key
to send the shifted character on other keys. You turn caps lock
mode on and off by pressing and releasing the lock key.

• In shift lock mode, all keys on the main keypad send their
shifted character. You can turn shift lock mode on or off by
pressing the Lock key.

When the lock key is down, the lock indicator on the keyboard turns
on.

Return Pressing Return sends either a carriage return or a carriage return
and a line feed (newline). You can choose the function of the
Return key from the VXT DECterm General Options dialog box
(Section 8.5).

<x Backarrow
key

Pressing the <x key normally sends a delete (DEL) character.
Many applications use DEL to erase one character to the left of the
cursor.

You can make the <x key send a backspace (BS) character instead
of DEL. You can select the function of the <x key from the VXT
DECterm Keyboard Options dialog box (Section 8.6).

Space bar Pressing the space bar sends a space (SP) character. You use spaces
to separate words or move the cursor forward.
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Compose
Character

LJ-00280-TI0

(left and right)

These are prefix keys, used to generate characters that do not
appear as standard keys on your keyboard. See Section 15.6.3.

On the German keyboard, the Compose Character key is replaced
by Group Shift and Alternate Shift.

Group
Shift

LJ-00281-TI0

(German)

You use Group Shift as a prefix or modifier key, to type the
characters on the right half of keycaps. See Section 15.6.4.

Alternate
Shift

LJ-00282-TI0

(German)

Alternate Shift is a modifier key, used to generate a no break space
(NBSP) or soft hyphen (SHY) character.

Alternate Shift + space bar = NBSP character.
Alternate Shift - = SHY character.

Alt
Function
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(left and right)

You use Alt with other keys, to select alternate functions defined by
your application software.

You can use Alt as a Compose Character key, by holding down the
Alt and space bar. This action starts a compose character sequence.

Your keyboard has both Compose Character and Alt Function keys.
If a workstation application’s documentation specifies use of the

Compose Character key as a modifier for keyboard keys or mouse
buttons, you may need to use the Alt key instead on the terminal.

15.1.4 Editing Keypad

The editing keypad has four arrow keys and six editing keys.

Normally, pressing an arrow key moves the text cursor in the direction of the
arrow. For example, pressing the # key moves the cursor down one line.

If you press Ctrl Shift F3 , you can use the editing keypad to perform some
mouse functions. In this mode, the arrow keys move the mouse pointer. The
Select , Prev , and Next keys correspond to the three mouse buttons. The mouse
continues to operate. There is no indication the mode is on, but the arrow keys
will not work for normal editing functions.

To turn this mode off, press Ctrl Shift F3 again.

The six editing keys generally perform screen control functions defined by
application software.
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15.1.5 Numeric Keypad

Numeric keypad keys often have functions assigned by your software
applications, especially PF1 to PF4 . For example, you may use a spreadsheet
program that assigns special functions to these keys. See your application
manuals for details.

You can use the numeric keypad to enter numeric data as you would with
a calculator. Programmers can use this keypad to do hexadecimal compose
sequences. See Section 15.6.7.

When you use VXT DECterm windows, you can set the keypad to work as
a numeric keypad or application keypad. See the VXT DECterm Keyboard
Options dialog box in Section 8.6.

Enter The Enter key on the numeric keypad normally works like the Return

key. Enter sends a carriage return, or a carriage return and a line
feed. You can select the function of the Return key from the VXT
DECterm General Options dialog box (Section 8.5).

Application software may use Enter as a special-function key.

15.1.6 Top-Row Function Keys

Predefined Keys

The first five top-row keys, F1 to F5 , are predefined to perform the following
functions. You cannot change these functions. Your application software
defines the functions of the remaining top-row keys. See your application
manual for details.

F1 (Hold) Pressing F1 (Hold) puts the screen display in the active window on
hold. This stops the scrolling of text, which can make reading easier.
When you press F1 (Hold), the hold indicator on the keyboard turns
on. Pressing F1 (Hold) again allows scrolling to resume.

F2 (Print) Pressing F2 (Print) sends the text in the active window to the printer.

The output may or may not correspond exactly to the display in the
window. The output depends on the window size and font size. See
Chapter 8 for more information on printing.

Ctrl F2 Pressing Ctrl F2 (Print) turns auto print mode on or off. In auto print
mode, you can automatically print each line of text as it is received
from the host system.

F3 This key if enabled in the Customize Terminal Manager window lets
you hide or display the Terminal Manager window. See Section 3.10.
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Ctrl Shift F3 Pressing Ctrl Shift F3 lets you use the editing keypad to perform
some mouse functions. In this mode, the arrow keys move the
mouse pointer. The Select , Prev , and Next keys correspond to the
three mouse buttons. The mouse continues to operate. There is no
indication the mode is on, but the arrow keys will not work for normal
editing functions.

To turn this mode off, press Ctrl Shift F3 again.

F4 This key is disabled.

F5 (Break) Pressing Break ends communication with your system if you are using
a VXT DECterm window running over the serial communication line.

Pressing F5 (Break) has no effect on LAT, TCP/IP, or DECnet
connections.

Shift F5 Pressing Shift F5 (Break) performs a disconnect on any VXT DECterm
window session (LAT, TCP/IP, DECnet, or serial line). A disconnect is
normally used to end communication with a modem in preparation for
another call.

Ctrl F5 Pressing Ctrl F5 (Break) sends the answerback message to the system
using LAT, TCP/IP, DECnet, or the serial line.

Note

Ctrl F5 (Break) sends the answerback message
even if you set the Conceal Answerback
Message feature in the VXT DECterm
Keyboard Options dialog box (Section 8.6).

User-Defined Keys and Application-Specific Keys

The function of the remaining top-row keys, F6 to F20 , often depends on
your application software. Refer to your application software manuals for a
description of key functions. You can also define the function of these keys
yourself.

F6 to F20 When pressed alone, these keys send predefined programming
sequences to the host system. Applications that recognize these
sequences can use the keys to perform various functions.

In VT100 and VT52 modes
Keys F11 , F12 , and F13 send control characters ESC, BS, and LF
respectively. Keys F6 to F10 and F14 to F20 do not function.
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Shift F6

to
Shift 20

User-defined keys (UDKs)
Pressing Shift and one of these keys sends the user-defined function
for that key. You can define keys F6 to F20 by using programming
sequences. You can use any sequence of characters in your definitions.
Definitions are loaded from the host system. See the VT320
Programmer Reference Manual for details.

15.1.7 Data Processing Keys

Most versions of the keyboard have some keys with characters on the left half
and right half of their keycap. Normally, you use the characters on the left half
of the key. These are called typewriter characters. The characters on the right
half are for data processing use.

You can set these keys to send their typewriter or data processing characters,
by choosing the keyboard mode. See Section 3.3.

For the following keyboard types, the typewriter and data processing settings
are identical:

• North American and Dutch

• When using 8-bit multinational characters: British, German, and
Portuguese

If you use 7-bit national replacement character sets (NRCs), make sure you
have chosen the correct NRC to match your keyboard. All data processing
keyboards, regardless of language, expect the U.S. ASCII character set to be
chosen. See Section 8.7.

# £ Key

The North American/United Kingdom standard keyboard has only one key with
three characters.

To use the £ symbol, you choose the British Keyboard type in the Customize
Keyboard dialog box (Section 3.3). To use the # symbol, you choose the North
American Keyboard type. There are no separate data processing legends on
the North American/United Kingdom keyboard.

15.1.8 Compose Characters

You can type compose sequences to display many more characters than those
shown on the keycaps. For example, you can display accented letters. See
Section 15.6.
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15.1.9 Text-Editing Functions

You can use the following key sequences to move the cursor or delete text in
most applications.

To move . . . Press . . .

To the next word Shift !
To the previous word Shift  
To the beginning of the line F12 or Ctrl H

To the end of the line Shift F12 or Ctrl E

To delete . . . Press . . .

The characters to the left of the cursor, up to and including
the beginning of the word

F13 or Ctrl J

The characters to the right of the cursor, up to and including
the end of the word

Shift F13

The character to the left of the cursor and move all text to
the right of the deleted character one space to the left

<x

The character to the right of the cursor and move all text to
the right of the deleted character one space to the left

Shift <x

All characters to the start of the line Ctrl U

15.1.10 Indicator Lights

The keyboard has two indicator lights that work with the F1 (Hold) and lock
keys. The indicator lights are at the upper-left of the keyboard.

Turns on or off when you press the F1 (Hold) key.

Turns on or off when you press the lock key.

15.1.11 Audible Indicators

The keyboard has two audible indicators, a keyclick and a bell. You can use
the bell as a margin bell, warning bell, or both. You can turn off the keyclick
and bell, or adjust their volume. See the Customize Keyboard dialog box
(Section 3.3).
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15.1.12 Keyclick

You hear the keyclick sound each time you press a key that sends a code or
causes the terminal to take some immediate action. Shift and Ctrl never click.
If a key is autorepeating, the keyclick will repeat once for each character or
key sequence sent. You can turn off the keyclick in the Customize Keyboard
dialog box.

15.1.13 Bell

The bell tone is a beeping sound. You can use the bell as a margin bell,
warning bell, or both.

Margin Bell

This bell sounds when the cursor is eight characters from the right margin.

Warning Bell

This bell sounds for any of the following conditions:

• During the power-up self-test

• When the terminal receives a bell (BEL) character from the host system

• After a compose character error

• After pressing a key for a character that is not available in the current
character set

15.2 Short ANSI Keyboard

The short ANSI keyboard is a compact version of the ANSI keyboard, for those
who make little use of auxiliary editing and numeric keypads. Most keys
on the short ANSI keyboard work the same way as on the ANSI keyboard.
This section describes how the short ANSI keyboard differs from the ANSI
keyboard.

The short ANSI keyboard is only available in the North American/United
Kingdom version. The keyboard has three groups of keys. The keys are
grouped by function.

The keyboard also has two audible indicators, a keyclick and bell.
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15.2.1 Main Keypad

The layout of the main keypad is similar to the ANSI keyboard, but includes
an Extend key. The Extend key lets you enter the same keystrokes as the
keypad and function keys found on the longer ANSI keyboard.

15.2.2 Using Extend Key Sequences for Keypad and Function Keys

You can use two-stroke Extend key sequences to perform the same functions as
the following keys that are on the longer ANSI keyboard:

• F11 to F20

• Editing keypad

• Numeric keypad

These functions are printed on the front of certain keys on the short ANSI
keyboard. For example, the P key also serves as the Select editing key. To
access this second function, you press the Extend key first. The following table
lists all the two-stroke Extend key sequences:
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To Select ... Press ... To Select ... Press ...

Top-Row Function Keys

F11 to
F20

Extend F1 to
Extend F10

Editing Keypad Keys

Find Extend 0 Select Extend P

Insert Extend - Prev Extend {

Remove Extend = Next Extend }

Numeric Keypad Keys

PF1 Extend 6 4 Extend H

PF2 Extend 7 5 Extend J

PF3 Extend 8 6 Extend K

PF4 Extend 9 , Extend L

7 Extend Y 1 Extend N

8 Extend U 2 Extend M

9 Extend I 3 Extend ,

- Extend O . Extend .

0 Extend space
bar

Special-Function Keys

The main keypad has the same special-function keys as the ANSI keyboard.
The only difference from the ANSI keyboard is the Extend key.

Extend front Pressing a two-stroke Extend sequence lets you perform the same
functions as the following keys on the longer ANSI keyboard: F11 to
F20 , editing keypad, and numeric keypad. Functions are printed on
the front of short ANSI keys.
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Extend

right Shift

Pressing the Extend and right Shift keys puts the keyboard in caps
lock mode or shift lock mode. You can select the mode from the
Customize Keyboard dialog box (Section 3.3). The default setting is
Caps Lock.

• In caps lock mode, the alphabetic keys send their uppercase or
shifted character when pressed alone. You can use a Shift key to
send the shifted character on other keys. You turn Caps Lock
mode on and off by pressing the Extend and right Shift keys.

• In shift lock mode, all keys on the main keypad send their
shifted character. You can turn shift lock mode on by pressing
the Extend and right Shift keys. You can turn it off by pressing
either the Extend and right Shift keys or the Shift key.

The ` ~ key and < > key work the same way as on the ANSI keyboard, but the
keycap legends are slightly different.

~
LJ-01471-TI0

ESC Pressing this key normally sends the ` or ~ character.

You can also use this key to send the escape (ESC) control character,
by choosing the Tilde Key Sends ESC button in the VXT DECterm
Keyboard Options dialog box (Section 8.6).

~>
<L

J
-0

1
4

7
3

-T
I0 If you use the ` ~ key to send the ESC character, you may want to

use the <> key to send the ` and ~ characters. To do this, choose the
Angle Bracket Key Sends ‘~ in the VXT DECterm Keyboard Options
dialog box (Section 8.6).

15.2.3 Arrow Keys

The four arrow keys work the same as on the ANSI keyboard.

If you press Ctrl Shift F3 , you can use the editing keypad to perform some
mouse functions. In this mode, the arrow keys move the mouse pointer. The
Select , Prev , and Next keys correspond to the three mouse buttons. The mouse
continues to operate. There is no indication the mode is on, but the arrow keys
will not work for normal editing functions.

To turn this mode off, press Ctrl Shift F3 again.

15.2.4 Top-Row Function Keys

Predefined Keys

The first five top-row keys, F1 to F5 , have the same predefined functions as on
the ANSI keyboard.
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User-Defined Keys and Application-Specific Keys

As on the ANSI keyboard, the function of the remaining top-row keys, F6 to
F10 and Extend F1 to Extend F10 , often depends on your application software.
Refer to your application software manuals for a description of key functions.
You can also define the function of these keys yourself.

F6 to F10

and
Extend F1 to
Extend F10

When pressed, these keys send predefined programming
sequences to the host system. Applications that recognize
these sequences can use the keys to perform various
functions.

In VT100 and VT52 modes
Keys Extend F1 , Extend F2 , and Extend F3 send control
characters ESC, BS, and LF respectively. Keys F6 to F10 and
Extend F4 to Extend F10 do not function.

Note

You can use the ` ~ key to send
the ESC character. See the VXT
DECterm Keyboard Options dialog
box in Section 8.6.

Shift F6

to
Shift F10

and
Shift Extend F1

to
Shift Extend F10

User-defined keys (UDKs)
Pressing Shift and one of these key sequences sends the
user-defined function for that key. You can define keys F6 to
Extend F10 by using programming sequences. You can use
any sequence of characters in your definitions. Definitions are
loaded from the host system.

# £ Key

This key works the same way as on the ANSI keyboard.

To use the £ symbol, you select the British Keyboard setting in the Customize
Keyboard dialog box (Section 3.3). To use the # symbol, you select the North
American Keyboard setting.

15.2.5 Compose Characters

The Compose keys work the same as the Compose Character keys on the ANSI
keyboard.

You can type compose sequences to display many more characters than those
shown on the keycaps. For example, you can display accented letters. See
Section 15.6.
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15.2.6 Indicator Lights

The short ANSI keyboard does not have indicator lights.

15.2.7 Audible Indicators

The short ANSI keyboard has the same two audible indicators as the ANSI
keyboard, a keyclick and a bell. You can use the bell as a margin bell, warning
bell, or both. You can turn off the keyclick and bell, or adjust their volume.
See the Customize Keyboard dialog box (Section 3.3).

15.3 The PC Keyboard

You can use Digital’s LK443 or LK444 PC keyboards with a VXT 2000
windowing terminal. The terminal does not support other PC keyboards.

You can operate the PC keyboard as a PC keyboard or as an ANSI keyboard
(Section 15.1). This chapter describes using the PC keyboard keys in both
modes.

15.3.1 PC Keyboard Models—Setting the Keyboard Type

There are two PC keyboards, a worldwide model (LK443) and a North
American model (LK444). This section shows the North American model.

• The North American model has 101 keys.

• The worldwide model has 102 keys. The worldwide model comes in the
following versions, for use in different countries.

Belgium
Denmark
France

Germany
Italy
Norway

Portugal
Spain
Sweden

Switzerland
United Kingdom

When you start up the terminal with a PC keyboard connected, the terminal
uses the North American PC keymap by default. To choose the keymap for
one of the worldwide models, change the Customize Keyboard Type to the
appropriate country (Section 3.3).

15.3.2 Using the ANSI Keyboard Layout

To switch from a PC keymap to an ANSI keymap, select one of the LK401
keyboard types (Section 3.3). When you switch to an ANSI keymap, the
keyboard keys work like the keys on that ANSI keyboard. For example,
if you have the LK443 North American PC keyboard, you might switch to
the NORTH_AMERICAN_LK401AA keymap. To switch back to the North
American PC keymap, you would choose the PC_US_LK443AA keymap.
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The PC keyboard does not have the following keys, which appear on the ANSI
keyboard: F16 Do, F17 , F18 , F19 , F20 , and the - hyphen key on the numeric
keypad. Applications that use these keys may not work properly with the PC
keyboard, unless the applications provide alternate keystrokes.

15.3.3 Layout

The PC keyboard has four groups of keys and three indicator lights. The keys
are grouped by function. The PC keyboard also has two audible indicators, a
keyclick and bell.
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15.3.4 Main Keypad

The layout of the main keypad is similar to a typewriter keyboard, with
alphanumeric characters, punctuation marks, and Shift keys. The main keypad
also has a number of keys not found on a typewriter, such as the Ctrl and Alt

modifier keys.

Modifier keys are pressed in combination with another key, to modify the
code sent by that key. Prefix keys are pressed and released before pressing
another key, to change the function of one or more keystrokes.
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Special-Function Keys

The main keypad and top row have the following special-function keys:

Tab Pressing Tab moves the cursor to the next tab stop.

Ctrl Holding down Ctrl and pressing another key sends a control code to
the host.

For example, Ctrl Z means to hold down Ctrl and press the Z key.

Caps Lock Pressing the Caps Lock key puts the keyboard in caps lock mode
or shift lock mode. You can select the mode from the Customize
Keyboard dialog box (Section 3.3). The default setting is Caps Lock
mode.

• In Caps Lock mode, the alphabetic keys send their uppercase or
shifted character when pressed alone. You can use a Shift key to
send the shifted characters on other keys. You turn Caps Lock
mode on and off by pressing the Caps Lock key.

• In Shift Lock mode, all keys on the main keypad send their
shifted character. You can turn Shift Lock mode on by pressing
the Caps Lock key. You can turn it off by pressing either the
Caps Lock key or the Shift key.

Shift Holding down a Shift key and pressing a standard key generates the
uppercase character on the key.

Enter Pressing Enter sends a carriage return to the host, which usually
puts the cursor either at the beginning of the next line or at the
beginning of the same line.

Pressing Enter normally moves the cursor to the beginning of the
next line.

 Backspace Pressing  Backspace deletes one character to the left of the
cursor.

Space bar Pressing the space bar adds a space character. You use spaces to
separate words or move the cursor forward.

Alt Alt is used to generate characters or alternate functions that do not
appear as standard keys on your PC keyboard. You can use Alt with
another key to generate additional codes, or with the function keys
to generate a third-level function for the key. See Section 15.1.8.

When you select the North American keyboard type, both Alt keys
work the same.

AltGr

(right)
You use AltGr with Janus-faced or front-faced keys to generate the
third character on a keycap. The North American PC keyboard does
not have an AltGr key.
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15.3.5 Janus-Faced and Front-Faced Character Keys

All PC keyboards, except the North American and United Kingdom, have
keycaps with more than two characters. In most cases, the third character
is on the top of the keycap, to the right of the first character. These keys are
called Janus-faced character keys. In other cases the extra characters are on
the front of the keycap. These keys are called front-faced character keys.

To display the third character on a Janus-faced or front-faced key:

• Press AltGr and the selected key.

15.3.6 Editing Keypad

The editing keypad has four arrow keys and six editing keys.

Pressing an arrow key normally moves the cursor in the direction of the arrow.
For example, pressing the # key moves the cursor down one line.

You can use the editing keys in several ways:

• For panning up or down a page, or for changing the size of a window on
the screen.

• For special functions defined by the application software.

15.3.7 Numeric Keypad

You can use the numeric keypad to enter numbers and arithmetic operators.
If you use an MS–DOS emulator, you can also use the numeric keypad as a
cursor keypad. You press the Num Lock key to change from a numeric to a
cursor keypad and back. In cursor keypad mode, the arrow keys and the Home

key work exactly like the arrow keys on the editing keypad.

15.3.8 Top-Row Function Keys

The top-row keys perform the following functions:

F1 to F5 These keys perform the same functions as on the ANSI keyboard
(Predefined Keys).

F6 to F12 Your application software defines the functions of these keys. See
your application manual for details.

Esc Pressing Esc begins a control sequence.

The function of the Print Screen , Scroll Lock , and Pause keys depends on your
operating system environment and the keyboard type selected in the Customize
Keyboard dialog box. In an MS–DOS environment (MS–DOS emulation):
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Print Screen Prints the screen.

Scroll Lock Stops the screen from scrolling.

Pause Stops or cancels a command.

In a non MS–DOS environment, the function of Print Screen , Scroll Lock , and
Pause is application-specific.

When you change the keyboard type to an LK401 ANSI keymap:

• F13 becomes the Print Screen key.

• F14 becomes the Scroll Lock key.

• Help (F15) becomes the the Pause key.

15.3.9 Audible Indicators

The PC keyboard has two audible indicators, a keyclick and a bell. You can use
a margin bell, warning bell, or both. See Section 3.3.

15.3.10 Keyclick

You hear the keyclick sound each time you press a key that sends a code or
causes the terminal to take some immediate action. If a key is autorepeating,
the keyclick will repeat once for each character or key sequence sent. Keys do
not click under the following conditions:

• You press Shift , Ctrl , or Alt . These keys never click except when Shift is
leaving the shift-lock state.

• You disable the Keyclick Volume in the Customize Keyboard dialog box
(Section 3.3).

• You press a key or key combination that does not have a function under the
current operating conditions.

15.3.11 Bell

The bell tone is a beeping sound. You can use the bell as a margin bell,
warning bell, or both.

Margin Bell

This bell sounds when the cursor is eight characters from the right margin.
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Warning Bell

This bell sounds for any of the following conditions:

• During the power-up self-test

• When the terminal receives a bell (BEL) character from the host system

• After a compose character error

15.3.12 Redefining Keys

You can use the X application xmodmap to modify key definitions.
Section 15.3.13 lists the default key definitions. Each key on the keyboard
sends a unique keycode to the terminal, and each keycode is assigned a key
symbol. The applications that you use perform actions based on key symbols.

To change a key’s function, you redefine the key by changing the key symbol.
For example, if you wanted to redefine the Insert key to work like the Find key,
you would look up the keycode for the Insert key in the Section 15.3.13. Then
you would assign the key symbol Find to that keycode by using the xmodmap
program.

For UNIX, ULTRIX, and DEC OSF/1 AXP systems

Here is the command format for redefining a key:

% xmodmap -e "keycode 0x keycode = key_symbol"

Examples

• To define the Insert key to work like the Find key:

% xmodmap -e "keycode 0x8A = Find"

• To make the Insert key work normally again:

% xmodmap -e "keycode 0x8A = Insert"

For OpenVMS systems

Note

The xmodmap program is available for systems using a DECwindows
Motif version later than Version 1.1.

First, define a logical name (like xmodmap) pointing to the xmodmap
executable image on your system. For example:

$ xmodmap:==$DECW$UTILS:XMODMAP.EXE
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Here is the command format for redefining a key:

$ xmodmap -e "keycode 0xkeycode = key_symbol"

Examples

• To define the Insert key to work like the Find key:

$ xmodmap -e "keycode 0x8A = Find"

• To make the Insert key work normally again:

$ xmodmap -e "keycode 0x8A = Insert"

15.3.13 PC Keyboard Keycodes and Symbol Assignments

Table 15–1 lists the key labels, keycodes, and key symbols for each key on the
North American PC keyboard.

Table 15–1 PC Keyboard Keycodes and Symbol Assignments

Key
Label

Key
Code

Key
Symbol

Shifted Key
Symbol

Main Keypad Keys

" Shift AB Shift_R
Alt AC Alt_L
Ctrl AD Control_R
" Shift AE Shift_L
Ctrl AF Control_L
Caps Lock B0 Caps_Lock
Alt Gr B2 Alt_R
 Backspace BC Delete
Enter BD Return
Tab BE Tab
‘ ~ BF quoteleft asciitilde
1 ! C0 1 exclam
Q C1 Q
A C2 A
Z C3 Z
2 @ C5 2 at
W C6 W
S C7 S
X C8 X
3 # CB 3 numbersign

(continued on next page)
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Table 15–1 (Cont.) PC Keyboard Keycodes and Symbol Assignments

Key
Label

Key
Code

Key
Symbol

Shifted Key
Symbol

Main Keypad Keys

E CC E
D CD D
C CE C
4 $ D0 4 dollar
R D1 R
F D2 F
V D3 V
Spacebar D4 Space
5 % D6 5 percent
T D7 T
G D8 G
B D9 B
6 ^ DB 6 asciicircum
Y DC Y
H DD H
N DE N
7 & E0 7 ampersand
U E1 U
J E2 J
M E3 M
8 * E5 8 asterisk
K E7 K
, < E8 comma less
9 ( EA 9 parenleft
O EB O
L EC L
. > ED period greater
0 ) EF 0 parenright
P F0 P
; : F2 semicolon colon
/ ? F3 slash question
= + F5 equal plus
] } F6 bracketright braceright
\ | F7 backslash bar

(continued on next page)
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Table 15–1 (Cont.) PC Keyboard Keycodes and Symbol Assignments

Key
Label

Key
Code

Key
Symbol

Shifted Key
Symbol

Main Keypad Keys

- _ F9 minus underscore
[ { FA bracketleft braceleft
’ " FB quoteright quotedbl

Editing and Arrow Keypad Keys

Insert 8A Insert
Home 8B Home
Page Up 8C Prior
Delete 8D Delete
End 8E End
Page Down 8F Next
 A7 Left
! A8 Right
# A9 Down
" AA Up

Top-Row Function Keys

Esc 55 Escape
F1 56 F1
F2 57 F2
F3 58 F3
F4 59 F4
F5 5A F5
F6 64 F6
F7 65 F7
F8 66 F8
F9 67 F9
F10 68 F10
F11 71 F11
F12 72 F12
Print Screen 73 Print
Scroll Lock 74 Scroll_Lock
Pause 7C Pause

(continued on next page)
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Table 15–1 (Cont.) PC Keyboard Keycodes and Symbol Assignments

Key
Label

Key
Code

Key
Symbol

Shifted Key
Symbol

Numeric Keypad Keys

0 92 KP_0
. 94 KP_Decimal
Enter 95 KP_Enter
1 96 KP_1
2 97 KP_2
3 98 KP_3
4 99 KP_4
5 9A KP_5
6 9B KP_6
+ 9C KP_Add
7 9D KP_7
8 9E KP_8
9 9F KP_9
Num Lock A1 Num_Lock
/ A2 KP_Divide
* A3 KP_Multiply
- A4 KP_Subtract
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15.4 The Sun Style Keyboard

This section describes the Sun style keyboard (LK460) for the VXT 2000
windowing terminal. The Sun style keyboard comes in a North American
model (101 keys) only.

When you start up the terminal with a Sun style keyboard connected, the
terminal automatically chooses the Sun style keyboard map. To choose
the keymap for another keyboard model, change the Keyboard Type in the
Customize Keyboard dialog box (Section 3.3).

15.4.1 Layout

The Sun style keyboard has four groups of keys and four indicator lights. The
keys are grouped by function. The Sun style keyboard also has two audible
indicators, a keyclick and bell.
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15.4.2 Main Keypad

The layout of the main keypad is similar to a typewriter keyboard, with
alphanumeric characters, punctuation marks, and Shift keys. The main keypad
also has a number of keys not found on a typewriter, such as the Control and
Alt modifier keys.

Modifier keys are pressed in combination with another key, to modify the
code sent by that key. Prefix keys are pressed and released before pressing
another key, to change the function of one or more keystrokes.

Special-Function Keys

The main keypad and top row have the following special-function keys:

Esc Pressing Esc begins a control sequence.

Tab Pressing Tab moves the cursor to the next tab stop.

Control Holding down Control and pressing another key sends a control code
to the host.

For example, Control Z means to hold down Control and press the
Z key.

Shift Holding down a Shift key and pressing a standard key generates the
uppercase character on the key.

Caps Lock Pressing the Caps Lock key puts the keyboard in caps lock mode
or shift lock mode. You can select the mode from the Customize
Keyboard dialog box (Section 3.3). The default setting is Caps Lock
mode.

• In Caps Lock mode, the alphabetic keys send their uppercase or
shifted character when pressed alone. You can use a Shift key to
send the shifted characters on other keys. You turn Caps Lock
mode on and off by pressing the Caps Lock key.

• In Shift Lock mode, all keys on the main keypad send their
shifted character. You can turn Shift Lock mode on by pressing
the Caps Lock key. You can turn it off by pressing either the
Caps Lock key or the Shift key.

Return Pressing Return sends a carriage return to the host, which usually
puts the cursor either at the beginning of the next line or at the
beginning of the same line.

Pressing Return normally moves the cursor to the beginning of the
next line.

 Backspace Pressing  Backspace moves the cursor one character to the left.
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Space bar Pressing the space bar adds a space character. You use spaces to
separate words or move the cursor forward.

} You use } instead of Alt in key sequences for VXT 2000 functions.
For example, you press Ctrl } Del to reboot the terminal. If you
use the keyboard instead of the mouse to navigate windows, use }
instead of Alt in key sequences (Section 15.5).

Alt You use Alt key sequences to generate added characters or functions.
To compose added characters, see Section 15.1.8. When you use Alt

with certain function keys, you generate a third-level function for
the key.

Alt Graph You use Alt Graph with Janus-faced or front-faced keys to generate
the third character on a keycap.

15.4.3 Editing Keypad

The 11 editing keys generally perform functions defined by application
software. See your Sun system documentation.

15.4.4 Numeric Keypad

You can use the numeric keypad to enter numbers and arithmetic operators.
You can also use the numeric keypad as a cursor keypad. You press the
Num Lock key to change from a numeric to a cursor keypad and back.

In cursor keypad mode, you can use arrow key functions. Pressing an arrow
key normally moves the cursor in the direction of the arrow. For example,
pressing the # key moves the cursor down one line. Other keys let you

• Pan up or down a page

• Change the size of a window on the screen

• Perform functions defined by your application software

The numeric keypad also includes special-function keys. The function of
the PrSc , Scroll Lock , and Pause keys depends on your operating system
environment and the keyboard type selected. When using the Open Look
window manager:

PrSc Prints the screen.

Scroll Lock Stops the screen from scrolling.

Pause Stops or cancels a command.

Num Lock Changes numeric keypad to a cursor keypad.
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15.4.5 Top-Row Function Keys

The top-row keys perform the following functions:

Delete Pressing Delete deletes one character to the left of the cursor.

15.4.6 Audible Indicators

The Sun style keyboard has two audible indicators, a keyclick and a bell. You
can use a margin bell, warning bell, or both.

15.4.7 Keyclick

You hear the keyclick sound each time you press a key that sends a code or
causes the terminal to take some immediate action. If a key is autorepeating,
the keyclick will repeat once for each character or key sequence sent. Keys do
not click under the following conditions:

• You press Shift , Control , or Alt . These keys never click except when Shift is
leaving the shift-lock state.

• You disable the Keyclick Volume in the Customize Keyboard dialog box
(Section 3.3).

• You press a key or key combination that does not have a function under the
current operating conditions.

15.4.8 Bell

The bell tone is a beeping sound. You can use the bell as a margin bell,
warning bell, or both.

Margin Bell

This bell sounds when the cursor is eight characters from the right margin.

Warning Bell

This bell sounds for any of the following conditions:

• During the power-up self-test

• When the terminal receives a bell (BEL) character from the host system

• After a compose character error
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15.4.9 Redefining Keys

You can use the X application xmodmap to modify key definitions.
Section 15.4.10 lists the default key definitions. Each key on the keyboard
sends a unique keycode to the terminal, and each keycode is assigned a key
symbol. The applications that you use perform actions based on key symbols.

To change a key’s function, you redefine the key by changing the key symbol.
For example, if you wanted to redefine the Insert key to work like the Find key,
you would look up the keycode for the Insert key in the Section 15.4.10. Then
you would assign the key symbol Find to that keycode by using the xmodmap
program.

Here is the command format for redefining a key using its keycode:

% xmodmap -e "keycode 0x keycode = key_symbol"

Examples

• To define the Insert key to work like the Find key:

% xmodmap -e "keycode 0x8A = Find"

• To make the Insert key work normally again:

% xmodmap -e "keycode 0x8A = Insert"

You can also redefine a key by looking up its key symbol and assigning a new
key symbol. However, make sure the key symbol you choose performs the
expected function. In other words, make sure that a new keycode was not
assigned to the key symbol. Here is the format for assigning a new key symbol:

% xmodmap -e "keysym old_key_symbol = new_key_symbol"

Example

To define the Backspace key to work like the Del key:

% xmodmap -e "keysym BackSpace = Delete"

15.4.10 Sun Keyboard Keycodes and Symbol Assignments

Table 15–2 lists the keycodes and key symbols for each key on the Sun style
keyboard. There are up to four key symbols for each keycode.
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Table 15–2 Sun Keyboard Keycodes and Symbol Assignments

Key
Code Key Symbols Key Symbol Valuess

8 F11 F11 Cancel ffc8 ffc8 ff69
a F12 F12 Redo ffc9 ffc9 ff66
c F1 ffbe ffbe
d F2 ffbf ffbf
e F10 ffc7 ffc7
f F3 ffc0 ffc0
10 SunXK_F36 1005ff10 1005ff10
11 F4 ffc1 ffc1
12 SunXK_F37 1005ff11 1005ff11
13 F5 ffc2 ffc2
14 Mode_switch ff7e ff7e
15 F6 ffc3 ffc3
17 F7 ffc4 ffc4
18 F8 ffc5 ffc5
19 F9 ffc6 ffc6
1a Alt_L ffe9 ffe9
1c F21 F21 Pause ffd2 ffd2 ff13
1d F22 F22 Print ffd3 ffd3 ff61
1e F23 F23 Scroll_Lock Break ffd4 ffd4 ff14 ff6b
20 F13 F13 SunXK_Props ffca ffca 1005ff70
21 F14 F14 Undo ffcb ffcb ff65
24 Escape ff1b ff1b
25 1 exclam 31 21 31 21
26 2 at 32 40 32 40
27 3 numbersign 33 23 33 23
28 4 dollar 34 24 34 24
29 5 percent 35 25 35 25
2a 6 asciicircum 36 5e 36 5e
2b 7 ampersand 37 26 37 26
2c 8 asterisk 38 2a 38 2a
2d 9 parenleft 39 28 39 28
2e 0 parenright 30 29 30 29
2f minus underscore 2d 5f 2d 5f
30 equal plus 3d 2b 3d 2b
31 grave asciitilde 60 7e 60 7e
32 BackSpace ff08 ff08
34 F24 F24 KP_Equal ffd5 ffd5 ffbd
35 F25 F25 KP_Divide ffd6 ffd6 ffaf

(continued on next page)
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Table 15–2 (Cont.) Sun Keyboard Keycodes and Symbol Assignments

Key
Code Key Symbols Key Symbol Valuess

36 F26 F26 KP_Multiply ffd7 ffd7 ffaa
38 F15 F15 SunXK_Front ffcc ffcc 1005ff71
39 Delete Delete KP_Decimal ffff ffff ffae
3a F16 F16 SunXK_Copy ffcd ffcd 1005ff72
3c Tab ff09 ff09
3d Q 71 51 71 51
3e W 77 57 77 57
3f E 65 45 65 45
40 R 72 52 72 52
41 T 74 54 74 54
42 Y 79 59 79 59
43 U 75 55 75 55
44 I 69 49 69 49
45 O 6f 4f 6f 4f
46 P 70 50 70 50
47 bracketleft braceleft 5b 7b 5b 7b
48 bracketright braceright 5d 7d 5d 7d
49 Delete ffff ffff
4a Multi_key ff20 ff20
4b F27 F27 KP_7 Home ffd8 ffd8 ffb7 ff50
4c Up F28 KP_8 ff52 ffd9 ffb8
4d F29 F29 KP_9 Prior ffda ffda ffb9 ff55
4e KP_Subtract ffad ffad
4f F17 F17 SunXK_Open ffce ffce 1005ff73
50 F18 F18 SunXK_Paste ffcf ffcf 1005ff74
53 Control_L ffe3 ffe3
54 A 61 41 61 41
55 S 73 53 73 53
56 D 64 44 64 44
57 F 66 46 66 46
58 G 67 47 67 47
59 H 68 48 68 48
5a J 6a 4a 6a 4a
5b K 6b 4b 6b 4b
5c L 6c 4c 6c 4c
5d semicolon colon 3b 3a 3b 3a
5e apostrophe quotedbl 27 22 27 22
5f backslash bar brokenbar 5c 7c a6

(continued on next page)
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Table 15–2 (Cont.) Sun Keyboard Keycodes and Symbol Assignments

Key
Code Key Symbols Key Symbol Valuess

60 Return ff0d ff0d
61 KP_Enter ff8d ff8d
62 Left F30 KP_4 ff51 ffdb ffb4
63 F31 F31 KP_5 ffdc ffdc ffb5
64 Right F32 KP_6 ff53 ffdd ffb6
65 Insert Insert KP_0 ff63 ff63 ffb0
66 F19 F19 Find ffd0 ffd0 ff68
68 F20 F20 SunXK_Cut ffd1 ffd1 1005ff75
69 Num_Lock ff7f ff7f
6a Shift_L ffe1 ffe1
6b Z 7a 5a 7a 5a
6c X 78 58 78 58
6d C 63 43 63 43
6e V 76 56 76 56
6f B 62 42 62 42
70 N 6e 4e 6e 4e
71 M 6d 4d 6d 4d
72 comma less 2c 3c 2c 3c
73 period greater 2e 3e 2e 3e
74 slash question 2f 3f 2f 3f
75 Shift_R ffe2 ffe2
76 Linefeed ff0a ff0a
77 R13 R13 KP_1 End ffde ffde ffb1 ff57
78 Down F34 KP_2 ff54 ffdf ffb2
79 F35 F35 KP_3 Next ffe0 ffe0 ffb3 ff56
7d Help ff6a ff6a
7e Caps_Lock ffe5 ffe5
7f Meta_L ffe7 ffe7
80 space 20 20
81 Meta_R ffe8 ffe8
84 KP_Add ffab ffab
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15.5 Using the Keyboard Instead of the Mouse

This section describes how to use the keyboard to navigate through windows
and choose items from menus and dialog boxes. You will find this section
useful if you prefer using the keyboard rather than the mouse, or if your mouse
is not working.

Sun Style Keyboard: Use } Instead of Alt

On the Sun style keyboard, use } instead of Alt in keyboard navigation
sequences.

15.5.1 Using the Editing Keypad to Perform Mouse Functions

When you enable the editing keypad to perform mouse functions, you can still
use your mouse. There is no indication the mode is on, but you cannot use the
arrow keys for normal editing functions.

To... Press...

Enable the editing keypad to perform mouse
functions.

Ctrl Shift F3

Move the mouse pointer " , # ,  , !
Perform MB1 functions Select

Perform MB2 functions Prev

Perform MB3 functions Next

Disable the editing keypad from performing
mouse functions.

Ctrl Shift F3 again

15.5.2 Using Menu Bars and Pull-Down Menus

To... Press...

Move to the first menu in a menu bar F10

Pull down a menu from the menu bar Alt mnemonic �

Move to the next menu item in a pull-down menu " or #
Move to another menu in the menu bar  or !
Move from one pull-down menu to the preceding
menu on the left in the menu bar

 , Ctrl  , or Ctrl "

�The underlined character in the menu name
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To... Press...

Move from one pull-down menu to the next menu
on the right in the menu bar

! , Ctrl ! , or Ctrl #

Choose a menu item Return , Ctrl Return , or Enter

Remove a menu, leaving the cursor on the menu
name

F11 (ESC)

Move the cursor from the menu bar to where
it was before you started using the menu bar
(explicit focus policy), or

Move the cursor from the menu bar to wherever
the pointer is located (implicit focus policy)

F11 (ESC)

Remove all displayed menus F10

15.5.3 Using Pop-Up Menus
To... Press...

Display a pop-up menu F4

Move to the next menu item in a pop-up menu " or #
Display a submenu from a pop-up menu item !
Choose a menu item Return , Ctrl Return , or Enter

Remove the displayed menu F11 (ESC)

Dismiss the menu F4

15.5.4 Using Submenus

To... Press...

Display a submenu Any of these:

Arrow key (in direction of
submenu), Ctrl arrow key, Return ,
Ctrl Return , or Enter

Choose a menu item Return , Ctrl Return , or Enter

Choose the default entry in a submenu Alt mnemonic �

Move to another menu item in a submenu " or #
Remove the submenu and move back to the
parent menu

 

�The underlined character in the menu name
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To... Press...

From the submenu to the parent menu  , Ctrl  , or Ctrl "
Move from the parent menu to the default menu
item in the associated submenu

! , Ctrl ! , or Ctrl #

15.5.5 Navigating Windows

This section describes how to use your keyboard to move between and within
windows.

Moving Between Windows

To move between groups of windows:

To move... Press...

From one group of windows to another Alt Tab or Alt F11 �

From one minimized window to another when the
minimized windows are not in an icon box

Alt Tab or Alt F11 �

From one minimized window to another in an
icon box

Arrow keys

Within a group of windows Alt F6

To the previous group of windows Alt Shift F11 or Alt Shift Tab

To move between minimized windows in an icon
box

Arrow keys

�If you use the mouse pointer to make windows active (Section 12.3), you cannot use the Alt Tab

or Alt F11 functions.

15.5.6 Miscellaneous

To ... Press...

Pop up the window menu of a minimized window
when that window is in an icon box.

F4

Restore a minimized icon box Alt F5 or Return

Moving Within Windows

To move within menus:
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To ... Press...

Focus on the menu bar F10

Pull down the window menu Alt+space bar or Shift F11

Move from one tab group to another Tab

To choose items in the window menu:

To ... Press...

Lower a window to the bottom of the window
stack

Alt F3

Close (not minimize) a window Alt F4

Restore a minimized window Alt F5

Move a window Alt F7

Size a window Alt F8

Minimize a window Alt F9

Maximize a window Alt F10

To move a window around the screen:

1. Press Alt F7 .

2. Use the arrow keys to move the window in the desired direction. You can
also press Ctrl + arrow keys to move the window several pixels at a time.

3. Press Return or Ctrl Return to finish the operation.

To size a window:

1. Press Alt F8 .

2. Press one arrow key to indicate which side of the window to size. For
example, press " for the top of the window.

You can also press two arrow keys in a row to indicate which corner to size.
For example, press "  to indicate the upper-left corner.

3. Press the arrow keys to size the window in the desired direction. You can
also press Ctrl arrow keys to size the window several pixels at a time.

4. Press Return or Ctrl Return to finish the operation.
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15.5.7 Using Dialog Boxes

To move... Press...

Forward from tab group to tab group (field to
field)

Tab or Ctrl Tab

Backward from tab group to tab group Shift Tab or Ctrl Shift Tab

From button to button in a tab group Arrow keys

To a pop-up Options menu Select , space bar, or Ctrl +space bar

To activate... Press...

The default selection in the dialog box Return , Ctrl Return , or Enter

A check or radio button in a group Select , space bar, or Ctrl +space bar

A push button in a group Select , space bar, Ctrl+space bar,
Return

A push button in a group Ctrl Return or Enter

An item in an Options menu Return , Ctrl Return , or Enter

To cancel... Press...

A dialog box or an Options menu Alt F4

15.6 Typing Additional Characters

The terminal lets you type more characters than appear on your keyboard. For
example, you can type accented characters or a © symbol. This chapter lists
the available characters and shows you how to select them.

To enter one of these characters, you type a sequence of keys. Most sequences
begin with one of the Compose Character keys. If you use the German
keyboard, you use the Group Shift key instead of Compose Character .

This chapter describes the following types of key sequences:

• Three-stroke Compose Character sequences (with all LK401 keyboards)

• Group Shift sequences (with the German keyboard)
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• Two-stroke key sequences (with keyboards that have nonspacing diacritical
keys)

• Hexadecimal key sequences (for programmers)

Two basic factors determine the key sequences you can use.

• The Keyboard Type setting, which should match your keyboard type
(Section 3.3).

• The character set the terminal is currently using (Chapter 8).

15.6.1 What Characters Can I Type?

You can type any of the characters in the character set the terminal is
currently using. You can select from two 8-bit multinational sets (DEC
Multinational or ISO Latin Alphabet No. 1) or many 7-bit national
replacement character sets (NRCs).

To choose ... Use...

The use of 8-bit multinational sets or 7-bit NRC
sets

The VXT DECterm General
Options dialog box (Section 8.5).

An 8-bit multinational set The VXT DECterm General
Options dialog box.

A 7-bit NRC set The 7-Bit NRCS Selection dialog
box (Section 8.7).

By default, the terminal uses the DEC Multinational character set. Section 8.5
describes multinational and national character sets.

15.6.2 Key Sequences with Nonspacing Diacritical Keys

Table 15–3 lists the keyboards that have keys with diacritical marks.
Table 15–4 lists all the additional characters for all character sets in the
terminal. Many of these characters include a diacritical mark. For example, Á
includes an acute accent.

To enter a character that has a diacritical mark, you press the diacritical key
followed by the character. If your keyboard does not have the diacritical key,
you must press the Compose Character key followed by the correct key sequence
listed in Table 15–4.
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To use diacritical keys, you must be using a multinational character set.

Table 15–3 Keyboards with Diacritical Marks

Keyboard
Grave
Accent

Acute
Accent

Circumflex
Accent

Tilde
Mark Umlaut

Finnish yes no yes yes no
Flemish yes no yes yes yes
French/Belgian yes no yes yes yes
French Canadian yes no yes yes no
German yes yes yes yes yes
Portuguese no no no yes no
Spanish yes yes yes yes yes
Swedish yes no yes yes no
Swiss (French) yes no yes yes yes
Swiss (German) yes no yes yes yes

15.6.3 How to Type a Character Using the Compose Character Key

To enter a Compose Character key sequence:

1. Find the character you want to type in Table 15–4.

2. Press the Compose Character key.

3. Type the sequence in Table 15–4 for the character you want.

Example

To type an é:

1. Find the é character in Table 15–4.

2. Press Compose Character .

3. Type e and ’ (apostrophe).

Note

If you try to enter a character that is not available in the current
character set, a warning bell sounds. See Section 15.6.5.
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15.6.4 How to Type a Character Using the Group Shift Key

If you select the Austrian-German keyboard type in the Customize Keyboard
dialog box (Chapter 3), the Group Shift key replaces the Compose Character key.

Many keys on the German keyboard have a second group of legends on the
right half of their keycap. These legends are called Group-2.

To enter a single character from Group-2:

1. Press and release the Group Shift key.

2. Type the key that has the desired character on the right half of the keycap.
The character appears on the screen.

Example

To type an ø:

1. Press Group Shift .

2. Type the key that has the ø character on the right half of the keycap: O ø .

To enter a series of characters from Group-2:

1. Hold down the Group Shift key.

2. Type the series of keys that have the desired characters on the right half of
their keycaps. The characters appear on the screen.

3. When you are done typing characters from Group-2, release the Group Shift

key.

15.6.5 Invalid Sequences

When you complete a valid compose or group-shift sequence, the character
appears on the screen. If you use an invalid sequence, the terminal cancels the
sequence and sounds the warning bell.

Some compose characters require that you type the key sequence in the order
listed in Table 15–4. If you do not follow the order, the sequence is invalid and
the warning bell sounds. If the terminal does not display the character, repeat
the sequence exactly as shown in Table 15–4.

Note

Pressing a function key cancels a compose or group-shift sequence
without sounding the bell.

You can turn the warning bell on or off from the Customize Keyboard
dialog box (Chapter 3).
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15.6.6 Canceling or Restarting a Key Sequence

If you accidentally start a key sequence by pressing Compose Character ,
Group Shift , or a nonspacing diacritical key, press the <x key. This immediately

cancels the sequence.

If you press Compose Character during a compose sequence, a new three-stroke
sequence starts from that point. The first sequence is canceled.

If you press any of the following keys during a key sequence, they cancel the
sequence and perform their usual function:

� Tab � Any top-row key

� Enter � Any Ctrl other key combination

15.6.7 Hexadecimal Key Sequences

This feature is primarily for programmers who are familiar with character
coding and hexadecimal representation.

The terminal uses coded character sets to exchange data with a host computer.
The code for a character can be represented by a pair of hexadecimal digits.
You can enter any 8-bit code from the terminal, by pressing Compose Character

or Group Shift then entering two hexadecimal digits on the numeric keypad.

When you press Compose Character or Group Shift , the terminal assigns
hexadecimal values to the numeric keypad keys. Here are the values assigned
to each key:

PF1 PF2 PF3 PF4

Enter

54

7 8 9
_

,
6

321

0
.

LJ-00252-TI0

Key

Name

PF1
PF2
PF3
PF4
Minus (–)
Comma (,)

Hexadecimal

Digit

A
B
C
D
E
F
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Note

The 8-Bit Multinational Characters, 7-Bit NRCS Characters, and UPSS
DEC Supplemental buttons in the VXT DECterm General Options
dialog box do not affect hexadecimal compose sequences.

Examples

• You can use a hexadecimal compose sequence to send the US (unit
separator) control character. The hexadecimal value for US is 1F.

1. Press Compose Character or Group Shift .

2. Press 1 on the numeric keypad.

3. Press , on the numeric keypad.

• You can use a hexadecimal compose sequence to send the DCS (device
control string) character. The hexadecimal value for DCS is 90.

1. Press Compose Character or Group Shift .

2. Press 9 on the numeric keypad.

3. Press 0 on the numeric keypad.

Invalid Hexadecimal Sequences

If you enter an invalid sequence, the terminal cancels the sequence and sounds
the warning bell. You can turn the warning bell on or off from the Customize
Keyboard dialog box (Chapter 3).
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Table 15–4 Key Sequences for Additional Characters

Character Sequence

" quotation mark ¨ (sp)

# number sign + +

’ apostrophe ´ (sp)

@ commercial at A A

[ opening bracket ( (

\ backslash / / or / <

] closing bracket ) )

^ circumflex accent ^ (sp)

` grave accent ` (sp)

{ opening brace ( -

| vertical line / ^

} closing brace ) -

~ tilde ~ (sp)

¡ inverted ! !!

¢ cent sign C / or C |

£ pound sign L- or L=

¥ yen sign Y- or Y=

§ section sign SO or S! or S0

¤ currency sign XO or X0

© copyright sign CO or C0

ª feminine ordinal A_

« open angle brackets < <

° degree sign 0 ^

± plus or minus sign + -

² superscript 2 2 ^

³ superscript 3 3 ^

µ micro sign / U

¶ paragraph sign P!

· middle dot . ^

(continued on next page)
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Table 15–4 (Cont.) Key Sequences for Additional Characters

Character Sequence

¹ superscript 1 1 ^

º masculine ordinal O_

» closed angle
brackets

>>

¼ fraction one-
quarter

1 4

½ fraction one-half 1 2

¿ inverted ? ??

À A grave `A

Á A acute ’A

Â A circumflex ^A

Ã A tilde ~A

Ä A umlaut ¨A or "A

Å A ring °A or *A

(degree sign)

Æ A E diphthong AE

Ç C cedilla C,

È E grave `E

É E acute ’E

Ê E circumflex ^E

Ë E umlaut ¨E or "E

Ì I grave `I

Í I acute ’I

Î I circumflex ^I

Ï I umlaut ¨I or "I

Ñ N tilde ~ N

Ò O grave `O

Ó O acute ’O

Most sequences that include diacritical marks can also be typed in reverse order.

(continued on next page)
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Table 15–4 (Cont.) Key Sequences for Additional Characters

Character Sequence

Ô O circumflex ^O

Õ O tilde ~O

Ö O umlaut ¨O or "O

Œ O E diphthong� O E

Ø O slash o /

Ù U grave `U

Ú U acute ’U

Û U circumflex ^U

Ü U umlaut ¨U or "U

Ÿ Y umlaut� ¨Y or "Y

ß German small
sharp s

ss

à a grave `a

á a acute ’a

â a circumflex ^a

ã a tilde ~a

ä a umlaut ¨a or "a

å a ring °a or a*

(degree sign)

æ a e diphthong a e

ç c cedilla c , (comma)

è e grave `e

á e acute ’e

ê e circumflex ^e

ë e umlaut ¨e or "e

ì i grave `i

í i acute ’i

î i circumflex ^i

�This character is only available when you use the DEC Multinational character set. See the VXT
DECterm General Options dialog box (Section 8.5).

(continued on next page)
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Table 15–4 (Cont.) Key Sequences for Additional Characters

Character Sequence

ï i umlaut ¨i or "i

ñ n tilde ~n

ò o grave `o

ó o acute ’o

ô o circumflex ^o

õ o tilde ~o

ö o umlaut ¨o or "o

œ o e diphthong� o e

ø o slash o /

ù u grave `u

ú u acute ’u

û u circumflex ^u

ü u umlaut ¨u or "u

ÿ y umlaut� ¨y or "y

�This character is only available when you use the DEC Multinational character set. See the VXT
DECterm General Options dialog box (Section 8.5).

(continued on next page)
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Table 15–4 (Cont.) Key Sequences for Additional Characters

Character Sequence

ISO Characters†

no break space sp sp

¦ broken vertical bar | | or ! ^

¬ logical not - ,

- soft (syllable)
hyphen

- -

® registered trade-
mark

R O

¯ macron - ^

¾ three quarters 3 4

÷ division sign - :

� multiplication sign x x

´ acute accent ’ ’

¸ cedilla , ,

¨ diaeresis ¨ (sp) or " "

Ý Y acute ’Y

ý y acute ’y

Þ capital Icelandic
thorn

T H

þ small Icelandic
thorn

t h

Ð capital Icelandic
Eth

- D

ð small Icelandic Eth - d

†These characters are only available when you use the ISO Latin Alphabet No. 1 character set.
See the VXT DECterm General Options dialog box (Section 8.5).
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Solving Problems and Getting Service

A

This appendix describes some simple operating problems you can solve
yourself. The appendix covers the following major topics:

• Operating Problems

• Power-Up Self-Test

• Digital Service Overview

A.1 Operating Problems

The following tables list some possible operating problems and suggested
solutions. If you have a problem with your terminal, check this list before
calling for service. If the problem persists and you need service, see Section A.4
in this appendix.

Table A–1, System Box, Monitor, Keyboard, Mouse, and Printer Problems
Table A–2, Booting, Server, and Network Problems
Table A–3, Session, Application, and Dialog Box Problems

Table A–1 System Box, Monitor, Keyboard, Mouse, and Printer Problems

Symptom Suggested Solution

System Box Problems

The system box fan is off. Check the power source. Make sure the power cord is
plugged in. Turn the system box’s power switch on ( | ).

Note: The VX225 and VX227 terminals do not have a
system box.

(continued on next page)
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Table A–1 (Cont.) System Box, Monitor, Keyboard, Mouse, and Printer
Problems

Symptom Suggested Solution

Monitor Problems

When you turn the terminal
on, the monitor does not
display the Terminal
Manager window after
45 seconds.

Make sure the monitor’s power switch is on ( | ).

System box models: Check the monitor cable connections
at the system box and monitor.

Adjust the monitor’s brightness and contrast controls.
See the monitor’s installation guide.

If you have a VRM17 monitor, set the scan switch to
High.

If you have customized the terminal to hide the Terminal
Manager window at startup, you can press F3 to
redisplay the Terminal Manager window.

If you have customized the terminal to not run the
terminal manager, you can start the Terminal Manager
window from the VXT Create pop-up menu. Press MB2
anywhere on the screen background to display the menu.

Check the keyboard cable connections at the terminal
and keyboard

The screen is blank, but the
terminal is on.

Check if the two keyboard lights are blinking, which
may indicate the CRT saver is on. If the CRT saver is
on, press any key to reactivate the screen.

Check if brightness and contrast controls are set
correctly.

System box models: On a
color terminal, the window
colors look wrong. The red
and blue colors appear to be
swapped.

Check the monitor’s cable connection at the back of the
system box. The cable may be plugged in upside down.

(continued on next page)
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Table A–1 (Cont.) System Box, Monitor, Keyboard, Mouse, and Printer
Problems

Symptom Suggested Solution

Keyboard Problems

The bell tone does not
sound when you turn the
terminal on. All keyboard
indicator lights are off.

Check the keyboard cable connection to the system box.

The information you type is
not displayed.

Check the hold indicator to see if the keyboard is on
hold. If the keyboard is on hold, press the F1 (Hold) key
to release the screen.

The current window may not accept input, or you may
not have activated the window. Check the window’s title
bar to see if the window has input focus.

Mouse Problems

The pointer for the mouse
or tablet does not appear on
the screen, or the pointer
does not respond to the
pointing device commands.

Turn the system box’s l O power switch off (O), then
disconnect and reconnect the mouse or tablet cable. Turn
the system box’s l O power switch on ( | ).

Replace the mouse. Until you get a new mouse, press
Ctrl Shift F3 to use the editing keypad to perform mouse
functions. See Chapter 15.

Printer Problems

The printer does not print. Turn the printer’s power switch on ( | ).

Check the printer cable connections.

Check the settings in the Customize Serial and Parallel
Ports dialog box (Section 4.2). Check that the correct
port is enabled (serial or parallel). Check that the
transmit rate, baud rate, and parity setting in the dialog
box match the printer’s settings.
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Table A–2 Booting, Server, and Network Problems

Symptom Suggested Solution

Booting Problems or Operating Failure

The monitor displays a >>>
prompt.

The >>> prompt appears when the terminal fails
operation or when you halt the terminal (by pressing the
halt button, or by pressing Ctrl C before the terminal
boots its VXT software).

Turn the terminal’s l O power switch off (O) and on
( | ) again. (On system box models, this is the switch on
the system box.)

If the terminal fails to load its software or fails operation
again, keep notes of any error messages and the
terminal’s operating state when the failure occurred.
For host-based terminals, see Section 1.5.1 to monitor
memory use.

You can also enter boot commands at the >>> prompt, to
load a specific version of VXT software (Section 5.7.5).

If you cannot correct the problem, call your Digital
Service representative with any error messages you
noted.

(continued on next page)
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Table A–2 (Cont.) Booting, Server, and Network Problems

Symptom Suggested Solution

Server-Based Terminals: Problems with Server Connections

The first time you start
the terminal, it fails to
load its VXT software
from an InfoServer system
and displays the following
message four times:

LASTport... Group code 0

The terminal does not have the same LASTport group
code as the InfoServer system. See your system manager
for the correct code. See Section 4.4 to enter a LASTport
code.

The terminal stops
operating correctly and
displays a message on the
top line of the screen.

The terminal may have lost its connection to the
InfoServer system. Wait for the connection to be
reestablished. When the connection resumes, the
message is erased, the screen is restored, and the
terminal returns to normal functions.

Contact your system manager if these messages appear
too frequently or for longer than a few seconds. If the
terminal does not recover, turn the terminal’s l O

power switch off (O) and on ( | ) again to restart the
terminal. On system box models, this is the switch on
the system box.

The terminal’s software
seems to be hanging in a
suspended state.

Reboot the terminal by pressing the following key
sequence:

ANSI keyboard – Press Ctrl +left Alt+keypad . .

PC keyboard – Press Ctrl+Alt+keypad . .

Short ANSI keyboard – Press Ctrl Alt Extend . .

Sun style keyboard – Press Ctrl } Del .

(continued on next page)
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Table A–2 (Cont.) Booting, Server, and Network Problems

Symptom Suggested Solution

Network Problems

The host system and termi-
nal do not communicate.

Check that the Ethernet cable is securely connected to
the terminal.

Make sure the port that your system cable is connected
to is active by trying a working system in the port.

If you are using a ThinWire Ethernet cable, make sure
the cable is attached to the system box by a T-connector.
Make sure there is no ThinWire segment between the
system box and the T-connector. Check if a terminator
has been removed or is connected to an active ThinWire
segment.

Server-based terminals: the
InfoServer system displays
messages at the top of the
terminal’s screen.

Communication between the InfoServer system and
terminal may have been interrupted. Wait to see if
the InfoServer system can reconnect to the terminal.
If normal operation does not resume, you may need to
reboot the terminal:

ANSI keyboard – Press Ctrl+left Alt+keypad . .

PC keyboard – Press Ctrl +Alt+keypad . .

Short ANSI keyboard – Press Ctrl Alt Extend . .

Sun style keyboard – Press Ctrl } Del .

Table A–3 Session, Application, and Dialog Box Problems

Symptom Suggested Solution

Problems Creating Sessions and VXT Applications

You cannot view the
Terminal Manager window.

If you have customized the terminal to hide the Terminal
Manager window, you can press F3 to redisplay the
Terminal Manager window.

If you have customized the terminal to not run the
terminal manager, you can start the Terminal Manager
window from the VXT Create pop-up menu. Press MB2
anywhere on the screen background to display the menu.

(continued on next page)
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Table A–3 (Cont.) Session, Application, and Dialog Box Problems

Symptom Suggested Solution

Problems Creating Sessions and VXT Applications

You cannot create sessions
with the TCP/IP transport
in the Create dialog box.
The TCP/IP button is
dimmed.

Make sure your terminal’s IP address is entered in the
Customize TCP/IP dialog box and appears at the bottom
of the Terminal Manager window. See Section 4.5.

Also, your system manager may have restricted access
to the Create menu settings by using the terminal’s
configuration manager. Ask your system manager which
of your terminal’s create and customize features are
restricted.

You cannot use the DECnet
transport to create sessions
in the Create dialog box.
The DECnet button is
dimmed.

Make sure your terminal’s DECnet address is entered
in the Customize DECnet dialog box and appears at
the bottom of the Terminal Manager window. See
Section 4.9.

Also, your system manager may have restricted access
to the Create menu settings by using the terminal’s
configuration manager. Ask your system manager which
of your terminal’s create and customize features are
restricted.

You cannot create a DECnet
X session to an OpenVMS
host from the Create dialog
box.

Make sure your system manager installed the network
object VXT$SERVER.COM on the OpenVMS host.
See VXT Software Version 2.1 Installation and System
Management.

Font Problems

Your host application fonts
display incorrectly on the
terminal.

Set the font path in the Customize Font Path dialog
box to access the fonts from your host system. List the
font path to your host system as the first entry in the
Customize Font Path dialog box (Section 5.3).

The terminal cannot access
fonts on your host system
or InfoServer system. The
VXT Message Box displays
Font not found error
messages.

Include backup font sources in the Customize Font Path
dialog box. If the primary font source is unavailable, the
terminal can find the same fonts on the backup source.

(continued on next page)
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Table A–3 (Cont.) Session, Application, and Dialog Box Problems

Symptom Suggested Solution

Problems with Customize Dialog Boxes

You cannot change settings
in Customize dialog boxes.

Your system manager may have restricted access to
some Customize dialog boxes by using the terminal’s
configuration manager. Ask your system manager which
of your terminal’s customize features are restricted.

Some buttons are dimmed if they do not apply to the
action you are currently performing.

VXT DECterm Window Problems

The DECterm window is too
high on the screen.

Adjust the terminal size in the DECterm Window
Options dialog box. You can also use the window menu
to move the window. To display the menu, click MB3
anywhere on the window frame.

A.1.1 NFS Error Codes

If an error occurs when mounting or accessing file systems, the VXT Message
Box displays an NFS error code. Table A–4 lists NFS numeric error codes.

Table A–4 NFS Error Codes

Error Code Meaning

0 NFS$_NORMAL

-1 NFS$_ERROR

10001 NFS$_NOMOREMNT

10002 NFS$_CANTMPGBL

10003 NFS$_NOTMOUNTED

10004 NFS$_INVPARAM

10005 NFS$_ALRDYMOUNTED

10006 NFS$_NOHOSTNAME

10007 NFS$_INVHOSTNAME

10008 NFS$_CANTGETHNAM

10009 NFS$_CANTGETIP

(continued on next page)
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Table A–4 (Cont.) NFS Error Codes

Error Code Meaning

10010 NFS$_DQUOTA

10011 NFS$_NFSDQUOTA

10020 NFS$_QUEERR

10021 NFS$_NOREQQUE

10022 NFS$_NOTOPENED

20001 NFS$_CANTENCODE

20002 NFS$_CANTDECODE

20003 NFS$_RPCTIMEDOUT

20004 NFS$_PROGUNAVAIL

20005 NFS$_PROCUNAVAIL

20006 NFS$_CANTDECODE

20007 NFS$_CANTSEND

20008 NFS$_CANTRECV

20009 NFS$_VERSMISMATCH

20010 NFS$_AUTHERR

20011 NFS$_PRGVERMISMATCH

20012 NFS$_ATHERERR

20013 NFS$_PMAPFAILURE

20014 NFS$_RPCSYSERR

20015 NFS$_RPCPROGNOTREG

30001 NFS$_NFS_PERM

30002 NFS$_NFS_NOENT

30003 NFS$_NFS_IO

30004 NFS$_NFS_NXIO

30005 NFS$_NFS_ACCES

30006 NFS$_NFS_EXIST

30007 NFS$_NFS_NODEV

(continued on next page)
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Table A–4 (Cont.) NFS Error Codes

Error Code Meaning

30008 NFS$_NFS_NOTDIR

30009 NFS$_NFS_ISDIR

30010 NFS$_NFS_FBIG

30011 NFS$_NFS_NOSPC

30012 NFS$_NFS_ROFS

30013 NFS$_NFS_NAMTOOLNG

30014 NFS$_NFS_NOTEMPTY

30015 NFS$_NFS_DQUOT

30016 NFS$_NFS_STALE

30017 NFS$_NFS_WFLUSH

A.2 Power-Up Self-Test

Every time your turn the terminal on, it automatically runs a power-up
self-test. This test checks the operating status of many internal parts in the
terminal. During the test, the keyboard lights turn on and off. The power-up
self-test should not take more than 45 seconds to complete.

If the test is successful:

The terminal downloads the VXT system image software, performs its boot
procedure, and displays the Terminal Manager window or a login prompt for
your host system.

If there were any test errors:

The terminal displays a diagnostic error message.

A.2.1 Error Messages

If the terminal fails the power-up self-test, the terminal may display an error
message and >>> prompt. The following table lists error messages for some
simple problems that you can correct yourself. If you see other error messages,
note the error messages and call your Digital service representative; only
qualified service personnel should try to correct these problems.
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Error Message Reason

?? 002 3 QDZ 0080 The keyboard failed the self-test. Check that the keyboard is
plugged in correctly.

?? 001 9 VNI 0132 The Ethernet failed the self-test. Check that your network
cable is plugged in correctly.

?? 020 12 IMG 0016 The image accelerator option board failed the self-test. Check
that the board is installed correctly. For VXT 2000 system
box models, see VXT 2000 Windowing Terminal Installation
Information. For other models, see instructions supplied with
the image accelerator board.

?MOP 1 Transmit error. MOP was unable to transmit due to a system
board error.

?MOP 255 Not enough space in memory to load the image.

?IP 2 An ICMP Protocol Unreachable message was received. The
TFTP host listed in the BOOTP response does not understand
the user datagram protocol (UDP) that TFTP runs over. The IP
download stops.

?IP 3 An ICMP Port Unreachable message was received. The remote
TFTP daemon has either never been started or is not running
on the load host. The IP download stops.

?TFTP 1 A TFTP error message was received while sending a TFTP
Read Request packet. The TFTP load stops. This error usually
means a file was not found or you do not have access to the file.

?TFTP 3 A TFTP error message was received while sending a TFTP
Acknowledgment packet. The TFTP load stops.

?TFTP 5 A TFTP error message was received while sending a TFTP
Error packet. The TFTP load stops.

?TFTP 255 Not enough space in memory to load the image.

A.3 Restoring the Terminal to Factory-Default Settings

You can reset the VXT 2000 windowing terminal’s nonvolatile RAM (NVRAM)
to the factory-default settings by entering a console command.

1. Place the terminal in console mode by pressing Ctrl Alt keypad . or
pressing the halt button on the rear of the terminal.

2. At the >>> console prompt, enter the following command:

>>> T/UTIL 1
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When you boot the terminal successfully it saves a record of the successful
booting method used. When you reboot the terminal, it tries using this saved
method first. You can clear this saved state while booting the terminal:

>>> B/10000

A.4 Digital Service Overview

As a full-service vendor, Digital provides hardware, software, network, and
operations support to a diverse, worldwide customer base. Digital offers one
of the most comprehensive portfolios of service in the industry, designed to
support customers throughout the computing life cycle—planning, design,
implementation and ongoing management.

Customers tailor the type and level of support to meet their individual
business needs. Regardless of the service solution, customers benefit from
Digital’s single-source support strategy.

Digital’s commitment to be the Best in Class service provider means that there
is a force of 40,000 service professionals operating from 450 locations in over
80 countries dedicated to support our customers.

Digital believes in backing its products with meaningful warranties. This
product may be covered by the Standard Product Warranty, which is
entitlement to one year of hardware Basic Service with priority response
time Monday through Friday, 8 AM to 5 PM. Where applicable, entitlement to
the Product Foundation Warranty for the kernel software is provided. This
Standard Warranty is further proof of Digital’s commitment to the customer.

Digital provides on-site and off-site remedial services.

Digital offers fast, competitively priced, quality maintenance performed at your
site by Digital trained Service Specialists. There are several on-site services
available.

A.4.1 How to Get Service

Digital has a central service center in your area to help you keep your system
running at peak efficiency. To find out more about Digital’s hardware and
software service offerings

In the United States

For customers who purchased standard warranty (on-site) support, have your
system manager call for remedial service at 1–800–354–9000.

Other customers may call 1–800–225–5385 for return to Digital Service.

For general information, call 1–800–DEC–INFO.
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For ordering and ordering support, call 1–800–DIGITAL.

Outside the United States

Contact your local Digital Customer Services Office.
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B

This appendix describes how to use the Color Mixing dialog box on VXT 2000
color and gray scale terminals. You can choose and mix your own colors for
windows, window borders, and certain other customizable features. When you
choose a feature that has customizable colors, the terminal displays a Color
Mixing dialog box.

The VXT 2000 color and gray scale terminals use 8-plane displays. The color
terminal lets you display 256 colors from a palette of 16.7 million colors. The
gray scale terminals provide 256 levels of gray.

B.1 What Color Settings Can I Customize?

Here is a list of VXT 2000 color settings you can change, using the Terminal
Manager window and workspace Options submenu.

To change this feature’s color... Use this dialog box...

Terminal Manager (Customize Menu)

Pointer Customize Pointer

Window Customize Window Color

Screen Customize Screen Background
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To change this feature’s color... Use this dialog box...

Window Manager (Workspace Options Submenu)

Border for active windows Border Color Options

Border for inactive windows Border Color Options

Window manager menu colors Border Color Options

Icons Icon Color Options

Window matte Matte Options

B.2 Color Mixing Dialog Box

The Color Mixing dialog box offers different methods for mixing colors, based
on different color models:

• Picker

• Hue, Lightness, Saturation (HLS)

• Red, Green, Blue (RGB)

• Browser

• Gray scale

The default model is the Picker model. You can use one model or a combination
of models. For example, you can use any color model to select a color, then use
the Picker color model to blend the selected color. When you choose a color
model in the dialog box, the terminal displays the set of controls for that model
in the dialog box.

The following sections describe how to use each of the color models to choose
your own colors.

B.2.1 Picker Color Model

When you click on a button in a dialog box to change a color, the terminal
displays the Picker version of the Color Mixing dialog box:

Note

The title of the dialog box may be Color Mixing or Highlight Color,
depending on what feature you are customizing.
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Highlight Color

Warmer

Cooler

Color Model:

InterpolatorLighter

Darker

Scratch Pad...

Smear Undo

Paint Bucket

Interpolator

Spectrum Label

Color Spectrum

Warmth
Arrow Buttons

Undo
Push Button

Smear
Push Button

Lightness
Arrow Buttons

Current Color

Color Display

New Color

Box

Picker

Spectrum

OK Apply Reset Cancel

LJ−03030−RAGS

The color spectrum is a static collection of colors. The spectrum options
menu lets you set the spectrum to one of the following common color palettes:

• Rainbow spectrum (white, red, orange, yellow, green, blue, blue-violet,
violet, brown and black)

• Pastels

• Vivids
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• Earthtones

• Any application-specific palettes

When you click MB1 on a spectrum tile or interpolator tile, that color becomes
the new color. The tile is highlighted to identify it as the currently selected
color.

You can use the selected color without modification, or you can do on or more
of the following tasks:

• Use the interpolator to smear (blend) the selected color into various shades.

• Use the arrow buttons to make the color lighter or darker, warmer or
cooler.

• Switch to another color model and use the features of that model to modify
the current selection.

To smear colors, use the two paint buckets to load the interpolator with the
colors:

1. Click MB1 on a spectrum tile or interpolator tile. The color display box
displays the color of that tile.

2. Click on a paint bucket, which fills the interpolator end tile below it with
the selected color.

3. Fill both interpolator end tiles or one. If you only fill one end tile, the color
of the empty interpolator end tile is white.

As an alternative to the paint buckets, you can use an eyedropper pointer to
load the interpolator. If you click and hold MB1 on a spectrum or interpolator
tile, the pointer becomes an eyedropper filled with the color of the tile.

You can use the eyedropper to fill one of the interpolator’s two end tiles, by
moving the eyedropper to the tile and clicking on MB1. If you do not position
the eyedropper directly on one of the two end tiles, the closest end tile is filled
with the eyedropper color. The cursor must be inside the interpolator.

Use the Undo button to reverse the last interpolator action, which can be
a smear, the filling of an end tile, or the activation of one of the warmth or
lightness adjustment buttons.
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B.2.2 Hue, Lightness, Saturation (HLS) Color Model

When you choose HLS from the pop-up Color Model menu, the Color Mixing
dialog box displays the controls for the HLS color model.

Highlight Color

Color Model: HLS

Scratch Pad...

Hue:
220

Black White

Gray Full

Lightness:
62

Saturation:
68

OK Apply Reset Cancel

LJ−03027−RAGS
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In the HLS color model, you specify a color by three characteristics: hue,
lightness, and saturation.

• Hue is color, such as red or blue.

• Lightness is color intensity, the amount of color.

• Saturation is the purity of the color, or how much the color is diluted by
white.

The HLS color model contains three scales that represent the ranges of hue,
lightness, and saturation.
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B.2.3 Red, Green, Blue (RGB) Color Model

In the RGB color model, you mix a color by adding different intensities of
the primary colors red, green, and blue. A primary color is a basic color that
cannot be created by mixing other colors.

The RGB color model contains three scales that represent the of red, green and
blue.

Color Mixing

Color Model: RGB

Scratch Pad...

Red

Green

Blue

Percentage Value

24672

35209

57825

RGB Values

OK Apply Reset Cancel

LJ−03028−RAGS
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B.2.4 Browser Color Model

The browser color model is a scrolled window that displays a list of X11 named
colors. Each button in the scrolled window shows the name of an X11 color.
Use the scroll bar to scroll through this color list. When you click MB1 on a
color in the list, the color display box becomes filled with that color. The color
browser is available on all systems.

Color Mixing

Color Model: Browser

Scratch Pad...

Aquamarine

MediumAquamarine

Blue

CadetBlue

Black

OK Apply Reset Cancel

LJ−03029−RAGS
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B.2.5 Grayscale

The grayscale color model contains a scale that lets you mix gray shades
ranging from black to white. Note that when you switch to the grayscale color
model, the current new color becomes a shade of gray.

Color Mixing

Color Model: Greyscale

Scratch Pad...

59

OK Apply Reset Cancel

LJ−03031−RAGS

Scratch Pad

The scratch pad lets you store intermediate colors for later use in color mixing.
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To access the scratch pad, click on the Scratch Pad button in any of the
color models.

ZK−2577A−GE

Scratch Pad...

Save colors here...

CancelClear

Paint Bucket to
Load Scratch Pad

To store the currently selected color in the scratch pad, click on the
paint bucket above the scratch pad color tile. The scratch pad adds that color
to its stored colors, which you can scroll through with the scroll bar.

To clear the scratch pad list, use the Clear button.

On the picker model, the currently selected color can be one of many color tiles.
On other color models, you can select only the new and original color tiles.

To set the new color tile to a scratch pad, scroll to that color and click on the
scratch pad color tile. The new color tile changes and the scratch pad tile
becomes highlighted. If you are in the picker model, you now have the option
to dump the highlighted scratch pad color into one of the interpolator end tiles
by using the paint bucket buttons.
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C

This appendix is for programmers using X windows image extension (XIE)
software for applications on the terminal. The appendix briefly covers the
following topics:

• Checking the Terminal’s Imaging Capabilities

• Hardware Accelerated XIE Functions

• XIE Pipeline Definitions

• XIE Pipeline Constraints

• XIE Pipeline Examples

The terminal includes the X windows image extension (XIE) to the X windows
server. The terminal supports Version 3.0 of the XIE protocol. With XIE:

• The server can save resources by managing images in compressed form

• The server can manipulate the images while accepting user input from
client-based application programs

The terminal supports all XIE protocol functions. Many VXT 2000 models have
an optional image accelerator board available. You do not need the optional
image accelerator board to use XIE functions, but the board accelerates certain
bitonal XIE functions to help display images faster.

All full function VXT system images include XIE support. The VXT EX system
image does not support XIE. To use XIE, make sure the X Image Extension
button in the Customize Boot dialog box is on. See Section 5.7.

For more information on XIE: Appendix D lists some available
documentation on XIE and Digital’s image application toolkit products that
support XIE, such as DECimage Application Services.
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C.1 Checking the Terminal’s Imaging Capabilities

If the terminal is using a VXT software image that supports XIE, you can
have your application use the following query to determine if the bitonal image
accelerator is present:

status = XInternAtom(display, "_DEC_XIE_ACCEL_TYPE_A", True);

The presence of the _DEC_XIE_ACCEL_TYPE_A atom indicates that the
bitonal image accelerator board is present in the terminal. This board
accelerates the following functions:

• CCITT Group 3 and Group 4 image data decompression

• Scaling range from 1/64 to 64 times the original size

• Orthogonal rotation (0°, 90°, 180°, and 270°)

• Cropping

• Convolution using a 3�3 or 5�5 kernel, with kernel values between 0 and
255

C.2 Hardware Accelerated XIE Functions

To take maximum advantage of the bitonal image accelerator, you must follow
these general rules:

• Use the XIE pipeline method of processing to display images (instead of
atomic XIE processing).

• Group all accelerated XIE functions together.

• Transport and work from compressed bitonal images whenever possible.

C.3 XIE Pipeline Definitions

Always use XIE pipelines to display images on the terminal.

XIE uses process control services, known as pipelines, to allow a client
to create and execute linear, macro-like assemblies of protocol requests. A
pipeline is a single threaded list of XIE protocol functions through which image
data flows sequentially.

When you construct pipelines for processing images in the terminal, use the
following guidelines for the best image display performance:

• Group all accelerated XIE functions together. That is, do not mix
nonaccelerated functions with accelerated functions. Accelerated XIE
functions include crop, area-constrain, scale, rotate, and mirror.
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• When using any accelerated functions, observe the following order: crop,
area-constrain, scale, rotate, mirror.

• If you use the area function, it must be followed by the constrain function.

• Do not include more than one instance of an accelerated XIE function in
the pipe. Do not use two scale functions in a single pipeline.

• End the pipeline with the export function.

• Do not use phototaps in the pipeline.

C.3.1 XIE Pipeline Constraints

Some accelerated XIE functions have associated constraints, to ensure that the
bitonal image accelerator option can handle the request. By following these
constraints, you ensure that the hardware accelerator is used to process XIE
requests, rather than the XIE software alone.

Following is a list of the hardware accelerated XIE constraints:

• The bitonal image accelerator supports CCITT Group 3 and Group 4
compressed image formats and Pulse Code Modulated (PCM) data. CCITT
is the Comitè Consultatif International de Télégraphique et Téléphonique,
a standards committee for the communication industry in Europe.

• Specify kernel values in the area request as follows:

Each value must be between 0 and 255.

The kernel size must be either 3�3 or 5�5.

The sum of all values must be between 224 and 255.

• Specify the IDC parameter as null in an area request.

• Specify the parameters op1 and op2 as mult and sum, respectively, in the
area request.

• Images may not be scaled to a size greater than 64 times or less than 1/64
of the original in the scale request.

• For data alignment purposes, the server may slightly adjust the output
scanline length from that specified in the scale request. Any adjustment
will be close to the specified scale, and will always be equal to or greater
than the specified scale.

• Specify a rotation request of 0°, 90°, 180°, or 270° only.
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• The constrain function immediately following the area function determines
the number of levels for a given output pixel.

Specifying two levels in the constrain function produces a bitonal
output on any display. In this case, the export function parameters
(lut_id, colormap_id, match, and grey) should all be null in the
export request.

In a gray scale or color system, specifying up to 256 levels in the
constrain function produces a multibit output. In this case, the export
function parameters colormap_id, match, and grey should be null
in the export request. The lut_id parameter should be specified as a
previously created server image resource.

Digital suggests that an application allocate a fixed number of gray
scale colormap entries at initialization time and always use these
entries to display the enhanced bitonal images. This is accomplished by
allocating the colors (actually gray scales) from the default colormap,
and creating a one-scanline image with these colormap entry pixel
values to use as the lut_id in all XIE export calls.

Digital recommends using from 8 to 32 gray scale values. Fewer values
introduce artifacts in the displayed image, and more values are a waste
of server resources. See the XIE documentation for details on creating
a LUT image.

C.3.2 XIE Pipeline Examples

The following examples show sample pipelines that illustrate how functions are
mapped either to the image accelerator board or to the XIE software routines.
The examples illustrate the difference in image display performance when you
program with the image accelerator board in mind.

1. All Accelerated Functions (Best Performance)

Crop
Area-Constrain
Scale
Rotate
Mirror

In this pipeline, all XIE routines are mapped to the image accelerator
board. Thus, this pipeline requires only one pass through the image
accelerator board, resulting in the best image display performance.

2. Interspersed Software Functions (Poorer Performance)

Crop
Scale
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Translate
Rotate

In this pipeline, the Crop and Scale XIE routines are first mapped to
the image accelerator board. The Translate routine is then mapped to
the XIE software. Finally, the Rotate routine is mapped to the image
accelerator board. Thus, this pipeline requires two passes through the
image accelerator board, resulting in degraded image display performance.
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Related Documentation

D

This document is part of your terminal’s user documentation kit.

Document Part Number

VXT 2000+/VXT 2000 Windowing Terminal User Documentation Kit EK–VXT20–DK

VXT 2000+/VXT 2000 Windowing Terminal Installing and
Getting Started

EK–VXT20–IN

VXT 2000+/VXT 2000 Windowing Terminal User Information EK–VXT20–UG

VXT 2000+/VXT 2000 Windowing Terminal Release Notes EK–VXT20–RN

You can also order the following related documents from Digital. Check with
your Digital sales representative for availability in your country.

Software and Service Documentation Part Number

VXT Software Version 2.1 Installation and System Management AA–PJHFE–TE

VXT Software Version 2.1 Release Notes AA–PKWSG–TE

VT320 Programmer Reference Manual EK–VT320–RM

DECimage Application Services for VMS

X Image Extension Programmer’s Reference Manual AA–PH7XA–TE

Image Display Services Programmer’s Reference Manual AA–LE73C–TE

Programmer’s Overview AA–LE65C–TE

ULTRIX DECwindows Motif User’s Guide AA–MA87B–TE

VMS DECwindows Motif User’s Guide AA–PGZ5A–TE

VXT 2000 Windowing Terminal and DECimage 2000 Option Service
Information

EK–VXT20–SV
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Software and Service Documentation Part Number

VXT 2000 Model VX225 Windowing Terminal Service Information EK–VXT15–SV

VXT 2000 Model VX227 Windowing Terminal Service Information EK–VXT17–SV

VRM17 Monitor Service Guide EK–VRM17–SV

VR315 Monitor Service Guide EK–VR315–SV

VR319 Monitor Service Guide EK–VR319–SV

VR320 Monitor Service Guide EK–VR320–SV

VR326 Monitor Service Guide EK–VR326–SV

D.1 Ordering Information

You can order options and documentation by mail, phone, or electronically. For
a list of options, see Appendix E.

Need Help?

If you need help deciding which documentation best meets your needs, please
call 800–DIGITAL (800–344–4825) and press 2 for technical assistance.

Electronic Orders

To place an order through your account at the Electronic Store, dial 800–
234–1998, using a modem set to 2400 or 9600 baud. You must be using a VT
terminal or terminal emulator set at 8 bits, no parity. If you need help, call
800–DIGITAL (800–344–4825) and ask for an Electronic Store specialist.
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D.1 Ordering Information

Telephone or Direct Mail Orders

If You Are
From . . . Call . . . Or Write . . .

U.S.A. DECdirect
Phone: 800–DIGITAL
(800–344–4825)
FAX: (603) 884–5597

Digital Equipment Corporation
P.O. Box CS2008
Nashua, New Hampshire 03061

Puerto Rico Phone: (809) 781–0505
FAX: (809) 749–8377

Digital Equipment Caribbean, Inc.
3 Digital Plaza, 1st Street
Suite 200
Metro Office Park
San Juan, Puerto Rico 00920

Canada Phone: 800–267–6215
FAX: (613) 592–1946

Digital Equipment of Canada Ltd.
100 Herzberg Road
Kanata, Ontario, Canada K2K 2A6
Attn: DECdirect Sales

International – Local Digital subsidiary or approved
distributor

Digital Personnel

To order hardware or software documentation, contact the U.S. Software
Supply Business group for instructions. For software documentation, request
an Internal Software Order Form (EN–01740–07).

U.S. Software Supply Business
Digital Equipment Corporation
10 Cotton Road
Nashua, NH, 03063–1260
DTN: 264–3030
(603) 884–3030
FAX: (603) 884–3960

VXT 2000+/VXT 2000 Windowing Terminal User Information 323



E
Options

E

This appendix lists the options available from Digital for the VXT 2000
windowing terminal. For ordering information, see Section D.1.

E.1 Options

Boards

Board Part Number

2 MB memory controller board VX20X–MA

2 MB memory module MS200–AA

4 MB memory module MS200–BA

Network board with ThinWire and thickwire connectors VX20D–AA

Network board with twisted-pair and thickwire connectors VX20D–BA

Image board VX20A–OP

Modems

Model Description

DF242 Scholar Plus 300, 1200, and 2400 baud, full-duplex asynchronous

DF224 300, 1200, and 2400 baud, full-duplex asynchronous

DF124 300, 600, and 1200 baud, full-duplex asynchronous
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Cables

Cable Length Part Number

Network Cables

Thickwire 2 m (6.5 ft) BNE4C–02

Twisted pair, uncrossed ( | | ) 3 m (10 ft) BN24G–03

Twisted pair, crossed (x) 3 m (10 ft) BN24F–03

ThinWire 3.6 m (12 ft) BC16M–12

9 m (30 ft) BC16M–30

T-connector – H8223

Terminator – H8225

LAN kit Includes 3.6 m (12 ft) cable,
T-connector, and terminator

BC16T–12

Video Cables

Monochrome M–17–02441–01

Color C–17–02906–02

Gray scale G–17–02878–01

AC Power Cables

Australia, New Zealand BN20V–2E

Austria, Belgium, Finland, France, Germany, Netherlands, Norway,
Portugal, Spain, Sweden

BN20S–2E

Canada BN20P–2E

Denmark BN20U–2E

Ireland, United Kingdom BN20R–2E

Israel BN19U–2E

Italy BN20W–2E

Switzerland BN20T–2E

For parallel and serial port cables and adapters, contact your Digital sales
representative.

VXT 2000+/VXT 2000 Windowing Terminal User Information 325



F
Specifications

F

This appendix lists general, environmental, and electrical specifications for the
terminal.

Site Planning

Weight Height Width Depth

System box 9 kg 57 mm 394 mm 360 mm

(20 lb) (2.25 in) (15.5 in) (14.17 in)

VRC16 monitor 22.5 kg 432 mm 411 mm 434 mm

(49.6 lb) (17 in) (16.2 in) (17.1 in)

VRM17 monitor 27.2 kg 457 mm 495 mm 452 mm

(60 lb) (18 in) (19.5 in) (17.8 in)

VR315 monitor 13 kg 400 mm 400 mm 391 mm

(29 lb) (15.7 in) (15.7 in) (15.4 in)

VR319 monitor 27.2 kg 457 mm 495 mm 452 mm

(60 lb) (18 in) (19.5 in) (17.8 in)

VR320 monitor 29 kg 457 mm 495 mm 452 mm

(63 lb) (18 in) (19.9 in) (17.8 in)

VR326 monitor 17.2 kg 381 mm 381 mm 396 mm

(38 lb) (15 in) (15 in) (15.6 in)

LK401/LK402 ANSI keyboard 1.4 kg 45 mm 478 mm 191 mm

(3.1 lb) (1.75 in) (18.8 in) (7.5 in)

LK421 Short ANSI keyboard 1.0 kg 51 mm 335 mm 165 mm

(2.2 lb) (2.0 in) (13.5 in) (6.5 in)
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LK443/LK444 PC keyboard 1.4 kg 50 mm 450 mm 180 mm

(3.1 lb) (2.0 in) (18.25 in) (7.25 in)

Mouse Weight Height Width Length

97 g 32.5 mm 60.9 mm 99.1 mm

(3.4 oz) (1.28 in) (2.4 in) (3.4 in)

Environment

Operating Storage

Temperature 10° to 40° C –40° to 66° C

(50° to 104° F) (–40° to 151° F)

Relative humidity 10% to 90% 0% to 95%

Maximum wet bulb 28° C (82° F)

Minimum dew point 2° C (36° F)

Maximum altitude 4.9 km (16,000 ft) 9.1 km (30,000 ft)

Electrical

Line voltage (U.S.) 100 V to 120 V ac nominal

88 V to 132 V rms operating range

single-phase, 3-wire

Line voltage (Europe) 220 V to 240 V ac nominal

176 V to 264 V rms operating range

single phase, 3-wire

Line frequency 50 Hz to 60 Hz

Input power 80 W maximum

Power cord Detachable, 3-conductor, grounded

Power cord receptacle EIA specified, CEE22-6A

Monitors (Screen Size and Resolution)

Monitor Screen Size Resolution

VRC16 CRT 425 mm (17 in) 100 dots/in

VRM17 CRT 425 mm (17 in) 100 dots/in

VR315 CRT 380 mm (15 in) 108 dots/in

VR319 CRT 495 mm (19 in) 95 dots/in

VR320 CRT 495 mm (19 in) 100 dots/in
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Monitor Screen Size Resolution

VR326 CRT 381 mm (15 in) 100 dots/in

LK401 or LK402 ANSI Keyboard

Item Description

Number of keys 108 sculptured keys with matte finish

Models Available in many language dialects, including English.

Cord 1.8 m (6 ft) coiled cord with a 4-pin telephone-type
modular connector

Indicator lights 2 keyboard indicators:

Hold

Lock

Keys (Approximate Size)

Home row 30 mm (1.18 in) above desktop

Key size (top) 13 mm (0.50 in) square

Key spacing 19 mm (0.75 in) center to center
(for single-width keys)

Numeric keypad 18 keys

Function keys 5 predefined keys, 15 user-definable keys

Audible Indicators If enabled . . .

Keyclick Sounds after each keystroke.

Margin bell Rings once when cursor approaches right margin

Warning bell Rings for compose errors and certain system messages.
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LK421 Short ANSI Keyboard (UNIX Style)

Item Description

General 74 sculptured keys with matte finish

Available in North American/UK version only

Cord 1.8 m (6 ft) coiled cord with a 4-pin telephone-type
modular connector

Keys Approximate Size or Number

Home row 30 mm (1.18 in) above desktop

Key size (top) 13 mm (0.50 in) square

Key spacing 19 mm (0.75 in) center to center (for single-width keys)

Function keys 5 predefined keys, 15 user-definable keys (including 10
Extend key sequences, to emulate the full set of ANSI
keyboard keys)

Audible Indicators If enabled . . .

Keyclick Sounds after each keystroke.

Margin bell Rings once when cursor approaches right margin.

Warning bell Rings for compose errors and certain system messages.
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LK443 or LK444 PC Keyboard

Item Description

Number of keys 101 or 102 sculptured keys with matte finish

Models Available in many language dialects, including English

Cord 1.8 m (6 ft) coiled cord with a 4-pin telephone-type
modular connector

Indicator lights 3 keyboard indicators:

Num
Lock

Caps
Lock

Scroll
Lock

Keys Approximate Size

Home row 30 mm (1.18 in) above desktop

Key size (top) 13 mm (0.50 in) square

Key spacing 19 mm (0.75 in) center to center (for single-width keys)

Numeric keypad 17 keys

Function keys 3 predefined key, 16 user-definable keys

Audible Indicators

Keyclick Sounds after each keystroke.

Margin bell Rings once when cursor approaches right margin.

Warning bell Rings for compose errors and certain system messages.

Mouse

Item Description

Switches Three tactile-feel type switches with an actuating force
of 85 grams (3 ounces) �25%

Surface Nonglare textured finish

Cable 1.5 m (5 ft) round, 0.375 cm (0.15 in) diameter
6-conductor, number 26 stranded, shielded, high-
flexibility design

Connector 7-pin micro-DIN type (male)
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Setting Up the Work Environment

G

This appendix contains recommendations to protect your health and safety.

G.1 Proper Setup and Use

Certain recent scientific literature suggests that poor posture, work habits, or
office equipment setup may cause injuries. Other literature suggests that there
is no cause and effect. Because the safety of our users is a great concern, it is
important to take the precautions described in Table G–1.
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Table G–1 Recommendations for Proper Setup and Use

Adjust So that . . .

Chair 1 Feet are flat on the floor or footrest, if needed.

2 Legs are vertical forming a right angle to the floor.

3 Your weight is off your thighs and your thighs are in a
horizontal position. Keep the back of your knees away
from the seat so you do not compress the area behind
them, which could restrict the blood flow.

4 Your upper body is erect and your lower back is supported
with a backrest.

Keyboard 5 Your wrists are straight and do not flex more than 15°.
They may be supported but should not rest on sharp
edges.

If you use a mouse, rest your hand on the mouse so your wrist is not on the work surface. Operate
the mouse close to your body’s centerline.

6 Upper arms are straight down at your sides, elbows
are close to your sides and support your arm weight.
Forearms are at a 70° to 90° angle.

Head 7 Your neck is not strained. Your head should incline
downward, but no more than 15° to 20°.

Terminal 8 The terminal is at eye level and at the correct distance for proper vision.

Eyes 9 You avoid eye fatigue, which can be caused by glare, image quality,
uncomfortable furniture, eye height, and uncorrected vision. If you cannot
read the screen at different distances, you may need special glasses. Relax
your eyes periodically by looking at distant objects.

(continued on next page)
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Table G–1 (Cont.) Recommendations for Proper Setup and Use

MA–0069–93.IL

(continued on next page)
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Table G–1 (Cont.) Recommendations for Proper Setup and Use

Adjust To . . .

Work
Breaks

Take periodic work breaks. Morning, lunch, and afternoon breaks meet
most recommendations. Take advantage of work breaks to move around
and do other movements.

Lighting Avoid direct lighting or sunlight on the screen, which causes glare and
reflections. Place lighting behind or to the side of your work area, and
distribute the lighting evenly on your work area. Adjust the terminal
brightness and the contrast controls as needed.

Noise Keep background noise at a minimum. Background noise above 65 dBA is
tiring. Sound-absorbing materials, such as curtains, carpeting, and acoustic
tile, can help reduce background noise.

Temperature 20°C to 23°C (68°F to 74°F)

Humidity 30% to 70%

Ventilation Provide adequate air ventilation for equipment operation and to avoid
fatigue.

Space
between
terminals

More than 70 cm (28 in) center to center, preferably more than 152 cm (60
in).

Warning

If you experience pain or discomfort while using the terminal, take a
substantial break and review the instructions for posture and work
habits. If the pain or discomfort continues after resuming use of the
terminal, then discontinue use and report the condition to your job
supervisor or physician.
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Accelerator

A key or sequence of keys that provides an alternative to using the mouse. You
can perform all mouse actions from the keyboard, such as displaying menus
and choosing menu items.

Active window

The terminal window that is ready to accept input. This window displays the
information you type (if the window accepts user input). Only one terminal
window can be active at a time.

ANSI

American National Standards Institute

ANSI keyboard

Digital’s standard keyboard, with a main keypad, editing keypad, numeric
keypad, and top-row function keys. Compare to Short ANSI keyboard.

Application launcher

In VXT software, a utility that allows terminal users to start applications
residing on a host system, for display on the terminal. The terminal user
connects to the host system, runs the application launcher, then enters a
command to launch the desired host application.

ASCII

American Standard Code for Information Interchange. A set of 7- or 8-bit
binary numbers representing the alphabet, punctuation, numerals, and other
special symbols used in text representation and communications protocol.
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Application

A program that performs a specific task.

Background process

A process that does not require the total attention of the computer for
operation. Background processing enables the operating system to execute
more than one program or command at a time. As a general rule, all clients
should run as background processes.

BDF

Bitmap distribution font format

Boot

To bring a device or system to a defined state where it can operate on its own.

CCITT

Comite Consultatif International de Telegraphique et Telephonique
(International Telegraph and Telephone Consultative Committee). A standards
committee for the communication industry in Europe.

Configuration manager

In VXT software, a set of windows and dialog boxes that system managers use
to centrally manage terminals and InfoServer font sets for terminals. System
managers can place server-based terminals in work groups that share settings.

Character set

A group of graphic characters and control characters stored as a unit in the
terminal. Graphic characters are characters you can display on the screen.
Control characters perform special functions.

Check buttons

A group of square toggle buttons that provide different settings for an option.
You choose one button from the group.

Click

To press and release a mouse button. The term comes from the fact that
pressing and releasing the buttons of most mice makes a clicking sound.

Client

A program written specifically for X windows. Clients make their own windows
and know how to resize and minimize themselves.
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Compose character

A character produced by pressing two or three keys in sequence, starting with
the Compose Character key or a diacritical mark key. You can use compose
sequences to produce characters that do not appear as standard keys on your
keyboard.

Computer system

A combination of system hardware, software, and external devices that
performs operations and tasks.

Cursor

A blinking line or block on the screen that indicates the active position.

Customizations

In VXT software, the set of customized operating settings for a terminal or
work group. Customizations are stored in a resource file.

Data processing keys

Keys that have three or four characters on the top of their keycap. The
characters on the right half of the keycap are data processing characters. To
use data processing characters, you must choose the data processing version of
your keyboard in the Customize Keyboard dialog box.

DECconnect cabling

Digital’s cabling system for extending Ethernet and terminal interconnections
into offices and work areas.

DEC Multinational character set

The default character set for the terminal. The DEC Multinational set is one
of two 8-bit sets built into the terminal. The other set is ISO Latin-1. Both
8-bit sets include the standard ASCII character set and a supplemental set.
For 7-bit environments, see National replacement character sets.

DECnet software

Digital’s networking software that runs on nodes in both local and wide area
networks.

DEC OSF/1 operating system

Digital’s implementation of the Open Software Foundation technology, with the
Motif graphical user interface and programming environment.
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DECterm

Digital’s VT series terminal emulator. VXT 2000 windowing terminals let
users create DECterm sessions on host systems.

Default option

A push button with a double outline, indicating the most frequently used
setting for a window. You can choose a default option by pressing Return or
clicking on the push button.

Default setting

A standard setting for one of the terminal’s operating features, set at the
factory. The terminal uses factory-default settings, unless you choose a new
setting.

Device icon

An icon on the back of the system box that identifies the device that can be
plugged into the connector.

Diacritical marks

Marks or symbols that indicate a change in the standard pronunciation of a
letter. Examples of diacritics are acute accent (’), grave accent (‘), and tilde (~).
On the terminal, you can use diacritical marks (if available on your keyboard)
to start two-stroke compose sequences.

Double click

To press and release a mouse button twice in rapid succession.

Drag

To press and hold down a mouse button while moving the mouse on the
desktop and the pointer on the screen. Typically, dragging is used with menu
selecting, and window moving and resizing.

Ethernet

A type of local area network, based on Carrier Sense Multiple Access
with Collision Detection (CSMA/CD). A communication concept for local
communication networks that use coaxial cable.
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Filter rectangle

A bounded area used defined on the screen. To activate the filter, you define its
coordinates with a control function. If the terminal detects that the locator is
outside the filter rectangle, the terminal sends an outside rectangle event and
disables the rectangle.

Font

A font is a set of character images in a particular typeface and style. For
example, Times Roman bold is a font.

Font path

A logical file that lets a device access alternate character fonts for certain X
window applications.

Full-duplex modem

A modem that can handle simultaneous, two-way communications.

Graphics

The use of lines, figures, shapes, and shaded areas to display information.

Graphics tablet

An optional device used to move the graphics input cursor on the screen and to
enter data to an application program. Most tablets have three parts: a tablet,
stylus, and puck. To move the cursor you move the puck or stylus across the
tablet. Also known as a locator device.

Group code

A number that represents a host or group of hosts on a LAT network.

Hardware

The physical equipment—mechanical and electrical—that make up a system.
Compare to Software.

Hardware Ethernet address

The unique Ethernet physical address associated with a particular Ethernet
communications controller.

Host-based terminal

A terminal that uses its own memory to operate VXT software. By default,
host-based terminals also use their own memory to store their customizations

in a native resource file. Compare to server-based terminal.
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Host-based resource file

A file created by a system manager or user to store customizations for a
terminal or group of terminals. The file is stored on a host system; terminals
can access the file using the NFS or TFTP protocols. Compare to native

resource file.

Host system

A computer system that has an active connection to your terminal. The
primary or controlling computer in a multiple-computer network.

Icon

A small graphic representation of an object, usually an application. A window
can be shrunk to an icon (or minimized) to save room on the workspace.

InfoReader

A library of online documentation provided with VXT software kits for
InfoServer systems. VXT 2000 windowing terminal users access the library
from the Getting Started menu in the Terminal Manager window.

InfoServer

A high-performance virtual disk server that can efficiently download the VXT
system image software to many terminals.

Internet

A collection of networks that includes the ARPAnet, a number of local networks
at universities and research institutions, and many military networks. See
TCP/IP.

IP address

A unique network address that identifies a device on the TCP/IP network.

ISO

International Standards Organization. ISO Latin-1 is one of the two 8-bit
multinational character sets built into the terminal. The other set is the DEC

Multinational set. For 7-bit environments, see National replacement character

sets.

Kilobyte (KB)

When referring to memory, 1024 bytes.
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LASTport group code

A number from 0 to 1023 assigned to an InfoServer system. The InfoServer
only communicates with systems that belong to the same group code.

LAT protocol

A network protocol created by Digital for local area network communication.

LAT address

A network address that identifies the location of a device on the LAT network.

LED

Light-emitting diode. LEDs are used as indicators on the keyboard.

Local area network (LAN)

A high-speed communications network that covers a limited geographical area,
such as a section of a building, an entire building, or a cluster of buildings.

Locator device

See pointing device.

Local terminal

A terminal from which the configuration manager is being used to manage
other terminals and work groups.

Matte

An optional decorative border between the window frame and the work area.

Maximize button

A button that lets you increase the size of the window to its maximum
allowable size. The maximize button is at the right edge of a window’s title
bar.

Megabyte (MB)

When referring to memory, 1024 kilobytes or 1,048,576 bytes.

Menu bar

The area below a window’s title bar that lists the names of pull-down menus
for the window’s application.
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Minimize button

A window button that lets you shrink a window to an icon. The minimize
button is to the left of the maximize button.

Mnemonic

An underlined character in a menu. Mnemonics allow you to display menus
and choose functions by typing letters on your keyboard.

Modem

Modulator - demodulator. A device that converts data from a computer or
terminal into signals that can be sent over a telephone line and back again.

Modifier key

A key pressed in combination with another key, to modify the code sent by that
key. Ctrl is a modifier key.

Monochrome monitor

A video screen that displays images in shades of one color.

MOP

Maintenance operation protocol. A network management protocol within
DECnet software that handles tasks such as downloading, upline dumping,
and circuit testing.

Mouse

A handheld pointing device used to select menu options and draw graphics.
Moving the mouse across the desktop moves the pointer or mouse cursor on
the screen. The mouse has three buttons that serve as function keys.

National replacement character sets (NRCs)

Seven-bit character sets for many Western European languages. Each set
has 94 characters. NRC sets are similar to the ASCII set, except for a few
characters.

Native resource file

In VXT software, the file that stores a terminal’s customized settings, entered
from the terminal’s dialog boxes or from the configuration manager of another
terminal. Host-based terminals store their native resource file in the terminal’s
nonvolatile memory. Server-based terminals store their native resource file on
an InfoServer system. Compare to Host-based resource file.
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Network

Two or more computers linked by communication lines to share information or
resources.

NFS

A network protocol developed by Sun Microsystems, Inc. The VXT 2000
windowing terminal can use NFS to access fonts or host-based resource files on
host systems.

Node

A computer, workstation, or peripheral device that is connected to a network
and can communicate with other members of the network.

Nonvolatile memory

Random access memory (RAM) that does not lose its contents when you turn
the terminal off. The terminal uses this memory to store your saved customize
settings.

OpenVMS operating system

Digital’s proprietary operating system.

PC keyboard

Digital’s LK443 or LK444 PC keyboard. The LK443 is a worldwide model, with
102 keys. The LK444 is a North American model, with 102 keys.

Pixel

Picture elements. The smallest displayable unit on a video screen. To display
a character, the terminal turns on a series of pixels.

Pointer

A graphic symbol indicating a screen position. You control the pointer location
by moving the mouse. You can change the pointer shape; an application may
also change the pointer’s shape to indicate the type or state of an action.

Port

A means for connecting one device to another. Usually, each port has an
associated connector.

Prefix key

A key that you press and release before pressing another key, to change the
function of one or more keystrokes. Compose Character is a prefix key.
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Pull-down menu

A menu accessed by pointing to the menu bar and pulling down with the
mouse. Pull-down menus are generally organized by the types of functions
they contain.

Push button

A control that causes an immediate action. To press a push button on the
screen, point to it then click the select button.

Radio buttons

A group of option buttons that allow you to select only one of the selections at
a time. Radio buttons may appear in a menu or in a program’s window. Radio
buttons are usually displayed as small diamond-shaped buttons.

Random access memory (RAM)

Memory that can be read from and written to. The terminal uses this memory
to store instructions of programs currently being run.

Read-only memory (ROM)

Memory that can be read from, but not modified. The terminal uses ROM
memory to store its operating code.

Read-only terminal

A terminal that cannot save new customized settings. It belongs to a work
group that does not allow the saving of new settings.

ReGIS software

A serial geometric graphics display protocol created by Digital.

Resize border

The resize border surrounds a window and is divided into eight handles—one
for each side, and one for each corner.

Restore

To change an icon back into its original window.

Resource file

In VXT software, the file that stores the customizations for a terminal or work
group. See Host-based resource file and Native resource file.
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Scroll bar

A vertical or horizontal bar that lets you control what portion of a larger object
is displayed within a window. The slider represents the relative position in
the list. The size of the slider represents the relative portion of the list that is
currently visible.

Scrolling

Moving information on the screen upward or downward to display more data.

Select button

The mouse button used for most operations, also known as mouse button 1
(MB1). By default, the select button is the left mouse button.

Server

Hardware or software that provides a specific set of services to a client.

Server-based terminal

In VXT software, a terminal that uses an InfoServer system to load its VXT
software and provide memory paging services. By default, a server-based
terminal also stores its customizations on the InfoServer, in a native resource

file. Compare to host-based terminal.

Service

A name that represents a host or cluster of hosts that provides access to that
host or cluster.

Session

An active connection between the terminal and the host system.

Short ANSI keyboard

A compact version of Digital’s ANSI keyboard, for those who make little use of
auxiliary editing and numeric keypads. An Extend key allows users to perform
keypad keystrokes when needed.

Sixel

A vertical column of six pixels. Screen displays can be printed in the form of
sixel graphics.
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Slider

Part of a scroll bar that lets you scroll through information in a window. The
size of the slider indicates how much of a file is currently displayed. The
smaller the slider, the larger the file. The location of the slider in the scroll
region indicates your relative position in the file.

Software

Programs that perform a chosen or required function. Compare to Hardware.

Stepping arrow

Part of a scroll bar that lets you move incrementally through information in a
window.

Submenu

A menu associated with a menu item on a pull-down or pop-up menu. When
you choose the menu item, you display the submenu.

Sun style keyboard

Digital’s LK460 keyboard. The Sun style keyboard comes in a North American
model only.

System

A combination of hardware, software, and peripheral devices that perform
specific processing operations.

System image

The VXT software, downloaded from a host system or server.

System manager

A person who performs tasks necessary to operate and maintain the system.
See VXT manager.

TCP/IP

Transmission control protocol/Internet protocol. The standard wide area
networking software for the ULTRIX and UNIX operating systems. TCP/IP
is a set of protocols developed by researchers centered around the Advanced
Research Projects Administration Network (ARPAnet).

Terminal Manager window

In VXT software, the window for creating and managing sessions, customizing
terminal settings, and performing local printing functions.
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Terminal server

An intelligent unit that can connect a number of asynchronous devices
(terminals and printers) to a host system. For example, Digital’s DECserver
200 can link eight terminals to a system in a local area network (LAN), using
a high-speed Ethernet cable.

Terminal window

A window that emulates a video terminal. Terminal windows allow you to use
applications that were designed for the video terminal they emulate.

Terminator

A connector used on one or both ends of an Ethernet segment that provides the
50-ohm termination resistance needed for the cable.

TFTP

Trivial file transfer protocol. The Internet standard protocol for file transfer
with minimal capability and minimal overhead. TFTP is intended for use
in application environments that do not require complex interaction among
clients and servers.

ThinWire Ethernet network

A term to describe Digital’s 10base2 (IEEE standard 802.3 compliant) Ethernet
products used for local distribution of data.

Title bar

An area at the top of the window frame that displays the name of the
application and provides window management buttons.

Toggle buttons

See Check buttons.

Transcript

An area of memory that contains the last saved lines of your screen display.

transport

The network software that routes user data to its destination and controls the
flow of data.

ULTRIX operating system

A UNIX based operating system created by Digital.
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UNIX operating system

An operating system created by AT&T and in wide use.

Unregistered Terminals work group

A work group supplied on a newly installed InfoServer, to let terminals operate
until they are registered (created) in a work group you have created. The
Unregistered Terminals work group is preconfigured with factory-default
settings that are read-only.

User-defined keys (UDKs)

Keyboard keys that a user can define to perform specific functions.

Visual character attribute

A quality of a display character that highlights the character, such as bolding
and underlining.

VXT launcher

See Application launcher.

VXT manager

The person who manages the VXT system, work groups and the network. This
person assigns unique node names and addresses for each terminal on the
network, and provides administrative assistance to network users.

Window

An area on your monitor screen that represents all or part of an application.

Window frame

The resize border and title bar surrounding a window.

Window manager

The window manager controls the size, placement, and operation of windows
in the workspace. The terminal’s Motif window manager includes the window
frames that surround each window object as well as the workspace menu. The
Motif window manager is a client program of the X Window System.

Window menu

A menu that lets you control the size, shape, and position of a window. To
display the menu, you use the window menu button.
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Window menu button

The button at the left corner of a window’s title bar. Clicking MB1 on the
window menu button displays the window menu.

Window system

A windowing architecture that allows the execution and display of applications
to be independent. Specific components of the architecture control the display
of applications and determine how applications run. Since its introduction by
MIT, the X Window System has become an industry standard.

Work area

The area in a window where you can perform user tasks.

Work group

A customization file and a set of terminals that share the file. Each work
group is assigned to a particular support server.

Workspace

The monitor screen, where all windows are displayed.

Workspace menu

A pop-up menu with items for arranging windows and customizing the window
manager. To display the workspace menu, point to anywhere in the workspace
and click MB1 or MB3. You can also display the workspace menu from the
window menu.

XIE

X image extension. An extension to the X core protocol that handles image
functions. XIE enables compressed image data to be sent across the X wire
and image processing to be handled at the X server.
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Index

8-Bit Multinational Characters button
(DECterm), 153

7-Bit NRC Characters button (DECterm),
153

7-Bit NRCS Selection Options dialog box
(DECterm), 156

A
Accelerator keys, 206
Additional characters, 282 to 292

canceling a sequence, 286
hexadecimal sequences, 286
invalid sequences, 285
table, 288

Address
Ethernet, 126

Adjust Video Centering (TM)
VX227 terminal, 60

Adjust Video Rotation (TM)
VX227 terminal, 60

Allow All Connections button
VXT EX, 245

Alt key, 218
Alt A key, 159
Alt Graph key (Sun), 272

Alt key (PC), 262
North American model, 262

Alt key (Sun), 272
Alternate Shift key (German), 250

AltGr key (PC), 262
< > keys, 155
, < . > keys, 156

ANSI keyboard, 247 to 255
editing keypad, 250
figure, 248
function keys, 249, 251
main keypad, 248
numeric keypad, 251

Answerback message
sending, 252

Answerback Message box (DECterm), 154
Any Host button (TM), 18
Any Host Indirect button (TM), 19
Application

font problems, 299
moving between applications, 199
starting, 14

Application Cursor Keys button (DECterm),
152

Application Keypad button (DECterm), 152
Application launcher, 237

command arguments, 238
running

OpenVMS systems, 238
UNIX systems, 237

Application launching, 232 to 241
host application, 236
remote application, 240
rsh commands, 241
VXT application, 233, 241

Apply button, 40
VXT DECterm options, 140

Arrow keys, 250
function, 152
PC keyboard, 263
short ANSI keyboard, 258
Sun style keyboard, 272
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Arrow keys (cont’d)
to move pointer, 206

Audible indicators, 254
PC keyboard, 264
short ANSI keyboard, 260
Sun style keyboard, 273

Authorizing hosts
TCP/IP, LAT, or DECnet connections, 50

Authorizing users, 50
Auto print mode

selecting, 251
Auto Print Mode button (DECterm), 159
Auto Repeat button (DECterm), 155
Auto Repeat button (TM), 43
Auto Resize Terminal button (DECterm),

144
Auto Resize Window button (DECterm), 144
Auto Wrap button (DECterm), 149
Autostart feature

Customize AutoStart dialog box (TM), 95
AutoStart feature, 24

entering settings, 95

B
Backarrow key (PC), 262
Background color (WM), 221
Backing Store button (DECterm), 157
Backing Store button (TM), 93
<x Backspace button (DECterm), 156
 Backspace key (PC), 262
 Backspace key (Sun), 271

Batch Scroll Lines box (DECterm), 150
Baud rate

serial communication, 68
Bell, 254, 255, 264, 273
Bell volume, 42
Big Font button (DECterm), 145
BIND name servers, 74
Booting the terminal, 98 to 110

BOOT commands, 108
Customize Boot dialog box (TM), 105
error codes, 302
from a remote node, 107
MOP trigger, 107
primary boot file, 106

Booting the terminal (cont’d)
reboot commands, 99
secondary boot file, 107
using the XIE option, 107
VXT software

from VXT EX Options dialog box,
246

Bootstrap history
clearing, 303

Border color settings
window manager, 220 to 221

Border settings
window manager, 218 to 219

Break key
See F5 key

Browser color model, 313

C
Cables

part numbers, 325
Cancel button, 40, 216

VXT DECterm options, 140
Cancel Printing (DECterm), 136
Caps Lock key (PC), 262
Caps Lock key (Sun), 271

Center Image button (TM), 49
Character format

serial communication, 68
Character sets

overview, 10
typing additional characters, 283
VXT 3270 window

translation table, 193
VXT DECterm window

7-bit NRC sets, 156
choosing a multinational set, 152
selecting 8-bit or 7-bit, 153

Check button
defined, 209

Clear Communications menu item
(DECterm), 133

Clear Display menu item (DECterm), 133

Index–2



Clear Lines Off Top menu item (DECterm),
133

Clicking
defined, 196

Clientless VXT software, 4, 242
Close button (WM)

using, 204
Color

customizable features, 306
eyedropper, 309
interpolator, 309
mixing colors, 306
monitor setting, 94
paint buckets, 309
printing, 49
smearing colors, 309
tiles, 309

Color map entries, 157
Color mixing

scratch pad, 314
Color Mixing dialog box, 307
Color models, 307

browser, 313
grayscale, 314
HLS, 310
picker, 307
RGB, 312

Color systems
customizing window colors, 221

Comma key, 156
Commands menu (DECterm), 133
Communication

See also Serial communication
breaking serial, 252
DECnet settings, 81, 82
font problems, 299
InfoServer systems, 71
LAT settings, 69
network problems, 298
NFS mount points, 78
serial and parallel ports, 66
TCP/IP settings, 73, 74, 76

Communications submenu (TM), 65

Compose Character key (ANSI), 250, 284
Compose sequences, 284
Composing characters

See Additional characters
Conceal Answerback Message button

(DECterm), 154
Condensed font setting (DECterm), 144
Configuration manager, 85

customizing the terminal, 8
identifying terminals, 59

Confirm Close Terminal Manager button
(TM), 58

Confirm Reset Session button (TM), 58
Connections Allowed button (TM), 50
Control key (Sun), 271

Copy menu item
VXT 3270 window, 171
VXT DECterm window, 130

Copying text
disabled by some applications, 132
extending selected text, 132, 173
host synchronization, 130
selecting text

VXT 3270 window, 171
VXT DECterm window, 131

using the keyboard only, 173
VXT 3270 window, 171
VXT DECterm window, 130

Create dialog box, 14
Create menu (TM), 14, 23
Creating sessions

problems, 298
Creating sessions and applications, 14 to 24

Getting Started menu, 36
Ctrl key (ANSI), 249
Ctrl key (PC), 262
Cursor

blinking or steady, 149
block or underline, 150
text, 149
VXT 3270 window, 168

Cursor Blink button (DECterm), 149
Cursor Blink button (TM), 43
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Cursor keypad mode (PC), 263
Customer service

See Service
Customize Font Path dialog box (TM), 88
Customize menu (message box), 61
Customize menu (TM), 39, 85

AutoStart settings, 95
basic settings, 38 to 61
communication settings, 64 to 83
configuration management, 85
Configuration submenu, 86
Customize AutoStart dialog box, 95
Customize Boot dialog box, 98, 105
Customize DECnet dialog box, 81
Customize DECnet Name Translator

dialog box, 83
Customize Font Path dialog box, 88
Customize Keyboard dialog box, 41
Customize Language dialog box, 44
Customize LASTport dialog box, 72
Customize LAT dialog box, 70
Customize NFS dialog box, 78
Customize Pointer dialog box, 45
Customize Print Screen dialog box, 48
Customize Screen Background dialog box,

52
Customize Security dialog box, 50
Customize Serial and Parallel Ports dialog

box, 66
Customize Software Options dialog box,

110, 111
Customize TCP/IP dialog box, 73
Customize TCP/IP Name Server dialog

box, 75
Customize TCP/IP Routing Tables dialog

box, 77
Customize Terminal Manager dialog box,

57
Customize Window Color dialog box

color, 55
monochrome, 54

Customize X Server dialog box, 93
DECnet Name Translator settings, 82
DECnet settings, 81
display language, 44

Customize menu (TM) (cont’d)
font path, 86
keyboard settings, 41
LASTport group code settings, 71
LAT settings, 69
NFS mount points, 78
parallel port settings, 66
pointer and mouse settings, 45
resource files, 113
Resource files, 113
saving the Terminal Manager window, 61
screen background settings, 52
security settings, 50
serial port settings, 66
system settings, 84 to 113
TCP/IP Name Server settings, 74
TCP/IP routing table settings, 76
TCP/IP settings, 73
video alignment, 60
video alignment dialog box, 60
window color settings, 54
X server, 93

Customize Message Box (TM), 63
Customize Message dialog box (TM), 61
Customize NFS dialog box (TM), 78
Customize Software Options (TM), 111
Customized settings

DECwindows Customize utility, 9
from a host system, 9
overview, 7
problems

cannot change settings, 300
resource file, 7
terminal manager, 38, 64, 84
VXT 3270 windows, 180
VXT DECterm windows, 138
window manager, 213

D
Data processing keys, 42

ANSI keyboard, 253
DEC OSF/1 AXP operating system

NFS mount points, 78
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DEC OSF/1 AXP system
print command, 35
quitting a remote session manager, 28
TCP/IP Name Server settings, 74
TCP/IP printer port setup, 68
TCP/IP routing table settings, 76
TCP/IP settings, 73

DECnet address, 16
checking, 127
entering, 82

DECnet session
entering a host name or DECnet address,

16
starting, 16

DECnet terminal window
AutoStart, 95
ending, 28

DECnet transport
Customize DECnet dialog box (TM), 81
Customize DECnet Name Translator

dialog box (TM), 83
enabling, 81
name translator address

primary, 83
secondary, 83

Name Translator settings, 82
network buffer size

entering, 82
security, 50, 51
settings, 81
terminal’s DECnet address, 12

DECnet X session
AutoStart, 95
ending, 28

DECnet/SNA gateway, 161
DECterm window

customizing, 8
DECterm windows

See VXT DECterm windows
DECwindows

keyboard setting, 42
overview, 7

Default button, 216

Default Message Box Window (TM), 63
Default options

choosing, 210
Default Terminal Manager Window (TM), 61
<x Delete button (DECterm), 156
<x delete key, 156
<x delete key (ANSI), 249
Delete key (Sun), 273
Determine IP Address (TM), 74
Diacritical keys, 283
Diagnostic messages

VXT Message Box, 13
Dialog boxes

description, 208
making changes, 210
options menus, 208

Digital manuals
See Related documentation

Dimmed items, 210
Disable F3 Key (TM), 58
Display Cursor button (DECterm), 149
Display Options dialog box (DECterm), 148
Display Scaling (TM), 94
Dithering, 49
Documentation, 321

online, 4, 36
ordering, 322

Domain name, 76
Double clicking

defined, 196
Dragging

See also Pointer shapes
defined, 196

Dynamic Routing button (TM), 77

E
EBCDIC translation table, 193
Echoing data, 152
Edit menu

VXT 3270 window
format, 171
Select All, 171

VXT DECterm window
format, 130
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Edit menu
VXT DECterm window (cont’d)

Select All, 131
Editing

VXT 3270 window, 170
Editing keypad

ANSI keyboard, 250
used as a mouse, 250

Electrical specifications, 327
Ending a session, 27
Enet address, 126
Enter Connection Parameters dialog box

(3270), 163
Enter key (ANSI), 251
Enter key (PC), 262
Return key (Sun), 271
Environmental specifications, 327
Error codes

booting, 302
NFS, 300

Error messages, 302
See Diagnostic messages
displaying, 62

Errors
Ethernet, 121
LASTport protocol, 121
LAT protocol, 118

ESC character, 155
Esc key (PC), 263
Esc key (Sun), 271
Escape key, 155
Ethernet

displaying errors and counters, 121
Ethernet address, 126

hardware address, 12
when using DECnet, 12

Ethernet Counters dialog box (TM), 120
Ethernet problems, 298
Ext key

location, 176
Extend key (short ANSI), 256, 257

F
F1 (Hold) key (ANSI), 251
F2 (Print) key (ANSI), 251
F3 key

hiding the Terminal Manager window, 58
F5 (Break) key, 154
F5 (Break) key (ANSI), 252
Factory-default settings

restoring, 303
File menu (DECterm), 137
Finish Printing (DECterm), 136
Font

problems, 299
scaling the display of, 94
VXT DECterm window, 144, 145

custom fonts, 146
Font manager

enabling or disabling use of, 112
Font path

activating, 87
checking, 126
directory, 89
entering, 88
errors, 92
font source, 88
NFS, 90
removing, 89
TCP/IP, 91
TFTP, 90
transport, 88

Font server
TCP/IP font path, 91

Fonts
font path settings, 86 to 92

Foreground color (WM), 221
Form Feed Terminator button (DECterm),

158
Function keys, 258

ANSI keyboard, 249, 251
PC keyboard, 263
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G
General Options dialog box (DECterm), 150
German Standard Font button (DECterm),

145
Getting Started menu

figure, 36
Getting Started menu (TM), 36
Graphics Options dialog box (DECterm), 157
Graphics printing button (DECterm), 159
Gray scale

monitor setting, 94
printing, 49

Grayscale color model, 314
Group code

entering, 71
Group Shift key (German), 250, 285

H
Hebrew keyboard

Customize Keyboard Type (TM), 41
Hebrew language

Customize Language dialog box (TM), 44
Hexadecimal key sequences, 286
Hiding

Terminal Manager window, 58
VXT Message box, 58

HLS color model, 310
Hold key

See F1 key
Horizontal Cursor Coupling button

(DECterm), 149
Horizontal Scroll Bar button (DECterm),

149
Host applications

See Remote applications
Host Preconfigured button (TM), 106
Host status line, 149
Host-based software, 3

font path
checking, 126

monitoring memory usage, 6

Host-based terminals
loading VXT software, 100

Host-based window manager, 57
HP–UX operating system

IP X session, 18
print command, 35

I
IBM AIX operating system

print command, 35
Icon box

saving the size and location of, 222
Icon color settings

window manager, 223 to 224
Icon Name button (DECterm), 145
Icon settings

window manager, 221 to 223
Icons, 201

customizing colors of, 224
displaying the icon box, 222
labels and images, 223
location of, 222
making a window active, 218
rearranging, 202
restoring, 93, 157
restoring windows, 203
size, 222
stacking, 205

Icons (DECterm)
selecting icon names, 145

Image accelerator board
functions, 317

Indicator lights, 254
InfoReader library, 4

accessing, 36
enabling or disabling use of, 112

InfoReader Library dialog box, 37
InfoServer system, 3

defined, 3
font path, 89
fonts

for VXT DECterm window, 146, 147
LASTport group codes, 71
name, 125

Index–7



Input focus
giving a window, 199

IP address, 17
checking, 126
domain name, 76
entering, 73, 74
entering an indirect address, 19
formats, 18
primary name server, 75
reading from a host, 74
secondary name server, 76

IP subnet mask
entering, 74

IP transport
for loading VXT software, 100

IP X session
AutoStart, 95
limit, 17
quitting, 28

J
Janus-faced keys, 263

K
# £ key (short ANSI), 259
Key bindings, 227
Keyboard

ANSI keyboard, 247, 248
auto repeat feature, 155
Customize Keyboard dialog box (TM), 41
indicator lights, 254
launching applications

local, 235
remote, 240

local echo, 152
PC keyboard, 260
PC keycodes, 266 to 269
problems, 295
short ANSI keyboard, 255
specifications, 326, 328, 329, 330
Sun keycodes, 274 to 277
Sun style keyboard, 270
UNIX keyboard, 255

Keyboard (cont’d)
VXT 3270 window, 184
warning bell, 155

Keyboard model
setting, 41

Keyboard Options dialog box (DECterm),
154

Keyboard settings (TM), 41 to 43
Keyclick, 254, 255, 264, 273

volume slide bar, 42
Keys

repeating, 43

L
LA printers

print settings for, 49
Language

Customize Language dialog box (TM), 44
display, 44
keyboard, 41

LASTport group code
entering, 72

LASTport transport
Customize LASTport dialog box (TM), 72
displaying errors and counters, 121
font path, 89
group code settings, 71

LAT Counters dialog box (TM), 118
LAT session

starting, 15
LAT terminal window

AutoStart, 95
creating, 28

LAT transport
circuit timer, 70
Customize LAT dialog box (TM), 70
displaying errors and counters, 118
font path, 91
font paths, 88
keep alive timer, 71
printing from a host, 68
retransmit timer, 71
security, 50, 51
settings, 69
terminal’s LAT address, 12
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LAT transport (cont’d)
tuning performance, 69
VXT EX security, 245

LAT X session
AutoStart, 95
ending, 28

Launching
applications, 232
sessions, 232

Lights
See Indicator lights

List Known Hosts button (TM), 19
Listed Users Only button (TM), 51
Little Font button (DECterm), 145
Local Echo button (DECterm), 152
Lock key (ANSI), 249
Lock key (short ANSI), 257
Lock Key State (TM), 43
Lock UDKs button (DECterm), 152
Lock User Features button (DECterm), 152
Lower button (WM)

using, 204
lp command, 35
lpr command, 35

M
Managing terminals, 85
Margin bell, 255, 264, 273
Margin Bell button (DECterm), 155
Matte

customizing, 225
Matte settings

window manager, 225 to 226
Maximize button (WM)

using, 200
MB3 pop-up menu (3270), 178
Memory

clearing, 6
controller board, 5
memory modules, 5
monitoring the use of, 123
monitoring usage, 6
requirements, 5
size, 127

Menu bindings, 227
changing or adding, 229

Menus
displaying from the keyboard, 206
overview, 206
pop-up menus, 207
pull-down menu, 206

Message Box, 13
AutoStart, 95
Customize menu, 61
displaying, 63

Message Box (TM)
booting software option, 112

Message region
scroll lines saved, 62
title, 62

Messages
controlling displays, 61
displaying, 62
pause prompt box, 59

Metric button(TM), 78
Minimize button (WM)

using, 201
Mnemonic, 206
Modem Control buttons (TM), 69
Modems

breaking communication, 252
part numbers, 324

Modified ISO-Latin Character Set
figure, 193

Monitor
color, 94
gray scale, 94
problems, 294

Monitors
specifications, 326, 327

MOP Boot File box (TM), 106
MOP transport

for loading VXT software, 100
MOP trigger

for rebooting the terminal, 107
Motif window manager

AutoStart, 95
restarting, 23
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Motif Window Manager (TM)
booting software option, 111

Mounting files
errors, 300

Mouse
See also Using scroll bars
button layout, 46
buttons defined, 195
double click timeout, 47
editing keypad, 250
figure, 196
pointer acceleration, 46
problems, 295
settings, 45
specifications, 327, 330
using, 195
using the editing keypad as a mouse, 252

Mouse button bindings, 227
Move button (WM)

using, 203
Multinational character sets, 152
Multiple VXT Launchers, 237

N
Name server, 74
National replacement character sets, 156
Network

monitoring network utilization, 123
problems, 298
routes

TCP/IP, 117
status, 28, 114
TCP/IP routing tables, 77

Network address, 12
Network buffer size

DECnet, 82
Newline button (DECterm), 151
NFS mount points scroll box (TM), 79
NFS transport

error codes, 300
font path, 90
mount points, 78

No Form Feed button, 49
Nonselectable items, 210
Normal Cursor Keys button (DECterm), 152
Normal font setting (DECterm), 144
Normal Print Mode button (DECterm), 159
Num Lock key (Sun), 272

Number generator mode (PC), 263
Number generator mode (Sun), 272
Number of Bit Planes button (DECterm),

158
Numeric keypad

ANSI keyboard, 251
PC keyboard, 263
Sun style keyboard, 272
VXT 3270 window, 175

Numeric Keypad button (DECterm), 152

O
OK button, 40, 216

VXT DECterm options, 140
Online documentation, 4, 36
Open Look window manager, 29

fonts
host system, 31
InfoServer system, 31

setup, 29
OpenVMS operating system

DECnet Name Translator settings, 82
DECnet settings, 81
LAT settings, 69
print command, 35

Option settings
VXT DECterm

recalling, 141
Options

ordering, 322
part numbers, 324 to 325
viewing installed options, 127
VXT DECterm window, 138 to 160

Options button (TM), 245
Options menu (DECterm), 135, 139

7-BIT NRCS Selection Options dialog box,
156

Display Options dialog box, 148 to 150
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Options menu (DECterm) (cont’d)
General Options dialog box, 150 to 154
Graphic Options dialog box, 157 to 158
Graphics Options dialog box, 157
Keyboard Options dialog box, 154 to 156
Printer Options dialog box:, 158 to 160
saving and restoring settings, 140
Window Options dialog box, 142 to 147

Options menus, 208
Options submenu (WM), 213 to 231

border colors, 220
border settings, 218
icon, 221
icon color, 223
list of window manager functions, 228
matte, 225
resource configuration, 226
Workspace: Border Color Options dialog

box, 220
Workspace: Border Options dialog box,

218
Workspace: Customize Resource dialog

box, 227
Workspace: Icon Color Options dialog box,

223
Workspace: Icon Options dialog box, 221
Workspace: Matte Options dialog box,

225
Workspace: Options dialog box, 216

Output Color Mode buttons (TM), 49

P
Pagefile, 125
Parallel communication

settings, 66
Parallel port

customizing, 66
for printing, 67

Parity, 68
Parity Check button (TM), 68
Paste menu item

VXT 3270 window, 171
VXT DECterm window, 130

Pasting text
host synchronization, 130
Quick Copy, 132, 172
remote DECterm windows, 132, 172
VXT 3270 window, 171, 172
VXT DECterm window, 130, 131

Pause key (PC), 264
Pause key (Sun), 272
Pausing a session, 25

resuming the session, 26
PC keyboard, 260 to 269

ANSI keyboard option, 260
editing keypad, 263
figure, 261
function keys, 263
Janus-faced keys, 263
main keypad, 261
models, 260
numeric keypad, 263
redefining keys, 265
special-function keys, 262

PF keys (3270), 174
PF1 to PF4 keys, 251
Photographic images

printing, 49
Picker color model, 307
ping

definition, 115
Pointer

settings, 45
shapes, 197, 201

Pointing
defined, 196

Pop-up menus, 207
Port number

specifying for Telnet, 18
Port usage

serial or parallel, 67
# £ pound key (ANSI), 253
Power-up self-test, 302
Preferred Services scroll box, 14

entries added to menus, 23
managing, 22
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Pressing
defined, 196

Print All Characters button (DECterm), 160
Print All Text (DECterm), 136
PRINT command, 35
Print Full Page + Transcript button

(DECterm), 160
Print Full Page button (DECterm), 160
Print Graphics (DECterm), 136

F2 (Print) key, 159
Print key

See F2 key
Print menu (DECterm), 135
Print National Characters + Line Drawing

button (DECterm), 160
Print National Characters Only button

(DECterm), 160
Print Screen (TM)

booting software option, 112
Print Screen key (PC), 264

PrSc key (Sun), 272
Print screen settings, 48
Print Scroll Region Only button (DECterm),

160
Print Selected Text (DECterm), 136
Print Selection Only button (DECterm), 160
Print Text Page (DECterm), 136
Printer controller mode, 159
Printer Options dialog box (DECterm), 158
Printer port

choosing serial or parallel, 67
Printer Port button (TM), 68
Printer to Host button (DECterm), 159
Printers, 32

baud rate, 68
problems, 295

Printing, 32
canceling, 34
center image, 49
Customize Print Screen dialog box (TM),

48
dithering, 49
form feed character, 49
from a host system, 34

canceling, 35

Printing
from a host system (cont’d)

HP–UX or SCO ODT, 35
OpenVMS, 35
ULTRIX, DEC OSF/1 AXP, SunOS, or

IBM AIX, 35
from a TCP/IP or LAT host, 68
from DECterm windows, 158 to 160
from the host system, 159
gray scale or color, 49
LAT print jobs

canceling, 33
network

enabling or disabling, 112
output format, 48
pixel aspect ratio, 49
Print Screen menu, 32
printer status, 34
ribbon or toner saver, 49
rotated image, 49
TCP/IP print jobs

canceling, 33
the screen, 159
under host control, 159
using TCP/IP, 34
VXT 3270 window, 171

Problems, 293
Pull-down menu

displaying, 206
Push button

defined, 210

Q
Quick Copy, 132, 172
Quitting

a remote session manager, 29

R
Radio button

defined, 210
Reboot menu item, 27

Index–12



Reboot Options box (TM), 107
Record dialog box (3270)

figure, 174
Record Lines Off Top box (DECterm), 150
Record Lines Off Top button (DECterm), 148
Recording key sequences (3270), 174
ReGIS graphics, 157, 158

VXT DECterm window, 141
Related documentation, 321
Remote application

entering the VXT launcher name, 21
Remote applications

starting
Create dialog box, 21

Remote session managers, 28
Remote window manager, 57
Report Macrograph Contents button

(DECterm), 157
Reset button, 216
Reset menu item, 27
Reset Terminal menu item (DECterm), 134
Resize border

customizing, 219
Resize cursor, 201
Resize Window menu item (DECterm), 133
Resizing

VXT DECterm windows, 144
Resource file, 7

specifying, 113
Resource settings

window manager, 226 to 231
Restore button (WM)

using, 203
Restore Message Box Window(TM), 63
Restore Terminal Manager Window (TM), 61
Restoring feature settings

terminal manager settings, 40
window manager settings, 215

Restoring settings
VXT DECterm windows, 140

Return key
selecting the function of, 151

Return key (ANSI), 249

RGB color model, 312
Rotate/Scale Picture button (TM), 49
Routes scroll box (TM), 78
Rows and columns (DECterm), 144
rsh commands

launching applications, 241

S
Save Message Box Window(TM), 63
Save Terminal Manager Window (TM), 61
Saving feature settings

terminal manager settings, 40
window manager settings, 215

Saving settings
VXT DECterm windows, 140

Scale
defined, 209

SCO ODT operating system
print command, 35

Scratch pad, for color, 314
Screen

Customize Screen Background dialog box
(TM), 52

Screen background, 53
Screen color (TM), 52
Screen Saver button (TM), 53
Screen settings (TM), 52
Scroll bar, 211

Scroll region, 211
Scrolling methods, 211

Scroll Lock key (PC), 264
Scroll Lock key (Sun), 272

Scrolling
controlling, 155

Seating, 332
Secondary Boot button (TM), 107
Security

Customize Security dialog box (TM), 50
OpenVMS sessions, 29

Security settings, 50
adding authorized users, 51
authorizing TCP/IP, LAT, or DECnet

connections, 50
removing authorized users, 51
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Security settings (cont’d)
VXT EX, 245

Select All menu item
VXT 3270 window, 171
VXT DECterm window, 130

Serial communication
baud rate, 68
settings, 66

Serial port
customizing, 66
for printing, 67

Serial printer
setup, 159

Serial session
starting, 15

Serial terminal window
AutoStart, 95
ending, 28

Server-based software, 4
font path

checking, 126
pagefile, 125

Server-based terminals
loading VXT software, 102

Service, 304 to 305
Session

AutoStart, 24
AutoStart settings, 95
creating

VXT Create pop-up menu, 23
ending, 27
help on creating, 36
pausing, 25
quitting from a remote session manager,

29
starting, 14

DECnet session, 16
IP session, 17
LAT session, 15
serial session, 15

using preferred services, 23
Session menu (TM), 24, 25, 27

Status submenu, 115

Session Status menu (TM)
TCP/IP Network Test (ping) dialog box,

115
TCP/IP Routes dialog box, 117

Setup
See Customize menu, Options submenu

Setup Key (VXT EX), 245
Shadow colors (TM), 55
Shadow colors (WM), 221
Share Color Map Entries button (DECterm),

157
Shift clicking

defined, 196
Shift key (ANSI), 249
Shift key (short ANSI), 258
Shift key (PC), 262
Shift key (Sun), 271
Short ANSI keyboard, 255 to 260

arrow keys, 258
extended ANSI layout, 256
figure, 255
main keypad, 256
predefined keys, 258
special-function keys, 257
top-row function keys, 258
user-defined keys, 259

Shutdown menu item, 27
Site preparation, 326
Sixel graphics, 158

VXT DECterm window, 141
Size button (WM)

using, 203
Slider

in scroll bar, 211
Software options

turning off, 110
Solving problems, 293
Specifications, 326 to 330
Startup State (TM), 58
Status Display button (DECterm), 149
Status indicators (VXT 3270), 169
Status line, 149
Status submenu (TM), 115

Ethernet Counters dialog box, 120
figure, 115
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Status submenu (TM) (cont’d)
LAT Counters dialog box, 118
System Configuration dialog box, 124
System Monitor dialog box, 123
using, 114 to 127

Status update frequency
seconds, 59

Stepping arrow, 211
Sun style keyboard, 270 to 277

editing keypad, 272
figure, 270
function keys, 271, 273
main keypad, 271
numeric keypad, 272
redefinding keys, 274

Sun system
font conversion, 31

Sun systems
Open Look window manager, 29

SunOS operating system
print command, 35

System box
problems, 293
specifications, 326

System Configuration dialog box (TM), 124
System Defaults button, 40
System Monitor dialog box (TM), 123
System-default settings

VXT DECterm
recalling, 141

T
Tab key (ANSI), 249
Tab key (PC), 262
Tab key (Sun), 271
TCP/IP Network Test (ping) dialog box (TM),

115, 116
TCP/IP Routes dialog box (TM), 117
TCP/IP session

displaying available hosts, 19
entering a host name or IP address, 17

options, 18
entering an indirect host name or IP

address, 19
preferred services

TCP/IP session
preferred services (cont’d)

adding from the Known Hosts dialog
box, 20

starting, 17
TCP/IP transport

Customize TCP/IP dialog box (TM), 73
Customize TCP/IP Name Server dialog

box (TM), 75
Customize TCP/IP Routing Tables dialog

box (TM), 77
enabling, 73
font path, 91
Name Server settings, 74
printing from a host, 68
routing table settings, 76
security, 50, 51
terminal settings, 73
terminal’s IP address, 12
VXT EX security, 245

Telnet terminal window
AutoStart, 95
ending, 28

Terminal
LASTport group codes, 71
network addresses, 12
overview, 1 to 10
problems, 296
resource file name, 127
status, 28, 114
system configuration, 124
TCP/IP address, 73

Terminal address, 126
Terminal ID button (DECterm), 153
Terminal Manager window, 11 to 37

AutoStart, 95
closing, 13
controlling display of, 58
Create dialog box, 14
Create menu, 14
Customize menu, 84

communications, 64
user preferences, 38

customizing, 8
features, 12
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Terminal Manager window (cont’d)
figure, 12
Getting Started menu, 36
hiding, 14, 58
icon, 58
option settings

saving and recalling, 40
Print Screen menu, 32
saving the size and position of, 61
Session menu, 24, 25
starting, 21
using, 11 to 37

Terminal Size box (DECterm), 144
Terminal Tag (TM), 59
Terminal window

on the serial port
AutoStart, 95

Test
power-up self-test, 302

Text-entry boxes
typing in, 209

TFTP
font path, 90

Tilde key, 155
Title bar

moving a window with, 200
Translation table, 193
Troubleshooting

boot error codes, 302
Troubleshooting problems, 293
Typewriter keys, 42

U
ULTRIX operating system

DECnet Name Translator settings, 82
DECnet settings, 81
NFS mount points, 78
print command, 35
quitting a remote session manager, 28
TCP/IP Name Server settings, 74
TCP/IP printer port setup, 68
TCP/IP routing table settings, 76
TCP/IP settings, 73

UNIX operating system
NFS mount points, 78
quitting a remote session manager, 28
TCP/IP Name Server settings, 74
TCP/IP printer port setup, 68
TCP/IP routing table settings, 76
TCP/IP settings, 73

UPSS DEC Supplemental button (DECterm),
152

UPSS ISO Latin 1 Supplemental button
(DECterm), 152

User-defined keys
ANSI keyboard, 252
locking, 152
short ANSI keyboard, 259

User-preferred settings, 38
User-preferred supplemental sets, 152

V
Vertical Cursor Coupling button (DECterm),

149
Vertical Scroll Bar button (DECterm), 148
Video alignment

Customize video alignment dialog box
(TM), 60

VX227 terminal, 60
VRM17 monitor settings, 294
VT emulation mode (DECterm), 153
VX227 terminal

video alignment controls, 60
VXT 2000 windowing terminal

overview, 1 to 10
VXT 3270 window

Access Name, 164
Application Name, 165
Authorization Password, 165
AutoStart, 95
character set

translation table, 193
character sets, 10
checklist, 162
connection parameters, 177
creating a session, 162
cursor

Index–16



VXT 3270 window
cursor (cont’d)

moving, 170
customizing, 8, 180 to 194
Data parameter, 165
Define Key dialog box

figure, 181
display

customizing, 183
Edit menu, 171
editing data, 170
enabling or disabling use of, 112
Enter Connection Parameters dialog box,

163
entering data, 169
exiting, 179
field attributes, 177
function list, 177
Gateway, 164
key functions, 187
keyboard functions, 184
keyboard layout map, 176
Logon Mode, 165
mouse, 184
numeric keypad

entering numbers, 175
overview, 161
pop-up menu, 178
printing, 171
protected and unprotected fields, 168
PU Name, 164
recording key sequences, 174

canceling, 175
playing back, 175
viewing, 175

Selector Mouse, 184
Session Address, 164
status indicators, 169
Terminal Type, 165
user-defined keys, 180

deleting, 182
saving and loading, 182

using, 161 to 179
VXT 3270 TE dialog box

figure, 167

VXT 3270 window (cont’d)
Wait parameter, 166
Window Options dialog box

figure, 183
work area, 167

format, 168
VXT application

starting, 21
VXT application launcher

See Application launcher
VXT Create pop-up menu (WM), 23, 24
VXT DECterm window

answerback message, 154
character set selection, 152, 153
character sets, 10
choosing a 7-bit NRC character set, 156
clearing, resetting, or resizing, 133
color, 149
Commands menu, 133
cursor, 150
cursor key functions, 152
customizing, 8
display settings, 148 to 150
Edit menu, 130
exiting, 137
font size, 145
format, 128
general settings, 150 to 154
graphics settings, 157 to 158
icon name, 145
keyboard settings, 154 to 156
locking UDKs, 152
numeric keypad function, 152
options, 138 to 160

saving and restoring, 141
saving and restoring settings, 140

Options menu, 135, 139
Print menu, 135
printer settings, 158 to 160
printing, 135 to 136
problems, 300
resizing, 144
rows and columns, 144
scrolling speed, 150
using, 128 to 137
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VXT DECterm window (cont’d)
window settings, 142 to 147
window title, 144

VXT DECterm windows
enabling and disabling, 111

VXT EX button (TM), 107
VXT EX software

loading, 243
overview, 4
security, 245
specifying, 98
switching to VXT software, 246
using, 242

VXT loader file (VXTLDR), 106
VXT Message Box, 13

closing, 13
controlling display of, 58
Customize menu

Customize Message dialog box, 61
customizing, 61
figure, 13
hiding, 14, 58
icon, 58
saving the size and position of, 63
starting, 21

VXT software
boot commands, 108
booting

from VXT EX Options dialog box,
246

loading
from an InfoServer system, 102
host-based operation, 100

loading process, 99
overview, 3
restarting, 27
software options, 126
specifying a version, 98
system image names, 101, 103
turning off options, 110
version number, 125

VXT Software button (TM), 107

W
Warning bell, 255, 265, 273

volume slide bar, 42
Warning Bell button (DECterm), 155
3270 window

See VXT 3270 window
customizing, 8

Window borders
customizing, 219

Window colors (TM), 54, 55
color, 55
monochrome, 54

Window manager
border colors, 220
border settings, 218
customizing, 8
defining

button, 226, 230
key, 226, 230
menu, 226
menu item, 229

icon colors, 223
icon settings, 221
launching applications, 232

local, 233
remote, 236

list of functions, 228
matte, 225
option settings

saving and restoring, 215
Options submenu, 214
remote, 29

Open Look window manager, 29
starting, 21
workspace settings, 216

Window manager menu
customizing colors, 221

Window menu (WM)
moving a window with, 203
using, 200

Window Options dialog box (DECterm), 143
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Window size
when moving or resizing, 218

Window Title button (DECterm), 144
Windows, 195 to 212

See also Pointer shapes
action when removed, 218
activating, 217, 218
background color, 56
changing input focus, 205
changing the size of, 200
closing with the window menu button,

219
customizing

colors, 221
defined, 197
foreground color, 56
highlight color, 56
lowering to the bottom of the stack, 202
moving, 199, 218
Options submenu, 213
popping to the top of the stack, 202
reducing to icons, 201
resizing, 203, 204
restacking, 205
restoring from icons, 203
saving window settings, 215
selecting, 199
settings

VXT DECterm windows, 142
shadow colors, 55, 56
stacking, 202, 217

Work environment, 331
Work group

resource file name, 127
Workspace button (WM)

using, 204
Workspace settings

window manager, 216 to 218
Workspace submenu (WM), 204

launching applications, 233
Workspace: Border Color Options dialog box

(WM), 220

Workspace: Border Options dialog box (WM),
218

Workspace: Customize Resource dialog box
(WM), 227

Workspace: Icon Color Options dialog box
(WM), 223

Workspace: Icon Options dialog box (WM),
221

Workspace: Matte Options dialog box (WM),
225

X
X image extension (XIE) software, 316 to

320
bitonal images, 317
enabling, 107
pipeline constraints, 318
pipeline examples, 319
pipelines, 317

X Image Extension (XIE) software
enabling or disabling use of, 112

X Image Extension button (TM), 107
X server, 93 to 94

checking for XIE capability, 317
Customize X Server dialog box (TM), 93
Monitor, 94
scaling the display, 94

X Session Reset Server Action (TM), 94
X Window System, 7
X11 colors, 313
XOFF signal, 69
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